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C omputers for consumers have come a long
way in just 20 years or so. They're now at

the heart of the way many people communicate,
shop, and learn. They provide useful tools for

tracking information, organizing finances, and
being creative.

During the rapid growth of the personal com-
puter, you might have been too busy to jump in
and learn the ropes, but you now realize how
useful and fun working with a computer can

be — and you've decided to opt for a laptop.

This book can help you get going with your
laptop quickly and painlessly.

About This Book

This book is specifically written for mature
people like you, folks who are relatively new to
using a computer and want to discover the
basics of buying a laptop, working with software,
and getting on the Internet. In writing this
book, I've tried to take into account the types
of activities that might interest a 50+ year old
citizen discovering computers for the first time.

Foolish Assumptions

This book is organized by sets of tasks. These
tasks start from the very beginning, assume you
know little about computers, and guide you
through from the most basic steps in easy-to-
understand language. Because I assume you're
new to laptops, the book provides explanations
or definitions of technical terms to help you out.

|1 .
Introduction

Conventions used in
this book

This book uses certain conventions fo help you
find your way around, including:

w=» When you have to type something in a text
hox, | put it in bold type. Whenever |
mention a Web site address, | put it in
another font, 1ike this. Figure
references are also in bold, to help you
find them.

w=p For menu commands, | use the <> symbol fo
separate menu choices. For example, choose
Tools=>Internet Options. The => symbol is
just my way of saying “Open the Tools menu
and then click Internet Options.”

w=p Callouts for figures draw your attention fo an
action you need to perform. In some cases,
points of inferest in a figure might be circled.
The text tells you what o look for; the circle
makes it easy fo find.

Tip icons point out insights or helpful
suggestions related fo tasks in the
step list.
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All computers are run by software called an operating system, such as
Windows. Because Microsoft Windows-based personal computers
(PCs) are the most common type, the book focuses mostly on
Windows 7 functionality.

Why You Need This Book

Working with computers can be a daunting prospect to people who
are coming to them later in life. Your grandchildren may run rings
around you when it comes to technology, and you might have fallen
for that old adage, “You can't teach an old dog new tricks.” However,
with the simple step-by-step approach of this book, you can get up to
speed with your laptop and overcome any technophobia you might
have experienced.

You can work through this book from beginning to end or simply
open up a chapter to solve a problem or help you learn a new skill
whenever you need it. The steps in each task get you where you want
to go quickly, without a lot of technical explanation. In no time, you'll
start picking up the skills you need to become a confident laptop user.

How This Book Is Organized

This book is conveniently divided into several handy parts to help
you find what you need.

w= Part I: First Steps with Your Laptop: If you need to

buy a laptop or get started with the basics of using a
computer, this part is for you. These chapters help
you understand how a laptop differs from a desktop
computer, explore the different specifications, styles,
and price ranges for laptops, and discover how to set
up your laptop out of the box, including hooking it up
to a printer. There’s even a chapter on the important
topic of power management so that you can maximize
the battery life of your laptop.
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Part II: Exploring Windows: These chapters provide
information for exploring the Windows desktop
when you first turn on your computer and customizing
Windows to work the way you want it to. Finally, I
provide information on using the Help system that'’s
part of Windows.

Part III: Having Fun and Getting Things Done with
Software: Here’s where you start working with that
new laptop. First, I cover how to work with applications
and the files you create with them. Then, using the
popular and inexpensive (or often free) Microsoft
Works software, discover how to create documents in
the Works Word Processor and work with numbers
in the Spreadsheet application. Chapters in this part
also introduce you to built-in Windows applications
you can use to work with digital photos, listen to
music, and play games.

Part IV: Exploring the Internet: It's time to get
online! The chapters in this part help you understand
what the Internet is and what tools and functions it
makes available to you. Find out how to explore the
Internet with a Web browser; how to stay in touch
with people via e-mail, instant messaging, chat,
blogs; and even how to make Internet phone calls.

Part V: Taking Care of Your Laptop: Now that you
have a laptop, you have certain responsibilities
toward it (just like having a child or puppy!). In this
case, you need to protect your laptop from theft and
protect the data on your computer, which you can
do using Windows and Internet Explorer tools.

In addition, you need to perform some routine
maintenance tasks to keep your hard drive uncluttered
and virus free.
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Get Going!

Whether you need to start from square one and buy yourself a laptop
or you're ready to just start enjoying the tools and toys your current
laptop makes available, it’s time to get going, get online, and get

laptop savvy.
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Discovering the
Laptop Advantage

Laptop computers started as very expensive
options for those who travelled on business
and were willing to carry almost ten pounds

of machine to be able to use a computer on
the road.

Move forward in time, and you'll find that lap-
tops have become a much more affordable,
portable, and ubiquitous option that many are
choosing as their only computer, whether they
travel much or not. If you're thinking about
joining the laptop revolution, it's time you
understand the advantages a laptop can offer.

In this chapter, I introduce you to the key differ-
ences between a desktop computer and a laptop,
the computing opportunities your laptop offers,

and the different styles of laptops available.

Understand the Difference
between a Desktop and Laptop

The fact is that when it comes to performing
computing tasks, a desktop and laptop are pretty
much identical. They both have an operating
system such as Windows 7 or Mac OS X. They
both contain a hard drive where you store data
and computer chips that process data, and they
both run software and access the Internet.
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Where a desktop and laptop differ is their physical appearance, size,
and weight. Here’s a rundown of the key differences:

w= Appearance: A desktop computer is typically encased

in a tower into which you plug a separate monitor,
keyboard, and mouse. (Though some newer models
have the brains of the computer incorporated into a
monitor base.) A laptop has all its parts in one unit,
as shown in Figure 1-1. The central processing unit
(CPU), chips, monitor, keyboard, and touchpad (a
laptop version of a mouse) all fit in one compact
package including ports for plugging in peripherals
such as a transmitter for a wireless mouse or printer.

'.".' Gateway. Shop Computers Displays Support |E\

Spread Some Holiday Cheer

With the stylish Gateway NV, now in 15.6" and 17.3” models.

Figure 1-1

w= Power source: A desktop computer is powered by
plugging it into a wall outlet. A laptop contains
a battery; you can run the laptop off of a charged
battery, or plug the laptop into a wall outlet.

w= Portability: Having a battery and coming in a more
compact package makes a laptop more portable
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(though some larger models are a bit hefty to tote
around); a desktop stays put on a desktop as a rule.

w= Extras: Very small laptops might not include a CD/
DVD drive and therefore require an external drive,
like the one shown in Figure 1-2, to be attached.
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Figure 1-2

Explore All You Can Do with Your Laptop

Your laptop is a computer in a smaller package, so you can perform all
the typical computing tasks with it. If you've never owned a computer
of any type, your laptop purchase will open up a world of activities.
Even if you're buying your laptop just to do e-mail (I hear this a lot
from seniors!), do yourself a favor and explore a few other computing
tasks that your laptop will allow you to do, such as:

w= Running software programs such as word processors
to write letters or create flyers, spreadsheet software
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to organize your finances or household inventory, or
photo-imaging software to work with your snapshots.

Working with financial activities, from keeping your
checkbook and credit card records in software data-
bases and doing your taxes to investing, banking,
and shopping online. These types of activities can be
very safe to perform online, and they are incredibly
convenient, with your accounts available 24/7.

Keep in touch with friends and family. The Internet
makes it possible to communicate with other people
via e-mail; share video images using Webcams (tiny,
inexpensive video cameras that capture and send your
images to another computer); and make phone calls
using a technology called VoIP (Voice over Internet
Protocol) that uses your laptop and Internet connec-
tion to place calls. You can also chat with others by
typing and sending messages using a technology
called instant messaging. These messages are exchanged
in real time so that you and your grandchild, for
example, can see and reply to text immediately. Part V
of this book explains these topics in more detail.

Research any topic from the comfort of your
home. Online, you can find many reputable Web
sites that give you information on anything from
expert medical advice to the best travel deals. You
can read news from around the corner or around the
world. You can visit government Web sites to find
out information about your taxes, social security,
and more, or even go to entertainment sites to look
up your local television listings.

Create greeting cards, letters, or home inventories.
Whether you're organizing your holiday card list or
figuring out a monthly budget, computer programs
can help. For example, Figure 1-3 shows a graph that
the Excel program creates from data in a spreadsheet.
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Pursue hobbies such as genealogy or sports. You
can research your favorite teams online or connect
with people who have the same interests. The online
world is full of special-interest chat groups where
you can discuss these interests with others.

Play interactive games with others over the
Internet. You can play everything from shuffleboard
to poker or action games in virtual worlds.

Share and create photos, drawings, and videos. If you
have a digital camera, you can transfer photos to your
laptop (doing this is called uploading) or copy photos
off the Internet and share them in e-mails or use them
to create your own greeting cards. If you're artistically
inclined, you can create digital drawings. Many popular
Web sites make sharing digital movies easy, too. If you
have a digital video camera and editing software, you
can use editing tools to make a movie and share it with
others. Steven Spielberg, look out!

Shop online and compare products easily, day or
night. You can shop for anything from a garden
shed to travel deals or a new camera. Using handy

Chapter 1: Discovering the Laptop Advantage
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online features, you can easily compare prices from
several stores or read customer product reviews. Web
sites such as www.nextag. com list product prices
from a variety of vendors on one Web page, so you
can find the best deals. Beyond the convenience, all
this information can help you save money.

Appreciate the Portability Factor

Because your laptop is portable, you can move it around your house
or around town with relative ease. What does this portability allow
you to do?

w= You can access your e-mail account from anywhere
to stay in touch with others or get work done away
from home or the office. You can also store docu-
ments online so that you can access them from
anywhere.

w= [se public hotspots — locations that provide access to
the Internet, such as airports and Internet cafés — to
go online. For example, most hotels today provide
Wi-Fi access free of charge, so you can work on your
laptop from the lobby or your room.

w= Even if you're staying in town, it might be fun to
take your laptop to a local café and putter while
sipping a latte.

Check your laptop battery-life specifications.
Recently, laptops are coming out that provide as

much as 9 hours of battery life, but many still offer
only about 2 hours. If you plan to use your laptop
for an extended time, be sure you've charged your
battery (find out more about this in Chapter 3), and
keep an eye on it. You could lose some work if you
haven't saved it and the battery power runs out.

12
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Understand Types of Laptops

Today, there are several types of laptop that vary by size and weight,
functionality, and the way you enter information into them. Here are
some options available to you:

2
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The garden-variety laptop (also referred to as a note-
book computer) runs around 5-8 pounds and has a
monitor size ranging from about 13 inches to 16 or
so. It's portable and can handle most computing
tasks. Multimedia/gaming laptops are laptops that have
more sophisticated graphics and sound cards.

Desktop replacements are laptops with more heft. They
might weigh more than 10 pounds and have larger
monitors (perhaps 18 inches). Their keyboards are
roomier as well. However, though they aren’t too dif-
ficult to move around your home, they aren’t meant
to be as portable as other types of laptops.

Netbooks (see Figure 1-4) were first introduced for
those who mainly wanted to use a computer to
access the Internet. They lack CD/DVD drives and
weigh only about 2-3 pounds. They have less-powerful
and slower processors, and less memory (space to
store documents). Still, if you mainly want to check
e-mail from anywhere, a netbook might fit the bill.

Tablet PCs (see Figure 1-5) are a type of laptop with a
screen that allows you to write on it using a special type
of stylus. Software in a tablet PC can convert what you
write or draw into an electronic document. Some tablet
PCs are similar to a writing pad without a lid; others
have a lid like traditional laptops, but you can turn the
lid around to make the computer more “pad-like.”

Mobile Internet Devices (MIDs) are the latest addition
to the laptop lineup. A MID falls somewhere
between your cellphone and a netbook in size. It's
super portable, but for all but the most eager

13
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cellphone texters, a MID probably sports too small a
keyboard for everyday computing tasks.
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Buying a Laptop

If you've never owned a laptop and now face
purchasing one for the first time, deciding
what to get can be a somewhat daunting expe-
rience. There are lots of technical terms to fig-
ure out, various pieces of hardware (the
physical pieces of your laptop, such as the
monitor and keyboard) to become familiar
with, and software (the brains of the computer
that help you create documents and play
games, for example) that you need to
understand.

In this chapter, I introduce you to the world of
activities your new laptop makes available to
you, and I provide the information you need
to choose just the right laptop for you.
Remember as you read through this chapter
that figuring out what you want to do with
your laptop is an important step in determin-
ing which laptop you should buy. You have to
consider how much money you want to spend,
how you'll connect your laptop to the Internet,
and how much power and performance you'll
require from your laptop.
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Understand Hardware and Software

16

Your computing experience is made up of hardware and software. The
hardware is all the tangible computer equipment, such as the body of
your laptop containing the hard drive, keyboard, and touchpad for
pointing and clicking at items on screen, and the software is what
makes the hardware work or lets you get things done, such as writing
documents with Microsoft Word or playing a Solitaire game. Think

of the hardware as being like your television set, and think of the

software as being like the shows that you watch.

The hardware on your laptop consists of:
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A central processing unit (CPU), which is the very
small, very high-tech semiconductor chip that acts as
the brains of your computer. The CPU is stored in
your laptop along with the other nuts and bolts of
your computer.

A monitor, which displays images on its screen such
as the Microsoft Windows 7 desktop or a document
in a software program.

A keyboard, which is similar to a typewriter key-
board. In addition to typing words, you can use a
keyboard to give the computer commands.

A touchpad, which you also use to give your com-
puter commands, but this little device is more tactile.
You move your laptop cursor on the screen using a
built in pointing device, which might be in the form
of a touchpad or a small button. Slide your finger
around the touchpad. This moves a pointer around
onscreen. You position this pointer on an onscreen
button or menu name, for example, and then click a
left or right button on your laptop that causes an
action. You can also click and drag your finger to
select text or an object to perform an action on it
(such as deleting it or making the text bold).
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A Webcam and speakers, and probably a micro-
phone, are likely to be built into your laptop. A
Webcam allows you to produce video images you
can share in online meetings and instant messaging
sessions. Speakers play back sounds, and a built-in
microphone allows you to record audio files.

Peripherals, such as a printer or scanner. Your lap-
top comes with slots (called ports) where you plug in
various peripherals. The type of port you'll use most
often is called a USB port; it's a small slot useful for
plugging in small sticks called flash drives you can
store data on, or devices that typically today sport a
USB connector.

Software (also known as programs or applications) is installed on your
laptop hard drive, which resides in the laptop casing. Here are a few
basics about software:
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You use software to get your work done, run enter-
tainment programs, and browse the Internet. For
example, Quicken is a financial-management pro-
gram you can use to balance your checkbook or keep
track of your home inventory for insurance purposes.

Some programs come preinstalled on your laptop;
you can buy and install other programs as you need
them. For example, computers need to have an operat-
ing system installed to be any use at all, because it runs
all the other programs. Also, some programs are
included with your operating system — such as
Solitaire, an electronic version of the old favorite card
game, which comes with Windows 7. Skype, a program
that enables you to make online phone calls using your
laptop, is a popular program that you can find on the
Internet and install on your laptop yourself.

You can uninstall programs you no longer need.
Uninstalling unwanted programs helps to free up some
space on your laptop, which helps it perform better.

17
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w= Some software programs called utilities exist to
keep your laptop in shape. An antivirus program is
an example of a utility used to spot and erase com-
puter viruses from your system. Your operating system
(such as Windows 7 Home Premium, which you
hear more about in the task, “Choose a Version of
Windows") also includes some utilities, such as the
Windows Defender program. Windows Defender
protects your laptop from unwanted intrusion by
malicious programs called spyware. See Part V for
details about using utilities.

Select a Type of Laptop

18

Just as there are many styles of shoes or mobile phones, you can find
several styles of laptop. Some are smaller and more portable, while
others are essentially desktop replacements with large screens and a bit
of heft. Some use different operating systems to make everything run,
and some excel at certain functions such as working with graphics or
playing games. This task explains some features you'll need to consider
when choosing the type of laptop you should buy.

w= Operating system: An OS is the software that allows
you to work with all the other software programs,
manage files, and shut down your computer.
Windows is probably the most common computer
operating system, and this book focuses mainly on
its features.

However, Mac laptops from Apple are also popular.
These use Apple-specific software, and many soft-
ware applications written for Windows are also avail-
able for the Mac. You can also set up your Mac to
run the Windows operating system, which gives you
the best of both worlds. Some computers run on a
freely available operating system called Linux, which
has similar functionality to Windows.
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w= Computer design: A laptop is portable computer,
weighing anywhere from two to ten pounds or so.
The lightest ones (as light as two pounds) are called
netbooks. A tablet PC is a kind of laptop that allows
you to write on the screen with a special style, and
its design is uniquely compact. The monitor, key-
board, and touchpad are built into a laptop. Note
that if the monitor is damaged, you have to pay
quite a bit to have it repaired, or you can hook it up
to an external monitor.

Figure 2-1 shows (from left to right) a laptop,
netbook, and tablet PC. Laptops are perfect if you
want to use your computer mainly away from home
or you have little space in your home for a larger
computer. Consider their design and weight when
purchasing a laptop.

Figure 2-1

w= Pictures and sound: If you work with a lot of visual
elements (for example, photographs, home movies,
or computer games), consider a laptop that has a
good graphics card. Games often involve sound, so a
high-end sound card might also be useful. Laptops
with more sophisticated sound and image capabili-
ties are often referred to as gaming or multimedia
models, and they typically require a large-capacity
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hard disk to handle these functions. Because the
capabilities of these cards change all the time, I don’t
give you the specifications for what's considered high
end; instead, ask the person you're buying the laptop
from whether the system can handle sophisticated
sound and graphics.

Choose a Version of Windows

20

As mentioned in the previous task, your laptop’s operating system
(software that runs all the programs and organizes data on your
computer) will be one of your first choices. This book focuses on

computers running the current version of Windows, which is called
Windows 7. Windows 7 comes in three different versions for home
and business users. If you consider yourself primarily a home user,
you should consider the Home Premium version of Windows 7. The

three different versions of Windows 7 are:

w= Home Premium: Includes entertainment tools such
as Windows Media Center for playing music and
movies. If you want to do more than look at photos,
you'll find that this version of Windows 7 is good at
working with design and image manipulation pro-
grams such as Photoshop. Also be aware that Home
Premium includes great features for managing the
battery power of your laptop.

w= Windows 7 Professional: Great for small businesses
or working from home. This version of Windows has
ultimate security features.

w= Windows 7 Ultimate: Provides everything that
Professional provides, plus a few more bells and
whistles for protecting your laptop from thieves with
BitLocker and handling languages other than
English.



Chapter 2: Buying a Laptop

before that, Windows XP. Many people still use
computers that run Vista or XP and get along just
fine. However, Windows XP doesn’t come with as
many security tools. If you decide to use Windows
XP, find a friend or family member who's knowl-
edgeable about laptops and can help you use XP
features or other software programs that will help
keep your laptop secure. Note that if you're using
Vista or XP, some of the steps for common tasks are
different than they are if you use Windows 7;
however, you can still use this book to find out
about many computer basics.

@ Before Windows 7, there was Windows Vista, and

Determine a Price Range

You can buy a laptop for anywhere from US $299 to $5,000 or more,
depending on your budget and computing needs. You may start with a
base model, but extras such as a larger monitor or higher-end graphics
card can soon add hundreds to the base price.

You can shop in a retail store for a laptop or shop online using a
friend’s computer (and perhaps get his or her help if you're brand new
to using a computer). Consider researching different models and
prices online and using that information to negotiate your purchase in
the store if you prefer shopping at the mall. Be aware, however, that
most retail stores have a small selection compared to all you can find
online on a Web site such as Dell.com.

Buying a laptop can be confusing, but here are some guidelines to
help you find a laptop at the price that’s right for you:

w= Determine how often you will use your computer.
If you'll be working on it eight hours a day running
a home business, you will need a better quality lap-
top to withstand the use. If you turn on the com-
puter once or twice a week, it doesn’t have to be the
priciest model in the shop.

21
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Consider the features that you need. Do you want
(or have room for) a heftier laptop with an 18-inch
monitor? Do you need the laptop to run very fast
and run several programs at once, or do you need to
store tons of data? (Computer speed and storage are
covered later in this chapter.) Understand what you
need before you buy. Each feature or upgrade adds
dollars to your laptop’s price.

Shop wisely. If you walk from store to store or do
your shopping online, you'll find that the price for the
same laptop model can vary by hundreds of dollars at
different stores. See if your memberships in organiza-
tions such as AAA, AARP, or Costco make you eligible
for better deals. Consider shipping costs if you buy
online, and keep in mind that many stores charge a
restocking fee if you return a laptop you aren’t happy
with. Some stores offer only a short time period in
which you can return a laptop, such as 14 days.

Buying used or refurbished is an option, though new
laptops have reached such a low price point that this
might not save you much. In addition, technology
goes out of date so quickly, you might be disappointed
with buying an older model. Instead, consider going to
a company that produces customized, non-name-brand
laptops at lower prices — perhaps even your local com-
puter repair shop. You might be surprised at the bar-
gains you can find (but make sure you're dealing with
reputable people before buying).

Online auctions are a source of new or slightly
used laptops at a low price. However, be sure you're
dealing with a reputable store or person by checking
reviews that others have posted about them or con-
tacting the Better Business Bureau. Be careful not to
pay by check (this gives a complete stranger your
bank account number) but instead use the auction
site’s tools to have a third party handle the money
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until the goods are delivered in the condition prom-
ised. Check the auction site for guidance on staying
safe when buying auctioned goods.

compare several models of laptops side by side, and
others such as NexTag.com allow you to compare
prices on a particular model from multiple stores.

@ Some Web sites, such as Epinions.com, allow you to

Select a Monitor

Monitors are the window to your computer’s contents. A good moni-
tor (also known as a screen) can make your computing time easier on
your eyes. The crisper the image, the more impressive the display of
your vacation photos or that highly visual golf game.

Consider these factors when choosing your laptop:

w= Size: Monitors for the average laptop user come in
several sizes, from tiny 9-inch screens on smaller lap-
tops to 18-inch screens on desktop replacement
models. Laptops with larger screens are typically
more expensive. A laptop with a larger monitor will
take up more space on your desk than a laptop with
a smaller monitor.

m= Image quality: The quality can vary greatly. You will
see terms such as LCD (liquid crystal display; also
referred to as flat panels), flat screen, brightness, and
resolution.

Look for a laptop with an LCD monitor, preferably
with a screen (see Figure 2-2) that reduces glare.

w= Resolution: A monitor’s resolution represents the
number of pixels that form the images you see on
the screen. The higher the resolution, the crisper the
image. You should look for a laptop that can provide
at least a 1,024 x 768 pixel resolution.

23
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Figure 2-2

Choose an Optical Drive

24

You've probably used or seen a DVD used to play movies at home.
Laptops can also read data from or play movies or music from DVDs
or store data on them (called burning). Your laptop is likely to come
with an optical drive, which is a small drawer that pops out, allowing
you to place a DVD in a tray, push the drawer back into the computer,
and use the contents of the DVD. If you buy a software program, it
will come on a CD or DVD, so you also need this drive to install soft-
ware. However, very small laptops such as netbooks have no DVD
drives, to save space. In that case, you can buy an external DVD drive
and plug it into a port on your laptop.

When you buy a laptop with a built-in or an external DVD drive, keep
these things in mind about optical drives:

w= DVDs versus CDs: DVDs have virtually replaced
CDs as the computer storage medium of choice, but
you might still find a CD floating around with music
or data on it that you need to read. For that reason,
you might want a DVD/CD combo drive.

w= DVD drives: DVD drives are rated as read (R), write
(W), or read-writable (RW). A readable DVD drive
only allows you to look at data on your discs, but
not save data to them. A writable DVD drive allows
you to save data (or images, or music) to discs. A
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read-writable DVD drive lets you both read and write
to DVDs.

w= DVD standards: In the earliest days of DVDs, there
were two different standards, + and -. Some drives
could play DVDs formatted + but not those format-
ted -, for example. Today, you should look for a
DVD drive that is specified as +/- so that it can deal
with any DVD you throw at it.

a laptop, if it doesn’t come with recovery discs, is to
burn recovery discs you can use if you have to restore
the laptop to its factory settings. You might need to
do this, for example, if a virus corrupts your settings.
Your laptop should offer this as an option when you
first start it, but if it doesn’t, check your computer
help system or the manufacturer’s Web site to find
out how to burn recovery discs, which will allow you
to return your system to factory settings if you have a
major crash.

@ One of the first things you should do when you buy

Understand Processor Speed and Memory

Your laptop contains a processor contained on a computer chip. The
speed at which your laptop runs programs or completes tasks is deter-
mined in great measure by your computer processor speed. Processor
speed is measured in gigahertz (GHz). The higher this measurement,
the faster the processor. I won’t quote the speed you should look for
because these chips are constantly getting smaller and contain more
and more power. However, when you shop, know that the higher
numbers give the best performance and factor that into your decision
depending on your needs.

In addition, computers have a certain amount of storage capacity for
running programs and storing data. You'll see specifications for RAM
and hard drive memory when you go laptop shopping. Again, the spe-
cific numbers will change, so the guideline is to look for higher RAM
numbers if you feel you need more storage capacity.
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m=» RAM is the memory needed to simply access and
run programs. RAM chips come in different types,
including DRAM, SDRAM, and the latest version,
DDR2. Look for a minimum of 1 gigabyte (GB) of
RAM for everyday computing.

w= RAM chips are rated by access speed, which relates
to how quickly a request for data from your sys-
tem can be completed. You might see RAM speed
measured in megahertz (MHz). Today, 800 MHz
could be considered acceptable good access speed.

w= Your hard drive has a certain capacity for data
storage measured in gigabytes (GB). These days,
you should probably look for a minimum of a
160GB hard drive, but hard drives can come with a
range of huge capacities, with the largest being mea-
sured in terabytes (TB, measured in thousands of

gigabytes).

w= Your laptop will require some RAM to run the
operating system. Windows 7 requires 1 gigabyte
(GB) of main memory and 16GB of hard drive
space.

Determine How You’ll Connect to the Internet

26

You have to decide how you'll connect to the Internet. You can use a
dial-up connection over a standard phone line or pay a fee to get a
broadband connection such as DSL. (Check with AARP to find out if
they offer discounted connections in your area.) However, if you want
a wireless connection that works like your cellphone to pick up a sig-
nal in certain hotspots, you have to be sure to buy a laptop with wire-
less capabilities (and luckily, most new model laptops have these).
Here’s how these work:
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w= Dial-up: If you intend to use a dial-up connection
(that is, connect over your phone line), your laptop
has to have a dial-up modem either built in or in an
external model. Dial-up connections can be very slow,
and while you're using them, you can’t use your
phone to make or receive calls. I'd discourage you
from using dial-up unless you absolutely have to.

w=  Wireless: Wireless connections require that you have
a laptop equipped with wireless capability. You can
access the Internet wirelessly when you're near a
wireless hotspot (a place that offers wireless service),
and many hotspots are appearing at public places
such as hotels, airports, and restaurants. You can also
subscribe to a Wireless Wide Area Network (WWAN)
service from a mobile phone provider, to tap into its
connection. Check the model laptop that you want
to be sure it is wireless-enabled. There are various
techy standards for wireless, such as 802.11a, b, or g.
The very latest standard to look for is 802.11n,
which delivers better wireless performance.

w= Broadband: Broadband connections can be DSL
(digital subscriber line) or cable. In both cases, you
pay a fee to a provider, which might be your phone
company or cable company. DSL works over your
phone line but doesn't prohibit you from using the
phone when you're online. Cable runs over your cable
TV line and is a bit faster than DSL, though connec-
tions can be less dependable. Both are considered
always-on connections, meaning that you don't have
to wait to dial up to a phone connection or connect
to a wireless network — you're always connected.

See Chapter 18 for more about setting up your
Internet connection.
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Buy a Customized Laptop

You can buy prepackaged laptops online or in an electronics store. An

alternative is to buy a customized laptop. Companies such as Dell (see
Figure 2-3) and Gateway offer customized laptops. When you buy the

laptop, you can pick and choose various features, and the provider will
build the system for you.

70 Customizt; | 9 Software & ies 9 Ei i o Services 9 Review
#SWITCH TO LIST VIEW -
SELECT MY SYSTEM COLOR Studio 15
Starting Price 1678
Instant Savings 178
+ Colors -
~ Blask Chainlink add $0 71 || subtotal $699

T Mary celay your Studio 15 ship date ‘

(@ MidnightBlue [Included in Price]
) RubyRed [add $40 or $2/month] |=
=) Premiss Pink [add $40 or $2imonth']

Dell will donste $5.00 to Susan G. Komen for the Cure.

() Plum Purple [add $40 or $2/month’] —_—
) Spring Green [add $40 or $2imonth’]

+ Design Studio +Tech Specs
) Design Studio featuring 100+ designs Peienalize
~ [add $85 or $3/month'] = | |25 low as $21mortte!
] SR _ Apply | Learn Mors
— € Discount Details
!‘ Preliminary Ship Date: 5222009
0 [@ @ B EE g sew o) Sl it Suriman _
ascas o8 Office I ‘f - < e My Components -
&3 | - Midnight Blue (=
m Processor  Opersting System  Office Software  Wiamanty and HO Display Memiory Hard Drive + Genuine Windows Vista® Home Premium _ |

Service Cditian S48 D

Here are some of the variables you'll be asked about when you
purchase a customized system, many of which are discussed in this
chapter:

w= Type and speed of processor
w=  Amount of RAM or hard drive capacity

w= Installed software, such as a productivity suite like
Microsoft Office or Microsoft Works, or a premium
version of an operating system

w= More sophisticated graphics or sound cards

w= Peripherals such as a printer or the addition of a
wireless mouse
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m= [ arger or higher-end monitor
w=p Wireless capability

w= Warranty and technical support

These all add to your final price, so be sure you need an option before
you select it. Most of these companies provide explanations of each
item to help you decide.

Get Accessories for Your Laptop

Laptop users might benefit from several types of accessories to protect
their laptops or add functionality. Here are a few to consider:

w= A laptop case will help you carry the computer
around and also protect it from damage. Some are
soft-sided, some are hard-sided, and most provide
space to store a cable or DVDs for your next
road trip.

w= A fingerprint reader comes built into some laptops.
These keep intruders from accessing your computer
contents. A fingerprint reader authorizes you via your
very unique fingerprint. You can also buy external
fingerprint readers.

m= You can buy laptop locks, which connect to your
laptop. You can wrap the lock around a desk leg or
chair arm (similar to a bicycle lock). This provides a
measure of protection if you have to leave your lap-
top unattended for a few minutes in a public place.

w= External CD/DVD drives are helpful if you buy a
smaller laptop that has no such drive built in. These
drives are useful for installing software programs or
playing audio or video content.
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w= Flash drives are small storage devices that you slot
into a USB drive on your laptop. Some flash drives
have such a large storage capacity that you can use
them as a second hard drive for storing files, and
they offer the convenience of being easily moved
from one computer to another.
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Setting Up Vour
Laptop

nce you unpack your new laptop, you

might need help getting it set up. Here, |
cover the basics: inserting and charging the
battery, turning the computer on and off,
logging on and off Windows 7, and mastering
the basic use of your built-in mouse and
function keys.

Next, you can set the date and time in your
computer’s internal clock so they match your
time zone and apply daylight savings time
settings properly. Finally, you get to work with
your user accounts. Windows allows you to
create multiple user accounts; each account
saves certain settings and allows you to control
files and folders separately. When each user
logs on with a particular user account, it’s like
accessing a unique personal computer.

Here, then, are the procedures that you can
follow to get going with your laptop.

| “*ap’rer

Getready to. ..

w= |nstall and Charge the
Battery......ccoevveiiiiiniien 32

w= Turn On Your Laptop and Log
On and Off Windows 7 ...... 33

w= Use the Built-ln Mouse ......... 35
w= Use the Function Keys.......... 37
w= Set the Date and Time ......... 38
w= Create a New User

Account .....ccoeiveiiiiiiiii, 40
w= Switch User Accounts .......... 42

w= Change Your User Account
Picture ...cooviiiiiiiiie, 43

w= Shut Down Your Laptop........ 44
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Install and Charge the Battery

Your laptop comes with a battery that you should insert and charge
when you first take the laptop out of the box. The battery is a
rectangular affair (similar to the one shown in Figure 3-1) that slips
into the bottom of your laptop. It's a good idea to completely charge
your battery when you first plug it in. Follow these instructions to
do that:

Figure 3-1

1. Locate the plug in your laptop packaging. (It's usually a
two-piece cable, one of which has a large boxy trans-
former on one end that plugs into the other.)

2. Plug one end into a wall outlet and the other into the
round power connection port on your laptop. Your users’
manual should indicate where this connection is located
(usually on the back or near the back of the right or left
side of the laptop).

32



Chapter 3: Setting Up Your Laptop

3.

When you turn your laptop on (see the next task) you
will find a small icon (usually called the Battery Meter
icon) that looks like a standard battery with a plug next
to it on the right side of your Windows taskbar. (The
taskbar is the blue area at the very bottom of your
screen.) Click this Battery Meter icon to see whether the
battery is fully charged to 100 percent capacity. (If you
aren’t yet sure how to move around the screen and click,
see the upcoming “Use the Touchpad, Your Laptop'’s
Built-In Mouse” task.)

This icon changes to just a battery (no plug) when the
computer isn’t plugged in; this battery icon indicates
visually how much charge your battery has left before
it drains.

Turn On Your Laptop and Log On and Off Windows 7

When you turn on your computer it takes a few moments to load the
files it needs to run your operating system. If this is the first time
you've started up a brand new computer, you might be asked to make
certain settings. If the computer has been used before (perhaps you
bought it used, or the person in the store showed you how to start it
up and make some settings), you won't see the set up screens; instead,
you'll be taken to a user sign-in screen. At that point, if a password has
been set for your account you'll have to type it in; if not, you'll just
click on a user icon to sign on and go to the Windows desktop. Here
are the steps to turn on your laptop and log onto Windows:

With your laptop charged, you're ready to turn it on.
Start by pressing the power button on your computer to
begin the Windows 7 start-up sequence. The power but-
ton might be somewhere towards the back of the key-
board or even on the monitor. Again, your users’ manual
will help you locate the power button on your particular
laptop model.
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2. In the resulting Windows 7 Welcome screen, use your
keyboard to enter your password in the text box provided
if you have set one (see Chapter 23 for more about this),
and press the left side of your touchpad to click on the
arrow button or click Switch User and choose another
user to log on as. (To move the onscreen cursor over one
of these selections you slide your finger on the touchpad
below your keyboard. If you need help with using the
touchpad to make your selection, see the next task).
Windows 7 verifies your password and displays the
Windows 7 desktop, as shown in Figure 3-2. The icons
on your desktop may vary depending on what programs
your computer manufacturer may have installed.

NN HNNNN NN
Wednesday

A

March 2009
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Note: If you haven't set up the password-protection fea-
ture or accounts for more than one user, you're taken
directly to the Windows 7 desktop. For more on adding
and changing passwords, see Chapter 23.

one account at a time. User accounts save documents
and settings for that user so whoever uses the com-
puter has a personal Windows environment to go
back to. To create another user account, see the task
“Create a New User Account” later in this chapter.

@ You can create different user accounts and log on to

to the password screen, you have to click the icon for

@ After you set up more than one user, before you get
the user you wish to log on as.

Use the Touchpad, Your Laptop’s Built-In Mouse

Unlike a typewriter, which uses only a keyboard to enter text into
documents, with a computer you use both a keyboard and a pointing
device to enter text and give commands to the computer. Though you
might have used a keyboard of some type before, or a traditional
mouse attached to a desktop computer, a laptop pointing device,
called a touchpad, might be new to you. Frankly, a laptop touchpad
take a little getting used to.

Laptop mouses come in two types, as shown in Figure 3-3: the touch-
pad and the pointing stick. The touchpad by far the most common
type, is a flat area, located beneath your keyboard. A pointing stick is a
small button located among your computer’s keys. In effect, when you
move your finger across the touchpad surface or place your finger on
the pointing stick and move the stick slightly in any direction, a corre-
sponding mouse pointer moves around your computer screen. With a
touchpad, which I'll focus on here because it is what you're likely to
have on your laptop, you perform clicking actions to open or select
things on screen by using the right and left buttons on the bottom of
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the touchpad. The left button is used for left-click actions and the right
button for right-click actions. Left clicking opens or selects items while
right-clicking opens a shortcut menu from which you can choose com-
mands to perform actions.

1" I ) 3 D

lFlG HIJIK L!
c NM'I"l‘
a lcm

MU

Touchpad Left (main) Right
mouse button mouse button

Figure 3-3
Here are the main functions of a touchpad and how to control them:

w= Clicking: When people say “click,” they mean “press
and release the left mouse button.” Clicking has a
variety of uses. You can click while in a document to
move the insertion point, a little line that indicates
where your next action will take place. For example,
you might click in front of a word you already typed
and then type another word to appear before it in a
letter. Clicking is also used in various windows to
select check boxes or radio buttons (also called option
buttons) to turn features on or off, or to select objects
such as a picture or table in your document. Double-
clicking can also be used to open objects for editing
or to quickly select whole words.

w= Right-clicking: If you click the right touchpad but-
ton, Windows displays a shortcut menu that is spe-
cific to the item you clicked. For example, if you
right-click a picture, the menu that appears gives you
options for working with the picture. If you
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right-click the Windows desktop, the menu that
appears lets you choose commands that display a
different view or change desktop properties.

w= Clicking and dragging: To click and drag, you press
and continue to hold down the left mouse button
and then move (drag) the mouse to another loca-
tion. For instance, you can press the left touchpad
button (keeping it held down) and drag your finger
on a touchpad up, down, right, or left to highlight
contents of your document. This highlighted text is
selected, meaning that any action you perform, such
as pressing the Delete key on your keyboard or click-
ing a button for Bold formatting, is performed on
the selected text.

m= Scrolling: Many touchpads and wireless mouse
models have a way to scroll through a document or
Web site on your screen. Just roll the wheel on a
mouse down to move through pages going forward,
or scroll up to move backward in your document.
With a touchpad, there is often an area marked on
the right or left where you can run your finger up or
down to scroll through a document.

can’t get the hang of the built-in mouse on your lap-
top, consider buying a portable wireless mouse. By
plugging a small transmitter into a USB port on your
laptop, you can use this more standard mouse to
point, click, and drag, just as you do with a desktop
computer.

@ If you're used to a desktop computer mouse and

Use the Function Keys

On a laptop computer, you might find that in order to save space,
some functions are accessible only via function keys. Here are the
basics of function keys:
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w= Function keys run across the top of your laptop key-
board, labeled F1, F2, and so on.

w= You'll find a key labeled Fn (for Function) near the
bottom of your keyboard.

w= By pressing and holding down the Function key (Fn)
and a numbered function key (F1, for example), you
can perform actions such as brightening your screen
or controlling your built-in speaker volume.

w= The functions assigned to your laptop’s keys will vary
depending on the model and manufacturer. Check
your users’ manual to find out the specific functions
assigned to your keyboard.

keys that give you a clue about what the keys do. For
example, pressing both the function key that has a
little light bulb icon and the up arrow key will proba-
bly brighten your screen. Pressing a function key with
double, right-pointing arrows (like you see on a
music player) may move you to the next track on an
audio CD.

@ You'll typically find small icons on your function

Set the Date and Time

38

1. The date and clock on your computer keep good time,
but you might have to provide the correct date and time
for your location. To get started, press the Windows key
on your keyboard (the one with the Windows logo on it)
to display the taskbar, if it isn't visible. (The taskbar is the
blue area at the very bottom of your screen.)

2. Using the right button on your touchpad, right-click the
Date/Time display on the far right end of the taskbar and
then slide your finger on the touchpad till the cursor rests
onthe Adjust Date/Time from the shortcut menu that
appears and click the left touchpad button to select it.



3. In the Date and Time dialog box that appears (see
Figure 3-4), click the Change Date and Time button.

= Date and Time (]

Date and Time | Addiﬁgnal_ EIE‘_:E?_ !__h_nbernet‘l’lme

Date:

[~ “N Wednesday, March 04, 2009
o
- \ ‘_-J."I Tirme:
N\ S msem
—— [ % Change date and time... | Click this button
Time zone

(UTC-08:00) Pacific Time (US & Canada)

| Change time zone...

Daylight Saving Time begins on Sunday, March 08, 2009 at 2200 AM. The
clock is set to go forward 1 hour at that time.

[#] Notify me when the clock changes

Get the latest time zone information and updates online

How do I set the clock and time zone?

oK | l Cancel

Figure 3-4

4. In the Date and Time Settings dialog box that appears,
use your left mouse button to click in the Time field and
enter a new time, or click on the up and down arrows
next to that field to change the time. If you wish, click a
new date in the calendar display to set the date.

5. When you're finished with adjusting the settings, click OK.

6. To change the time zone, click the Change Time Zone
button, choose an option from the Time Zone drop-
down list, and click OK.

7. Click OK to apply the new settings and close the dialog box.

Daylight Saving Time, click Change Time Zone and
click the Automatically Adjust Clock for Daylight
Saving Time check box to turn this feature off.

@ If you don’t want your computer to adjust for

Chapter 3: Setting Up Your Laptop
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Another option for displaying the time or date is to
add the Clock or Calendar gadget to the Windows
desktop. See Chapter 12 for more about using
gadgets.

Create a New User Account

1. If you want to create a new user account which will save
settings and documents for another person, choose
Start=>Control Panel.

2. In the resulting window, click the Add or Remove User
Accounts link.

3. In the resulting Manage Accounts window, as shown in
Figure 3-5, click the Create a New Account link. (Text
links are typically blue; when you move your cursor over
them a small icon of a finger with pointing hand

appears.)

Choose the account you would like to change
|

Owner MacFeegle
Administrator Standard user

Guest
Guest account is off

&

Create a new account

What is a user account?

Additional things you can do
B Set up Parental Controls

Go to the main User Accounts page

Click this link

Figure 3-5
40 g
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4. In the next window, shown in Figure 3-6, enter an
account name, and then select the type of account you
want to create. You can choose from these two:

¢ Administrator, who can do things like create and
change accounts and install programs.

¢ Standard user, who can’t do the tasks an adminis-
trator can.

Enter the account name here

Name the account and choose an account type

This name will appear on the Welcome screen and on the Start menu.
— New account name

@ Standard user
Standard account users can use most software and change system settings that do not affect other users or
the security of the computer,
Adrninistrator
Administrators have complete access to the computer and can make any desired changes. Based on
notification settings, administrators may be asked to provide their password or confirmation before
making changes that affect other users,

We recommend that you protect every account with a strong password.

Why is a standard account recommended?

| Create Account | | Cancel

Figure 3-6

5. Click the Create Account button and then close the
Control Panel by clicking the X symbol in the upper
right-hand corner of the window.

After you create an account, you can make changes to
it, such as assigning a password or changing the
account type, by double-clicking it in the Manage
Accounts window you reached in Step 4 (in the pre-
ceding step list) and following the links listed there.
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Switch User Accounts

42

1. Click Start and then click the arrow on the side of the
Shut Down button. (See Figure 3-7.)

@ Spyware Terminator
e SnagltQ

Sticky Motes

= WordPad
Computer Management
r

s Snipping Tool

2/ Calculator

avorites
@ RealPlayer Computer

' >
@;J Slidewhere Control Panel

Switch User

%, Solit evices i i
g T Devices and Biin Log oﬁ{ Switch users without closing programs.

& FreeCell Help and Suppo S

Restart

»  All Programs
Sleep

| [ Search programs and files i oo | Hibernate

Click this arrow

Figure 3-7

2. Choose Switch User from the pop-up menu that appears.
In the resulting screen, click the user you want to log in as.

3. If the user account is password protected, a box appears
for you to enter the password. Type the password and
then click the arrow button to log in.

4. Windows logs you in with the specified user’s settings.

without entering one, Windows shows your password
hint, which you can create when you assign a password
to help you remember it. See the preceding task for
instructions on creating and modifying a user account.

@ If you forget your password and try to switch users
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You can set up several user accounts for your laptop,
which helps you save and access specific user settings
and provide privacy for each user’s files with pass-
words. Again, to find out about setting up user
accounts and changing their settings, see the preced-
ing task in this chapter.

Change Your User Account Picture

1. If you don't like the picture associated with your user
account, you can change it. Choose Start=>Control
Panel=>Add or Remove User Accounts.

2. In the resulting Manage Accounts window, click the
account you want to change (See Figure 3-8.).

Send Feedback | — |[ =1 |[&3]
@vv“ﬁ{“ User Accounts » Manage Accounts - | vyl | Search Controf Panel £ |

File Edit View Tools Help

Choose the account you would like to change

|
Owner
Administrator

MacFeegle

Standard user

B

Guest

Guest account is off

&

Create a new account

What is a user account?

Additional things you can do
Hg)Set up Parental Controls

Go to the main User Accounts page

Figure 3-8

3. In the resulting window, click the Change Picture button
and click another picture (or browse to see more picture
choices) to select it.
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4. Click the Change Picture button; the window closes.

5. Click the Control Panel Close button to close it.

Shut Down Your Laptop

To turn off your laptop when you're done, you need to initiate a
shutdown sequence in your operating system instead of simply
turning off the power. Don't simply turn off your computer at the
power source — unless you have to because of a computer dysfunc-
tion. Windows might not start up properly the next time you turn it
on if you don't follow the proper shutdown procedure.

To properly turn off your laptop, choose Start and then click the Shut
Down button. (Simply press the power button later to turn it back

on.) Or you can click the arrow to the right of the Shut Down button
and choose one of the following from the menu shown in Figure 3-9:

@ Spyware Terrinator

)| Sticky Notes

-
o Snaglt 9
U WordPad

Owner
Documents
Pictures

*.g Computer Managemnent

Music

—
-~/ Calculator
4 Games

)

S snipping Tool

% NIppIng 100 Favorites
@ FreeCell Computer

'__ Hearts Control Panel

Switch User
Log off
Lock

“@@" Purble Place Devices and Prin

%, Solitaire
)

Restart

»  All Programs

Sleep
| [Seor pogroms v s BRI eense —— Click this option

Figure 3-9
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Hibernate: If you prefer to stop your laptop running
but not turn the power off, choose this option (or
simply close the lid of your laptop) to shut the
laptop down. When you want to use it again just
open the lid.

Sleep: If you're going away for a while but don’t
want to have to go through the whole booting up
sequence complete with Windows 7 music when you
return, you don't have to turn off your laptop. Just
select the Sleep command instead to put your laptop
into a kind of sleeping state where the screen goes
black and the fan shuts down.

When you get back, just click your mouse button or
press Enter, or in some cases (especially on some
laptops), press the Power button; your laptop springs
to life, and whatever programs and documents you
had open are still open.

Restart: If you want to reboot (turn off and turn back
on) your laptop, choose this option.

If your laptop freezes up for some reason, you can
turn it off in a couple of ways. Press Ctrl+Alt+Delete
twice in a row, or press the power button on your
CPU and hold it until the laptop shuts down.

Chapter 3: Setting Up Your Laptop
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Managing Power

One of the big differences between a desktop
computer and your laptop is that your
laptop can run off of a battery. Battery life, or
the length of time it takes your laptop battery
to run out of juice, is getting better all the
time, with some recent laptop batteries getting
as much as nine hours on one charge. Other
laptop batteries get as little as a couple of
hours of battery life.

For that reason, it's important that you under-
stand some tools that Windows 7 provides to
help you manage your laptop power,
including:

w= Choosing a power plan, which has preset
timings for actions such as dimming your
screen or putting your computer to sleep.

w= Creating a customized power plan by
choosing settings you want.

w= Adjusting settings for your display that
deal with the screen brightness (a
brighter screen uses more power), how
frequently your screen automatically
dims, and so on.

w= Changing how much time lapses before
your laptop automatically goes to sleep —
a state which uses minimal power but
keeps currently open documents and
programs active and quickly available
to you.

| “*op’rer

Getready to. ..

w= Choose a Power Plan..........

w= Create a Customized
Power Plan..............ccccvvn.

w= Adjust Display Settings ........

w= Change How Quickly the
Computer Goes to Sleep......

w= Define Power Button
Functions.......covvvveeiieeiinn..,
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w= Defining power button functions gives you some
control over what happens when you press the
laptop power button or close the lid.

Choose a Power Plan

1. Choose StartrvControl Panel®>Hardware and
Sound=>Power Options.

2. In the Power Options window that appears (see Figure 4-1),
locate the Hide Additional Plans section. If this section
isn't already displayed, click the downward arrow on the
Show Additional Plans section to change the arrow to an
upward arrow and view the Hide Additional Plans

The Power Saver plan
(===
@uﬂﬁ ) Control Panel » Hardware and Sound » Power Options v |43 || searcn controt Pane o]
Control Panel H @
ontrol Panel Home
Select a power plan
Require a password on wakeup Power plans can help you maximize your computer's performance or conserve energy. Make a plan active by
selecting it, or choose a plan and customize it by changing its power settings. Tell me more sbout power
Choose what the power plans
buttons do
Choase what closing the lid Plans shown on the battery meter
does @ My Custom Plan 1 Change plan settings
Create a power plan
(D) Choosewhen to turn off the e | Powver saver Change plan settings
display Saes energy by reducing your computer’s performance uwhere possible,
W Change when the computer
sleeps Hide additional plans A
High performance Change plan settings
Fawors performance, but may use more energy,
HF Recommended (recommended) Change plan settings
Personalization
Windows Mebility Center
User Accounts Screen brightness: O J

The manufacturer’s power plan
Figure 4-1
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3. Click the radio button next to a plan to select it. Note
that you might have a laptop manufacturer’s power plan
among your selections. (In Figure 4-1, the manufacturer’s
power plan is the HP Recommended option.) The Power
Saver plan (in Figure 4-1, this is listed in the Plans
Shown on the Battery Meter section) will cause your
computer to go to sleep more frequently and dim the
screen brightness. A higher performance setting will never
put the computer to sleep and will have a brighter screen
setting. If you run off a battery frequently, the Power
Saver plan is your best bet.

4. Click the Close button to close the window box.

down or putting your laptop to sleep. See Chapter 3

@ There are several options you can use for shutting
for more about these.

Create a Customized Power Plan

1. If the preset power plans don't appeal to you, you can
modify one and save it as your own customized power
plan. Choose Start=>Control Panel=>Hardware and
Sound=>Power Options.

2. In the Power Options window that appears, click the
Create A Power Plan link on the left side.

3. In the Create a Power Plan window that appears, shown
in Figure 4-2, select the preset plan that is closest to what
you want to create.
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Select a power plan to customize

(== )

@Q-vl@ <4 Hardware and Sound » Power Options » Create a Power Plan - ‘*?I | Search Control Panel g |

Create a power plan

To create your own plan, start by selecting one of the following plans that is closest to what you want.

@ HP Recommended (recommended)

*) Power saver
Saves energy by reducing your computer’s performance where possible,

High performance
Favors performance, but may use maore energy,

Plan name:

Enter a name for the customized plan
Figure 4-2

4. Enter a name for the plan in the Plan Name text box and
click Next.

5. In the Edit Plan Settings window that appears (see
Figure 4-3) make settings for how the laptop power
functions when plugged in or running on the battery.
(See the next two tasks in this chapter for changing
display settings and changing how quickly the computer
goes to sleep and for more information on what these
settings control.)

6. Click Create to create your new plan. Windows returns
you to the Power Options window with your new plan
added to the power plan list.

cord plugged in, your laptop could get warm to the
touch, even though it has an internal fan. Consider
unplugging your laptop occasionally to run off of
battery power, or buying a laptop cooler, a pad with a
fan inside that you rest your laptop on to dispel heat.

@ If you choose to run your laptop with the power
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Make your plan settings here

[=lfE s
@uw\ﬁ <¢ Hardware and Sound » Power Options b Edit Plan Settings - |+,\ | Search Controt Pane o

Change settings for the plan: My Custom Plan |
Choose the sleep and display settings that you want your computer to use.

j On battery 9 Pluggedin

2 Dim the display: |Never vl |Nevar -‘

[ Turn off the display: |5 minutes 'l |15 minutes "

% Put the computer to sleep: |15 minutes VI |30 minutes V‘

Adjust plan brightness: - U 9 i

Figure 4-3

Adjust Display Settings

1. Choose StarttoControl Panel®>Hardware and Sound. The
Hardware and Sound window appears.

2. Click the Power Options link.

3. Find the selected power plan. (There’s a dot in the radio
button next to it.) To the right of that selected option,
click the Change Plan Settings link for the selected
power plan.

4. In the Edit Plan Settings window that appears (shown in
Figure 4-4), modify any of the following display settings
for the laptop when it’s running on the battery and you
haven't used it for a time, keeping in mind that the longer
your screen stays on, the more power it uses:

e Dim the Display: Modifies the time intervals at
which the screen automatically dims.

e Turn Off the Display: Sets the time interval when
the screen goes black.
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¢ Put the Computer to Sleep: Indicates the time
interval before the computer sleeps. See the next
section for more on this option.

e Adjust Plan Brightness: Adjusts the preset screen
brightness; a less bright screen saves power.

5. Click the Save Changes button to close the Edit Plan
Settings window and save your new settings.

Modify your plan settings here

(== )

@Qvl@l« Hardware and Sound » Power Options » Edit Plan Settings - ‘*,I | Search Control Panel pel

Change settings for the plan: Power saver

Choose the sleep and display settings that you want your computer to use.

j On battery #9 Plugged in
O Dim the display: |1 minute 'l |2 minutes "
[ Tumn off the display: |2minutas vl |S minutes "
W Putthe computer to sleep: |1ﬂ minutes v| |15 minutes vl i
+ Adjust plan brightness: - U J rJ /

Change advanced power settings

Restore default settings for this plan

[ cancel |

Figure 4-4

You can adjust many settings for screen brightness
and your modify power plan in the Mobility Center.
Choose Start=>Control Panel=>Hardware and Sound,
and then click the Windows Mobility Center link.
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Change How Quickly the Computer Goes to Sleep

1. The third option in the Edit Plan

Settings window you

saw in the previous section deals with putting your com-
puter to sleep. To change this setting, select
Starte>Control Panel=>Hardware and Sound. The window

shown in Figure 4-5 appears.

[=lrE ]

@Uw‘ﬂ’ﬂ » Control Panel » Hardware and Sound »

Control Panel Home : ;
/ Devices and Printers

8] Add a device

SdemandGecuty Add a printer | Mouse
Metwork and Internet ii i AutoPlay

e eatwvar e and Soumd — Change default settings for media or devices
Programs (@) Sound

User Accounts and Family Adjust system valime

Safety =
Appearance and J

Personalization

Power Options
Change battery settings
Clock, Language, and Region Adjust screen brightness

Ease of Access .

Display

Make text and other items larger or smaller
Connect to an external display

Windows Mobility Center
Adjust commonly used mobility settings

Change system scunds

Change what the power buttons do
Require a password when the computer wakes

- |4u,.‘ | Search Control Pane

# Device Manager
Play CDs or other media automatically

Manage audio devices
Change when the computer sleeps

Adjust screen resclution | Connect to a projector

Click thi
Figure 4-5

s option

2. In the Power Options section, click the Change when the

Computer Sleeps link.

3. In the Edit Plan Settings window that appears (see
Figure 4-6), find the Put the Computer to Sleep field
and click the arrow in the On Battery column.
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4. From the drop-down list, select another setting for when
the computer automatically puts itself to sleep. A smaller
interval saves battery power, but it might disrupt your
work. So choose a setting accordingly.

Click this arrow to change the settings

(=)
@uvl@ « Hardware and Sound » Power Options » Edit Plan Settings - ‘*,l | Search Conirol Panef e |
Change settings for the plan: My Custom Plan 1
Choose the sleep and display settings that you want your compuer to use,
j On battery 29 Plugged in
@ Dim the display: |Nevar 'J ‘Never '|
[k Turn off the display: |5 minutes V} ‘15 minutes v|
%W Putthe computer to sleep: llS minutes -'}- ‘EG minutes v|
1 minute 1o
+~ Adjust plan brightness: ; m:gﬁt: 9 l J
5 minutes
10 minutes |
15 minutes |
Change advanced power settings |20 minutes |
25 minutes
30 minutes
45 minutes T
1 hour eonceley
2 hours |
2 b

Figure 4-6

5. Click the Save Changes button to save the new setting.

Define Power Button Functions

54

1. You can control what happens when you press the Power
button, close the computer lid, or press the Sleep button

(if your laptop offers one). Choose Start=>Control

Panelm>Hardware and Sound. The Hardware and Sound

window appears.
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2. In the Power Options section, click the Change What the
Power Buttons Do link.

3. In the System Settings window that appears (see
Figure 4-7), change the options in the On Battery col-
umn. The options (depending on the setting) include:

e Do Nothing: Does nothing. You guessed that,
right?

¢ Sleep: Essentially pauses your computer, leaving
your open programs and documents intact, held in
your computer memory. When you awaken your
computer, it comes back almost immediately ready
for you to work. Sleep draws a small amount of
power.

e Hibernate: Saves open programs and documents
on your computer hard disk and then turns off
your computer so you're not using any power. If
you'll be away from your computer for a while but
want to return to the items you had opened before
quickly, Hibernate is a good choice. Hibernate is
usually the default action when you close a laptop
lid. And it requires you to log in again when you
revive your computer by pressing Enter, the power
button, or move your mouse.

e Shut Down: Closes any open programs and
powers down your computer. You have to turn
the power on again to use it — no programs or
documents are open when you turn the laptop
on again.
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Choose your options here

@\/’wl% » Control Panel » Hardware and Sound + Power Options b System Seftings [ 43 || searcn control 2ane

Define power buttons and turn on password|protection

Choase the power settings that you want for your computhr. The changes you make to the settings an this
page apply to all of your power plans.

Power and sleep buttons and lid settings I__l

j On battery ZF Plugged in
@ When 1 press the power button: ‘Danothing vl [Sleep '|
@ When 1 press the sleep button: [Sleep ~| [sleep -
‘& When 1 close the lid: Sieep ~| [steep -
: |
Hibernate

Password protection on wakeup Sleep
?‘. Change settings that are currently unavai gp 4 down
(@ Require a password (recommended)

When your computer wakes from sleep, no one can access your data without entering the correct
password ta unlock the computer, Create or change your user account password

Don't require a password
When your computer wakes from sleep, anyone can access your data because the computer isn't
locked.

‘ Save changes | Cancel

Figure 4-7

Consider using the Require a Password setting in the
System Settings window, shown in Figure 4-7, to
require that a password be entered to access your
computer if you dont want others to access your
computer.

You can also use the System Settings window to
define the power button functions that apply when
you have your laptop plugged into a power source.
These are listed to the right of the battery power
settings.
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Getting Around
the Windows 7

Desktop

Fne Windows 7 desktop is a command
center for organizing your laptop work.
The desktop appears when you log on to a
Windows 7 laptop. The Start menu is located
on the desktop; you use this menu to access
your laptop settings, files, folders, and
software. On the desktop, there is also a
taskbar that offers settings, such as your
laptop’s date and time, as well as shortcuts
to your most frequently accessed programs
or files.

This chapter is an introduction to all the things
you can do via the desktop. Along the way,
you discover the Recycle Bin, where you place
deleted files and folders, and the Frequently
Used Programs area, which allows quick access
to commonly used programs. You also find
out how to work with application windows,
create a desktop shortcut, and shut down your
laptop when you're done for the day.

| “*ap’rer
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Understand the Desktop

60

The Windows desktop is the place where you access various Windows
functions and open and work with all the windows that you use to get

your work done. The desktop appears when you first turn on your
laptop. You can use various elements of the desktop to open or
manage files, access settings for Windows, go online, and more.

Figure 5-1 shows the desktop and some of the elements on it, including

the following:

w= The taskbar is home to the Start menu, which you
open by clicking the Start button. Currently open
programs are listed here, and you can click on one to
switch programs. Finally, you can work with various
settings such as the volume control using icons
displayed on the taskbar.

w= The right side of the taskbar, which is called the
Notifications area, contains many commonly used
functions such as the laptop date and time settings,
the network connections icons, and the icon you
click to safely remove hardware, such as a USB
storage device, from your laptop.

w= The Frequently Used Programs area is a set of icons
within the taskbar that you use to open frequently
used programs. You can customize this area of the
taskbar to contain any programs you want. See the
section “Work with Frequently Used Programs” later
in this chapter.

m= The Recycle Bin holds recently deleted items. It will
empty itself when it reaches its maximum size
(which you can modify by right-clicking the Recycle
Bin and choosing Properties), or you can do so
manually. Check out the section “Empty the Recycle
Bin” later in this chapter for more about this.
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Recycle Bin  Desktop shortcut  Taskbar Gadgets

L L e
Wednesday

4

March 2009

- =
e " — 216 PM

= u i @) EN o me el )

MQ : ﬁf i % ()l o 34209

T |
Start  Frequently Used Programs Notifications
button area area
Figure 5-1

w= Desktop shortcuts are icons that reside on the
desktop and provide shortcuts to opening software
programs or files. Your laptop usually comes with
some shortcuts, such as the Recycle Bin and a
browser shortcut, but you can also add or delete
shortcuts. Click a desktop shortcut to open an
associated file or folder. See the “Create a Shortcut to
a File or Folder” section later in this chapter.
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w= Gadgets are handy little tools that can be placed on

®

the desktop. Windows 7 includes stock ticker, clock,
and calendar gadgets, but you can also download
lots of other gadgets from the Windows Web site.
Chapter 12 explains how to get started with gadgets.

The desktop is always there as you open program
windows to get your work done. If you make a pro-
gram window as big as it can be (referred to as maxi-
mizing it), you won't see the desktop, but the desktop
is still there. You can go back to it at any time by
shrinking a window (minimizing it) or closing win-
dows. You can also press Alt+Tab simultaneously and
choose the desktop from the open programs icons in
the window that appears.

Work with the Start Menu

1. Press the Windows key on your keyboard or click the
Start button on the desktop to display the Start menu.
(See Figure 5-2.)
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2. From the Start menu, you can do any of the following:

e Click All Programs to display a list of all programs
on your laptop. You can click any program in the
list to open it.

e Click any category on the right of the Start menu
to display a Windows Explorer window with
related folders and files. (See Figure 5-3.)

e Click either frequently used programs at the left of
the Start menu or click the arrow to the right of an
application to display a list of recently used files.
Click a file to open it in that application.

e Click the Power button icon to close all programs
and turn off Windows.
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¢ Click the arrow next to the Power button to
display a menu of choices for putting your laptop
in Sleep or Hibernate mode (see the next tip for
more about these settings); restarting your laptop;
or for logging off or logging in as a different user.

@ Spyware Terminator
Sticky Notes

-

e Snaglt &

q WordPad

'J# Computer Management

—
z Calculator

‘-\—‘% Snipping Tool

avorites
& FreeCell Computer

‘__ Hearts Control Panel

"8 &) Purble Place Devices and Printers

Help and Support

Click the Start button... to display the Start menu
Figure 5-2

3. When you move your cursor away from the Start menu,
it disappears.

laptop without closing open documents and programs.
Sleep still uses a bit of power but allows you to quickly
get back to work after only a few seconds. Hibernate
mode is mainly for laptops because it saves your battery
life. When you choose Hibernate (or simply shut your
laptop’s lid), open documents or program settings are
saved to your hard drive and your laptop switches off. It
takes a few seconds longer to start up your laptop from
Hibernate and display the Windows desktop, but it
saves more power than Sleep.

@ Putting your laptop in Sleep mode is like pausing your



Part lI: Exploring Windows

64

Files in the Pictures folder

I o [ ]

'\‘:./k:/' ‘E— b Librafies » Pictures » '|*7| [ Search Pictures P
File Edit View Todls Help
Organize v Mew Jolder Share with » Slide show 1_5 e ﬂ] ‘-é'
 Favorites Pictures |ibl'ar'y y: Folder * Includes: 2 library locations
i Recently Changgd [
Public Sample Pictures
P Desktop
¥ Downloads Terri cats
=| Recent Places
. Playlists VideoWebDownloader
4 Libraries m 000 0190
| Documents
@ Music 000_0191
=] Pictures h
H videos o
1% Computer iy, 457450 Fopiol
&, vistabd (C) - W
a DATA (D] i 457450 Fgo101
lese
€M Network e girl image
w— IMG_1153 Grey_sm
| = KB
.
Figure 5-3
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Open the Start menu, right-click in a blank area, and
click Properties to display the Taskbar and Start Menu
Properties dialog box, where you can customize the
Start menu behavior. For example, you can modify
the functionality of the Power button and choose
whether to list recently opened programs and files in
the Start menu.

If you open the Start menu and right-click in a blank
area of the menu, a shortcut menu pops up. Choose
Properties to display the Taskbar and Start Menu
Properties dialog box, where you can customize the
Start menu behavior. If you would rather use the
look and feel of the Start menu in older versions of
Windows, select Classic Start Menu in the Taskbar
and Start Menu Properties dialog box and then click
OK. (Note: This book deals only with the Windows 7
style Start menu features.)
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Work with Frequently Used Programs

1. If you have programs you use often, you can pin them to
the Frequently Used Programs area, which is the area of
the taskbar just to the right of the Start button. (See
Figure 5-4.) When you first open Windows, this area
may include icons for programs such as Internet Explorer
and Windows Media Player, or a shortcut to open
Windows Explorer.

Bl 0 ¥ 9

|
Frequently Used Programs area
Figure 5-4

2. To open one of these items, click its icon, and the
window for that program opens. (See the Windows
Media Player program in Figure 5-5.)

|| Windows Media Player o= =8
el Y Library » Playlists » Animal sounds Play Burn Sync
Organize v  » \a 2+ @ I savelist -
I Guess Vi
Love C L,
Muita
QAM's Bl
Despert:
Amand, u .
Drag items here
to create a playlist,
=
% O !) - H — =

Figure 5-5
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3. To close an item you've opened, click the Close button in
the top-right corner of the window (the button with an X
on it).

©)
®

To display additional items on the taskbar, right-click
that application in the Start menu or on the Desktop
and then choose Pin to Taskbar. You can also drag a
desktop icon to the taskbar. (If you want help creating
a desktop shortcut, see the task, “Create a Shortcut

to a File or Folder,” later in this chapter.)

You can add other functions to the taskbar.
Right-click a blank area of the taskbar and choose
Properties. Click the Toolbars tab to display it. Click
the check box for any of the additional items listed
there, such as a browser Address bar, or Links.

Arrange Icons on the Desktop

1. Right-click the desktop and choose View in the resulting
shortcut menu; be sure that Auto Arrange Icons isn't
selected, as shown in Figure 5-6. (If it is selected, deselect
it before proceeding to the next step.)

Verify that Auto Arrange lcons isn't selected

View
Sort By
Refresh

NVIDIA

New

Undo Rename Ctrl+Z

L4 Large Icons
| @ Medium Icons

Small Icons

Auto Arrange Icons

v | Alignlcons to Grid

v | Show Desktop tems

Control Panel

B Screen Resolution
B Gadgets

@ Personalize

Figure

66
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2. Right-click the Windows 7 desktop. In the resulting
shortcut menu, choose Sort By, and then click the criteria
for sorting your desktop shortcuts. (See Figure 5-7.)

View 3 |

Sort by 3 Mame
Refresh Size

Pasa Ttem type

— Date modified

Undo Rename Ctrl+Z
Mew 4

= Screen resolution
@ Gadgets
ﬂ_' Perzonalize

Figure 5-7

3. You can also click any icon and drag it to another
location on the desktop — for example, to separate it
from other desktop icons so you can find it easily.

If you've rearranged your desktop by moving items
hither, thither, and yon and you want to arrange

your icons into orderly rows along the left side of
your desktop, snap them into place with the Auto
Arrange feature. Right-click the desktop and then
choose Viewr>Auto Arrange Icons.

To change the size of the desktop icons, use the
shortcut menu in Step 1 and choose Large Icons,
Medium Icons, or Small Icons in the View submenu.

Empty the Recycle Bin

1. When you throw away junk mail, it’s still in the house —
it's just in the trash bin instead of on your desk. That'’s
the idea behind the Windows Recycle Bin. Your old files
sit there, and you can retrieve them until you empty it or
until it reaches its size limit and Windows dumps a few
files. Right-click the Recycle Bin icon on the Windows 7
desktop and choose Empty Recycle Bin from the menu
that appears. (See Figure 5-8.)
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Open
o EmpyResyclesin  —— Select this option
Create shortcut

Rename

Properties

Figure 5-8

2. In the confirmation dialog box that appears (see Figure 5-9),
click Yes. A progress dialog box appears, indicating that
the contents are being deleted. Remember: After you
empty the Recycle Bin, all files in it are unavailable
to you.

Delete Multiple ltems

Are you sure you want to permanently delete these 39 items?

Yes Mo |

Figure 5-9

by performing the preceding steps, you can retrieve
items in the Recycle Bin by right-clicking the desktop
icon and choosing Open. Select the item you want to
retrieve and then click the Restore This Item link near
the top of the Recycle Bin window.

@ You can modify the Recycle Bin properties by right-

@ Up until the moment you permanently delete items

clicking it and choosing Properties. In the dialog box
that appears, you can change the maximum size for
the Recycle bin, and whether to immediately delete
files you move to the Recycle Bin. You can also dese-
lect the option of having a confirmation dialog box
appear when you delete Recycle Bin contents.
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Find a File with Windows Explorer

1. Windows Explorer is a program you can use to find a file
or folder by navigating through an outline of folders and
subfolders. It's a great way to look for files on your laptop.
Right-click the Start menu button and choose Open
Windows Explorer, or click the Windows Explorer button
on the taskbar. (It looks like a set of folders.)

2. In the resulting Windows Explorer window (shown in
Figure 5-10), double-click a folder in the main window
or the list along the left side to open the folder.

e (o [EES

4 ¥ Libraries » v|¢'-,| | Search Libraries 2o |

File Edit View Tools Help

Organize » Mew library B il 9'

-

[ Favorites ] Documents

i Recently Change| < -0

Public L )

= { Music

= Desktop 3 J) Librar

¥ Downloads -

=l Recent Places = )7 Pictures

. Playlists h} Librar

= Libraries ﬁ Videos

= Documents

) -
@' Music

=| Pictures

4 items
Libraries let you access and arrange items from one or more folders quickly without moving th...

4 items

Double-<lick a folder to open it
Figure 5-10
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3. The folder’s contents are displayed. If necessary, open a
series of folders in this manner until you locate the file
you want.

4. When you find the file you want, double-click it to open it.

To see different perspectives and information about
@ files in Windows Explorer, click the arrow on the
Views button (it looks like series of columns) and
choose one of the following menu options: Extra
Large Icons, Large Icons, Medium Icons, or Small
Icons for graphical displays; Details to show details
such as Date Modified and Size; Tiles to show the
file/folder name, type, and size; and Content to
display the date modified and file size only. If you
are working with a folder containing graphics files,
the graphics automatically display as thumbnails (tiny
versions of the pictures) unless you choose Details.

in the Start menu, including Documents, Pictures,
Music, and Games. Click one of these, and Windows
Explorer opens that particular window.

@ There are some shortcuts to commonly used folders

Create a Shortcut to a File or Folder

70

1. Shortcuts are handy little icons you can put on the
desktop for quick access to items you use on a frequent
basis. This is especially useful for laptop users who may
have to get to what they need quickly to save on battery
power. (See this chapter’s first section, “Understand the
Desktop,” for an introduction to shortcuts.) To create a
new shortcut, first choose Start=>All Programs and locate
the program on the list of programs that appears.

2. Right-click an item, Freecell for example, and choose
Send Tor>Desktop (Create Shortcut), as shown in
Figure 5-11).



Chapter 5: Getting Around the Windows 7 Desktop

Play

More Games from Microsoft

Support

Pin to Start Menu
Pin to Taskbar

Restore previous versions

Send To »

Bluetooth File Transfer Wizard
T Compressed (zipped) Folder Cl ICk
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. ASUS Uil Cut Fax Recipient
1 s (Create Shortcut)

Copy

Copy To Folder...
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& FreeCem
“?; Games Explorer
@ Hearts
@ Internet Backgammon Favorites
@ Internet Checkers
@, Internet Spades Computer
#| Mahjong Titans
@ Minesweeper Control Panel

Games

#  More Games from Microsoft
%4 Purble Place Devices and Printers
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g_l Spider Solitaire Eelpandsupport

1 Back

| Search programs and files
e |

igure 5-11

3. The shortcut appears on the desktop, as shown in
Figure 5-12. Double-click the icon to open the application.

Double-click to use the new shortcut

A

Eleinajzasids

Figure 5-12
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Occasionally, Windows 7 offers to delete desktop
icons that you haven't used in a long time. Let it.
The desktop should be reserved for frequently used
programs, files, and folders. You can always re-create
shortcuts easily if you need them again.

To clean up your desktop manually, right-click the
desktop and choose Personalize. Click the Change

Desktop Icons link to the left. In the Desktop Icon
Setting dialog box that appears, click the Restore
Default button, which returns to the original desktop
shortcuts set up on your laptop.

right-clicking the desktop, choosing New, and then
choosing an item to place there, such as a text docu-
ment, bitmap image, or contact. Then double-click
the shortcut that appears and begin working on the
file in the associated application.

@ You can create a shortcut for a brand-new item by

Start a Program

1. Before you can use a program, you have to start it (also
called launching a program). Launch an application by
using any of the following four methods:

¢ Choose Start=>All Programs. Locate the program
name on the All Programs list that appears and
click it. Clicking an item with a folder icon
displays a list of programs within it; just click the
program on that sublist to open it (as shown in
Figure 5-13).

e Double-click a program shortcut icon on the
desktop. (See Figure 5-14.)
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e Click an item on the taskbar. The taskbar should
display by default; if doesn’t, press the Windows
key (on your keyboard) to display it, and then
click an icon on the taskbar (refer to Figure 5-14),
just to the right of the Start button.

e If you used the program recently and saved a
document, choose it from the list of recently used
programs displayed when you first open the Start
menu. Then click a document created in that
program from the list that displays.

Click a folder to display the programs within it

. Administrative Tools
. ASUS Uility

, Axara

, Camtasia Studio 6

J Crawler Toolbar

) CyberLink DVD Suite
. Extras and Upgrades

Owner

Documents

. Garnes

, HP

. iTunes

. LightScribe Direct Disc Labeling
. Maintenance

Pictures
Music

Games
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"o Activation Assistant for Microsoft O
l': Microsoft Office Access 2007 Computer
[ Microsoft Office Excel 2007
[ Microsoft Office Outlook 2007 Control Panel
ll’L_“J' Microsoft Office PowerPoint 2007
[ Microsoft Office Publisher 2007 Devices and Printers
i, Microsoft Office Word 2007
. Microsoft Office Tools

Help and Support
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| | Search programs and files ye | I Shut Down E

igure 5-13
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Doublelick a program shortcut . . .

-

-'3!1!73!‘ (ifsietately
@

e - O ¥ 9

or click a program icon
Figure 5-14

2. When the application opens, if it's a game, play it; if it's a
spreadsheet, enter numbers into it; if it's your e-mail
program, start deleting junk mail . . . You get the idea.

Not every program that’s installed on your laptop
appears as a desktop shortcut or taskbar icon. To

add a program as a desktop shortcut, right-click the
program name in the Windows Start menu and
choose Send Tor>Desktop (Create Shortcut) from the
menu that appears.

Resize Windows

1. When you open an application window, it can be
maximized to fill the whole screen, restored down to a
smaller window, or minimized to an icon on the taskbar.
With an application open and maximized, click the
Restore Down button (the icon showing two overlapping
windows) in the top-right corner of the program window.
(See Figure 5-15.) The window reduces in size.
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The Restore Down button

7% FreeCell [~ TR
Game Help

2
s
3
3
re
A
8

Game #10413 Cards left 52

Figure 5-15

2. To enlarge a window that has been restored down to
again fill the screen, click the Maximize button. (Note:
This button is in the same location as the Restore Down
button; this button changes its name to one or the other,
depending on whether you have the screen reduced in
size or maximized. A ScreenTip identifies the button
when you rest your mouse pointer on it.)

3. Click the Minimize button (it's to the left of the Restore
Down/Maximize button and looks like a small bar) to
minimize the window to an icon on the taskbar. To open
the window again, just click the taskbar icon.

75



Part lI: Exploring Windows

With a window maximized, you can’t move the
window. If you reduce a window in size, you can
then click and hold the title bar to drag the window
around the desktop, which is one way to view more
than one window on your screen at the same time.
You can also click and drag the corners of a reduced
window to change it to any size you want.

Switch between Programs

1. Open two or more programs. The last program that you
open is the active program.

2. Press Alt+Tab to move from one open application
window to another.

3. Press and hold Alt+Tab to open a small box, as shown in
Figure 5-16, revealing all opened programs.

FreeCell

B !:I_I

Press the Tab key to select another
open program in this list

Figure 5-16

4. Release the Tab key but keep Alt pressed down. Press Tab
to cycle through the icons representing open programs.

5. Release the Alt key, and Windows 7 switches to whichever
program is selected. To switch back to the last program
that was active, simply press Alt+Tab, and that program
becomes the active program once again.
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All open programs also appear as items on the
Windows 7 taskbar. Just click any running program
on the taskbar to display that window and make it
the active program. If the taskbar isn’t visible, press
the Windows key on your keyboard to display it.

Close a Program

1. With an application open, first save any open documents
(typically you can choose Filew>Save to do this, though in
recent Microsoft Office products, you click the Office
button in the upper-left corner and choose Save As) and
then close the application by using one of these methods:

¢ Click the Close button in the upper-right corner of
the window.

e Press Alt+F4 to close an active open window.

¢ Choose File (or click the Office button)= Exit
(as shown in Figure 5-17).

2. The application closes. If you haven't saved changes in
any open documents before trying to close the applica-
tion, you see a dialog box (before the application closes)
asking whether you want to save the document(s). (See
Figure 5-18.) Click Yes or No, depending on whether
you want to save your changes.

To save a document before closing an application,

@ choose Filer>Save and use settings in the Save dialog
box (that appears) to name the file and also specify
which folder to save it to.

ments in an application. Choose File>Close to close
only the currently active document and keep the
application and any other open documents open.

@ Note that choosing File=>Exit closes all open docu-
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2™ i = | Document - WordPad
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Recent documents
j Hew
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Sl Send e-mail

About WordPad
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Exit WordPad

Select the Exit option
Figure 5-17

WordPad

Do you want to save changes to Document?

Don't Save || Cancel |

Figure 5-18

You don’t have to close an application to open or
switch to another. To switch between open applica-
tions, press Alt+Tab and use the arrow keys to move
to the application (or document if multiple docu-

ments are open in an application) in which you want
to work.
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Setting Up Vour
Display

ou chose your designer Day Planner, paper

clip holder, and solid maple inbox for your
real-world desktop, right? Why shouldn’t the
Windows desktop give you the same flexibility
to make things look the way you like? After all,
this is the main work area of Windows, a space
that you traverse many, many times in a typical
day. Take it from somebody who spends many
hours in front of a laptop: Customizing your
desktop pays off in increased productivity as
well as decreased eyestrain.

To customize your desktop, you can do the
following:

m=  Set up Windows to display images and
colors.

w= [Ise screen saver settings to switch from

everyday work stuff to an attractive
animation when you’ve stopped working
for a time.

w= Modify your screen resolution setting,
which controls how sharp and detailed
a picture your screen displays. (See
Chapter 7 for more about settings that

help those with visual challenges.)

| “*ap’rer

Getready to. ..

w= Customize Windows'
Appearance..................

w= Set Your Screen’s
Resolution ....ccoeeeeeeeenn

w= Change the Desktop
Background...................

w= Choose a Desktop Theme ...

w Set Up a Screen Saver ...

w= Change the Color and
Appearance of Windows

= Modify Windows'

Transparency.................
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w=  Modify Windows transparency. Windows Aero Glass

is an effect that makes the borders of your windows
transparent so you can see other windows layered
underneath the active window. You might love it, or
hate it, but you should know how to turn the effect
on or off.

Customize Windows’ Appearance

80

When you take your laptop out of the box, Windows comes with
certain preset, or default, settings that determine the appearance of the
desktop and a color scheme for items you see on your screen. Here are
some of the things you can change about the Windows environment
and why you might want to change them:

w= As you work with your laptop, you might find that

=y

=y

changing the appearance of various elements on
your screen not only makes it more pleasant to look
at, but also helps you see the text and images more
easily. You can change the graphic that’s shown as
the desktop background, even displaying your own
picture there.

You can adjust your screen resolution, which not
only affects the crispness of images on your screen,
but lower resolutions will display items larger on
your screen, which could help you if you have visual
challenges or a smaller laptop screen. (See Chapter 7
for more about Windows features that help people
with visual, hearing, or dexterity challenges.)

Windows has built-in themes that you can apply
quickly. Themes save sets of elements that include
menu appearance, background colors or patterns,
screen savers, and even mouse cursors and system
sounds. If you choose a theme and then modify the
way your laptop looks in some way — for example,
by changing the color scheme — that change over-
rides the setting in the theme you last applied.
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w= Screen savers are animations that appear after your
laptop has remained inactive for a time. In the early
days of personal computers, screen savers helped to
keep your monitor from burning out from constant
use. Today, people use screen savers to automatically
conceal what they're doing from passersby or just to
enjoy the pretty picture. Note, however, that if you
are running your laptop off the battery, you might
want to disable the screen saver so it doesn’t use up
your power.

Set Vour Screen’s Resolution

1. Changing screen resolution can make items onscreen
easier to see. Choose Start=>Control Panel=>Appearance
and Personalization and click the Adjust Screen
Resolution link.

2. In the resulting Screen Resolution window, click the
arrow to the right of the Resolution field.

3. Use the slider (as shown in Figure 6-1) to select a higher
or lower resolution.

You can also change the orientation of your display by
making a choice in the Orientation drop-down list.

4. Click OK to accept the new screen resolution and then
click the Close button to close the window.

smaller, crisper images. Lower resolutions, such as
800 x 600, produce larger, somewhat jagged images.
The upside of higher resolution is that more fits on
your screen; the downside is that words and graphics
can be hard to see because they're smaller.

@ Higher resolutions, such as 1400 x 1250, produce

The Advanced Settings link in the Screen Resolution
window displays another dialog box where you can
work with color management and monitor settings.
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@-v-vlu « Appearance and Personalization » Display » Screen Resolution - ‘ *1‘ | Search Control Panel el

File Edit View Tools Help

Change the appearance of your display

| Detect |

| Identify ‘

Display: 1. Mobile PC Display "

Resolution: 1024768 - |

Orientation: Advanced settings

1280 x 800 (recommended)
Connectto a projeg
Make text and othe

What display settin
s PRI o) Comea )

800 x 600

Click and drag the Resolution slider
Figure 6-1

Remember that you can also use your View settings
@ in most software programs to get a larger or smaller
view of your documents without having to change
your screen’s resolution. Consult the program’s Help
feature for instructions on how to adjust the view.

Change the Desktop Background

1. You can display a picture or color that appeals to you on
your desktop. Right-click the desktop and choose
Personalize from the shortcut menu.

2. In the resulting Personalization window, click the
Desktop Background link to display the Desktop
Background window, as shown in Figure 6-2.

3. Select a category of desktop background options from the
Picture Location drop-down menu (see Figure 6-3), and
thumbnails of your choices display in the viewing area.
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Figure 6-2
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Figure 6-3
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4. Click the image that you want to use. The background is
previewed on your desktop.

5. Click Save Changes to apply the settings and close the
window, and then close the Personalization window.

If you apply a desktop theme (see the next task), you
overwrite whatever desktop settings you've made in

this task. If you apply a desktop theme and then go
back and make desktop settings, you replace the
theme’s settings. However, making changes is easy
and keeps your desktop interesting, so play around
with themes and desktop backgrounds all you like!

Choose a Desktop Theme

1. Themes apply several color and image settings at once.
Right-click the desktop and choose Personalize. The
Personalization window opens.

2. In the resulting Personalization window, as shown in
Figure 6-4, select a theme. Your options include the
following groups:

¢ My Themes: Uses whatever settings you have and
saves them with that name.

e Windows Themes: Offers up themes related to
nature, landscapes, light auras, and your country
of residence.

e Ease of Access Themes: Offers a variety of easy to
read contrast settings in a variety of themes.

3. Click Close to close the dialog box.
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Select a desktop theme

& Control Panel Home . @
E Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once,

Change mouse pointers [Ty Themes (5) +

Change your account picture

Ol
Taskbar and Start Menu

Ease of Access Center

[ — " IENEEERS

—
‘/(-\ uv‘n‘_’ » Control Panel » JAppearance and Personalization » Personalization - | +7| ‘ Search Control Panel el

File Edit View Tools Help

Get more themes online

Windows Themes (5]

P T

Ease of Access Themes (6)

= g o

m

Current Theme: Windows 07 Wiley Final Theme March ~ Save theme
— h —
= =2 %
Desktop Background Window Color Sounds Screen Saver
Solid Color Custom Windows Default MNone

Figure 6-4

Themes affect sets of elements that include menu
appearance, background colors or patterns, screen
savers, and even cursors and sounds. If you modify
any of these individually — for example, by changing
the screen saver to another one — that change over-
rides the setting in the theme you last applied.

You can save custom themes. Simply apply a theme,
make any changes to it you like using the various
Appearance and Personalization settings options, and
then in the Personalization window, click Save
Theme. In the resulting dialog box, give your new
theme a name and click Save. It will now appear on
the Theme list.
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Set Up a Screen Saver

86

1. If you want an animated sequence to appear when your
laptop is not in use for a period of time, set up a screen
saver. Right-click the desktop and choose Personalize. In
the resulting Personalization window, click the Screen
Saver button to display the Screen Saver Settings dialog
box, as shown in Figure 6-5.

EX Screen Saver Settings oL N R

Screen Saver

Screen saver

!E(None) e

Power management

Conserve energy or maximize performance by adjusting display
brightness and other power settings.

Change power settings...

OK Cancel |

Figure 6-5

2. From the Screen Saver drop-down list, choose a screen
saver.

3. Use the arrows in the Wait xx Minutes text box to set the
number of inactivity minutes that Windows 7 waits
before displaying the screen saver.

4. Click the Preview button to take a peek at your screen
saver of choice. (See Figure 6-6.) When you're happy
with your settings, click to stop the preview, and then
click OK.
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Figure 6-6

5. Click the Close button in the Personalization window to
close it.

Some screen savers allow you to modify their set-

@ tings: for example, how fast they display or how
many lines they draw onscreen. To customize this,
click the Settings button when you're in the Screen
Saver Settings dialog box.

Change the Color and Appearance of Windows

1. You can modify the appearance of elements on your
screen one by one. Right-click the desktop and choose
Personalize.
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88

2. In the resulting Personalization window, click the
Window Color button to display the Window Color and
Appearance dialog box, as shown in Figure 6-7.

EX Window Color and Appearance LS R
Window Color and Appearance
=10]x] |

Active Window =10} x|
MNormal Selected

Window Text j
Message Box x|

Message Text J

o OK

Access theme,

To turn on Windows Aerg, select a Windows theme. Colors and sizes zelected
here apply only if you have selected the Windows 7 Basic theme or an Ease of

Itern: Colorl:
Desktop ||:| v|
OK Cancel |
Figure 6-7

3. Select items one by one from the Item drop-down list.
Make any changes you wish by using the Size, Color, and

Font settings.

4. Click OK to accept the settings, and then click Save
changes to return to the Personalization window.

5. Click the Close button to close the Personalization

window.

When customizing a color scheme, be aware that not
all screen elements allow you to modify all settings.
For example, setting an Application Background
doesn’t make the Font setting available — because
it's just a background setting. Makes sense, huh?
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Some colors are easier on the eyes than others. For
example, green is more restful to look at than orange.
Choose a color scheme that is pleasant to look at and

easy on the eyes!

Modify Windows’ Transparency

1. You can apply a Windows Aero theme to get a transparent
effect on windows you display. Choose Starte>Control
Panel=>Appearance and Personalization. In the
Appearance and Personalization window that appears
(see Figure 6-8), click Personalization.

Click the Personalization link

il (o[

@uv"ﬁ + Control Panel » Appearance and Perfonalization »

File Edit View Tools Help

B Control Panel Home

| Personalization

Systemn and Security Change the theme

Metwork and Internet :
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Hardware and Sound

Programs Connectto an external display

User Accounts and Family
Safety
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Personalization

| Desktop Gadgets
Add gadgets to the desktop

Clock, Language, and Region
g 2 Taskbar and Start Menu

Ease of Access B Customize the Start menu

All Control Panel ltems
N Ease of Access Center

* Accommodate low vision | U
Turn High Contrast on or off

- Folder Options

Show hidden files and folders

Fonts

Change desktop background

¥ Make text and other items larger or smaller

Restore desktop gadgets installed with Windows

Customize icons on the taskbar

Change the picture on the Start menu

se screen reader

Specify single- or double-click to open

Preview, delete, or show and hide fonts

= [4| [ Search Control Pane |

Change sound effects | Change screen saver

Adjust screen resolution | Connectto a projector

Get more gadgets online

Uninstall a gadget

Turn on easy access keys

Use Classic Windows folders

Adjust ClearType text settings

Figure 6-8

2. In the resulting Personalization window (see Figure 6-9)
click a theme in the Aero Themes section.

3. Click the Close button to close the Personalization

window and see the results.
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Select a theme from the Aero Themes section
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Fase nE Aocacs Genter r“g' Troubleshoot problems with transparency and other Aero effects

Figure 6-9

You have to have a graphics card that supports
Windows Aero to see the effect. If nothing happens
when you apply an Aero effect, click the
Troubleshoot Problems with Transparency and Other
Aero Effects link at the bottom of the Personalization
window to have Windows search for the cause.
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Customizing
Windows and
Accessibility

Tnough Windows knows how to do a lot

of things right out of the box, when it
comes to being more accessible to each person
using it, it has to be taught how to behave.

For example, if you have a vision challenge
that requires special help, or prefer a certain
cursor, or have difficulty using a keyboard,
Windows depends on you to make settings that
customize its behavior. This is good news for
you because the ability to customize Windows
gives you a lot of flexibility in how you interact
with it.

Here’s what you can do to customize
Windows:

w= Control features that help visually
challenged users work with a laptop,
such as setting a higher contrast, using
Narrator to read the onscreen text
aloud, or increasing the size of text
onscreen.

| “*ap’rer

Getready to. ..

w= Use Tools for the Visually

Challenged ..........cccvn.. 92
w= Replace Sounds with Visual

CUBS.c.eveeecce 95
w=» Make Text Larger or

Smaller.....ccoocovviiiiini, 96
w= Set Up Speech

Recognition ..........ccccceueenne. 98
= Modify How Your Keyboard

Works ......covevviiiiiinn, 101
w= Use the Onscreen Keyboard

Feature ......cccoovvvrieiiins, 103
w= Set Up Keyboard Repeat

Rates ....oovvvveeriiiiiiieniien, 105

w= Customize Touchpad
Behavior ..........ccocevveinnn. 106

w= Change the Cursor............ 108
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w= Work with the Speech Recognition feature, which
allows you to input data into a document using
speech rather than a keyboard or mouse.

w= Modify the touchpad functionality, change the cursor
to sport a certain look, or make your cursor easier to
view as it moves around your screen.

w= Work with keyboard settings that make input easier
for those who are challenged by physical conditions,
such as carpal tunnel syndrome or arthritis.

Use Tools for the Visually Challenged

92

1. You can set up Windows to use higher screen contrast to
make things easier to see, read descriptions to you rather
than make you read text, and more. Choose
Start=>Control Panel.

2. In the Control Panel window, click the Optimize Visual
Display link under the Ease of Access tools.

3. In the resulting Make the Computer Easier to See dialog
box (as shown in Figure 7-1), select the check boxes for
features you want to use:

e High Contrast: Turn on higher contrast when
Alt+Left Shift+Print Screen Is Pressed. High
contrast is a color scheme that increases the
darkness of darker elements and the lightness of
lighter elements so that it's easier for your eyes to
distinguish one from the other. You can also
choose to have a warning message display when
you turn this setting on, or have a sound play
when it’s turned off or on.

e Hear Text and Descriptions Read Aloud: You can
turn on a Narrator feature that will read onscreen
text or an Audio Description feature to describe
what’s happening in video programs.



e Make Things on the Screen Larger: If you click

Turn on Magnifier, you have two cursors onscreen.

One cursor appears in the Magnifier window,
where everything is shown enlarged, and one
appears in whatever is showing on your laptop

(for example, your desktop or an open application).

You can maneuver either cursor to work in your
document. (They're both active, so it does take
some getting used to.)

Make Things On the Screen Easier to See: Here's
where you make settings that adjust onscreen
contrast to make things easier to see, enlarge the
size of the blinking cursor (see Figure 7-2), and
get rid of distracting animations and backgrounds.

Chapter 7: Customizing Windows and Accessibility

e i HEH |55
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Figure 7-1
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Figure 7-2

4. When you finish making settings, click OK to apply them
and then click the Close button to close the dialog box.

If you bought a laptop with a 12-inch screen and
find things are hard to read, don’t run out and buy a
new laptop. It's possible to connect your laptop to a
stand-alone monitor using a VGA port. If you mainly
use your laptop at home, this may be a less expensive
way to upgrade your screen to a larger size. Consult
your laptop manual for instructions on how to hook
up a separate monitor.
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Replace Sounds with Visual Cues

1. Sometimes Windows alerts you to events with sounds. If
you have hearing challenges, you might prefer to get
visual cues. Choose Start>Control Panel=>Ease of Access
and then click the Replace Sounds with Visual Cues link.

2. In the resulting Use Text or Visual Alternatives for Sounds
window (see Figure 7-3), make any of the following
settings:

e Select the Turn on Visual Notifications for Sound
(Sound Sentry) option so that Windows will give a
visual alert when a sound plays.

e Choose a setting for visual notifications. These
warnings essentially flash a portion of your screen
to alert you to an event.

e To control text captions for any spoken words,
select Turn on Text Captions for Spoken Dialog
(When Available). Note: This isn't always available
with every application you use.

3. To save the new settings, click OK, and then click the
Close button to close the window.

don't always pick up system sounds alerting you to
error messages or a device disconnect. After the
setting is turned on, it is active until you go back
to the Use Text or Visual Alternatives for Sounds
window and turn it off.

@ Visual cues are useful if you are hard of hearing and

ing, you may want to simply increase the volume for
your speakers. You can modify your system volume
by choosing Hardware and Sound in the Control
Panel and then clicking the Adjust System Volume
link. Most laptop keyboards also offer special volume
keys you can click to quickly adjust system sounds.

@ This may seem obvious, but if you are hard of hear-

Chapter 7: Customizing Windows and Accessibility
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Figure 7-3

Make Text Larger or Smaller

1. Choose Start=>Control Panel=>Appearance and
Personalization. In the resulting window, click Make Text
and Other Items Larger or Smaller.

2. In the resulting Display window (see Figure 7-4), click
the radio button for the size of text you prefer. Smaller is
the default, but you can expand text size to 125 percent
with the Medium setting and 150 percent with the Larger
setting.

3. Click Apply and then click the Close button to close the
window. You'll see the results (see Figure 7-5, which
shows the Larger setting applied) next time you log into
Windows.
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Make your text size selection

v‘!] » Control Panel » dppearance and Personalization » Display v|<‘7| ‘ Search Control Panel el

File Edit View Tools Help

E Control Panel Home " " .
= Make it easier to read what's on your screen
You can change the size of text and other items on your screen by choosing one of these options. To

temporarily enlarge just part of the screen, use the Magnifier tool.

Adjust resoluti

. ; () Smaller - 100% (default) Preview
Change displa -

Connect to a proje

@ Medium - 125%

Set custom tex

@ Larger - 150%

Figure 7-4

Recycle Bin

U Caleator ol B )

View Edit Help

EPSON Scan

BERERETR
Lo J| - [l

Figure 7-5
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Set Up Speech Recognition
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1.

If you have dexterity challenges from a condition such as
arthritis, you might prefer to speak commands using a
technology called speech recognition rather than type
them. If your laptop doesn’t have a built-in microphone,
plug a headset with a microphone into to your laptop
headset ports.

Choose Starte>Control Panele>Ease of AccesstvStart
Speech Recognition.

The Welcome to Speech Recognition message appears;
click Next to continue. (Note: If you've used Speech
Recognition before, this message will not appear.)

In the resulting Set Up Speech Recognition dialog box (as
shown in Figure 7-6), select the type of microphone that
you're using and then click Next. The next screen tells
you how to place and use the microphone for optimum
results. Read it and click Next.

In the following dialog box (see Figure 7-7), read the
sample sentence aloud. When you're done, click Next. A
dialog box appears, telling you that your microphone is
now set up. Click Next.

are given the option of printing out commonly used

@ During the Speech Recognition setup procedure, you

6.

commands. It's a good idea to do this, as speech
commands aren’t always second nature!

In the resulting dialog box, choose whether to enable or
disable document review, which allows Windows to review
your documents and e-mail to help it recognize your
speech patterns. Click Next.
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&, = Microph

What type of microphone is

N
o

.t o

==

one Setup Wizard

ficrophone (Realtek High Definition Audic)?

© Headset Microphone

Best suited for speech recognition, you wear this on your head.

Desktop Microphone

These microphones sit on the desk,

Other

Such as array microphenes and microphones built into other devices,

Iext ] Cancel

Figure 7-6

@ ‘L Microph

one Setup Wizard

Adjust the volume of Microphone (Realtek High Definition Audio)

Read the following sentences aloud in a natural speaking voice:

"Peter dictates to his computer. He prefers it to typing, and particularly
prefers it to pen and paper.”

Mote: After reading this, you can proceed to the next page.

| Cancel |

Figure 7-7
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7.

10.

11.

In the resulting dialog box, choose either Manual
Activation mode, where you can use a mouse, pen, or
keyboard to turn the feature on; or Voice Activation
mode, which is useful if you have difficulty manipulating
devices because of arthritis or a hand injury. Click Next.

In the resulting screen, if you wish to view and/or print a
list of speech recognition commands, click the View
Reference Sheet button and read about or print reference
information, and then click the Close button to close
that window. Click Next to proceed.

In the resulting dialog box, either click Run Speech
Recognition at Startup to disable this feature or leave the
default setting. Click Next.

The final dialog box informs you that you can now
control the laptop by voice, and it offers you a Start
Tutorial button to help you practice voice commands.
Click that button, or click Skip Tutorial to skip the
tutorial and leave the Speech Recognition setup.

The Speech Recognition control panel appears. (See
Figure 7-8.) Say “Start listening” to activate the feature if
you used voice activation in Step 6, or click the Start
Speech Recognition link if you chose manual activation
in Step 8. You can now begin using spoken commands to
work with your laptop.

on the Control Panel. To start the Speech

@ To stop Speech Recognition, click the Close button

Recognition feature again, choose Start=>Control
Panel=>Ease of Access and then click the Start Speech
Recognition link. To learn more about Speech Recog-
nition commands, click the Take Speech Tutorial link
in the Speech Recognition Options window accessed
from the Ease of Access window of the Control
Panel.
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The Speech Recognition control panel

Configure your Speech Recognition experience @

]U' Start Speech Recognition

T Start using your v/, = '
g} Set up microph ;‘ ‘:"

— Set up your comp

Take Speech Tutorial

®  Learn to use your computer with speech. Learn basic commands and dictation.

_a Train your computer ta better understand you
Read text to your computer to improve your computer's ability to understand your veice, Doing this
isn't necessary, but can help improve dictation accuracy.
/ Open the Speech Reference Card

= View and print a list of commen commands to keep with you so you always know what to say.

I you would like to learn more about speech related tools and support from Microsoft, please visit the Microsoft Speech Online Community.

Figure 7-8

Modify How Your Keyboard Works

1. If your hands are a bit stiff with age or you have carpal
tunnel problems, you might look into changing how
your keyboard works. Choose Start=>Control Panel=>Ease
of Access and then click the Change How Your Keyboard
Works link.

2. In the resulting Make the Keyboard Easier to Use window
(see Figure 7-9), make any of these settings:

e Turn on Mouse Keys: Select this option to control
your cursor by keyboard commands. If you turn
on this setting, click the Set Up Mouse Keys link to
specify settings for this feature.

e Turn on Sticky Keys: Select this option to enable
keystroke combinations (such as Ctrl+Alt+Delete)
to be pressed one at a time, rather than in
combination.

e Turn on Toggle Keys: You can set up Windows to
play a sound when you press Caps Lock, Num Lock,
or Scroll Lock (which I do all the time by mistake!).
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e Turn on Filter Keys: If you sometimes press a key
very lightly or press it so hard that it activates
twice, you can use this setting to adjust repeat rates
to adjust for that. Use the Set Up Filter Keys link to
fine-tune settings if you make this choice.

e Make It Easier to Use Keyboard Shortcuts: To
have Windows underline keyboard shortcuts and
access keys wherever these shortcuts appear, click
that setting.

e Make It Easier to Manage Windows: If you want
to avoid windows shifting automatically when you
move them to the edge of your screen, use this
setting.

— o =]

File Edit View Tools Help

Make the keyboard easier to use
When you select these settings, they will automatically start each time you log on.

Control the mouse with the keyboard
[T] Turn on Mouse Keys

Use the numeric keypad to move the mouse around the screen.

Set up Mouse Keys

Make it easier to type
[7] Turn on Sticky Keys
Press keyboard shortcuts (such as CTRL+ALT+DEL) one key at a time,

Set up Sticky Keys
[T Turn on Toggle Keys
Hear a tone when you press CAPS LOCK, NUM LOCK, or SCROLL LOCK.
[] Tumn on Toggle Keys by holding down the NUM LOCK key for 5 seconds
[ Turn on Filter Keys
Ignore or slow down brief or repeated keystrokes and adjust keyboard repeat rates.

Set up Filter Keys

Make it easier to use keyboard shortcuts
[T]Underline keyboard shortcuts and access keys

Make it easier to manage windows

|| Prevent windows from being automatically arranged when moved to the edge of the screen

Seealso

Add a Dvorak keyboard and change other keyboard input settings

OK | | Cancel

@\‘;}-vl'\;} » Control Panel » Ease of Access » Ease of Access Center » Make the keyboard easier to use - |+7| | Search Control Panel el

Figure 7-9
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3. To save the new settings, click OK, and then click the
Close button to close the Ease of Access Center.

You can click the Learn about Additional Assistive

@ Technologies Online link to go the Microsoft Web
site and discover add-on and third-party programs
that might help you if you have a visual, hearing, or
input-related disability.

Keyboards all have their own unique feel. When you

@ buy a laptop, it’s important to try different keyboards
to see if one works better for you than another. See
Chapter 2 for more about selecting the right laptop
for you.

Use the Onscreen Keyboard Feature

1. Clicking keys with your mouse may be easier for some
than using a regular keyboard. If you have a tablet PC,
there’s a handy onscreen keyboard feature. If you have
another style of laptop, Windows offers its own onscreen
keyboard. To use the onscreen keyboard, choose
Start=>Control Panel=>Ease of Access category.

2. In the resulting window, click the Ease of Access Center link
to open the Ease of Access Center window. (See Figure 7-10.

3. Click Start On-Screen Keyboard. The onscreen keyboard
appears. (See Figure 7-11.)

4. Open a document in any application where you can
enter text, and then click the keys on the onscreen
keyboard to make entries.

the first key (in this case, Ctrl), and then click the
second key (Z). You don’t have to hold down the
first key as you do with a regular keyboard.

@ To use keystroke combinations (such as Ctrl+Z), click
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Click this link

o [ S

@Qvl'@ » Control Panel » Ease of Access » Ease of Access Center hd | 5 | | Search Control Panel £

File Edit View Tools Help

E Control Panel Home .
Make your computer easier tq use

@ Change administrative settings Quick access to common{tools
You can use the tools in this sectiof to help you get started,
‘Windows can read and scan this lisf automatically. Press the SPACEBAR to select the highlighted tool,

[7] Always read this section aloud [ Always scan this section
ij Start Magnifier & Start Narrator
= Start On-Screen Keyboard P set up High Contrast

'Y MNotsure where to start? Get recommendations to make your computer easier to use

Explore all settings
When you select these settings, they will automatically start each time you log on.

| Use the computer without a display

Optimize for blindness

Make the computer easier to see
Optimize visual display
Use the computer without a mouse or keyboard

Set up alternative input devices

Make the mouse easier to use

Adjust settings for the mouse or other pointing devices

0L Qoo & ik

_ Make the keyboard easier to use
Adjust settings for the keyboard

Use text or visual alternatives for sounds

Set up altematives for sounds

E' Make it easier to focus on tasks
b Adjust settings for reading and typing

@ -

m

Figure 7-10

IR LRGN S |
Figure 7-11

5. To change settings, such as how you select keys (Typing
Mode) or the font used to label keys (Font), click the Options
key on the onscreen keyboard. Choose one of the four
options shown in the Options dialog box and click OK.

6. Click the Close button on the onscreen keyboard to stop
using it.
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You can set up the Hover typing mode to activate a
key after you hover your pointer over it for a pre-
defined period of time (x number of seconds). If you
have arthritis or some other condition that makes
clicking difficult, this option can help you enter text.
Click the Hover over Keys item in the Options dialog
box and use the slider to set how long you have to
hover before activating the key.

Set Up Keyboard Repeat Rates

1. Adjusting your keyboard settings might make it easier for
you to type, and it can be helpful to people with dexter-
ity challenges. To see your options, choose Start=>Control
Panel=>All Control Panel Items. In the resulting window,
click the Keyboard link.

2. In the Keyboard Properties dialog box that appears, click
the Speed tab (see Figure 7-12) and drag the sliders to
adjust the two Character Repeat settings, which do the
following:

e Repeat Delay: Affects the amount of time it takes
before a typed character is typed again when you
hold down a key.

e Repeat Rate: Adjusts how quickly a character
repeats when you hold down a key after the
first repeat character appears.

If you want to see how the Character Repeat rate

@ settings work in action, click in the text box below
the two settings and hold down a key to see a
demonstration.

3. Drag the slider in the Cursor Blink Rate section. This
affects cursors, such as the insertion line that appears
in text.
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~- Keyboard Properties Sl bl (=)
Speed | Hardware
Character repeat

Bt Fepeat delay:
Long gShort

Bepeat rate:
Slow M Fast

Click here and hold down a key to test repeat rate:

Cursor blink rate

None r ] Fast

OK | Cancel |

Figure 7-12

4. Click OK to save and apply changes and close the dialog
box. Click the Close button to close the Control Panel
window.

If you have trouble with motion (for example,

@ because of arthritis or carpal tunnel syndrome), you
might find that you can adjust these settings to make
it easier for you to get your work done. For example,
if you can’t pick up your finger quickly from a key, a
slower repeat rate might save you from typing more
instances of a character than you'd intended. This is
especially helpful for laptops with smaller keyboards,
such as netbooks.

Customize Touchpad Behavior

1. To avoid having to click your touchpad too often, you
can use your keyboard to move the cursor instead of
moving your mouse with your hand, or you can activate
a window by hovering your mouse over it rather than
clicking. Choose Start=>Control Panel=>Ease of Access
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and then click the Change How Your Mouse Works link.
The Make the Mouse Easier to Use window opens (as
shown in Figure 7-13).

2. To use the numeric keypad to move your cursor on your
screen, choose the Turn on Mouse Keys setting. If you
turn this feature on, click Set Up Mouse Keys to fine-tune

its behavior.

3. Select the Activate a Window by Hovering Over It
with the Mouse check box to enable this (pretty self-
explanatory!) feature.

4. Click OK to save the new settings and then click the

Close button to close the Ease of Access Center.

—— o[ [

File Edit View Tools Help

e —
@\\L}-vll@ » Control Panel b Esseof Access » Ease of Access Center » Make the mouse easier to use

Make the mouse easier to use

When you select these settings, they will sutomatically start each time you log on.

Mouse pointers

Change the color and size of mouse pointers.

- |+,| | Search Control Panet 2 |

@ Regular [% I

White

) Large White [% I

() Regular Black R i

Large Black k I
Extra Large I (") Extra Large I
White Black

Regular
Inverting

i Large

Inverting

() Extra Large

Inverting

AAA

Control the mouse with the keyboard

[T Turn on Mouse Keys

Use the numeric keypad to move the mouse around the screen.

Set up Mouse Keys

Make it easier to manage windows

[] Activate 2 window by hovering over it with the mouse

[ Prevent windows from being automatically arranged when moved to the edge of the screen

See also
Mouse settings

Learn about additional assistive technologies anline

| [ Cancel

Figure 7-13
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If you're left-handed, click the Mouse Settings link
in the Make the Mouse Easier to Use window; then,
on the Buttons tab, use the Switch Primary and
Secondary Buttons feature to make the right mouse
button handle all the usual left-button functions,
such as clicking and dragging, and the left button
handle the typical right-button functions, such as
displaying shortcut menus. This helps left-handed
people use the mouse more easily.

If you want to modify the behavior of the pointer, in
the Mouse Properties dialog box, click the Pointer
Options tab to set the pointer speed (how quickly
you can drag the pointer around your screen),
activate the Snap To feature that automatically moves
the cursor to the default choice in a dialog box, or
modify the little trails that appear when you drag the
pointer.

Though some laptop keyboards have separate num-
ber pads, many have them embedded in the regular
keyboard to save space. Using these embedded keys
requires that you press the Fn key and then the letter
key where the number you want is embedded. (The
numbers are usually included on the key in a differ-
ent color, such as red or blue.)

Change the Cursor

108

1. Having trouble finding the mouse cursor on your screen?
You might want to enlarge it or change its shape. Choose
Start=>Control Panel=>Ease of Access>Change How Your
Mouse Works. In the resulting Make the Mouse Easier to
Use dialog box, click the Mouse Settings link.

2. In the resulting Mouse Properties dialog box, on the

Pointers tab, as shown in Figure 7-14, click to select a



pointer, such as Normal Select, and then click the Browse
button. (Note: This dialog box may have slightly different

Chapter 7: Customizing Windows and Accessibility

tabs depending on your mouse model features.) In the
Browse dialog box that appears, click an alternate cursor
and then click Open.

¥ Mouse Properties

Buttons Buttons

Scheme

Hardware Activities

Il Bl (250

ﬂ] Device Settings Wireless
Poirters Pointer Options Scrolling

Customize:

Help Select

‘Warking In Backaground

Busy

Precision Select

| Enable pointer shadow

/| Allow themes to change mouse pointers

Use Default | | Browse.. |

OK | Cancel |

Figure 7-14

3. Click Apply to use the new pointer setting and then click

the Close button to close the Mouse Properties dialog box.

cursor (for example, changing the Normal Select

@ Be careful not to change the cursor to another standard

cursor to the Busy hourglass cursor). This could
prove slightly confusing for you and completely
baffling to anybody else who works on your laptop.
If you make a choice and decide it was a mistake,
click the Use Default button on the Pointers tab in
the Mouse Properties dialog box to return a selected
cursor to its default choice.
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®

You can also choose the color and size of mouse
pointers in the Make the Mouse Easier to Use dialog
box. A large white or extra large black cursor might
be more visible to you, depending on the color
scheme you have applied to Windows 7.
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Install a Printer

Read the instructions that came with your printer. Some printers
require that you manually install software before connecting them, but
others automatically install software and can be connected right away.
After reading the instructions, turn on your laptop and then follow the
option that fits your needs:

=y

-y

=y

If your printer is a Plug and Play device, connect it
and power it on; Windows installs what it needs
automatically.

Insert the disc that came with the device and follow
the onscreen instructions.

If you have a wireless printer, choose Start>Devices
and Printers and click the Add a Printer link in the
window that appears. Choose the Add a Network,
Wireless, or Bluetooth Printer option and follow the
instructions provided.

Note: In the step that follows the one where you
name the printer, you can indicate whether you want
to share the printer on your network. You can select
the Do Not Share This Printer option to prevent
others from using the printer, or you can select the
Share Name option and enter a printer name to
share the printer on your network. This means that
others can see and select this printer to print their
documents.

If none of those options are suitable, follow these steps:

1. Choose Start=>Devices and Printers.

2. In the Devices and Printers window that appears, click
the Add a Printer link near the top.
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3. In the resulting Add Printer Wizard (shown in Figure 8-1),
click the Add a Local Printer option and click Next.

Select this option and click Next

() = Add Printer
What type of prirger do you want to install?

=+ Add a local printer
Use this optian only if you don't have a USB printer, (Windows automatically
installs USB printers when you plug them in.)

= Add a network, wireless or Bluetooth printer
Make sure that your computer is connected to the network, or that your Blustooth
or wireless printer is turned on.,

Cancel

Figure 8-1

4. In the Choose a Printer Port dialog box shown in
Figure 8-2, click the down arrow on the Use an Existing
Port field and select a port, or just use the recommended
port setting that Windows selects for you. Click Next.

Select a printer port

K3 = Add Printer

Choose a printer port

Aprinter portis a type of connection that allows your computer th exchange information with
printer.

@ Use an existing port: [tpT1: Erinter Port) -

) Create a new port:

| Next H Cancel

Figure 8-2
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5. In the Install the Printer Driver dialog box, shown in
Figure 8-3, choose a manufacturer and then choose a
printer. You then have two options:

e If you have the manufacturer’s disc, insert it in the
appropriate CD or DVD drive now and click the
Have Disk button. Click Next.

e [f you don’t have the manufacturer’s disc, click the
Windows Update button to see a list of printer
drivers that you can download from the Microsoft
Web site. Click Next.

Choose a manufacturer  Then choose a printer

@ = Add Printer

Install the printgr driver
Choose yolr printer from the list. Click Windows Update to see more models.

To instzll t§e driver from an installation CD, click Have Disk,

Manufacturer * || Printers

Brother 5 Brother DCP-116C
Canon ¥ Brother DCP-117C
Epson
Fuji Xerox

EF  This driver is digitally signed. Windows Update | { Have Disk... |

Tell me why driver signing is important

Net | [ Cancel

Figure 8-3

6. In the resulting Type a Printer Name dialog box (see
Figure 8-4), enter a printer name. Click Next.

7. In the resulting dialog box, click Finish to complete the
Add Printer Wizard.

If you need to print on the go, consider a portable

@ printer. These lightweight (5 pounds or less) units
don't offer the best print quality, but for quick, on
the fly printing, they can be useful. See Chapter 2 for
more about buying laptop accessories.
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Enter a name for your printer

Q (= Add Printer

Type a printer name

D T
Prnternane: | e

This printer will be installed with the Brother DCP-129C driver.

Net | [ Cancel

Figure 8-4

Set a Default Printer

1. You can set up a default printer that will be used every
time you print so that you don't have to select a printer
each time. Choose Start=>Devices and Printers.

2. In the resulting Devices and Printers window (as shown
in Figure 8-5), the current default printer is indicated by
a check mark.

3. Right-click any printer that isn’t set as the default and
choose Set as Default Printer from the shortcut menu, as
shown in Figure 8-6.

4. Click the Close button in the Devices and Printers
window to save the new settings.

To modify printing properties that are available for
your particular printer model (for example, whether

the printer prints in draft or high-quality mode, or
whether it uses color or only black and white), right-
click a printer in the Devices and Printers window
(refer to Figure 8-6) and choose Printing Preferences.

115



Part lI: Exploring Windows

This same dialog box is available from most
common Windows-based software programs, such
as Microsoft Word or Excel, by clicking the Properties

116

button in the Print dialog box.
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Figure 8-5

=
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Choose Set As Default Printer
Figure 8-6



@ If you right-click the printer that is already set as the

default, you'll find that the Set as Default Printer
command will not be available on the shortcut menu
mentioned in Step 3.

Set Printer Preferences

1.

Your printer might have capabilities, such as printing in
color or black and white, printing in draft quality (which
uses less ink), or high quality (which produces a darker,
crisper image). To modify these settings for all documents
you print, choose Start=>Devices and Printers (in the
Hardware and Sound group).

In the resulting Devices and Printers window, any
printers you have installed are listed. Right-click a printer
and then choose Printing Preferences.

In the Printing Preferences dialog box that appears (as
shown in Figure 8-7), click any of the tabs to display
various settings, such as Color. (See Figure 8-8.) Note
that different printers might display different choices and
different tabs in this dialog box, but common settings
include the following:

e Color/Grayscale: If you have a color printer, you
have the option of printing in color or not. The
grayscale option uses only black ink. When
printing a draft of a color document, you can
extend the life of your color ink cartridge (which is
more expensive to replace or refill than the black
one) by printing in grayscale.

¢ Quality: If you want, you can print in fast or draft
quality (these settings might have different names
depending on your manufacturer) to save ink, or
you can print in a higher or best quality for your
finished documents. Some printers offer a dpi
setting for quality — the higher the dpi setting, the
better the quality.

Chapter 8: Setting Up Printers and Scanners
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e Paper Source: If you have a printer with more
than one paper tray, you can select which tray to
use for printing. For example, you might have 8/
x 11 paper (letter sized) in one tray and 8'-> x 14
(legal sized) in another.

e Paper Size: Choose the size of paper or envelope
you're printing to. In many cases, this option
displays a preview that shows you which way to
insert the paper. A preview can be especially handy
if you're printing to envelopes and need help
figuring out how to insert them in your printer.

Click a tab to see different settings

= HP Deskjet F4100 serie4 Printing Preferences =

| Advanced | Pinting Shortouts | Featuwes | Color | Sevives|]

& piinting shortcut is a collection of saved print settings that
you can select with a single click

Pinting shortcuts:

General Everydap Piinting

m Phata Printing-Borderless
Paper sizes 86 = 11 inches

[Letter -

Paper type:

| mamm—
G | Photo Printingsit whits bordsrs
o )

[Piain paper -

_ Print on bath sidgs:

m Fiesentation Printing —| [on -

Print guality.

Two-sided [Duplex] Printing | e ]
omal =

Orisntation:

lFDltlall T |

Fast/Economical Printing

Save As. Delsts Reset
ra
oK Cancel Apply
Figure 8-7

4. Click the OK button to close the dialog box and save set-
tings and then click the Close button to close other open
Control Panel windows.
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Also, the settings in the Printing Preferences dialog
box might differ slightly depending on your printer
model; color printers offer different options from
black and white ones, for example.

= HP Deskjet F4100 series Printing Preferences ==
[ cvanced | Pirting Shotous | Festwes | Cobr [ senices|

Color Options

Piirt in grayscale

High qualiy

[ Show preview before printing

O]

Click OK to save settings
Figure 8-8

this task are your default settings for all printing you
do. However, when you're printing a document from
within a program, such as Works Word Processor, the
Print dialog box you display gives you the opportunity
to change the printer settings for that document only.
See Chapter 13 for information about printing a
document.

@ Whatever settings you make using the procedure in
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View Currently Installed Printers

1. Over time, you might install multiple printers; in
which case, you might want to remind yourself of the
capabilities of each or view the documents you have sent
to be printed. To view the printers you have installed and
view any documents currently in line for printing, choose
Start=>View Devices and Printers.

2. In the resulting Devices and Printers window (see Figure
8-9), a list of installed printers and fax machines appears.

If a printer has documents in its print queue, the number
of documents is listed at the bottom of the window. If
you want more detail about the documents or want to
cancel a print job, select the printer and click the See
What's Printing button at the top of the window. In the
window that appears, click a document and choose
Document=>Cancel to stop the printing, if you want.
Click the Close button to return to the Devices and
Printers window.
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The number of documents in queue to print
Figure 8-9
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3. You can right-click any printer and then choose
Properties (see Figure 8-10) to see details about it, such
as which port it’s plugged into or whether it can print
color copies.

i HP Deskjet FA100 series Properties ==

ﬁ“, HP Deskist F4100 series
=

Dewice Infarmation
Manufacturer Unavailable:

Madel HP Deskiet F4100 series

Device Tasks

To view tasks for this device, right-click the icon for the device in
Devices and Printers.

Ok Canceal

Figure 8-10

4. Click the Close button (the red X in the upper-right
corner) to close the Devices and Printers window.

Remove a Printer

1. Over time, you might upgrade to a new printer and toss
the old one (recycling it appropriately, of course). When
you do, you might want to also remove the older printer
driver from your laptop so that your Printers window
isn’t cluttered with printers that you don’t need anymore.
To remove a printer, choose Start=>Devices and Printers
(in the Hardware and Sound group).

2. In the resulting Devices and Printers window (see
Figure 8-11), right-click a printer and choose Remove
Device. (Or you can select the printer and click the
Remove Device button at the top of the window.)
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HP Deskjet FA100 series  Modek HP

Click Remove Device
Figure 8-11

3. In the Printers dialog box that appears, click Yes; the
Devices and Printers window closes, and your printer is
removed from the printer list.

installed printers, and if it was the default printer,
Windows makes another printer you have installed
the default printer. You can no longer print to it,
unless you install it again. See the task, “Install a
Printer,” if you decide you want to print to that
printer again.

@ If you remove a printer, it's removed from the list of

Install a Scanner

1. Before you can scan documents into your laptop, you
need to install the scanner driver so that your scanner
and laptop can communicate. Start by connecting the
scanner to your laptop’s USB port. (See your scanner
manual for information about how it connects to your

laptop.)
122



2.

Chapter 8: Setting Up Printers and Scanners

Turn the scanner on. Some scanners use Plug and Play, a
technology that Windows uses to recognize equipment
and automatically install and set it up.

If your scanner is Plug and Play enabled, Windows 7
shows a Found New Hardware message on the taskbar
notification area (in the lower-right corner). Most Plug
and Play devices will then automatically install, the message
changes to indicate that the installation is complete, and
that’s all you have to do.

If that doesn’t happen, either you're not using a Plug and
Play device or Windows doesn’t have the driver for that
device. So you should click the Found New Hardware
message to proceed.

In the resulting Found New Hardware Wizard (this starts
only if you don’t permit Windows 7 to automatically
connect to Windows Update), click Yes, This Time Only
and then click Next.

. If you have a CD for the scanner, insert it in your CD/

DVD drive and click Next. Windows 7 searches for your
scanner driver software and installs it.

Choose Startz>Control Panel. In the Search box, type
scanners. Windows returns a set of links. Click the
View Scanners and Cameras link. In the resulting
Scanners and Cameras window, click the Add Device
button.

In the resulting Scanners and Cameras Installation
Wizard window, click Next. In the next screen of the
wizard (see Figure 8-12), click your scanner’s manufacturer
in the list on the left and then click the model in the list
on the right.
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Select a manufacturer Then select a model
Scanner and Carhera Installation Wizard =34
‘Which scanner pr camera do you want to install?
= Select thf manufacturer and model of your device. If you have ah installation disk, click Have
SEi Disk.
T |
| Manufacturer | Model |
Lexrnark ‘ Sl Lewrnark X422
Herox
551 This driver is digitally signed. | Havedik. |
Tell rme why driver signing is important
<Back || Hess ] | Caneel
.
Figure 8-12

7. Follow the wizard directions based on the model of scanner

you chose in Step 6 and whether you have a manufacturer’s
disc (a CD- or DVD-ROM). If you don't have a disc,
Windows will help you download software from the
Internet. When you reach the end of the wizard, click
Finish to complete the installation.

Modify Scanner Settings

124

1. After you install a scanner, you might want to take a look

at or change its default settings— for example, whether
you usually want to print in color or grayscale. To do so,
choose Start=>Control Panel. Type scanners in the
Control Panel search field and press Enter.

2. In the resulting Control Panel window, click View

Scanners and Cameras.

3. In the resulting Scanners and Cameras dialog box, a list

of installed scanners appears. (See Figure 8-13.) In the
Scanners and Cameras area, click the scanner for which
you'd like to modify the settings, and then click the Scan
Profiles button.
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~% Scanners and Cameras ==

If wou do not see your device in the list, rake sure itis connected to the cormputer and tumed
on, then choose Refresh,

Scanners and Camera! 5

=

_|_HP Deskjet
Fa100

Refresh H B 4dd Device... | [ Scn Profiles | | Broperties |

DoIneed to use this to install my scanner or cameraf

Close ‘

Click a scanner  Then click Scan Profiles
Figure 8-13

4. In the resulting Profiles dialog box, select a scanner and
click Edit. In the Edit Default Profile dialog box (see Figure
8-14), review the settings, which might include (depending
on your scanner model) color management for fine-tuning
the way colors are scanned and resolution settings that con-
trol how detailed a scan is performed. (The higher the reso-
lution, the crisper and cleaner your electronic document,
but the more time it might take to scan.)

5. Click Save Profile to return to the Properties dialog box
and then click the Close button twice to close the Scan
Profiles and Scanners and Cameras windows.

When you're ready to run a scan, you place the item

@ to be scanned in your scanner. Depending on your
model, the item may be placed on a flat “bed” with a
hinged cover or fed through a tray. Check you scanner
manual for the specific procedure to initiate a scan
(for example, pressing a Scan or Start button). After
you begin the scan, your laptop automatically detects
it and displays a dialog box showing you the scan
progress and allowing you to view and save the
scanned item.
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Edit Default Profile: Photo
HP Deskjet F4100
Prafile name: B |
Setthis profile as default

Source; |Flatbed -
Calar farmat: |Co|or V‘
File type: [1p5 UPEG image) -
Resolution {DPL: 200
Brightness: (] 0
Cantrast: (] 0

Preview or scan images as separate files

Preview | Save Profile Cancel

Figure 8-14
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Getting Help

Fnough designed for ease of use, Windows is
so feature rich, you're bound to run into
something that doesn’t work the way you
expected it to, or isn't easy to figure out. If you
can’t find your answer in this book, that's
when you need to call on the resources that
Microsoft provides to help you out.

Through the Help and Support Center, you can
get assistance in various ways, including the
following:

m= Access information that’s stored in the
Help system database. Logically enough,
a database contains data; in this case, it
contains information about Windows 7,
organized by topics such as Printers or
Using Your Mouse. Drill down from one
topic to another or use a powerful search
mechanism to search by keywords such
as e-mail. There’s even a troubleshooting
feature that helps you pin down your
problem.

w= Get help from your fellow Windows
users. Tap into information exchanged
by users in Windows communities (sort
of like the community bulletin board in
your local community center) or by using
a little feature called Remote Assistance,
which allows you to let another user take
over your laptop from a distance (via the
Internet) and figure out your problem
for you.

| “*ap’rer

Getready to. ..
w= Explore the Help Table of

Contents .....coevveeeieeinnnn... 128
w= Search for Help ................ 130
w= Post a Question in Windows

Communities......coeveeveunnn... 132

wa» Access Windows Online

Help ..o, 135
w= Connect to Remote
Assistance .......cooveeveeeen.... 137

w=» Change Windows Help and
Support Display Options.... 139

w= Contact Microsoft Customer
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w= Open your wallet and pay for it. Microsoft offers
some help for free (for example, help for installing
its software that you paid good money for), but
some help comes for a price. When you can’t find
help anywhere else, you might want to consider fork-
ing over a few hard-earned bucks for this option.

Explore the Help Table of Contents

1. Your first stop in searching for help is likely to be the
built-in help database. (It’s also the only help feature that
doesn’t require an Internet connection.) One of the
simplest ways to find what you need here is to use the
Table of Contents, which is similar to a book’s Table of
Contents. Choose Start=>Help and Support to open
Windows Help and Support, as shown in Figure 9-1.
Note: If your copy of Windows came built into your
laptop, some computer manufacturers (such as Hewlett-
Packard) customize this center to add information that'’s
specific to your laptop system.

Click this link
[@ |Windows Help and Support I o & =]
(] &) /i“ - il g% Ask Options ~

[|search Help pel

Pex Find an answer quickly

Enter a few words in the search box above.

= How to get started with your computer

= |earn about Windows Basics

b » Browse Help topics

w~  Check out the new Windows website, which will soon have more information, downloads, and ideas for getting the most out of your Windows 7 PC.

s

Figure 9-1
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2. Click the Browse Help Topics link to display a list of
topics. Click any of the topics to see a list of subtopics.
Eventually, you get down to the deepest level of detailed
subtopics, as shown in Figure 9-2.

@ Windows Help and Support [ TR
G v B = W 3 ask gptions ~

[ search Help Al

Can I protect files or folders with a password?

[This content is preliminary and subject to change.]

Mo, you can't use a password to protect files and folders in Windows. However, some programs that run on Windows allow you to protect individual files with a password. For more
information, check the Help for the program you're using.

There are other ways to protect your files and folders in Windows. You can encrypt your files using Encrypting File System (EFS), manually specify who can access the folders or files by
setting permissions, or hide them. Choose your method based on how secure the folders or files need to be. Encrypting is the most secure, while hiding the folders is the least secure.

For more informatian about EFS, see What is Encrypting File System (EFS)? For more information about permissions, see What are permissions?

Was this helpful?

‘ Yes ” No “ Somewhat

Read the privacy statement online

Figure 9-2

3. Click a subtopic to read its contents. Some subtopics
contain blue links that lead to related topics or perform
an action such as opening a dialog box. Green links display
a definition or explanation of a term when clicked.

4. When you finish reading a help topic, click the Close
button to close the Windows Help and Support window.

You can click the Print icon in the set of tools at the
top-right corner of the Windows Help and Support
window to print any displayed topic, if you have a
printer connected to your laptop. You can also click
the Minimize button in the title bar to minimize the
window and keep it available while you work on
your laptop.

Windows will automatically get the most up-to-date
help information if you are connected to the Internet
when you open Help and Support. See Chapter 18
for help with connecting to the Internet.
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Search for Help

1. If you don't find what you need by using the Table of
Contents (for instance, say you wanted help using your
mouse but didn’t realize that’s listed under the topic
Getting Started), you might want to use the help search
feature to find what you need by entering keywords such
as mouse or input. Start by opening the Windows Help
and Support window.

2. Enter a search term in the Search Help box and then click
the Search Help button. Search results, such as those
shown in Figure 9-3, appear. Windows will search online
help by default, if you are connected to the Internet. If
you wish to use only offline help, click the Online Help
link in the bottom-right corner and choose Get Offline
Help.

3. Explore topics by clicking various links in the search
results. These links offer a few different types of help:

e Procedures, such as “Make the mouse easier to use.”

¢ Troubleshooting help items are phrased as
statements, such as “I can’t hear any text read
aloud with Narrator.” Clicking one of these takes
you to a troubleshooter wizard.

e Some items provide general information rather
than procedures, such as “Tips for searching the
Internet.” (See Figure 9-4.)

4. 1f you have no luck, enter a different search term in the
Search Help text box and start again.
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If you don’t find what you need with Search,
consider clicking the Browse Help button in the
top-right corner of the Windows Help and Support
window (it sports a little blue icon in the shape of a
book) to display a list of major topics. Those topics
may also give you some ideas for good search terms
to continue your search.

Enter a search term here

[ Windows Help and Support i (= |2 )
@ @) ”B\ _,g,’ w 9‘% Ask Options
Mouse P

-

24 results for Mouse —_—
1. Make the mouse easier to use
2. Usethe compuiter without the mouse or keybaard (alternative input ..
3 Make items on the screen appear bigger (Magnifier)
4. Make the keyboard easier to use
5. Keyboard shortcuts
6.  Type without using the keyboard {On-5creen Keyboard)
7. Make your computer easier to use
8. How canl select text and move around a2 webpage with my keyboard? =
9. Create keyboard shortcuts to open programs
10. Zoomin on a webpage |
11.  Add-on (definition)
12, Operating system (definition)
13.  Use Speech Recognition to click anywhere on the screen
14, Use Speech Recognition to browse the Internet
15.  Make the computer easier to see (optimize visual display)
16.  Spyware: frequently asked questions
17.  Using Accelerators to find addresses, define words, and do other tasks ...
18.  Driver (definition)
19.  Keyboard shortcut {definition)
20, Tips for searching the Internet o
Qg More support options
& Online Help =

View the search results here

Figure 9-3
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[@ Windows Help and Support I (o (e =S
o 3 =/ W B as options ~
Mouse 2|

Tips for searching the Internet |

[This content is preliminary and subject to change.] In this article

The Internet contains a vast collection of information, but finding what you are looking for can be a challenge. Here are a few tips to help you & Usephisearch bow

search the web mare effectively. # Usethe Address bar

Use more than one
Use the search box search provider

In the Internet Explarer search box, type a keyword or phrase and then press Enter (or press Alt+Enter to display the search results in a new Search more efficiently

tab).

Find words or phrases on
a page

m

K2 Live Search o -
Internet Explorer search box
Tip
® Press Ctrl+E to go to the search box without using the mouse.

Use the Address bar

In the Internet Explorer Address bar, type Find, Go, or ? followed by a keyword, website name, or phrase, and then press Enter. If you want the search results to display in a new tab, press
Alt+Enter after typing the phrase.

Use more than one search provider

¥ you do not find what you're looking for with a particular search provider, you can search using a different one. The Internet Explorer search box lets you add additional search providers
and switch between them to improve your search results. You can quickly change which search provider to use on a search by clicking the provider's icon below the search box.

To learn how to use different search providers, install new search providers, or change the search provider that Internet Explorer uses by default, see Change or choose a search provider in
Internet Explorer,

Search more efficiently

Here are a few ideas for improving the results of searches. When searching using the address bar, first type find, go, or 2.:

& Use specific words rather than generic categories. For example, instead of searching for dogs, search for a specific breed of dog.

& Use quotation marks to search for specific phrases. Surrounding terms with quotation marks limits the search results to only those webpages that contain the exact phrase you've
specified. Without the quotation marks, the results will include any page that contains the words vou've used, regardless of what order those words are in.
53, More support options

& Online Help +

Figure 9-4

Post a Question in Windows Communities

1. If you want to see how other Windows users have solved
a problem, you can visit Windows communities on the
Internet, read posted messages, or even post one yourself
and see if others can help you out. Open the Windows
Help and Support window. Click the Ask button in the
top-right corner.

2. In the Ask a Person for Help section of the page, click the
Microsoft Answers link.

3. In the Microsoft Answers page that opens in your
browser, click the topic on the left that relates to your
problem or question. (See Figure 9-5.)
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Browse top answers,

):;‘ Hame

'l._, Appearance and Personalization

#y  Gaming

a# Hardware and Drivers

B 1mprove Perfarmance

< % Install, Upgrade, and Activate
—] &2 Internst Explorer

Jiy  Proarams

f Security and Privacy

N sound and Media

“:-- Wireless and Metworking

_"1 windows Update

,,.‘:,,: Fetting Ready for Windows 7

Manage Your Profile

Getting Ready for Windows 7
g Top Answers in the Forum B

Getting Ready for Windows 7 Forum
Uninstalling Windows 7 RC

what happened to Windows Mail? [ can't
find it in Windows 7277

will Photo Gallery and Movie Maker be
included in windows 77

wWindows 7 looks cool, should I install the
Release Candidate?

What's the best way to back up my PC?

will the Win7 bets autormnatically update to
the Release Candidate?

How long can I use the Windows 7 beta?

what does "clean installation” of the RC
mean?

Does testing Windows 7 get you a free
copy of the real thing?

Qf See all Answered Questions

) Go to the Forum

2009 Microsoft Corporation. All rights reserved. Terms of Use | Trademarks | Privacy Statement

:1 Top Microsoft Resources
b 7 IT Pro ar technical expert? Check out the
Windows 7 Springboard Series
Cion't lose your datal Get tips for backing up
your PC

See what's new in Windows 7

More...

Get Help Now
(jj Contact support by E-mail, Online, or Phone
Find Compatible Devices & Applications
Wisit the Windows Wista Compatibility Center

Help us Improve

m

Give feedback

Figure 9-5

4. Click the Go to the Forum button, which displays a page
with discussion summaries and the number of discussion
messages in each. (See Figure 9-6.)

5. Click the discussion title to display the threads (series of
related postings) contained in it.

6. Click a thread title to open it. Scroll through the original
posting and replies to it. If you'd like to add your own
question or comment, follow these instructions:

e Post a new message. To post a message, you have
to sign into Microsoft TechNet using a Windows
Live ID (which you can get for free by going to
www . windowslive.com).

When you have your Windows Live ID, go back to
the Forum and select the discussion group to par-
ticipate in. Then click the Ask a Question button.

If you have never participated in a discussion, you
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will be asked to create a profile. Enter a display

name and click the Accept button.

In the Start a New Question or Discussion form,
enter the title and message body in their respective
text boxes. Add any descriptive tags or categories,
and then click Submit to post your question.

windows Wista = Forums Home = windows Wista Forums = Gaming

@ Ask a question Search Forums: |Segrch

Gaming®

Install, troubleshaoot, set parental cantrals

(P4l Threads = g Mo Replies ' Helpful

1234 56|78 9 10 .. 49 50| == (Showing 1to 20 of 982)

@ - Mechwarrior 4 Yengeance

wilwlvr Wednesday, August 5, 2009 2:57 AM

Last Reply Diana - PSS MSFT Thursday, August 06, 2009 10:27 Pi
42\ = Undo Password Parental Controls Option

laila beaudain Friday, dpril OF, 2002 6127 BM

Last Reply KannanSampathkumar Mondsy, August 03, 2009 10:15 AM
2 - video games graphics glitching

Dan77097 Mondsy, June 08, 2009 3:57 AM

Last Reply Gab 1 Saturday, Avgust 01, 2009 3:01 &M
E’) - Zoo Tycoon 2 and Windows Yista Compatability issues

sE nUss Twesday, July 21, 20039 5:47 AM

Filtering and Sorting Use these options to narrow down the question and discussion list,

United States (English}= | Microsoft.com | Signin

R Web |

Need Help with Forums?
(FAQ)

My Forum Links

Sign In To Forums
Farums Home
Browse Forums Users

Popular Threads

Fable: The Lost chapters not
@ Sort By installing...
WEER CAMERA DID NOT
REINSTALL AFTER FACTORY
Replies Wiews REBOCT

Flight Sirmulator ¥ Errar 1305
&l 1ch

“+ 9 en i try to

Wideo games graphics glitching
7 9965

Recent Visitors
g 3153 Maveen K - Microsoft

Support
Pj Syed V - Microsoft
Support
z 132
Q TOMLOC

m

Figure 9-6

¢ Reply to a message in a discussion. With the list
of postings and replies displayed, click the Reply
button, fill in the message, and then click Post.

You can also use the Search feature to search for key-
words or phrases in discussions. Enter a word or
phrase in the Search Forums text box, select where to
search in the Search Forum drop-down list, and then
click Go. Relevant messages are displayed; click one

to read it.
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If you have a question specific to the workings of
your particular laptop model, consider visiting your
manufacturer’s site. They usually post helpful infor-
mation by model, including an online version of
your user manual.

Access Windows Online Help

1. Enter http://windows.microsoft.com/en-us/windows7/
help in your browser address line and click the Go
button.

2. On the Windows 7 Help & How-To page (see Figure
9-7), use the links in the following sections to get help:

e Getting Started: Includes topics such as installing
Windows or hardware and personalizing your PC.
(See Figure 9-8.)

e Top Solutions: Takes you to the most-viewed
troubleshooting topics that help you work with
Windows features and settings.

e More to Explore: Offers information on upgrading
to Windows 7, a link to community forums, and
how-to videos.

3. Click the Close button to close the online help window
in your browser, and then click the Close button to close
Windows Help and Support.

To set up Help and Support to always include
Windows Online Help and Support when you search
for help, click the Options button and choose
Settings. Be sure the check box labeled Improve My
Search Results by Using Online Help (Recommended)
is selected, and click OK to accept the change.
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Use these sections to get help

United States Change | All Microsoft Sites

£7 Windows

Home  Discover Windows  Products

¥Windows 7 Help home

Windows 7 Help &

Getting started

How-to

oing (2]
Shop  Downloady  Help & How-to
Top solutions  How-to fideos Community & forums  Contact support

I Getting started

Find out how to get up and running with
Windows 7,

Top Solutions

Browse the most-viewed troubleshoating
articles,

More to explare

"]

Installing Windows Upgrading from Windows XP to Windows 7
Installing new harcware

Security checklist

Upgrading from Windows Vista to
Windows 7

what do I do if my Windows product key
isn't valid?

Transfer files and zettings from another i PSR R R
computer
Wisia.. Get help with compatibility problems

More...

Lt How-to videos
Get the most out of Windows T by
watching our how-te videos,

& Windows Community

Check out Windows community
forums, blog posts, colurnns, and
articles.

Contact Support

Get in touch with a technical support
professional by e-rail, chat, or phone,

o n

m

Figure 9-7

United States Change | All Microsoft Sites

£7 Windows

Search this website

oing [

Home  Discover Windows  Products  Shop  Downloads

Windows 7 Help home  Getting started  Top solutions  How-to wideos

Personalizing your computer

You can add a personal touch to your computer by changing the computer's theme,
color, sounds, desktop background, screen saver, font size, and user account picture, You
can also select specific gadgets for your desktop.

Themes

Atherne indudes a desktop background, 2 screen saver, a window border color, sounds,
and sometirmes icons and mouse pointers, You can choose from several Aero thermes,
Use the whole therme or create your own customized theme by changing the pictures,
colors, and sounds individually. ¥ou can also find more themes online at the Windows
wehsite, For more information, see What is a therme?

Campanents af a theme

+ Top of page

Aorn

Help & How-to

Community & forums

Contact support

Applies to these editions of Windows 7:

Home Premium
Professional
Ultimate
Enterprise

@ Compare editions

In this topic
= Themes
= Aero
= Sounds
= Desltop background
= Screen saver

= Font size

T

Figure 9-8
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Connect to Remote Assistance

3.

4.

5.

6.

Remote Assistance can be a wonderful feature for new laptop users
because it allows you to permit somebody else to view or take control
of your laptop from her own computer, no matter where she is. You
can contact that person by phone or e-mail, for example, and ask for
help. Then, you send an invitation using Windows 7 Help. When that
person accepts the invitation, you can give her permission to access
your system. Be aware that by doing so you give the person access to
all your files, so be sure this is somebody you trust. When that person
is connected, she can either advise you on your problem or actually
make changes to your laptop to fix the problem for you. To use
Remote Assistance, you and the other person first have to have
Windows and an Internet connection. Then, follow these instructions:

Enable Remote Assistance by choosing Start=>Control
Panel=>System and Security=>Allow Remote Access.

. On the Remote tab of the System Properties dialog box

that is displayed, select the Allow Remote Assistance
Connections to This Computer check box, and then
click OK.

Open the Windows Help and Support window by selecting
Start=>Help and Support.

Click the Ask button, and then click the Windows
Remote Assistance link.

In the window that appears, as shown in Figure 9-9, click
the Invite Someone You Trust to Help You link. If you
have Windows Firewall or a third-party firewall active,
you may have to disable that feature to allow remote
access to your laptop.

On the page that appears, you can choose to use your
e-mail to invite somebody to help you. You have two
options:
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e Click the Save This Invitation as a File option and
follow the instructions to save it as a file; then you
can attach it to a message using your Web-based
e-mail program.

e (Click the Use E-mail to Send an Invitation option
to use a pre-configured e-mail program to send an
e-mail. (See Figure 9-10.) Enter an address and
additional message content, if you like, and send
the e-mail.

Click to invite a helper

1 Windows Remote Assistance

Do you want to ask for orfoffer help?

Windows Remote Assistance conffects two computers so that one person can help troublesheot or fix
problems on the other person's cfmputer.

| al Invite someone you trust to help you
Vour helper can view your screen and share control of your computer.

Help someone who has invited you
Respond to a request for assistance from anather persan,

Read our privacy statement online

Cancel

Figure 9-9

7. In the Windows Remote Assistance window, as shown in
Figure 9-11, note the provided password. When an incom-
ing connection is made, use the tools there to adjust set-
tings, chat, send a file, or pause, cancel, or stop sharing.

8. When you're finished, click the Close button to close the
Windows Remote Assistance window.

Setting a time limit to not more than a few hours is a
good idea. After all, you don’t want somebody trying
to log on to your laptop unexpectedly two weeks
from now when you've already solved the problem
some other way. You can make these timing settings
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in the Remote Assistance settings in the System
Properties dialog box. (Choose choosing
Start=>Control Panel=>System and Security=>Allow
Remote Access to bring up that dialog box.)

Figure 9-10

£~ Windows Remote Assistance bl (=[5 ES
Chat Settings |:& Troubleshoot h Help

Tell your helper the connection password
PANLMRYWBGX6

-@-"."."aiting for incoming connection...

Figure 9-11

the password — it isn’t included in your e-mail unless
you add it. Although using a password used to be
optional in Windows XP, it's mandatory in Windows 7.

@ Remember that it’s up to you to let the recipient know

Change Windows Help and Support Display Options

1. If you're having trouble reading help topics, get some
help with modifying text size. Open the Windows Help
and Support window.
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2. Choose OptionstoText Size and then choose one of the
text size options: Largest, Larger, Medium (the default),
Smaller, or Smallest. (See Figure 9-12.)

e | || B )

T:h ] i| ‘E.-:i Ask |Options «

Print...

Browse Help
Largest Text Size 4
Larger Find (on this page]...

@  Medium
Smaller
Smallest J
Select a text size option

Figure 9-12

Settings...

3. Your new settings take effect immediately; click the Close
button or navigate to another area of the Windows Help
and Support window.

screen, you can change them by choosing a different
color scheme in the Control Panel, Appearance and
Personalization settings.

@ If you don't like the colors in your Help and Support

Don’t forget that you can reduce the size of the Help

@ and Support window by clicking the Restore Down
button in the upper-right corner of the window. This
is especially useful with the Help window. You can
display it side by side with an application or Control
Panel window where you're trying to troubleshoot
the described help topic.

Contact Microsoft Customer Support

140

1. Go to the Windows Help and Support window and click
the Ask button in the upper-right corner. On the page
that appears, as shown in Figure 9-13, click the Microsoft
Customer Support link to open the Customer Support
Web site in your default browser.
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Click this link

[@ Windows Help and Support [T T IERERExE
@ ) ’:!“ % il g% Ask Options ~

[ Mouse P|

More support options
[This content is preliminary and subject to change.]

If you can't find an answer to your question in Help, try these additional support options,

Ask a person for help
& Getafriend to help you over the Internet
1 you have computer-savvy friends, you can use % Windows Remote Assistance to enable them to help you fix your problem remotely over the Internet.
e hsk a volunteer expert anline

There are thousands of volunteers online who can help you answer a question, Ask a question or search for an answer online in Windows communities,

bt o Contact technical support

Go online to contact your computer manufacturer or Microsoft Customer Support for technical assistance. Microsoft support is also available by e-mail, chat, or phone.

Search other resources

* Get more on the Windows website
The new Windows website will have more how-to articles, videos, free downloads, and inspiring ideas for getting the most out of your Windows 7 PC,
# Find info for IT professionals

If you're an IT professional, go to the Microsoft TechMet website to find in-depth technical information.

Figure 9-13

2. In the Microsoft Help and Support window that
appears, click a product to see what support options and
information are offered. (See Figure 9-14.)

3. Click various links for help topics. If you need help
solving problems, click a Solution Center link along the
left side of the product window.

4. Click Support Option links along the bottom left to
contact Microsoft or search for online help topics.

5. Use the Top Issues or Latest News links to find out what
problems others are experiencing and how they've solved
them, or New from Microsoft for details about how to fix
problems or download updates.

6. Click the Close button to close the Internet Explorer
browser.

Typically, you can contact Microsoft support for two
free help sessions or unlimited installation support.
You can submit a request via e-mail or call 1-800-
936-3500. There is the option of Premier Third Tier
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Support, but this is for what Microsoft refers to as
non-mission critical issues. This program is geared
towards corporations, and it gives customers access
to Microsoft experts to solve your problems. If
Windows 7 came preinstalled on your laptop, you
may be able to contact your manufacturer for sup-
port questions.

Top Solution Centers
2007 Office Suites

Internet Explorer
| Microsoft Update
| Office 2003
Outlook 2007
Ernail
Microsaft Fix it
Product Activation
windows Wista
windows ©pP

More Solution Centers

Support Options
Self Support Options

Downloads & Updates
Microsoft Services

Contact Microsoft

>

>

>

Top Issues

Identify, locate, or replace a product key
Get help with error messages
Microsoft Fix it Solution Center

& folder that is created under the root of the
systerm drive is missing entries in its security
descriptar, which may cause some
application failures on the English version of
windows 7 Release Candidate 32-bit Ultimate

Diescription of test update 1 for Windows 7
and Windows Server 2008 R2Z Beta and
Release Candidate builds

Error message when you use applications
that are based on legacy Transport Driver
Interface (TOI) filker drivers on a computer
thatis running Windows 7 Beta or Windows
Server 2008 R2; "STOP 0x00000001

An update is available for Windows Media

Center and Windows Media Player in
windows 7 Beta

Solution Centers

United States Cl

Latest news
July 28: Critical security patch for
Internet Explorer
windows 7 RTM: Learn maore

Wwhat to Expect: Windows Server
2008 R2Z RTM

Download Wista Service Pack 2

Obtain the Microsoft Security
Updates for July

Office 2007 Service Pack 2 is

available

Microsoft Money Plus will not be
available for purchase after June
30, 2009

Get Help Now

Contact 3 Support
! | Professional by Email.
Lo/  online, or Phone.

Page Tools
Print this page
E-rnail this pags

Figure 9-14

To find out about specific support options in your
country, click the Understand Your Support Options
link on the Help and Support home page. Click
Support Options on the page that appears, then
select your country and press Enter. Use the product
finder feature to drill down to the specific help avail-
able to you.
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Working with
Software
Programs

Wndows 7 is first and foremost an
operating system whose main purpose
is to enable you to run and manage other
software programs. Using tools in Windows,
you can run and work with programs that do
anything from helping you to manage your
finances to play a great game of solitaire. By
using the best methods for accessing and
running programs with Windows 7, you save
time; setting up Windows 7 in the way that
works best for you can make your life easier.

In this chapter, you explore several simple and
very handy techniques for launching and

moving information between applications. You

go through step-by-step procedures ranging
from setting program defaults to removing
programs when you no longer need them.

| “*opter

Getready to. ..

w= Launch a Program............. 146
w= Move Information between
Programs .........cccccceveennes, 148
w= Start a Program
Automatically ................... 151
w= Set Program Defaults.......... 153
w= Remove a Program............ 154
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Launch a Program

1. Launch a program by using any of the following four methods:

146

¢ Choose Start=>All Programs. Locate the program name

on the All Programs list that appears and click it.

Clicking an item with a folder icon displays a list of
programs within it; just click the program on that sub-
list to open it (as shown in Figure 10-1).

Double-click a program shortcut icon on the
desktop. (See Figure 10-2.)

Click an item on the taskbar. The taskbar should dis-
play by default; if it doesn’t, press the Windows logo
key (on your keyboard) to display it, and then click
an icon on the taskbar (as shown in Figure 10-2), just
to the right of the Start button. See Chapter 5 for
more about working with the taskbar.

If you used the program recently and saved a
document, choose it from the list of recently used pro-
grams displayed when you first open the

Start menu. Then click a document created in

that program from the list that displays. (See

Chapter 11 for information about displaying recently
used files on the Start menu.)
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2. When the application opens, if it's a game, play it; if it's a
spreadsheet, enter numbers into it; if it's your e-mail
program, start deleting junk mail. . . . You get the idea.

Not every program that’s installed on your laptop
appears as a desktop shortcut or taskbar icon. To add
a program to the taskbar or add a desktop shortcut,
see Chapter 5.

. Administrative Tools
. ASUS Utility

. Axara

. Camtasia Studic 6

, Crawler Toolbar

J CyberLink DVD Suite
. Extras and Upgrades

Owner

Documents

. Games

. HP

, iTunes

. LightScribe Direct Disc Labeling

. Maintenance

Pictures
Music

Games
, Microsoft Mouse
. Microsoft Office Favorites
"o Activation Assistant for Microsoft O
= Microsoft Office Access 2007 Computer
[ Microsoft Office Excel 2007
[ Microsoft Office Outlook 2007 Control Panel
(& Microsoft Office PowerPaint 2007
[ Microsoft Office Publisher 2007 Devices and Printers
[ Microsoft Office Word 2007

. Microsoft Office Tools Helpand Suppart

1 Back

| |Search programs and files P | | Shut Down

Click an item to launch it
or click a folder to see its sublist

Figure 10-1
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Double-lick a program’s shortcut icon to launch it...

Wednesday

4

March 2009

=

=
il s

alalate Wesials

ﬁ'fa S 3 ¥ 9

|
Or click an icon on the Taskbar
Figure 10-2

Move Information between Programs

1. Open documents in two programs. (See the next task for
more about opening applications.) Right-click the taskbar
on the Windows desktop and choose Show Windows
Side by Side. (See Figure 10-3.)

2. If you don't need one of the active programs displayed,
click the Minimize button in that program so that just
the programs you're working with appear.
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3. Select the information that you want to move (for example
text, numbers, or a graphical object in a document)
and drag it to the other application document. (See
Figure 10-4.)

4. Release your mouse, and the information is copied to the
document in the destination window.

You can also use simple cut-and-paste or copy-and-
paste operations to take information from one appli-
cation and move it or place a copy of it into a
document in another application. To do this, first
click and drag over the information in a document,
and then press Ctrl+X to cut or Ctrl+C to copy the
item. Click in the destination document where you
want to place the item and press Ctrl+V.
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Figure 10-4

In addition, some applications have Export or Send
To commands to send the contents of a document to
another application. For example, Microsoft Word
has a Send Tor>Microsoft Office PowerPoint com-
mand to quickly send a Word document to be the
basis of a PowerPoint presentation outline.

Remember, this won't work between every type of
program. For example, you can't click and drag an
open picture from Paint into the Windows Calendar.
But it will most dependably work when dragging text
or objects from one Office 2010 or other standard
word processing, presentation, database, or spread-
sheet program to another.
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Start a Program Automatically

1. If you use a program often, you might want to set it
to start every time you start your laptop. Click Start=>
All Programs.

2. Right-click the Startup folder and click Open. (See
Figure 10-5.)

Camtasia 5tudic @
Crawler Toclbar 5,
CyberLink DVD Suite ==

Extras and Upgrades
Games Owner
HP
iTunes
LightScribe Direct Disc Labeling
Maintenance
Microsoft Mouse

Microsoft Of

Documents

Pictures

Expand

Mozilla Firefi

Mozilla Thur ~ OPE

Morton Inter Open All Users

QuickTime Explore

Real Explore All Users

Second Life

SlideWhere Delete

Snaglt 9 Renarne

Spyware Terl S— Devices and Printers
Startup

Windows Live (ki vt Suppoet

1 Back

| Search programs and files

;igure 10-5

3. Right-click Start and choose Open Windows Explorer. In
the window that appears, locate and open the folder
where the program you want to start when you start
Windows is located. Click to select it.

4. Drag the item to the Startup window that you opened in
Step 2. The program appears in the Startup folder. (See
Figure 10-6.)
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Figure 10-6

Moving the item to the Startup window

5. When you finish moving programs into the Startup
folder, click the Close button in the upper-right corner of
both windows. The programs you moved will now open

every time you start Windows 7.

If you place too many programs in Startup, it might
take a minute or two before you can get it to work
because you have to wait for programs to load. Don't
overfill your Startup folder: Use it just for the pro-

grams you need most often.

You can remove an application from Startup folder
by right-clicking it and choosing Delete.
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Set Program Defaults

1. To make working with files easier, you may want to
control which programs are used to open files of
different types. Choose Start=>Control Panel=>Programs.

2. In the resulting Programs window, as shown in
Figure 10-7, click the Set Your Default Programs link
in the Default Programs section to see specifics about
the programs that are set as defaults.

il (o)==
. =/l » ControlPanel » Programs » - |+ Search Control Panel 2|
v 9! +

File Edit View Tools Help

Control Panel Home

Programs and Features
System and Security 4 Uninstall  program | B Turn Windows features on or off
% ' 2 S o
ek st bt View ms.talled updates | Use an older program with this version of Windows
How to install a program
Hardware and Sound
Programs (@ Default Programs
“ Change default settings for media or devices

User Accounts and Family
Make a file type always open in a specific program | Set your default programs

Safety
Appearance and
Personalization

J Desktop Gadgets
Add gadgets to the desktop | Get more gadgets online | | Uninstall a gadget
Restore desktop gadgets installed with Windows

Click this link
Figure 10-7

3. In the resulting Set Default Programs window, click a
program in the list on the left (see Figure 10-8) and then
click the Set This Program as Default option. You can
also click Choose Defaults for this Program and select
specific file types (such as the . jpeg graphics file format
or .docx Word 2007 and 2010 file format) to open in
this program; click Save after you've made these selections

4. Click OK to save your settings.
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Figure 10-8

You can also choose which devices to use by default
to play media such as movies or audio files. Click the
Change Default Settings for Media or Devices link in
the Programs window you opened in Step 1.

Remove a Program

1. If you don't need a program, removing it might help
your laptop’s performance, which can get bogged down
when your hard drive is too cluttered. Choose
Start=>Control Panel=>Uninstall a Program (under the
Programs and Features category).

2. In the resulting Uninstall or Change a Program window,
as shown in Figure 10-9, click a program and then click
the Uninstall (or sometimes this is labeled Uninstall/
Change) button that appears. Although some programs
will display their own uninstall screen, in most cases, a
confirmation dialog box appears. (See Figure 10-10.)
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Warning: If you click the Change or Uninstall
button, some programs will simply be removed with
no further input from you. Be really sure that you
don't need a program before you remove it, or that
you have the original software on disc so you can
reinstall it should you need it again.
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Figure 10-10

3. If you're sure that you want to remove the program, click
Yes in the confirmation dialog box. A dialog box shows
the progress of the procedure; it disappears when the
program has been removed.

4. Click the Close button to close the Uninstall or Change a

Program window.
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With some programs that include multiple applica-
tions, such as Microsoft Office, you get both an
Uninstall and a Change option in Step 2. That's
because you might want to remove only one pro-
gram, not the whole shooting match. For example,
you might decide that you have no earthly use for
Access but can’t let a day go by without using Excel
and Word — so why not free up some hard drive
space and send Access packing? If you want to mod-
ify a program in this way, click the Change button in
Step 2 of this task rather than the Uninstall button.
The dialog box that appears allows you to select the
programs that you want to install or uninstall, or it
might open the original installation screen from your
software program.

When you buy your laptop, you may be offered a
service to clean out all the preinstalled programs your
manufacturer added. This can help your laptop’s
performance. If you feel capable of uninstalling
programs yourself, skip paying the fee for this service.
If you can’t, consider paying for it — though it’s
undeniably irritating to have to pay to remove things
that you never asked for that make your laptop
perform more slowly!



Working with
Files and Folders

If you worked in an office before computers
came along, you remember the metal filing cab-
inets and manila file folders holding paper rather
than the sleek computer workstations and boxes
of DVDs we use today to store our documents.

With a computer, you still organize the work
you do every day in files and folders, but
today, the metal and cardboard have been
dropped in favor of electronic bits and bytes.
Files are the individual documents that you
save from within applications, such as Word
and Excel, and you use folders and subfolders
to organize several files into groups or catego-
ries, such as by project or by year.

In this chapter, you find out how to organize
and work with files and folders, including:

w= Finding your way around files and
folders: This includes tasks such as
locating and opening files and folders.

w= Manipulating files and folders: These
tasks cover moving, renaming, deleting,
and printing a file.

w= Squeezing a file’s contents: This
involves creating a compressed folder to
reduce a large file to a more manageable
creature.
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w= Backing up files and folders: To avoid losing valuable
data, you should know how to make backup copies of
your files and folders on a recordable CD/DVD or flash
drive (a small stick-shaped storage device that slots right
into a USB port on your laptop).

Understand How Windows Organizes Data
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When you work in a software program, such as a word processor, you
save your document as a file. Files can be saved to your laptop hard
drive, removable storage media such as USB flash drives (which are
about the size of a package of gum), or to recordable CDs or DVDs
(small, flat discs you insert into a disc drive on your laptop).

You can organize files by placing them in folders. The Windows
operating system helps you to organize files and folders in the
following ways:

w= Take advantage of predefined folders. Windows
sets up some folders for you. For example, the first
time you start Windows 7, you find folders for
Documents, Pictures, Videos, and Music already set
up on your laptop. You can see them listed in
Windows Explorer (right-click the Start menu button
and choose Open Windows Explorer), as shown in
Figure 11-1. (See Chapter 5 for a more detailed
explanation of Explorer.)

The Documents folder is a good place to store letters,
presentations for your community group, household
budgets, and so on. The Pictures folder is where you
store picture files, which you may transfer from a
digital camera or scanner, receive in an e-mail mes-
sage from a friend or family member, or download
from the Internet. Similarly, the Videos folder is a
good place to put files from your camcorder, and the
Music folder is where you place tunes you download
or transfer from a music player.
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Predefined folders help organize files
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Figure 11-1

m= Create your own folders. You can create any num-

2

ber of folders and give them a name that identifies
the types of files you'll store there. For example, you
might create a folder called Digital Scrapbook if you
use your laptop to create scrapbooks, or a folder
called Taxes where you save e-mailed receipts for pur-
chases and electronic tax-filing information. The task
“Create a Shortcut to a File or Folder” later in this
chapter explains how to create a shortcut to a folder.

Place folders within folders to further organize
files. A folder you place within another folder is
called a subfolder. For example, in your Documents
folder, you might have a subfolder called Holiday
Card List that contains your yearly holiday newsletter
and address lists. In my Pictures folder, I organize
the picture files by creating subfolders that begin
with the year and then a description of the event or
subject, such as Home Garden Project, 2010 Christmas,
2009 San Francisco Trip, Family Reunion, Pet Photos,
and so on. In Figure 11-2, you can see subfolders
and files stored within the Pictures folder.
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b& Homegroup
1™ Computer
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Figure 11-2

w= Move files and folders from one place to another.
Being able to move files and folders helps you if you
decide it’s time to reorganize information on your
laptop. For example, when you start using your
laptop, you might save all your documents to your
Documents folder. That's okay for a while, but in
time, you might have dozens of documents saved in
that one folder. To make your files easier to locate,
you can create subfolders by topic and move files
into them.

Access Recently Used Files

1. If you worked on a file recently, Windows offers a
shortcut to finding and opening it to work on again.
Open the Start menu and right-click any blank area.
From the resulting shortcut menu, choose Properties.

2. In the Taskbar and Start Menu Properties dialog box that
appears, click the Start Menu tab (if that tab isn’t already
displayed).
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3. Make sure that the Store and Display Recently Opened
Items in the Start Menu and the Taskbar check box is
selected (see Figure 11-3) and then click OK.

L Taskbar and Start Menu Properties vl e (3]

| Taskbar | StartMenu | Toolbars |

To customize how links, icons, and menus look and Customize. ..

behave in the Start menu, dick Customize.

Power button action: | Shut Down ¥, |

Privacy
[¥] Store and display recently opened programs in the Start menu

/| Store and display recently opened items in the Start menu and the
taskbar

Make sure this option is selected

How do I change the way the Start menu looks?

l OK ] l Cancel Apply

Figure 11-3

4. Open the Start menu and hover your mouse over any
recently opened program listed on the left side that has
an arrow and a submenu of recently opened items
appears to the right. Choose a file from the submenu
(see Figure 11-4) to open it.

@ Spyware Terminator fecent

=] Document

Sticky Motes ¥ |=] 000_0150

-
a Snaglt 9
7:‘ WordPad 3

:# Computer Management

Click a file to open it

—
~+f Calculator

Figure 11-4
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Recently opened programs should be displayed in
the Start menu by default, but if they aren’t, follow
directions in Step 1 to open the Taskbar and Start
Menu Properties dialog box and make sure that the
Store and Display Recently Opened Programs in the
Start Menu check box is selected.

Locate Files and Folders in Vour Laptop

1. Can't remember what you named a folder or where on your
laptop or storage media you saved it? You can open the
Computer window to locate it. Choose Start=>Computer.

2. In the resulting Computer window (see Figure 11-5),
double-click an item, such as a USB drive, a CD-ROM
drive, or your laptop hard drive, to open it.

= U (Ee

|_'l" » Computer » - |¢'v’| [ Search Computer o |

File Edit View Tools Help

Organize = Systemn properties Uninstall or change a program » o S | 0'
¥ Downloads

4 Hard Disk Drives (2)

Vistabd (C:)

= Recent Places .
Playlists O — Double-click

an item
to open it

- Libraries DATA (D)
(£ Boumeny S 132 GB frez of 133 6B

m

@' Music
=| Pictures

E Videos

‘M Computer
&, vistabd (C:)

NATA (M

. . OWNER-PC Workgroup: WORKGROUP Memory: 4.00 GB
= — Processor Intel(R) Core(TM)2 Duo ...
2 items

Figure 11-5

3. If the file or folder that you want is stored within another
folder (see Figure 11-6 for an example of the resulting
window), double-click the folder or a series of folders
until you locate it.
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Recent Places
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< Documents
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e [ 055
@\_./-V!{:_v « Vistadd (C:) » v | 45| | Search vistasa (cy F
File Edit WView Tools Help

Organize v Mew Folder Include in library + Share with « SR 1l t)

p:
2 Mame

7 Uszers

| devlist
| Finish
| KQ21
L NBOVC_MNED...

Date modified Item Type Size

Intel
Perflogs
Program Files

Program File., 125

Windows

Figure 11-6

4. When you find the file you want, double-click it to open
it in the application in which it was created.

Figure 11-6. Use the commands in this area to

@ Note the buttons near the top of the window in

perform common file and folder tasks, such as
organizing, sharing, or opening files.

folders, you might see text listings (as in Figure

@ Depending on how you choose to display files and

11-6), icons, or even thumbnail representations of
file contents. Use the View menu in the Computer
window to configure how to display files and folders.

Search for a File

1. If you can't locate a file in the Computer window or your
Documents folder, you could simply perform a simple
search for it. Open the Start menu and type a search term
in the search box at the bottom.
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2. A list of search results appears, divided into categories
based on the locations of the results. (See Figure 11-7.)

=5 Devices and Printers

= View devices and printers
& Share printers

LA Change advanced color management settings for displays, sca...
= Add a printer

& Change default printer
‘ﬁ contacts(2)

=ﬂ_1 contacts(2)

1] 406922 Intro_tebpvs_

1] 406922 Chl2_tebpvs_|
] 406922 Ch15_tebpvs_
81 406922 Ch13_tebpys

4 FW: K-12 booklet Edits

[f=1 Print Management

~ See more results

[ printers | Shut Down | b |

Figure 11-7
3. Click the See More Results link.

4. In the window that appears (see Figure 11-8) click an
item to view it.

5. When you locate the file you want, you can double-click
it to open it.

that has carried over to Windows 7. To save the
results of a search, you can click the Save Search but-
ton. In the Save As dialog box that appears, provide a
filename and type, set the location to save it to, and
then click Save. The search results are saved as a
search folder on your laptop in your username
folder.

@ Search Folders was a new feature in Windows Vista
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k= Pictures Search again in:

E Mideos il Libraries (M Computer “"I Custom... ;é[ntelnel

1M Computer
. Windows7 ()
e MANCY FLASH [E}

€ network

Figure 11-8

You can modify the Search feature’s settings. When
you're in the Search Results window shown in Figure
11-8, click the arrow on the Organize button and
choose the Folder and Search Options command.
Using the Search tab in the Folder Options dialog
box that appears, indicate what locations to search,
whether to find partial matches for search terms,

and more.

Move a File or Folder

1. Sometimes you save a file or folder in one place but, in
reorganizing your work, decide you want to move the
item to another location. To do so, right-click the Start
menu button and choose Open Windows Explorer.

2. In Windows Explorer, double-click a folder or series of
folders to locate the file that you want to move. (See
Figure 11-9.)
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el (o (B =S
@k /.v! <« Sample Pictures » - v-,l | Search Sample Pictures pel
File Edit View Tools Help
Organize v Mew Folder Share with » Slice show :-;E hd 1dl t)
1 Recently Change # . .
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FZ Desktop -
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Recent Places =
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Libraries m Flower
| Documents
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& | Pictures '
E_ Videos m Leaves 3 File
9 items
9 items

Figure 11-9
3. Take one of the following actions:

e Click and drag the file or folder to another folder
in the Navigation pane on the left side of the win-
dow. If you right-click and drag, you are offered
the options of moving, copying, or creating a
shortcut to the item when you place it via the
shortcut menu that appears.

e Right-click the file and choose Send To. Then
choose from the options shown in the submenu
that appears (as shown in Figure 11-10); these
options may vary slightly depending on the type
of file you choose and what software you have
installed.

4. Click the Close button in the upper-right corner of
Windows Explorer to close it.

If you change your mind about moving an item
using the right-click-and-drag method, you can click

Cancel on the shortcut menu that appears.
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File Edit View Tools Help
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4 Recently Change = Pictur Print
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= Documents ;
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Open file location

Properties

Figure 11-10

If you want to create a copy of a file or folder in
another location on your laptop, right-click the item
and choose Copy. Use Windows Explorer to navigate
to the location where you want to place a copy, right-
click, and choose Paste or press Ctrl+V.

Rename a File or Folder

1. You may want to change the name of a file or folder to
update it or make it more easily identifiable from other
files or folders. Locate the file that you want to rename
by using Windows Explorer. (Right-click Start, choose
Open Windows Explorer, and then browse to find the file
you want to rename.)

2. Right-click the file and choose Rename. (See Figure 11-11.)

3. The filename is now available for editing. Type a new
name, and then click anywhere outside the filename to
save the new name.
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Play

Add to Windows Media Player list

Open With 3
Share with 3
Restore previous versions

Send To 3 = |[E =]

@uv|‘:’ v Libraries » Music » Copy To Folder... A |
Move To Folder... |

File Edit View Tools Help
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- | Copy
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2 Recently Change |
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Public
£ ————— Rename
Bl Desktop 3 iTun
¥ Downloads Play| Open file location
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=| Documents
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= Pictures sl 1! ¥
mandrill Dafe modified: 11/7/2008 1:31 PM
IE:' AU Format Sound Size: 361 KB
Renames the selected item.

Select Rename
Figure 11-11

You can’t rename a file to have the same name as
another file located in the same folder. To give a file
the same name as another, cut it from its current
location, paste it into another folder, and then follow
the procedure in this task. Or open the file and save
it to a new location with the same name, which cre-
ates a copy. Be careful, though: Two files with the
same name can cause confusion when you search for
files. If at all possible, use unique filenames.
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Create a Shortcut to a File or Folder

1. You can place a shortcut to a file or folder you used
recently on the desktop to make it quick and easy to
open it. Locate the file or folder by using Windows
Explorer. (Right-click Start and choose Open Windows
Explorer, and then browse to find the file you want to
make a shortcut to.)

2. In Windows Explorer, right-click the file or folder that

you want and choose Send Tow>Desktop (Create
Shortcut) as shown in Figure 11-12.

e o (]

Public
Bl Desktop
¥ Downloads
=il Recent Places

Playlists

7 Libraries

<| Documents
@' Music

= Pictures
2 Videos
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¥
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= 000_013(
v
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| 0000190 Date taken: 9/8/2008 2:12 |
JPG File Tags: Add atag

« [ 42| [ Search Pictures
Preview

Set as Desktop Background
Edit
Print

Preview

Rotate Clockwise

Rotate Counterclockwise
Open With

Share with

@ Snaglt

Restore previous versions

Send To

Copy To Folder...
Move To Folder...
Cut

Copy

Create Shortcut
Delete

Rename
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Properties

r

m

Bluetoath File Transfer Wizard
Compressed (zipped) Folder
Desktop (create shartcut)

Fax Recipient

W =N

Mail Recipient

|

Figure 11-12

Select Desktop (Create Shortcut)
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3. A shortcut appears on the desktop.

@ Once you have placed a shortcut on the desktop, to

open the file in its originating application or a folder
in Windows Explorer, simply double-click the desk-
top shortcut icon.

desktop, you can right-click a file or folder and
choose Send To=>Desktop (Create Shortcut) to
accomplish the same thing.

@ Instead of creating a shortcut and dragging it to the

Delete a File or Folder

170

1. If you don't need a file or folder anymore, you can clear

up clutter on your laptop by deleting it. Locate the file or
folder by using Windows Explorer. (Right-click Start,
choose Open Windows Explorer, and then browse to
locate the file you want to delete.)

. In Windows Explorer, right-click the file or folder that

you want to delete and then choose Delete from the
shortcut menu, as shown in Figure 11-13. (Or you
can simply click the file to select it and then press the
Delete key.)

. In the resulting Delete File dialog box (see Figure 11-14),

click Yes to delete the file.

really gone. It's removed to the Recycle Bin. Windows
periodically purges older files from this folder, but
you might still be able to retrieve recently deleted
files and folders from it. To try to restore a deleted
file or folder, double-click the Recycle Bin icon on
the desktop. Right-click the file or folder and choose
Restore. Windows restores the file to wherever it was
when you deleted it.

@ When you delete a file or folder in Windows, it’s not



e [
@uv| <« Alaska Course Grades ... » v|¢y| | Search Alaska Course Grades N.. S |

File Edit View Tools Help

Organize v B8 Open with Adobe Reader8 « Share with » 2 BE » [ l@]
-
- Favorites Documen... Arrange by:  Folder  Includes: 2 library locations
4 Recently Change|
Public e B 200803 EDL 550,8D1 Internet Safety (CHG OF GRADE][1]
|E s r 1 6L5KB |B
B Desktop — | Open with Adobe Reader 8 B ]l
i. Downloads @ Bgi'_ 200803 Open ;vJT_R:\\C.j..
= Recent Places | ks | | Pri | ‘835 KB
o} | & | rint I
J Playlists 20080:: Open With . ‘JTFJI?\CF
= Libraries @ ASSESEE Share with b
[%| Documents j Authal Restore previous versions 245 KB
& Music i attach  SendTo y l/24/2008
= b - i -
B Pictures = | Copy To Folder...
IE{ 200803 EDL 550.8D1 Internet Safety P
/ Adobe Acrobat Document
* Mdbe
Cut
Deletes the selected items.
Copy

Create Shortcut

Select Delete —— pelete

Rename

Open file location

Properties
.
Figure 11-13
Delete File e paians
= Arewyou sure you want to mowe this file to the Recycle Bin?
>
- 200803 EDL 550.8D1 Internet Safety (INC GRADE C..,
N Type: Adobe Acrobat Document
Size: 9.5 KB

Date modified: 11/22/2008 8:31 AM

Adobe

Figure 11-14

Chapter 11: Working with Files and Folders

171



Part lll: Having Fun and Getting Things Done with Software

Compress a File or Folder

1. To shrink the size of a file, or all the files in a folder, you
can compress it. This is often helpful when you're send-
ing an item as an attachment to an e-mail message.
Locate the files or folders that you want to compress by
using Windows Explorer. (Right-click Start, choose Open
Windows Explorer, and then browse to locate the file(s)
or folder(s).)

2. (Optional) In Windows Explorer, you can do the follow-
ing (as shown in Figure 11-15) to select multiple items:

e Select a series of files or folders. Click a file or
folder, press and hold Shift to select a series of
items listed consecutively in the folder, and click
the final item.

¢ Select nonconsecutive items. Press the Ctrl key
and click the items.

e (= [T =S
< [ Sample Pictures » v | 44| | Search Sample Pictures M
e/ £
File Edit View Tools Help
Crganize = 113 Preview Share with » Slide show » = - il t)
i Recently Change # . .
i Pictures li... Arangeby: Folder v Includes
FZ Deskt e
SR Butterfly 5 f i
o Downloads - m 1024 % 76
Recent Places Z
Field
Playlists
Flower
Libraries v m
| Documents
Musi "¢ girl image
2 Music
e | Pictures

: = Leaves
3 Videos 7 E

3 items selected Date taken: 2/11/2008 5:05 PM - 3/24/2008 5:05 PM

3items selected

Figure 11-15

172



Chapter 11: Working with Files and Folders

3. Right-click the selected item(s). In the resulting shortcut
menu (see Figure 11-16), choose Send To=>Compressed
(Zipped) Folder. A new compressed folder appears below
the last selected file in the Windows Explorer list. The
folder icon is named after the last file you selected in the
series, but it's open for editing. Type a new name or click
outside the item to accept the default name.

i = [T ESE

File Edit View Tools Help
Organize » i) Preview Share with + Slide show

4/ Recently Change =

e Pictures li... Arangeby: Folder  Includes:
; Desktop = Butterfl Preview
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Copy To Folder...
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i
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o

@
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Desktop (create shortcut)
Fax Recipient

Mail Recipient
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Figure 11-16

You might want to subsequently rename a com-
pressed folder with a name other than the one that
Windows automatically assigns to it. See the task
“Rename a File or Folder,” earlier in this chapter, to

find out just how to do that.

Add a File to Vour Favorites List

1. The Favorites list in the Start menu offers another quick
way to access frequently used items. Locate the files or
folders that you want to add to the Favorites list by using

173



Part lll: Having Fun and Getting Things Done with Software

Windows Explorer. (Right-click Start and choose Open
Windows Explorer.)

2. In Windows Explorer, click a file or folder and drag it to
any of the Favorites folders in the Navigation pane on
the left. (See Figure 11-17.)
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1 Sample Musfc Date modified: 1/23/2009 2:48 PM

" File Folder

1item selected

Adding a file to the Favorites list
Figure 11-17

3. To see a list of your Favorites, choose Start=>Favorites.

4. In the resulting submenu (see Figure 11-18), click an
item to open it.

menu, right-click the Start menu and choose
Properties. On the Start Menu tab in the Taskbar and
Start Menu Properties dialog box, click the Customize
button. Make sure that Favorites Menu is selected,
and then click OK twice to save the setting.

@ If the Favorites item doesn’t display on your Start
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Figure 11-18

Back Up Files to a Read/Writable CD or DUD

1. You've put a lot of work into your files, so don't forget to
back them up. If your laptop is damaged or loses data,
you'll want to have a copy safely tucked away. If your
laptop doesn’t have a CD/DVD drive built in (for exam-
ple, if you have a netbook), you'll have to purchase an
external CD/DVD drive and connect it to your laptop to
perform these steps. Place a blank writable CD-R/RW
(read/writable) or DVD-R/RW in your CD-RW or
DVD-RW drive and then choose Start=>Documents.

2. In the resulting Documents window (see Figure 11-19),
select all the files that you want to copy to disc.

3. Right-click the files that you want and then choose Copy
to Folder.
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Figure 11-19

4. In the Copy Items dialog box that appears, click the
CD-R/RW or DVD-RW drive and click Copy.

5. Click the Close button to close the Document window.
such as the Document folder, you can just click the

Documents folder itself in Step 2 and follow the rest
of the steps.

@ If you want to back up the entire contents of a folder,

by using the Back Up Your Computer link in the
Control Panel. Using Windows Backup, you can
make settings to regularly back up to a local disk or
CD-R/RW/DVD drive, or to a network. Backing up to
a CD/DVD is a little different from burning a disc in
that after you back up your files, only changes are
saved each subsequent time a backup is run.

@ You can also back up to a network or another drive
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Using the Desktop
Gadget Gallery
and Gadgets

W indows 7 has a feature called the Desktop
Gadget gallery. The gallery contains little
applications, called gadgets, that you can dis-
play as icons on the desktop. Using gadgets,
you can quickly access various handy features
to check the time, organize your schedule with
a calendar, feed online data direct to your
desktop, and more. Here are some of the
things you can do with the Windows gadgets
that we cover in this chapter:

w=  Work with images. Slide Show displays a
continuous slide show of the photos in
your Pictures folder.

w= Organize your time. The Calendar gad-
get displayed on your desktop helps you
keep track of the days, weeks, and months.
The Clock gadget displays the time using
an old-style wall clock and allows you to
make changes to your time zone.

w= Play with a puzzle. A neat little Picture
Puzzle allows you to play a game that's
so tiny, even your boss won't notice
you're not actually working.
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12

Getready to. ..
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and Add Gadgets to the

Desktop .....covevveieieiane. 178
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w= Work with online data. The Feed Headlines gadget
allows you to grab data from online RSS feeds (a for-
mat used for syndication of news and other content),
such as the latest news or other useful information.
Stocks and Currency conversion gadgets provide up-
to-the-minute data on stocks and currency values.

w= Keep an eye on your system performance. The CPU
Meter provides up-to-date information about your
laptop processor speed and available memory.

Open the Gadget Gallery and Add Gadgets
to the Desktop

1. Right-click the desktop and choose Gadgets to open the
Gadget Gallery window, as shown in Figure 12-1.

2. Click any gadget and drag it to the desktop. (See
Figure 12-2.)

I-:-IEIIEI

Pagel of 2 3 [ searen gadgets P -

AQL HP Daily 5... Calendar Clock CPU Meter

=B -

Currency Feed Headlines ~ Morton Security... PC Discovery

Picture Puzzle Power2Go Reversi Slide Show

@

H @
EE

| Show details & Get more gadgets online

Figure 12-1
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2
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7024M

Dragging a gadget to the desktop

Figure 12-2

3. Click the Close button to close the Gadget Gallery.

®
®

Gadgets are hot, and people are creating more all the
time. Click the Get More Gadgets Online link in the
Gadget gallery to scope out the latest gadgets and
then download them.

If you want to send a gadget away, just place your
pointer over it and then click the Close button
(marked with an X) that appears next to it. The
gadget closes. Just follow the steps above to display it
on the desktop again at any time.
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Check the Time

1. To display a clock on your desktop, right-click the
desktop and choose Gadgets.

2. In the Gadget Gallery that appears, click the clock and
drag it to the desktop.

3. To make changes to the clock style or change the time
zone, place your mouse over the Clock and click the
settings button. (It sports a little wrench symbol.)

4. In the resulting Clock dialog box (see Figure 12-3), click
the Next or Previous buttons to move through the
various available clock styles.

The Previous and Next buttons

oK | cancel

Figure 12-3

5. If you wish, you can enter a name for the clock in the
Clock Name field. To change the time zone, click the
arrow in the Time Zone field and choose your local time.

6. Click OK to save the clock settings.

clicking the Show the Second Hand check box in the

@ You can display a second hand on your clock by
Clock dialog box.
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If you are on the road with your laptop and want to
keep track of the local time and the time back home,
you can display more than one clock by simply drag-
ging the clock gadget to the desktop from the Gadget
gallery again. Make changes to the time zone settings
and even use two different styles of clock to tell them
apart at a glance.

Display a Continuous Slide Show

1. You can display a continuous show of the pictures in
your Pictures folder to keep you entertained as you work
or play on your laptop. Add the Slide Show gadget to the
desktop. (See the earlier task, “Open the Gadget Gallery
and Add Gadgets to the Desktop.”)

2. Move your mouse over the Slide Show gadget and
use the tools along the bottom of the slide show
(see Figure 12-4) to do the following:

| |
Previous View button
Next

Pause
Figure 12-4

e Click the View button to display the current slide
in Windows Photo Viewer.

e Click Pause to stop the slide show at the current
slide.
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¢ Click Previous to go to the previous slide.
e Click Next to go to the next slide.

3. The Slide show uses the Sample Pictures folder contents
by default, but you can display pictures in any folder.
Click the Settings button. In the resulting Slide Show dia-
log box (see Figure 12-5), change the picture folders to
include in the slide show.

In this dialog box, you can also modify the number of
seconds to display each slide or a transition effect to use
between slides. Click the arrow to display and select your
options.

Slide Show

Folder:

/| Include subfolders
Show each picture:

15 seconds -

Transition between pictures:
Mone -

Shuffle pictures

i oK || Cancel .

Figure 12-5
4. Click OK to close the dialog box.

When you click the View button to display the cur-
rent slide in Windows Photo Viewer, you can use
tools to modify the image, print it, e-mail it, or even
create a movie. See Chapter 15 for more about using
Windows Photo Viewer.
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Note that continuously playing features like the slide
show, or continuously updating features such as the
stock ticker, may put a drain on your laptop’s battery.
If you're running on battery power, you might hide
the Gadget gallery to save juice.

Use the Windows Calendar

1. The Calendar gadget isn’t an organizer, it just helps you
remember dates with a Calendar display you can place
on your desktop. Add the Calendar gadget (see Figure
12-6) to the desktop. (See the earlier task, “Open the
Gadget Gallery and Add Gadgets to the Desktop.”)

October 2009

igure 12-6

2. Move your pointer over the Calendar and click the Size
tool to move between the larger size, which displays both
the monthly and daily sections (as shown in Figure
12-7), and the smaller size, which displays only the daily
display by default.

4 »
Sl E~The Size tool
4| 5 67 ; ; 13

1112 13 14 15 16 17
18 19 20 21 22 23 4
xE]z = = 0 3l

o

October 2009

Figure 12-7
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3. With the larger calendar displayed, click the Next or

Previous arrows to move to another month; double-click
a date to display it in the lower part of the calendar; and
click the red tab in the lower-left corner to return to
today’s date in the lower area.

@ If you prefer to use the smaller size calendar but have

it display the monthly calendar rather than daily, just
double-click the small display and it toggles between
month and day.

you can jump to the daily display for a specific date
by double-clicking that date in the monthly view.

@ With the monthly display shown in the smaller size,

Play with Puzzles
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1. Add the Picture Puzzle gadget to the Desktop. (See the

earlier task, “Open the Gadget Gallery and Add Gadgets
to the Desktop.”)

2. Click any of the tools along the top of the puzzle (see

Figure 12-8) to do the following:

¢ Pause timer: Stops the automatic count of seconds
of play.

e Show Picture: Displays the completed picture;
release it and you go back to where you were in
the game.

¢ Solve: Ends the game and displays the completed
picture.

3. To play the game, click any piece adjacent to a blank

square. It moves into the blank space. Keep clicking and
moving pieces until you get the picture pieces arranged to
form a picture.
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Pause Show
timer  Picture

4. Click the Settings button to the right of the puzzle to
display its settings dialog box. (See Figure 12-9.)

b 1 of 11 (&

| ok || Conca

Figure 12-9

5. Click the Previous or Next button to scroll through
available pictures for the puzzle.

6. When you find the picture you want, click OK to close
the dialog box.

Convert Currency

1. Are you shopping in a market in Paris with your laptop
under your arm and need to change dollars to euros? If you
have an Internet connection, you can get up-to-the-minute
currency values. Start by adding the Currency Conversion
gadget to the desktop. (See the earlier task, “Open the
Gadget Gallery and Add Gadgets to the Desktop.”)
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2. Connect to the Internet to access the latest currency rates
(as shown in Figure 12-10) and do any of the following.

e Enter the number of dollars; the number of
equivalent euros is displayed.

e Click one of the currency names, and a list of
available currencies appears. (See Figure 12-11.)
Click another currency to change which currencies
to convert from and to.

Figure 12-10

-
SWISS FRANC .

TAWWAN DOLLAR

TANZANIAN SHILLING

THAIBAHT

THSANUNAR,

4m

VIE_NA.MESE DONG
ZIMBABWEAN DOLLAR
DATA PROVIDERS | 1R

Figure 12-1

conversion rates, with the larger size Currency gadget
displayed, click the Data Providers link. The MSN
MoneyCentral page opens. Click the Banking tab and
then click the Currency Exchange Rates link to view
current rates.

If you want to, you can display several Currency
conversion gadgets to compare multiple currencies at

the same time.

@ To view the online source for the latest currency
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Use the Feed Headlines Gadget

1. If you like to read the latest headlines (this requires an
Internet connection) add a news feed to your desktop.
First, add the Feed Headlines gadget to the desktop.
(See the earlier task, “Open the Gadget Gallery and Add
Gadgets to the Desktop.”)

2. Click the Feed Viewer window to connect to the default
RSS feed. (Figure 12-12 shows what the feed might look
like.)

Bitter cold, outages after late winter st...

MSNBC News

Madoff wants to kee...

Read online...

il
i

Coast.

More than 80,000 homes and
businesses remained without
power Tuesday, most in the
Southeast, after a late winter
storm dumped snow across
that region and the East

Figure 12-12

3. At the Web site that appears, you can view blog entries,
submit an entry, or subscribe to additional feeds.

4. Click the Settings button. In the resulting Feed Viewer
dialog box (see Figure 12-13), select the default feed.

Feed Headlines
D'Lsgla){ hisfe: =
Al feeds - ——— Select the default feed
Mumber of recent headlines to show:
100 headlines -
What are feeds?
| 0K | | Cancel

Figure 12-13
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5. Click OK to close the dialog box.

Set of Feeds arrows that appear at the bottom of the
Feed Headlines gadget when you move your pointer
over it to scroll through available feeds.

@ Use the Show Next Set of Feeds and Show Previous

Monitor Your CPU
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1. Is your laptop acting sluggish? Check its performance by
using the CPU Meter. Add the CPU Meter gadget (see
Figure 12-14) to the desktop. (See the earlier task, “Open
the Gadget Gallery and Add Gadgets to the Desktop.”)

Figure 12-14
2. Use the readouts to monitor the following:

e CPU (on the left) monitors how hard your CPU is
working to process various programs and processes
running on your laptop.

¢ Memory (on the right) monitors the percent of
your laptop memory that is being used.

the Size button to toggle between a larger and
smaller version, but you can’t make any settings for
it. It's just a little reminder that helps you keep track
of your laptop’s performance. If memory is almost at
100%, consider freeing some space. If the CPU is at a
higher percentage, odds are you've got lots of pro-
grams running which could be slowing down your
laptop’s performance; consider shutting some down!

@ That's about all there is to CPU Meter! You can click
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If you want more detail about your laptop memory,
use the Start menu to display the Control Panel and
choose System and Security. The System links allow
you to view the processor speed and the amount of
RAM available.
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Creating
Documents with

Works Word

Processor

The two kinds of software programs that
people use most often are word processors
(for working with words) and spreadsheets (for
working with numbers and organizing data).
In this chapter, you get to see the basic tools of
the word processor built into Microsoft Works 9.
Microsoft Works is a suite (a bundle that
includes multiple programs). The Works
program that I cover in this chapter is named,
simply, Word Processor. In the next chapter, I
cover the Works program called Spreadsheet.

Works, or a trial version of the product, comes
installed on many Windows-based laptops. If
not, the program is relatively inexpensive
(anywhere from U.S. $30 to $40 depending on
where you shop), so it's a good entry-level
program you might want to have on your
laptop. (Note that if you don’t have Works and
want an entirely free word processing program
to try these tasks with, many will work similarly
with Google Docs (www.docs.google.com),
which you can use for free online, or
OpenOffice.org (www.openoffice.org),
which you can download for free.

| “*ap’rer

13

Getready to. ..
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w= Save a Document.............. 194
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With a word processor, you can create anything from simple letters to
posters or brochures. You can use both text and graphics to add style
to your documents. You can even use a word processor to print enve-
lopes or labels, so you can send those holiday newsletters or fund rais-
ing letters for the local food bank on their way.

In this chapter, you explore the following:

w= Enter text and format it by applying different fonts,
colors, and effects.

w= [nsert tables for organizing information.
w= [nsert graphics and arrange them on the page.

w= Prepare your document for printing by using spelling
and grammar checking tools, modifying the page
setup, and finally, printing it!

Open a New Document and Enter and Edit Text

1. Your first step in creating any document is to open your
word processor and enter and edit text. Choose Startr>All
Programs=>Microsoft Works and then select Microsoft
Works Word Processor. The program opens, and a blank
document is displayed. (See Figure 13-1.)

2. Begin typing your text. Word Processor (like all word
processing programs) wraps the text, which means it
automatically moves to the next line within a paragraph
as you type. Press Enter twice on your keyboard only
when you want to start a new paragraph.

3. To edit text you have entered, perform any of the
following actions:
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¢ Click anywhere within the text and press
Backspace on the keyboard to delete text to the left
of the cursor.

¢ Click anywhere within the text and press the
Delete key to delete text to the right of the cursor.

e Click and drag your cursor over text to select it and
press Delete or Backspace to delete the selected text.

e Click anywhere within the text and type additional
text.

Begin typing in a blank document

[/ Untitled Doc§ment - Microsoft Works Word Processor [E=NE X
File Edit Viely Insert Format Tools Table Help [LveSarch ——— |[A]
DzEdE|skya | e@ @Y @ v - 7|
Times Mew Roman > 10 *+H - | B I U Hj = ‘ = :| B

T O T 2 B &eoca 7| TaskPane

“ Recent Documents

(=2 Browse Documents...
#7 Browse Templates

[} New Document

Tip of the Day

Word Processor Shortcuts
When you use the Word
Pracessor, mause and keyboard
shorteuts can help you work more
quickly.

Learn Mare...

T 3

Page 1 of 1

Figure 13-1
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Save a Document
1. To save a document for the first time, choose Filer>Save.

2. In the resulting Save dialog box (see Figure 13-2), click
the arrow on the right of the Save In field and click a
different folder.

Type a name for your document

% Save As ==l
Save in; ’r Docunjents - & /a0
-
Mame Date podified Type Size Tags
column ItsDeductible200&
electronics laptops
electronics zip file My Web Sites
Elect5TG3e MNancy
invoices nano web site
Fi mm }
File narme: led Documel l Save |
Save az type: |'W'orks Document [* wpsz) v| | Cancel |

| Template...

Figure 13-2
3. Type a name for the document in the File Name text box.

If you want to save the document in another format
(for example, you can save a Works document as
plain text so that any word processor can open it),
click the arrow on the Save as Type field in the Save
As dialog box and choose a different format before
you click the Save button.

4. Click Save.
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Open an Existing Document

1. After you create a file and save it, you can open it to add
to or edit the contents, or print it. To open a file after you
save it, with the Works word processor open, choose
File>Open.

2. In the Open dialog box that appears (see Figure 13-3),
locate the file on your laptop, storage device, or disc by
clicking the arrow on the Look In field and clicking the
drive or folder where your file is located.

% Open [

Look ir: Electronics -7 mEr

Namef Date modified Type Size Tags

|# Figure_corrections

File name: Figure_comections | Open |

Files of type: | Works Documents [ wps) - | | Cancel |

Click Open
Figure 13-3

3. After you locate the file and click it, click the Open
button. The file opens, ready for you to edit or print it.

Cut, Copy, and Paste Text

1. You can cut and paste or copy and paste selected text
to move or duplicate it in another location in your
document. With a document open in Works word
processor, click and drag over text to select it; the text is
highlighted. (See Figure 13-4.)
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Click Cut
Click Copy
qure ps - Microsoft | forl s Word Processor (=] " 5o
File Edit Wiew Insert Format | Togls Table Help
DSEHBE SAYHE|Lma RE g RY @ o - T(@
TmesNewRoman v 12 v M v | B I U|[El===|iz = = &M@
[ 1 3 A4 ' it e i
Figure # Error Replace with
45 Resistor symbol labeled as | Lamp symbol, see figure
lamp 207
42 Eesistor symbol in upper Larmp symbol
right of figure
4.8 Resistor symbol in upper Lamp symbol
right of figure
49 Larmp symbol
410 Eesistor spmbol labeled az Lamp symbol
lamp
411 Resistor spmbol labeled as | Lamp symbol

Select text
Figure 13-4

2. Perform either of the following two steps, depending on
whether you want to cut the text (remove it) or copy it
(leave the existing text and make a copy of it):

e (Click the Cut button on the toolbar to cut the text.

¢ Click the Copy button on the toolbar to make a
copy of the text.

3. Windows places the cut or copied text on its Clipboard, a
temporary holding place for cut or copied text or objects.
To paste the cut or copied text to another location within
the document, click where you want the text to appear
and click the Paste button on the toolbar. The text
appears in the new location.
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After you place text or an object on the Windows
Clipboard, you can paste it anywhere. For example,
you can open another document and paste it there or
paste it in an e-mail message. However, it won't stay
on the Clipboard forever. If you cut or copy other
text or objects, your earlier item will soon be
removed from the Clipboard, which holds only a few
items at a time.

Format Text

1. To format text means to change its size, apply effects such
as bold or italic to it, or change the font (that is, a family
of typeface style with a certain look and feel to it). You
start by selecting the text you want to format. Click and
drag your mouse over the text you want to format to
select it. (Figure 13-5 shows how the selected text is
highlighted in black.)

2. Choose Format=>Font. In the resulting Font dialog box
(see Figure 13-6), make any of the following formatting
choices:

e Select a font from the list of available fonts. Use
the arrows or scroll bar in this list to see more
choices and click the one you want to select it. The
font is previewed in the large box near the bottom
of the dialog box.

e Select a font style such as Bold or Italic from the
Font Style list. Font styles are useful for emphasis.

e Choose a different text size by selecting a point
size setting from the Size list. The higher the point
size, the larger the text.
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e If you want to underline the selected text, choose a
style from the Underline drop-down list.

e (Click the arrow on the Color drop-down list and
select a different color for the text.

e Click any of the Effects check boxes to apply effects
to the text.

3. Click OK to apply the formatting options you have

selected.

Click and drag to select text
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Click the arrow to see options
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Figure 13-6
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®

You can also use the Formatting toolbar to apply
individual formatting settings to selected text. For
example, you can click the Bold button or choose a
different font from the Font drop-down list. If you
don't see the Formatting toolbar, choose Viewr>
Toolbars=>Formatting.

Try not to use too many formatting bells and whis-
tles in a single document, as the formatting might

become distracting or make the document difficult to

read. A good guideline is to use only two fonts on a
single page and use effects such as bold or shadowed
text for emphasis only.
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Insert a Table

1. A table is a handy way to organize information with
headings, rows, and columns. You can easily insert tables
in word processors and then fill in the data you want
to organize. With a document opened, choose Tablew>
Insert Table.

In the Insert Table dialog box that appears (see

Figure 13-7), click a predesigned format for the table
in the Select a Format list box. A sample of the format
is displayed.

of rows and columns in the table and to specify row
height and column width. If you don't change the height

and width settings, rows and columns will adjust auto-

matically to the text you enter in each table cell.

Select a table style

Use the arrows on the other four fields to set the number
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4. Click OK to insert the table. In the blank table that
appears (see Figure 13-8), the cursor is ready and waiting
for you in the top-left cell, and if that's where you want
your first entry, you can simply begin typing your table
contents.

5. Press Tab to move to the next cell in the table. If you
reach the last cell in the last row and press Tab, a new
row is inserted. Alternatively, you can click in any cell
where you want to add text.

You can format text you enter in a table just as you
do any other text in your document. Just click and
drag to select the cells you want to format and then
follow the steps in the preceding task, “Format Text.”

Type text in the table cells
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To insert additional columns after you've created
your table, click in the column next to which you
want to insert a column and choose Table=>Insert
Column. Then choose either the Before or After
Current Column option, depending on whether you
want the new column to appear to the left or right of
the current column.

Add Graphics

1. 1f you have files that contain a drawing or photo, you can
insert them in your document to spruce it up or help you
make a point. With a document open, choose Insert=>
Pictures=>From File.

2. In the resulting Insert Picture dialog box (see Figure 13-9),
click the file in your Pictures folder to select it. If the
picture file is in a subfolder within the Pictures folder,
double-click the folder to display those files. If you want
to use a picture file located elsewhere, click the arrow on
the Look In field and choose another location.

3. Click the Insert button. The picture is inserted in your

document.
Click the picture
_# Insert Picture (B
Lookin: [ Pictures - & T o E
Name, Date taken Tags Size | S
) | ||
bl I
je il | — B |
101MNCD50 Microsoft subdivision 0001BFC4[1] Capture
Clip Or...
[ .re] Szl %
File name: | Insert
Files of type: ‘AII supported image file formats v] I Cancel | [¥]Enable preview

Figure 13-9
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You can also insert built-in drawings and photos
called clip art by choosing Insertw> Picturer>Clip Art.
In the dialog box that appears, select a category and
subcategory to display picture previews. Then click a
picture and click the Insert button to place it in your
document.

Resize Objects

1. After you insert a picture or piece of art, you may want to
resize it. Click the object (such as a photo or clip art) to
select it. Small boxes called handles appear around its
edges. See Figure 13-10.
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Click a handle and drag
Figure 13-10
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2. Do any of the following to resize the object:

©)

e Click the center handles on the left or right side of
the object and drag outward to make the object
wider, or drag inward to make the object narrower.
This distorts the original proportions.

e Click the center handles on the top or bottom of
the object and drag up or down to make the object
higher or shorter. This action also distorts the
proportions.

¢ Click a handle in any corner and drag outward to
enlarge the object and keep it in proportion, or
drag inward to shrink the object, again keeping it
in proportion to its original size.

You can use another method to resize objects. Select
the object and choose Format=>Object to display the
Format Object dialog box. Click the Size tab and
enter new Height and Width settings. Click OK to
accept the new settings. Depending on the dimen-
sions you enter, the resulting object might be out of
proportion.

Check Spelling

1. Especially if you go on the road with your laptop and
leave your hefty dictionary behind, you'll be glad to hear
that Works has a tool that helps you check and correct
your spelling. Although the tool won't catch every error
(if you typed sore instead of soar, the tool won't catch it),
it can catch many spelling mistakes. With the document
you want to check open, choose Tools=>Spelling and
Grammar. If you didn’t make any discernable errors, a
message appears that the spelling check is complete, but
if you did, a dialog box appears.
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2. In the resulting Spelling and Grammar dialog box (see
Figure 13-11), take any of the following actions:

e Click a suggested spelling and then click Change
to change just this instance of the word.

e Click a suggested spelling and click Change All to
change all instances of the word.

e Click Ignore Once to ignore the current instance of
the word not found in the dictionary.

e Click Ignore All to ignore all instances of this
word.

e Click Add to add the word to the dictionary so
that it is no longer questioned in a Spelling and

Grammar check.

Click to select an alternate spelling

Spelling and Gramnjar: English (United States) (=5
Mok in dickionary:
blogs Ignore Cnce
Ignore All |
Add |
Suggestions: )
bogs . Change |
blocs —_—
blats | Change Al
blobs
blows =

Spelling options

-L{ Ignore words in UPPERCASE options... |
[¥] 1gnore words with numbers

[¥] Ignore Internet and file addresses

["]check grammar

Close |

Figure 13-11
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3. The spell checker moves to the next suspect word, if any,

and you can use any of the options in the preceding list
to fix mistakes. This continues until the spell checker tells
you that the spell check is complete.

4. Click Close to close the dialog box.

grammar, you can select the Check Grammar check
box in the Spelling and Grammar dialog box. When
you next run the Spelling and Grammar check,
Works displays sentences with possible grammatical
problems and suggestions for how to fix them.

@ If you would also like to have Works check your

words or acronyms you use often in the dictionary.
For example, you might add unrecognized names of
people or companies, scientific terms, or acronyms
such as IBM or MTV. By adding such words to the
dictionary, you save yourself the time it takes to tell
Works over and over again that those words are
correct.

@ It's a good idea to use the Add feature to put unusual

Change Page Setup
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1. Word processors have default page setup settings that

determine, among other things, how wide or tall the
margins are and which way the page is oriented. If you
want to change those settings, you can do that when you
first create the document, or you may wait until you're
ready to print the document onto paper. With the docu-
ment whose setup you want to change displayed, choose
Filec>Page Setup.

2. In the Page Setup dialog box that appears (see Figure

13-12), click the Margins tab. Use the up and down
arrows (called spinner arrows) to increase or decrease mar-
gin settings, or type a new measurement in any of the
Margins boxes.
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Click arrows to change margin settings

Page Setup
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Figure 13-12

3. Click the Source, Size & Orientation tab. (See Figure
13-13.) Select a radio button for either Portrait orienta-
tion (with the longer edges of the paper on the sides) or
Landscape (with the shorter edges of the paper on the
sides).

Choose an orientation

Page Setup
: Marginsn% Source, §ize & Orientation Cther Options | Preview
Crientation
@ Portrait
Landscape —_——
Paper
Source; | Aukomatically Select v| e —
Sizet | Letker = |
Width: 3.5" = ——
Height: 1" 2
| Reset | Ok | | Cancel

Figure 13-13
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4. Also on the Source, Size & Orientation tab, you can use
the Paper settings to specify the size of paper you will
print to and, if your printer has multiple paper trays,
select the source for the paper.

5. Click OK to save the new settings.

If you're inserting a header or footer (for example, a

@ page number or the name of the document that you
want to appear on every page on either the top or
bottom) you should adjust some settings in the Page
Setup dialog box. On the Margins tab, you can spec-
ify how far from the edge of the paper the header or
footer should appear. On the Other Options tab, you
can control what page number you start with and
whether the header or footer should appear on the
first page of the document. (To insert headers or
footers in your document, use the Header and Footer
command on the View menu.)

Print a Document
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All Windows software use a similar procedure to print files, and Works
is only slightly different. You simply choose Filew>Print — or in Office
2007 and later programs, click the Office button and choose Print —
and use the settings shown in Figure 13-14 to determine these
variables:

e Number of Copies: Be sure there’s enough paper
in your printer to handle them all!

e Collate: Collating assembles sets of documents in
the correct page order rather than printing, say,
five page 1s, then five page 2s, and so on. This can
save you effort when you're assembling multiple
copies of a document yourself.
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Page Range: The Print dialog box you see in

Windows software allows you to print the current

page, text you select before choosing the Print
command, the entire document, or a specified
page or range of pages.

Find Printer: Click this button to open a dialog
box where you can choose which printer to print
to and indicate your preferences for that printer.
You can determine preferences such as the print

quality and whether to print in color or grayscale.

Print 7
Printer
Marme: L!j |ﬂ Properties
Skatus: Prlntlng:.Z documents. waiting Find Printer. ..
Tvpe: HP Deskjet F4100 series
Where: LSBao1 I Print to file
Comment: [ Manual duplex
Page range Copies
@ Al Nurnber of copies: 1 e |

" Currert page

" Selection

" pages: |

i B ¥ Collate
Enter page numbers and/or page ranges IFI 1

separated by commas. For example, 1,3,5-12

Print what: |Document showing markup ﬂ Zoam

Pages per sheet: 1
pages in range ﬂ ERELS RA9E i

Print: |P.II
Scale to paper size: Mo Scaling ﬂ
Options. .. OF I Close |
Figure 13-14

Always remember that before you print, you should
proofread your document and run a spell check to
make sure it’s letter perfect.
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Working with
Numbers and
Finances

A spreadsheet program allows you to orga-
nize data and automate both simple and
complex calculations. You enter numbers and
then perform actions on them such as calculat-
ing an average or generating a sum for a range
of numbers. You can format the data in a
spreadsheet and also generate charts based on
the numbers you enter.

Microsoft Works 9 includes a spreadsheet pro-
gram that provides some pretty sophisticated
tools for working with numbers and charts.
You can also use this and other spreadsheet
programs to create tables of data, such as your
home inventory or investments.

In addition to working with a spreadsheet
program, there are several ways you can get
information about your investments and per-
form financial transactions online. Together, a
spreadsheet program and the financial tools
you can use on the Internet can make manag-
ing your financial life much easier.
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Explore the Structure of a Spreadsheet

Spreadsheet software, such as Microsoft Works Spreadsheet and
Microsoft Excel, uses a grid-like structure for entering data. The
individual cells of the grid are formed by the intersection of a row
with a column, and so a cell is identified by a column letter followed
by a row number. For example, B3 identifies the cell located at the
intersection of the second column over and third row down.

Here are some additional facts you should know about spreadsheets:
w= You can enter text or numbers in spreadsheets.

m= When you click in a cell, the Formula bar becomes
active. You can enter contents and edit those con-
tents in the Formula bar. (See Figure 14-1.)

w= [Ise the two scrollbars, the one to the right and the
one at the bottom, to move vertically or horizontally
through a large spreadsheet.

w= You can perform calculations on numbers that
you've entered in a spreadsheet, such as adding up
numbers or calculating an average of several num-
bers. See the “Perform Simple Calculations” task
later in the chapter for instructions.

w= You can format the contents of cells or use an
AutoFormat feature to apply predesigned styles to
selected cells. Note that in some predesigned for-
mats, the grid lines are neither displayed nor printed.
See the “Apply AutoFormats to Cells” task for more
details.

w= After you've entered some data into your spread-
sheet, you can easily generate a chart representing
that data graphically. The “Insert a Chart” task tells
you how.
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If you're used to using a number pad on a desktop
computer keyboard and your laptop doesn’t include

a number pad, you'll need to become acquainted

with the embedded number pad. Look for some keys
on your keyboard that have the numbers 0 through 9
on them. By pressing the Fn key on your keyboard
and then pressing these keys, you can use them to
enter your spreadsheet numbers.

Enter data in the Formula bar
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Open Works Spreadsheet and Enter Data

1. To start a new spreadsheet and begin filling it with
information, first choose Starte>All Programs= Microsoft
Works>Microsoft Works Spreadsheet.

2. In the blank spreadsheet that appears, click in a cell to
make it active. (See Figure 14-2.)

3. Begin typing; notice that what you type appears in both
the cell and Formula bar.

4. Press Tab to complete the entry and move to the next
cell. Note that you can also click the Enter button in
Works Spreadsheet (see Figure 14-3), which looks like a
check mark, to complete your entry and keep the current
cell active.

Click a cell to make it active
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Figure 14-2
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The Enter button
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Figure 14-3

Remember to save your work often to avoid losing

@ anything. I like to back up all my work to a USB
stick, which I can easily move between my desktop
computer and laptop. See Chapter 13 for informa-
tion about saving.

Format Numbers

1. You can format text in the cells of a spreadsheet, apply-
ing effects or changing the text font or color, just as you
do for text in a word processor. (See Chapter 13.)
However, formatting numbers in a spreadsheet is a bit

different. In this procedure, you format the number to fit

a category, such as currency, or include a certain number
of decimal points. To begin formatting numbers, first

click the cell containing the numbers you want to format.

To select multiple cells, click a cell and drag up, down,
right, or left to select a range of cells.

2. Choose Format>Number.
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3. In the Format Cells dialog box that appears with the
Number tab displayed (see Figure 14-4), click an option
in the Select Format Type list, such as Currency or
Percent.

Click a number format

Format Cells (=3

Mumber | glignment | Forft | Border | Shading

Specify the tyvpe of Formgtting you wank For the selected cells,

Select Format type: Select additional formatting for Currency
General

Text Set decimal places: 2 B
Mumber =
Percent Show negative numbers in red
Exponential

Leading zeros
Fraction
True/False
Date

Tirme

IJse the eura sign (€) as the currency symbol

Presiew:

1,500,599

[ QK ] | Cancel

Figure 14-4

After you select a format, you'll usually see, on the right
side of the dialog box, additional options for indicating
how you want the data to display. For example, if you
choose the Currency format, you can click the up or down
arrow on the Set Decimal Places field to specify how many
decimal places the number should have; for example,
22.10 (two decimals), 22.1 (one decimal), or 22 (no
decimals). Your settings appear in the Preview box.
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4. Click OK to apply your formatting selections and close
the dialog box.

matting numbers in lists or budgets, but they aren’t
the only ones. You can even format numbers to dis-
play as dates, times, or fractions. If you want a zero
to appear as False (in other words no value) and any
number (that is, any value at all) to appear as True,
choose the True/False format type.

@ Currency and General are common options for for-

Apply AutoFormats to Cells

1. You can also format sets of cells by using AutoFormats,
which are predesigned sets of formatting choices such as
cell shading or borders. Click and drag to select a range
of cells.

2. Choose Format=>AutoFormat.

3. In the AutoFormat dialog box that appears (see Figure
14-5), select a format from the list provided. You see a
preview of the design.

4. 1f you like, you can modify the settings for including
column and row headings and totals by selecting or
deselecting any of the four check boxes on the right side
of the dialog box.

5. Click OK to apply the selected formatting to the cell
range.
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Click a format
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Figure 14-5

Perform Simple Calculations

1. A spreadsheet program is way more than just a place to
list numbers and text. After you've entered some numbers
in your spreadsheet, you can use powerful spreadsheet
tools to perform simple or complex calculations, from
averaging a set of numbers to complex statistical analysis.
Click in a cell where you would like calculation results to
appear.

2. Choose Tools>Easy Calc or press the Easy Calc button
on the toolbar.

3. In the Easy Calc dialog box that appears (see Figure

14-6), click a function in the Common Functions list box
and then click Next.
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Click a function

Easy Calc

Click. the Function you want to use in your Formula,

Camman Functions

Add Multiplies bwa or more numbers Using a
Subtrack FDI'ITILIIE.
MUy A
Diivvicd
Average
Other functions
Cither | Displays a complete list of Functions

Cancel < Back Mext =

Figure 14-6

4. 1n the next Easy Calc dialog box (see Figure 14-7) enter a
range of cells, such as A1:C4, in the Range field. Or click
the button on the right of the Range field; the dialog box
is hidden, allowing you to click and drag on your spread-
sheet to select the cells you want to calculate. After you
make the selection, the dialog box appears again.

5. Click Next. In the Final Result dialog box, you can enter a
different cell location, such as G5, in the Result At text
box, and the result will be saved in the cell you indicate.
Click Finish to complete the calculation. The result of the
calculation now appears in the designated cell.

cell where you want to place the results and then click
the AutoSum button on the toolbar (which looks kind
of like a capital M turned sideways). Spreadsheet sug-
gests cells you might want to include in the calculation,
but you can click and drag to select more or different
cells. Click or press Enter to complete the sum.

@ To quickly add numbers, you can simply click in the
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Easy Calc @I“
SUM
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Figure 14-7

Complete a Series with Fill

1. Life consists of patterns, and spreadsheets make entering
items with patterns quick and easy. For example, if you
are entering a series of odd numbers (1, 3, 5, and so on),
you can use tools to complete the series automatically.
Enter some data in contiguous cells that constitute the
beginning of a series, such as 1, 2, 3, or January,
February, March. (See Figure 14-8.)

2. Click and drag over the data; a small handle appears at
the end of the series (in the bottom-right corner for items
in a column or at the far right for items in a row).

3. Click and drag the handle to add items to your series.
(See Figure 14-9.) For a series in a column, drag down,
but for a series in a row, drag to the right. For example, if
you entered January, February, and March in a column,
you might drag down nine blank cells to add the rest of
the months of the year. Works Spreadsheet completes the
series.
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Begin a data series Handle
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Figure 14-8

Drag the handle to fill out the series
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Figure 14-9
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Items in a series don’t have to be sequential. Works
Spreadsheet can detect patterns as well. For example,
if you enter 11, 22, and 33 and fill out the series, you
get 44, 55, 66, and so on. However, if selected data
has no discernable pattern, when you drag to fill, the
data will simply be repeated again and again.

Insert a Chart

1. If you want to see your data represented visually, the
Works spreadsheet can create attractive charts from your
data. To start, you have to first enter the data you want
your chart to be based on.

2. Click and drag over the data to select it and then click the
New Chart button on the toolbar.

3. In the resulting New Chart dialog box (see Figure 14-10),
click a Chart Type image to select it.

Click a chart type

New Chart ExT|
Basic Options | Advanced Options

Click the chart bypes until you find a chart you want and then specify the other display options you want,

Chark bype: Bar Preview:

r-w

0
= StaJanFebMarApr MaJun

B = eries 1

Specify a title and other display options.,

Chart title:

[ Show border [T] Show gridiines

OK | | Caniel

Figure 14-10
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4. Enter a title for the chart in the Chart Title text box. Click
the Show Border or Show Gridlines check boxes to apply
those effects.

5. Click OK to display the chart. (See Figure 14-11.) To
go back to the spreadsheet, you can choose Viewt>
Spreadsheet.

"1l Unsaved Spreadsheet - Chart1 - Microsoft Works Spreadsheet
File Edit View Format Tools Window Help

aval -0 C D@ E SRR e 7 [T e

Chapter 14: Working with Numbers and Finances

400

300

200

100

u]
Stamp Collection January February March Agpril May June

I Series 1

[press ALT to choose commands,

Figure 14-11

Format menu or on the Chart toolbar, such as the
Chart Type button or Borders button, to make
changes to chart type, borders used around the chart,
or font style or size.

@ After you insert a chart, you can use tools on the
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Get Advice about Finances Online

You can use the Internet to access a wealth of financial information
online. You can read current news stories, get advice about how to
invest, and connect with others to share information. Keep in mind
that the quality of information online can vary drastically, and you
can’t always believe everything you read. Try to find sites of reputable
financial companies you might know from your offline financial
dealings, such as Merrill Lynch or Forbes Magazine. Also, never give
out financial account numbers to anybody via e-mail, even if they
claim to be with a reputable company.

Here are some of the resources available to you for planning and
monitoring your finances. (See Chapter 18 for details about how to go
to any Web site.)

we  Visit sites such as www .money . cnn.com/magazines/
moneymag/money101 for simple financial lessons
about topics such as setting a budget and planning
your retirement, from CNN Money.

wa  Visit www . financialplan.about .com for
financial planning advice by age.

w= Search for online publications such as The Wall
Street Journal (www.wallstreetjournal.com),
Forbes (www . forbes . com), as shown in Figure 14-12,
or Kiplinger (www.kiplinger.com) for articles
about the latest financial and investing trends.

w= Check out online discussion forums such as www .
money .MSN. com to connect with others who are
interested in learning more about finances. However,
be very careful not to reveal too much personal
information to anybody you meet online, especially
about your specific finances and accounts.
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Figure 14-12

In the U.S., you're entitled to order a free credit
report from the three major credit reporting organiza-
tions every year, and you can order those reports
online. Visit www . annualcreditreport.com to
get started.

Windows 7 lets you display gadgets (little programs,
such as a calculator, that do handy things) on your
desktop. Add the Stocks gadget to check stock quotes
at a glance. See Chapter 12 for details on adding
gadgets.

Bank Online

Many people today are banking online because it's convenient. You
can typically make account transfers, check your balance, and even
download your account activity to a program such as Quicken to
manage your financial records or work with your taxes.
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Consider this information when banking online:

w= Most online banks, such as Barclay’s in the United
Kingdom (see Figure 14-13), have very strong security
measures in place; however, you should be sure that
you're using a secure Internet connection to go online.
If you use a hotspot in a hotel or airport that isn't pro-
tected, for example, it’s possible for someone to tap
into your online transactions. If you work on a home
network, you should have whoever sets up your net-
work enable security and a firewall. (See Chapter 23
for an introduction to basic security.) Also, if you use
a public wireless network such as those in airports or
hotels, don’t log on to any financial accounts.

w= You might need to set things up with your bank so
that you can access your account online and make
transfers among your different accounts. Talk to your
bank about what they require.
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Be careful to choose strong passwords (random com-
binations of letters, numbers, and punctuation are
best) for accessing your bank accounts. If you write
the passwords down, put them someplace safe. See
Chapter 20 for advice about strong passwords.

Be aware of your financial rights, such as how credit
cards and bank accounts are protected by law. The
FDIC Web site offers lots of information about your
banking and financial life at www. £dic.gov. It's spe-
cific to the U.S., but some of the advice about online
financial dangers is pertinent no matter where you live.

Invest Online

Every major broker has an online presence. Investing online is
convenient, and online brokers enable you to place buy or sell
orders very quickly and inexpensively. In addition, you can manage
investment accounts online.

Here are some tips for online investing:

2

-y

2

Understand the fees. Online brokerage fees are
typically lower than working with a full-service
broker. However, online broker fees can vary
widely. Shop around for a broker you trust with
reasonable fees.

Buyer beware. Though online banking is protected
by most federal governments including the United
States, online investment accounts don’t always
share similar protections, depending on what
country you live in. Consider asking your investment
counselor for advice about how protections work in
your country.

Handle various types of investments. Beyond
buying and selling stocks, you can invest in bonds,
deposit to your IRA or other retirement accounts,
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and more. Companies such as Fidelity (www .
fidelity.com) give you lots of investment
choices.

w= Retain offline access to your account. Remember
that one downside to online investing is that if your
laptop connection is down or your broker’s server is
down, you can’t get to your online brokerage to
invest. Keep a phone number handy so you can
reach your broker by an alternative method in the
case of technical glitches.

m= Check what others have to say. Visit sites such as
MotleyFool.com (see Figure 14-14) for articles
and advice on investing.
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Getting the Most
from Movies and
Digital Photos

M ost people today have access to a digital
camera (even if only on their cell

phones) and have started manipulating and
swapping photos, both online and off.
Windows allows you to view, share, and
organize photos and play movies with ease.

In this chapter you discover how to

m= Play movies with Windows Media Player.

w= [Upload photos from your digital camera.

w= View your photos and add tags and
ratings to help you organize and search
through photos.

w= E-mail a photo to others.

m= Burn photos to a CD or DVD to pass
around to your friends.

| “*op’rer
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Your laptop is a doorway into a media-rich world full of music, digital
photos, and movies. Your laptop provides you with all kinds of possi-
bilities for working with media. Windows 7 has two useful media pro-
grams built right into it: Windows Media Player and Windows Photo
Viewer. In combination, they give you the ability to play music and set
up libraries of music tracks; view, organize, and edit photos; and edit
and play your own homemade movies.

Here’s what you can do with each of these programs:

w= Windows Media Player (see Figure 15-1) is just

what its name suggests: a program you can use to
play music, watch movies, or view photos. It also
offers handy tools to create playlists (customized lists
of music you can build and play) and set up libraries
of media to keep things organized. You can even
burn media to a DVD so that you can play it on your
DVD player or another computer.

w= Windows Photo Viewer (see Figure 15-2) enables
you to work with digital photos; it opens automati-
cally when you double-click a photo file. You can
also burn (save) media to a disc or order prints from
within Photo Viewer.

w= [Ising photo properties in the Pictures library (see
Figure 15-3), you can organize your photos by add-
ing tags that help you search for just the photo you
need. You can also run slide shows using the Pictures
library.
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Play Movies with Windows Media Player

1. To open Windows Media Player and begin working with
music and movie files, click the icon with an orange
circle containing a right-facing arrow on the taskbar, or
choose Start=>All Programs>Windows Media Player. If
this is your first time using the player, you may be
prompted to make some basic settings.

2. Click the Maximize button in the resulting Media Player
window. (Maximize is the square icon in the upper-right
corner of the window, next to the X-shaped Close
button.)

3. Click Videos in the navigation pane to the left.

4. In the window listing video files, click the Library folder
that contains the movie you want to play (as shown in
Figure 15-4).
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Click the folder that contains the movie you want to play
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Figure 15-4

5. Double-click a file to begin the playback. (See Figure 15-5.)
Use tools at the bottom of the screen to do the following.
(If they disappear during playback, just hover your
pointer over that area to display them again.)

¢ Adjust the volume of any sound track by clicking
and dragging the slider left (to make it softer) or
right (to make it louder). Click the megaphone-
shaped volume icon to mute the sound (and click
it again to turn the sound back on).

e Pause the playback by clicking the round Pause
button in the center of the toolbar. (Click it again
to resume playback.)
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e Stop the playback by clicking the square-shaped
Stop button toward the left.

e Skip to the next or previous movie by clicking the
Next (rewind) and Previous (fast forward) arrow
buttons to the left and right of the Pause button.

6. Click the Close button to close Media Player when you're
done viewing the movie.

To stop the movie before it finishes, click the Stop
button. Note that the Previous and Next buttons
aren’t available for single movie clips — they jump

you from one track to another when playing sound
files.

Playing 'Wildlife in HD': 6134 K bits/second

= =EE

Figure 15-5
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If you own a smaller laptop or netbook, you may not
have a built-in DVD player. Consider buying an exter-
nal DVD drive that you attach through a USB port.

There are many small models that are highly portable.

Upload Photos from Your Digital Camera

Uploading photos from a camera to your laptop is a very simple
process, but this task helps you understand what'’s involved.
(Uploading photos is similar to the process you can use to upload
movies from a camcorder — in both cases, check your manual for
details.) Here are some highlights:

=y

2

[T 2

Installing software: Digital cameras also typically
come with software that makes uploading photos to
your laptop easy. Install the software and then follow
the easy-to-use interface to upload photos. If you're
missing such software, you can simply connect your
camera to your laptop and use Windows Explorer to
locate the camera device on your laptop and copy and
paste photo files into a folder on your hard drive.
(Chapter 5 tells you how to use Windows Explorer.)

Making the connection: Uploading photos from a
digital camera to a laptop requires that you connect
the camera to a USB port on your laptop using a
USB cable that typically comes with the camera.
Power on the camera or change its setting to a play-
back mode as instructed by your user’'s manual.

Printing straight from the camera: Cameras save
photos onto a memory card, and many printers
include a slot where you can insert the memory card
from the camera and print directly from it without
having to first upload pictures. Some cameras also
connect directly to printers. However, if you want to
keep a copy of the photo and clear up space on your
camera’s memory card, you should upload even if
you can print without uploading.
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View a Digital Image in the Windows Photo Viewer

1. To peruse your photos and open them in Windows
Photo Viewer, choose StartcvPictures.

2. In the resulting window, if there are folders in this
library, double-click one to display files within it.
Double-click any photo in any Pictures library folder. In
Windows Photo Viewer, as shown in Figure 15-6, you
can use the tools at the bottom (see Figure 15-7) to do
any of the following:

¢ The Display Size icon in the shape of a magnify-
ing glass displays a slider you can click and drag to
change the size of the image thumbnails.

e The Next and Previous icons move to a previous
or following image in the same folder.

¢ The center Play Slide Show button with a slide
image on it displays the images in your Picture
folder in a continuous slide show.

¢ The Rotate Clockwise and Rotate
Counterclockwise icons spin the image 90 degrees
at a time.

e The Delete button deletes the selected image.

If you want to quickly open a photo in another
application, click the Open button at the top of the

Windows Photo Viewer window and choose a pro-
gram such as Paint or Microsoft Office Picture
Manager.
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1111 000_0202 - Windows Photo Viewer
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Figure 15-7

Add a Tag to a Photo

1. Tags help to categorize photos so that you can search for
them easily. To create a new tag, choose Start=>Pictures.

Locate the photo you want, right-click it, and choose
Properties.
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2. In the Properties dialog box that appears, click the
Details tab. (See Figure 15-8.)

3. Click the Tags item and a field appears. Enter a tag(s) in
the field (see Figure 15-9) and click OK to save the tag.

4. Now if you display your Pictures library in Windows
Explorer in Details view, the tag is listed next to the
photo. Tags are also used when you view photos in
Windows Media Center.

log box again, click to the right of the tag, and press

@ To delete a tag, just display the photo Properties dia-
Backspace.

by tags, click the arrow on the Arrange By item and

@ To see a list of all photos in the Photo gallery organized
choose Tag.

Click the Details tab
|
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Property Value -
Description
Title =
Subject
Rating
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Comments
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Authors
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Date acquired 1/24/2009 7:55 AM
Copyright
Image
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Dimensions 3264 x 2448
Width 3264 pixels
Height 2448 pixels
L. | rmmels i ACN Aei 5
Remove Properties and Personal Information
[ ok |[ Cancel

Figure 15-8
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Enter a tag here
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Figure 15-9

E-Mail a Photo

1. Choose Start=>Pictures. In Pictures library, shown in
Figure 15-10 in Details view, click the check box to the
left of the thumbnail to select the photo; a check mark
appears in the check box to indicate that it’s selected. To
choose multiple photos, click the check boxes next to
additional thumbnails.

2. Choose FilecvSend To=>Mail Recipient. In the Attach Files
dialog box that appears (see Figure 15-11), change the
photo size by clicking the Picture Size drop-down arrow
and choosing another size from the list if you wish.
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Selected photos
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Figure 15-10

Choose smaller photos to attach to an e-mail because
graphic files can be rather big. You might encounter
problems sending larger files, or others might have
trouble receiving them. Using a smaller size is especially
important if you are sending multiple images.

il il = /[
Picture size: | Medium; 1024 x 768 L —

Total estimated size: 230 KB

| Click to change
the photo size

l Attach J | Cancel

Figure 15-11
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3. Click Attach. An e-mail form from your default e-mail
appears with your photo attached.

4. Fill out the e-mail form with an addressee, subject, and
message (if you wish), and then click Send.

Note that although you can send a video file as an

@ e-mail attachment, you can't resize it; video files
make photo files look tiny by comparison, so it’s
probably better to send one at a time, if at all.
Consider using a video-sharing Web site to post
videos online to share with others.

You can also use another method to include a photo

@ in an e-mail: Open an e-mail form first. Then, with
the Photo Viewer open, click and drag a photo to
your e-mail. This method attaches the original file
size to the message.

Burn a Photo to a CD or DVD

1. You can burn (save) a copy of your photos to a writable
disc to share them or back up your original copies. Insert
a writable disc into your disc drive. (You can save photo
files to CDs or DVDs.)

2. With the Pictures library open in Windows Explorer,
display a photo by locating it with the Navigation pane
and double-clicking the thumbnail to display it in
Windows Photo Viewer.

3. Click the Burn button and then choose Data Disc.

4. A balloon message appears on the taskbar indicating that
you have files waiting to be burned to disc. Click the
balloon, and a list of files waiting to be burned appears,
as shown in Figure 15-12.
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Figure 15-12

5. Click the Burn to Disc button. In the Burn to Disc dialog
box that appears, enter a name in the Disc Title field (the
default name is today’s date). Click Next when you're
ready to burn the disc.

6. A progress window appears. (See Figure 15-13.)

7. When the files have been burned to the disc, a confirma-
tion dialog box appears, and your disc drawer opens. Click
Finish to complete the process and close the dialog box.
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If you want to check the photos you've added before
you burn the DVD, click the Preview button in the
Ready to Burn DVD window.

) = Burn to Disc

Please wait..

Burning the data files to the disc...

Figure 15-13

Create and Play a Slide Show

1. You can use the photos in your Pictures Library to run
your own slide show. Choose Start=>Pictures. Double-
click the Pictures library to display all pictures within it.

2. Click an image to select it. Holding down the Ctrl key,
click additional images to select all the photos you want
to appear in the slide show. (See Figure 15-14.)

3. Click the Slide Show button. The first image appears in a
separate full-screen display. The slides move forward
automatically, cycling among the photos repeatedly. (See
Figure 15-15.)
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4. Press Escape to stop the slide show.

If you want a more sophisticated slide show feature,
check out Windows Media Center. Here you can cre-
ate and save any number of custom slide shows, reor-
ganize slides, and edit slide shows to add or delete
photos. You might also consider a commercial slide
show program such as Microsoft PowerPoint if you
want to create more complex slide shows.

Photos selected for slide show
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Figure 15-15
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Playing Music
in Windows 7

Music is the universal language, and your
laptop opens up many opportunities for

appreciating it at home or on the road. For
example, on your laptop you can listen to your
favorite music, download music from the
Internet, play audio CDs and DVDs, and
organize your music by creating playlists. You
can also save (or burn, in computer lingo)
music tracks to a CD/DVD or portable music
device such as the hugely popular iPod.

With a sound card installed and your laptop’s
built-in speakers, you can use Windows media
programs to do the following:

w= Getting your laptop ready for listening by
setting up your speakers and adjusting
the volume.

w= Playing music using Windows Media
Player.

w= Managing your music by creating
playlists of tracks you download.

w= Burning tracks to CD/DVD or syncing
with portable music devices.

w= Making settings to copy music from CD/
DVDs to your laptop (called ripping).

| “*opter

Getready to. ..

w= Set Up Speakers................ 248
w= Adjust System Volume ....... 249
w=> Create a Playlist ............... 251
w= Burn Music to a

CD/DVD....cvvevvveiiiene, 252
= Sync with a Music

Device ...covvvviiiiiiiinn, 254
wm Play MUSIC ......ooviiiinen. 255
= Make Settings for

Ripping Music .................. 257
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Set Up Speakers

1. Your laptop probably has built-in speakers. If you prefer,
you can attach external speakers to your laptop by plug-
ging them into the appropriate connection (often labeled
with a little megaphone or speaker symbol).

2. Choose Start>Control Panelt®Hardware and Sound; then
click the Manage Audio Devices link (under the Sound

category).

3. In the resulting Sound dialog box (see Figure 16-1), click
the Speakers item and then click the Properties button.

4 Sound R = T

Playback |Recording | Sounds | Communications|

Select a playback device below to modify its settings:

MNVIDIA HDMI Output
NVID Audic

Realtek Digital Output
g Ready

[ 0K J| Cancel J

Click on Speakers... Then click Properties
Figure 16-1

4. In the resulting Speakers Property dialog box, click the
Levels tab and then use the Speakers slider, as shown in
Figure 16-2, to adjust the speaker volume. Note: If there
is a small red x on the speaker button, click it to activate
the speakers.
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] Speakers Properties e it (23]
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Click and drag the slider
PC Beep -
[ 100 |ﬂ| | Balance |
Microphone
[} 91 |ﬂ| | Balance |
| OK | | Cancel

Figure 16-2

5. Click the Balance button. In the resulting Balance
dialog box, use the L(eft) and R(ight) sliders to adjust
the balance of sounds between the two speakers.

6. Click OK three times to close all the open dialog boxes
and save the new settings.

Adjust System Volume

1. You can set the master system volume for your laptop
to be louder or softer. Choose Starte>Control Panel=>
Hardware and Sound.

2. Click the Adjust System Volume link under Sound to display
the Volume Mixer dialog box (as shown in Figure 16-3).

3. Make any of the following settings:

e Move the Device slider to adjust the system's
speaker volume up and down.
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e For sounds played by Windows (called system
sounds), adjust the volume by moving the
Applications slider.

e To mute either main or application volume, click
the speaker icon beneath either slider so that a red
circle appears.

4 Volume Mixer - Speakers (Realtek High Definition Audio)

Device
& £y

Speakers - Windows Sounds

=

Applications

I_I

Figure 16-3

4. Click the Close button on each of the dialog boxes.

®

®

Here’s a handy shortcut for quickly adjusting the vol-
ume of your default sound device. Click the Volume
button (which looks like a little gray speaker) in the
notifications area of the taskbar. To adjust the vol-
ume, use the slider on the Volume pop-up that
appears, or select the Mute Speakers button to turn
off sounds temporarily.

Today, most laptop keyboards include volume con-
trols and a mute button to control sounds; sometimes
these are included in the function keys along the top
of the keyboard. Some even include separate buttons
to play, pause, and stop audio playback. Having these
buttons and other controls at your fingertips can be
worth a little extra in the price of your laptop.



Create a Playlist

1. A playlist is a saved set of music tracks you can create
yourself — like building a personal music album. Choose

Start=>All Programs>Windows Media Player.

2. Click the Library button and then click the Create Playlist
button. A playlist appears in the Navigation pane on the
left, open for editing. Type a name for the playlist and
then click anywhere outside the playlist to save the name.

3. Double-click a category (for example, Music) to display
libraries, and then double-click a library in the left pane;
the library contents appear. (See Figure 16-4.) Click an

item and then drag it to the new playlist in the

Navigation pane. Repeat this step to locate additional

titles to add to the playlist.

Click an item in the Library contents

[] Windows Media Player

@\) » Library » Music + All Music

Send Feedback | = |[ = |[=3]

Play Burn sync

Organize » » 9= v [ ean

e @ | SaveList P+ Zv

The Mojo Mom Podc...
Amy Tiemann -- Magj...
Podcast

2009

Streisand Alternate Theme %20 [~ Drag items here
Traditional Chistinas 319 to create a playlist
Loretta Lynn Country lingle 3:20 N
= kil Mood Music 3:19 Play favorites
@2 O | . e ('9’1 el 4 & =

| Unsaved List

Mojo Mom and Internet.., 41:06 b

Figure 16-4

Then drag the item to the new playlist
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4. To play a playlist, click it in the Library pane and then
click the Play button.

5. You can organize playlists by clicking the Organize but-
ton (see Figure 16-5) and then choosing Sort By. In the
submenu that appears, sort by features such as title, art-
ist, or release date.

Click the Organize button

|| Windows Media Player (~= 1" = RN Eol Ex )
» Library + Music » All Music Play e T
» 2 v [ Searc P +| @ I Savelist ClearList P~ @
Manage Libraries » | Title Length
Mood Music
Apply Media Information Changes Mped Mibic
Mojo Mem and Internet...  41:06 ! S
Choose Columns... i & Streisand
Sort By » Title ‘ Tr
hop
Customize Navigation Pane... Album artist
Menu bar Album = Unsaved List =
Options... Release date » Mood Music - Trad 319
Traeionar | Date taken Country lingle ona 3:20
Streisand Rating 320 Maojo Mom and Internet Safety 41:06
Traditional File name 3:19
Loretta Lynn " Country Jingle 320
< 1999 Mood Music 219
| Streisand wdz O | B (4 f@"u PRl 4 & S

Figure 16-5

and choose Play to play it or choose Delete to delete
the list, though the original tracks that make up the
list still exist.

Burn Music to a CD/DVD

1. Saving music files to a storage medium such as a CD or
DVD is referred to as burning. You might burn music to a
disc so that you can take it to a party or another location.

@ You can also right-click a playlist in the Library pane
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Insert a blank CD or DVD suitable for storing audio files
in your laptop CD/DVD-RW drive.

2. Open Windows Media Player, click the Burn tab, and
then click one or more songs, albums, or playlists and
drag them to the Burn pane. (See Figure 16-6.)

[ windows Media Player Bl bl (= [
Q@ » Library » Music » All Music Play Burn Sync
Organize » » = v [Search o vl @ e it Clear List P~ A
Album
Amy Tiemann -- Majo Mom .
The Mojo Mom Podc... Mojo Morn and Internet... 4106 g Conpeciabuncrand
Amy Tiemann -- Moj... "i/ restart the player
Podcast
2009
Burn List
Traditional Alternate Theme 3:20
Streisand Alternate Theme 3:20 Country lingle 3:20
Traditional Christmas 310
J Loretta Lynn Country Jingle 3:20
> 1999 Moad Music 319
Mood Music  01:50 v O H 44 f'@'w el 4| = H=4
i) i

Songs placed in the Burn pane
Figure 16-6

3. Click Start Burn. Windows Media Player begins to burn
the items to the disc. The Status column for the first song
title reads Writing to Disc and changes to
Complete when the track is copied.

4. When the burn is complete, your disc is ejected.
(However, you can change this option by clicking the
Burn Options button and choosing Eject Disc After
Burning to deselect it.)

If you swap music online through various music-
sharing services and then copy them to CD/DVD
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®

and pass them around to your friends, always
perform a virus check on the files before handing
them off. Also, be sure you have the legal right to
download and swap that music with others.

Note that optical discs come in different types,
including CD-R (readable), CD-RW(read/writable),
DVD+, DVD- and DVD+/-. You must be sure your
optical drive is compatible with the disc type you
are using or you cannot burn the disc successfully.
Check the packaging for the format before you
buy!

If you own a netbook, you should know by now that
it doesn’t include an optical drive. Your recourse is to
buy an external drive which you can connect to your
netbook using a USB port.

Sync with a Music Device

1. If you have a portable music player, such as an iPod or
another type of MP3 player, you can sync it to your lap-
top to transfer music files. Connect the device to your
laptop and open Windows Media Player.

2. Click the Sync tab; a Device Setup dialog box appears.
(See Figure 16-7.)

3. Name the device, and click Finish. The device is
now synced with Windows Media Player and will be
automatically updated whenever you connect it to
your laptop.

®
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To add items to be synced to a device, with the Sync
tab displayed simply drag items to the right pane. If
you are connected, or the next time you connect, the
items are copied onto the device automatically.
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If you want to be sure that the sync is progressing,
click the Sync Options button (it's on the far-right
side at the top of the Sync tab and looks like a little
box with a check mark in it) and choose View Sync

Status.
|ZWindows Media Player - Device Setup o AN
wl Device Setup
Lexar (7.4 GE) Configure Sync

Mame your device:

iPod|

When you dick Finish, your device will be updated to mirror your Windows Media Player
library. In the future, the device will be updated whenever you connect it to your computer.

What are my options with sync?

Finish | cancel |

Figure 16-7

Play Music
1. Choose Start=>All Programs>Windows Media Player.

2. Click the Library button and then double-click Music or
Playlists to display a library like the one shown in
Figure 16-8. Double-click an album or playlist to open it;
the titles of the songs are displayed in the right pane.

3. Use the buttons on the bottom of the Player window
(as shown in Figure 16-9) to do the following:

e Click a track, and then click the Play button to
play it. When a song is playing, this button
changes to the Pause button.
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¢ Click the Stop button to stop playback.

e Click the Next or Previous buttons to move to the
next or previous track in an album or playlist.

e Use the Mute and Volume controls to pump the
sound up or down without having to modify the
Windows volume settings.

|2 Windows Media Player il bl (o [ ==
h‘?'\) » Library » Music » All Music Play Burn Sync
Organize » » OZ | P ~| @ | savelist ClearList P~ A+
Traditional
Streisand Alternate Theme 3:20
Traditional Christmas 318
Loretta Lynn Country Jingle 3:20
1999 ood Music 3:1
Unsaved List =
Country Jingle 3:20
Mojo Mom and Internet Safety 41:06
| Mood Music 0028 & O | B | I44 !_[y PRl 4 = =

Figure 16-8

Stop Mute

Play/Pause
|

| 2 |
I Mood Music 0108 | & C_I) o [ leq i@] ] T

Repeat List Next

Shuffle List

nm
1=

Previous Volume

Figure 16-9
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Tired of the order in which your tracks play? You can
use the List Options button on the Play Pane and
choose Shuffle List to have Windows Media Player
play the tracks on your album randomly. Click this
button again to turn the shuffle feature off.

and Previous buttons you can double-click a track in
the track list in the Media Player window. This can be
much quicker if you want to jump several tracks
ahead or behind of the currently playing track.

@ To jump to another track, rather than using the Next

Make Settings for Ripping Music

1. If you place a CD or DVD in your disc drive, Windows
Media Player will ask if you want to rip the music from
the disc to your laptop. Doing so stores all the tracks on
your laptop. To control how ripping works, open
Windows Media Player, click the Organize button, and
choose Options.

2. Click the Rip Music tab to display it.

3. In the resulting Options window (see Figure 16-10) you
can make the following settings:

¢ Click the Change button to change the location
where ripped music is stored; the default location
is your Music folder.

e Click the File Name button to choose the informa-
tion to include in the filenames for music that is
ripped to your laptop. The File Name Options dia-
log box appears, as shown in Figure 16-11, and
click OK when you're done.

e Choose the audio format to use by clicking the
Format drop-down list.
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e Many audio files are copyright protected. If you

have permission to copy and distribute the music
you might not want to choose the Copy Protect
Music check box; however, if you are downloading
music you paid for — and, therefore, should not
give away copies of — you should ethically choose
to Copy Protect music so that Windows prompts
you to download media rights or purchase another
copy of the music when you copy it to another
location.

If you don’t want to be prompted to rip music
from CD/DVDs you insert in your drive, but
instead want all music ripped automatically, click
the Rip CD Automatically check box.

If you want the CD/DVD to eject automatically
after ripping is complete, select the Eject CD after
Ripping check box.

Use the Audio Quality slider to adjust the quality
of the ripped music. The Smallest Size will save
space on your laptop by compressing the file, but
this causes a loss of audio quality. The Best
Quality will provide optimum sound, but these
files can be rather large. The choice is yours based
on your tastes and your laptop’s capacity!

4. When you finish making settings, click the OK button to
save them and close the Options dialog box.



v, Specify where music is stored and change rip settings.

Rip music to this location

C:\UsersiOwnerMusic

Rip settings
Format:
Windows Media Audio i |
Copy protect music Learn about co

Rip CD automatically

Options R R
Librany Plug-ins Privacy Security DD Metwork
Player Rip Music Devices Bum Performance

File Mame... |

S e B R b G LS L

Eject CD after ripping
Audio quality:
Smallest n Best
Size 4 Quality
Uses about 56 MB per CD {128 kbps).
| QK | | Cancel Help
L]
Figure 16-10

File Name Options el P

Set file naming convention to use when ripping music,

Options

Select the details you want to indude in file names.
Click Move Up or Move Down to arrange the detail order.

Alburn
| Track number Move Down
7| Song title
| Genre
Bit rate

Separator: | (Space) -

Preview:
01 Sample Song Mame, WMA

Ok Cancel

Figure 16-11
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Playing Games
in Windows 7

A s a senior, you may have earned your way
to retirement and need fun activities to fill
up your days. If so, you'll be happy to hear
that Microsoft has built plenty of games into
Windows 7 to keep you amused. If not, you
need games to relieve the stress of your job!

Many computer games are essentially virtual
versions of games that you already know, such
as solitaire and chess. But Windows has added
some interesting treats to the mix — several
that depend to a great extent on some neat
onscreen animation.

Altogether, you can access eleven games through
Windows, and this chapter gives you a sampling
of the best of them. Here’s what you can expect:

w= Traditional card games, such as Solitaire
and Hearts

w= Games of dexterity, such as Minesweeper,
where the goal is to be the fastest, smart-
est clicker in the West

w= An online version of chess called Chess
Titans that helps you hone your chess
strategy against another player or your
computer

w= A world of online gaming

| “*op’rer

17

Getready to. ..

w= Play Solitaire .................... 262
w= Play FreeCell .................. 265
w= Play Spider Solitaire.......... 267
w= Play Minesweeper............. 269
w= Play Hearts...........ccccoe.e... 271
w= Play Chess Titans.............. 273
w= Play Online Games........... 274
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No matter what your comfort level with computers, these games are
pretty darn fun and easy to play, so why not give them a try?

Play Solitaire

1. Choose Start=>Games. If this is the first time you're playing
games, Windows displays a Set Up Game dialog box. If it
does, make choices (like whether to automatically check
for game updates) and click OK. In the resulting Games
window, (see Figure 17-1), double-click Solitaire.

i (o ((E =]

I’\JU |‘v’: » Games - |¢¢| | Search Games Lo |
File Edit View Tools Help
Organize » Options Tools « Parental Controls e > O 9
_f‘ | Internet Checkers i s il
\ Microsoft Corporation \ ; 1/
' " d
£ N
Yo | Internet Spades
= Mahjong Tltans
‘%l ! oft Corporation -
by This computer's Performance
s Mlnesweeper

Information has not been created.

Rate this computer

P Purble Place Learn more
‘9 .-\ Microsoft Corporation
: Solitaire 3
’!I' Microsoft Corporation
| crosoft Corporatic
2 Spider Solitaire
1 “ Microsoft Corporation :
'@- 12 items
E ]
12items

Double-click Solitaire
Figure 17-1

2. In the resulting Solitaire window, if you need help with
game rules, read the How to Play message that appears.
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When you're ready to play, click a card (see Figure 17-2)
and then click a card in another deck that you want to
move it on top of. The first card you click moves.

Click a card

Time: 10 Score: 3

Figure 17-2
3. When playing the game, you have the following options:

¢ If no moves are available, click the stack of cards
in the upper-left corner to deal another round of
cards.

e If you move the last card from one of the six laid-
out stacks, leaving only face-down cards, click the
face-down cards to flip one up. You can also move
a King onto any empty stack.

e When you reach the end of the stack of cards in
the upper-left corner, click them again to redeal
the cards that you didn't use the first time.
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e You can play a card in one of two places: either
building a stack from King to Ace on the bottom
row, alternating suits; or starting from Ace in any
of the top four slots, placing cards from Ace to
King in a single suit.

e When you complete a set of cards (Ace to King),
click the top card and then click one of the four
blank deck spots at the top-right area of the win-
dow. If you complete all four sets, you win.

4. To deal a new game, choose Gamer>New Game (or press
F2). Unlike life, it’s easy to start over with Solitaire!
When prompted, choose Quit and Start a New Game.

5. To close Solitaire, click the Close button.

®

To change settings for the game, choose Gamer>
Options. The two main settings you'll probably deal
with here are Draw (which gives you an option of
turning over one card or a stack of three cards on
each deal) and Scoring (which offers the option of
not using scoring at all, or using Standard or Vegas-
style scoring). Standard scoring starts you off with
nothing in the bank and pays you $5 or $10 for
every card you place, depending on whether you
place it on the lower stacks or the area where you
place Aces. Vegas-style is a bit more complex, starting
you off with a $52 debit ($1 per card in the deck),
and crediting you $5 per card you place in the Aces
area, with the object being to come out in the black
(money-wise, that is) at the end. You can also choose
to time your game.

Don't like a move you just made? Undo it by choos-
ing Gamer>Undo. This works for the last move only,
however. You can also get unstuck if you're on a los-
ing streak by choosing Game= Hint.



®

If you're using your laptop on battery power, keep an
eye on the battery level as you play games. Because
they use a bit more power to display graphics and
sometimes animations, you may find your battery
drains quickly and you could be surprised if you've
gotten absorbed in your game.

Play FreeCell

1. FreeCell is a variation on solitaire. Choose Start>Games;
in the Games window, double-click FreeCell.

2. In the resulting FreeCell window, as shown in Figure
17-3, a game is ready to play. If you want a fresh game,
you can always choose Gamer>New Game; a new game is
dealt and ready to play.

®

The goal is to move all the cards, grouped by the four
suits, to the home cells (the four cells in the upper-
right corner) stacked in order from Ace at the bottom
to King at the top. The trick here is that you get four
free cells (the four cells in the upper-left corner)
where you can manually move a card out of the way
to free up a move. You can also use those four slots
to allow you to move up to four cards in a stack at
once. (For example, you might want to move a Jack,
10, 9, and 8 all together onto a Queen.) You can
move only as many cards as there are free cells avail-
able plus one. Free spaces in the rows of card stacks
also act as free cells. You win when you have four
stacks of cards for each of the four suits placed on the
home cells.

3. Click a card; to move it, click a free cell or another card at
the bottom of a column. Figure 17-4 shows a game
where two free cells are already occupied.
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Figure 17-3

Two occupied free cells

S FreeCell e (o o]
Game Help

Game # 615 Cards left 52

Figure 17-4
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@ If you move a card to a free cell, you can move it

back to the bottom of a column, but only on a card
one higher in an alternate color. You could move a 3
of hearts to a 4 of spades, for example. You stack

the cards in the columns in alternating colors,

but the cards in the home cells end up in order and
all in one suit.

@ If you get hooked on this game, try going to www .

freecell.org, a Web site devoted to FreeCell.
Here you can engage in live games with other play-
ers, read more about the rules and strategies, and
even buy FreeCell merchandise. Don't say I didn’t
warn you about the possibility of addiction.

Play Spider Solitaire

1.

3.

4.

Choose Start>Games; in the Games window, double-
click Spider Solitaire. If you've never played the game
before, the Select Difficulty window appears. Click your
comfort level: Beginner, Intermediate, or Advanced.

In the resulting game window, click a card and then click
another card or drag it to the bottom of another stack or
to an empty stack so that you match the same suit in

each stack, moving in descending order from King to Ace.

(See Figure 17-5.)

Move a card to automatically turn over a new card in the
stack.

After you complete a set of cards in a suit, those cards are
moved off the game area. The goal is to remove all the
cards in the fewest moves. You can

e Deal a new set of cards. Choose Gamer>New
Game or click the stack of cards in the bottom-
right corner to deal a new set of cards. (Note: You
are prompted to quit, restart, or keep playing;
choose Keep Playing.)
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e Save your game. Choose Gamer>Exit and then click
Save in the Exit Game dialog box to save your game.

¢ Change the options. Choose Gamer>Options (see
Figure 17-6) and select a new difficulty level.
Other options mainly affect how or whether you
save games and open them to continue, and
whether the variously annoying or angelic sounds
play when you click a card, deal a card, or fold a
stack (assuming your laptop system is set up with
a sound card and speakers).

Stack same-suited cards in descending order

| @/ spider Solitaire i (=GRS
Game Help

Score: 491 Moves: 9

Figure 17-5

5. When you finish playing, click the Close button and either
click Save or Don’t Save in the Exit Game dialog box.
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Stuck for a move? Try choosing Gamer>Hint. Various
combinations of cards are highlighted in sequence to
suggest a likely next step in the game. If you're not
stuck but just bored with the appearance of the game,
choose Gamer>Change Appearance and select
another desk and background style.

Options e LA

Difficulty

@ Beginner
One suit

Intermediate
Two suits

Advanced
Four suits

/| Display animations

/| Play sounds

J| Show tips
Always continue saved game
Always save game an exit

QK Cancel

Figure 17-6

Play Minesweeper

1. Choose Startt>Games; in the Games window, double-
click Minesweeper. If you've never played the game, a
Select Difficulty dialog box appears. Click your selection.

2. The Minesweeper game board opens. (See Figure 17-7.)
Click a square on the board, and a timer starts counting
the seconds of your game.

e If you click a square and numbers appear in
various squares, the number tells you how many
mines are within the up to eight squares surrounding
that square; if it remains blank, there are no mines
within the eight squares surrounding it.

e If you click a square and a bomb appears, all the
hidden bombs are exposed (see Figure 17-8), and
the game is over.
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e Right-click a square once to place a flag on it marking
it as a mine. Right-click a square twice to place a
question mark on it if you think it might contain a
bomb to warn yourself to stay away for now.

¥ Minesweeper [ i (=12 ==
Game Help

— Click any square to start

Figure 17-7

G Mineswoeper | INEEMEN (= = es]
Game Help
T | |
1(2]2]1] |»
2/#{3]1
Ji|. 3 2
1 12 — Clicking a bomb ends the game
1/1] [1[2]# 1
2[#{3]1
1[1[1]22]
SO 111 i
Y SO

Figure 17-8

3. To begin a new game, choose Gamer>New Game. In the
New Game dialog box, click Quit and Start a New Game.
If you want to play a game with the same settings as the
previous one, click Restart This Game.
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4. You can set several game options through the Game
menu:

e To change the expertise required, choose
Game=Options and then choose Beginner,
Intermediate, or Advanced.

e To change the color of the playing board, choose
Game=>Change Appearance.

e If you want to see how many games you've won,
your longest winning or losing streak, and more,
choose Gamer>Statistics.

5. To end the game, click the Close button and, when
prompted to save the game, click Save or Don’t Save.

If you want a bigger game board (more squares,
more bombs, more fun) choose Game=>Options and

then click Custom and specify the number of squares
across, down, and the number of bombs hidden
within them.

Play Hearts
1. Choose StartevGames and double-click Hearts.

2. In the resulting Hearts window, as shown in Figure 17-9,
your hand is displayed while others are hidden. Begin
play by clicking three cards to pass to your opponent,
and then click the Pass Left button. (It's the big arrow
above the bottom row of cards.)

3. Each player moving clockwise around the window plays
a card of the same suit by clicking it. The one who plays
the highest card of the suit in play wins the trick. (A trick
is the cards you collect when you play the highest card of
the suit.)
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Click to pass three selected cards

Owner

R R EEX v‘
¥

Y BRI

Points taken this hand: 0

Figure 17-9

4. Choose Game=>Options to change the settings shown in
Figure 17-10. You can rename the other three players,
play sounds, show tips, or specify how to save a game.

Options EEL = T
Computer Player Mames
Wast
Marth

East

[V] Display animations

!_-J_'éPlay sounds

[V] show tips

EAIways cantinue saved game

'_ :Always save game on exit

| OK | | Cancel

Figure 17-10

5. To end the game, choose GamerExit or click the Close
button. When prompted, either Save or Don’t Save the
game.
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@ Check out the menus in the Games window for

organizing and customizing the various games that
Windows 7 makes available and to set Parental
Controls.

Play Chess Titans

1.

Chess is an ancient game of strategy. If you're a chess buff,
you'll enjoy playing a computer opponent in the Windows
version, Chess Titans. To begin playing chess, choose Start=>
Games; in the Games window, double-click Chess Titans.
The first time you play the game, the Select Difficulty win-
dow appears. Click a skill level to start a game.

In the resulting Chess Titans window, a new game is
ready to play. By default, a new game will be played
against the computer, but you can choose to play another
person when you start a new game. If you want to start a
new game at any time, you can always choose Gamer>
New Game Against Computer or New Game Against
Human; a new game is ready to play.

Click a piece; all possible moves are highlighted. To
move the piece, click the space where you want to
move it. Once you make a play, your opponent (either
the computer or another human) moves a piece.
Figure 17-11 shows a game in progress with possible
moves highlighted.

moves are not highlighted. Choose Game=>Options.

@ You can change the game options so that possible

In the resulting Options window, deselect the Show
Valid Moves check box and then click OK. The
Options dialog box also lets you control a variety of
other settings, including whether you're playing as
black or white, whether to show tips or play sounds,
and the quality of graphics. If you're new to the
game, which is rather complex, try visiting www .
chess. com for beginner instructions and strategies.
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Possible moves are highlighted

Figure 17-11

Don'’t like the look of your chess board? You can

@ modify it to look like a different material, such as
wood. Choose Game>Change Appearance. In the
Change Appearance window, click a style of chess
piece and a style of chess board. Click OK to save
your settings.

Play Online Games

There are thousands of gaming sites online that let you interact with
other players from around the world. Search in your browser using
keywords such as card games or chess to find them. Some are simple
games like poker or chess. Others are part of sophisticated virtual
worlds where you take on a personality, called an avatar, and can even
acquire virtual money and goods.

Here are some tips for getting involved in online gaming and some
advice for staying safe:
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Safety first! You're playing games with strangers, so
avoid giving out personal information or choosing a
revealing username. If somebody is inappropriately
emotional or abusive while playing the game, leave
the game immediately and report the player to the
site owner.

In some cases, you can play a computer; in others,
you're playing against other people that the game
site matches you up with. You can usually request a
level of play, so if you're a beginner, you can feel
comfortable that you'll be matched with other
beginners.

To play some games, you might need additional soft-
ware, such as Adobe Shockwave Player or software to
enable your laptop to play animations. If you see
such a message on a game site, be sure you're down-
loading software from a reputable source that has a
good privacy policy for users and credentials like a
Better Business Bureau seal so that you don't down-
load a virus or spyware.

Many games are free, though some require that you
enter information about yourself to become a mem-
ber. Read the fine print carefully when signing up.

Many game sites offer tutorials or practice games to
help you learn and improve. Figure 17-12 shows the
Tutorial page for Legends of Norrath, a multiplayer
online role-playing game.

Some games allow several players to participate at
once, so you might have to be on your toes! In addi-
tion to manipulating pieces or characters, you might
also be able to communicate with other players
using instant messaging or even voice messages.
Chapter 22 explains how instant messaging works.

Chapter 17: Playing Games in Windows 7
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Figure 17-12

m= Online gaming can be addictive, so be as moderate
in your playing online as you are offline. Remember
that these games are just for fun.

If you aren’t comfortable making the moves required
when playing games with your laptop’s touchpad or
other style of built-in mouse, it might be worth
investing in a wireless mouse. Many highly portable
models exist, and they are easy to connect, use, and
carry with you on the road.
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Understanding
Internet Basics

M any people buy a laptop mainly to tap
into the wonderful opportunities the
Internet offers. You can use the Internet to
check stock quotes, play interactive games with
others, and file your taxes, for example. For
seniors especially, the Internet can provide
wonderful ways to keep in touch with family
and friends located around the country or on
the other side of the world via e-mail or instant
messaging. You can share photos of your
grandchildren or connect with others who
share your hobbies or interests.

But before you begin all those wonderful
activities, it helps to understand some basics
about the Internet and how it works.

This chapter helps you to understand what the
Internet and World Wide Web are, as well as
some basics about connecting to the Internet
and navigating it.

Understand What the Internet Is

The Internet, links, the Web . . . people and the
media bounce around many online-related
terms these days, and folks sometimes use
them incorrectly. Your first step in getting
familiar with the Internet is to understand
what some of these terms mean.

| “*op’rer

Getready to. ..

w= Understand What the
Internet IS ..ooovveveneeeee, 279

w= Explore Different Types of
Internet Connections.......... 281

w= Set Up an Internet

Connection.......cccocceveunnn... 285
w= Navigate the Web............ 287
w= Use Tabs in Browsers ........ 289

w= Set Up a Home Page ........ 292
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Here's a list of common Internet-related terms:

I

nmp

=y

nmp

nmp

I

The Internet is a large network of computers that
contain information and technology tools that can
be accessed by anybody with an Internet connection.
(See the next task for information about Internet
connections.)

Residing on that network of computers is a huge set
of documents, which form the World Wide Web,
usually referred to as just the Web.

The Web includes Web sites, which are made up of
collections of Web pages just as a book is made up of
chapters that contain individual pages. Web sites can
be informational and/or host communication tools
such as chats or discussion boards that allow people
to “talk” via text messages.

You can buy, bid for, or sell a wide variety of items
in an entire online marketplace referred to as the
world of e-commerce.

To get around online, you use a software program
called a browser. There are many browsers available,
and they're free. Internet Explorer is Microsoft's
browser; others include Mozilla Firefox, Google
Chrome, and Opera. Browsers offer tools to help you
navigate from Web site to Web site and from one
Web page to another.

When you open a Web site, you might see colored
text or graphics that represent hyperlinks, also
referred to as links. You can click links to move from
place to place within a Web page, on a Web site, or
between Web documents. Figure 18-1 shows some
hyperlinks indicated by highlighted text (such as
Don't Miss Out) or graphics (like the Free Download
button).
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Figure 18-1

A link can be a graphic (such as a company logo) or
text. A text link is identifiable by colored text, and it's

usually underlined. After you click a link, it usually
changes color to show that you've followed the link.

Explove Different Types of Internet Connections

Before you can connect to the Internet for the first time, you have to
have certain hardware in place and choose your Internet service provider
(also referred to as ISP or simply a provider). An ISP is a company that
owns dedicated computers (called servers) that you use to access the
Internet. ISPs charge a monthly fee for this service.

In the past, you could sign up with an ISP such as Microsoft's MSN to
get dial-up access (that is, access via your regular phone line) to the
Internet. Today, many people pay to access the Internet through their
telephone or cable-television provider, whose connections are much
faster than a dial-up connection. Companies such as AOL, which was
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once a top dial-up service provider, now focus on the content they
provide, such as news, human-interest stories, horoscopes, and games.

You can choose a type of connection to go online. Depending on the
type of connection you want, you will go to a different company for
the service. For example, a DSL connection might come through your
phone company, whereas a cable connection is available through your
cable-TV company. Wireless connections are so convenient when you
travel with your laptop. You can use them for free at Wi-Fi hotspots, or
you can subscribe to a wireless network so that you can pick up Wi-Fi
signals as you roam.

Not every type of connection is necessarily available in every area, so
check with phone, cable, and small Internet providers in your town to
find out your options and costs. (Some offer discounts to AARP mem-
bers, for example.)

Here are the most common types of connections:

w= Dial-up connections: With a dial-up connection,
you plug your laptop into a phone line at home or
at a hotel room or friend’s house to connect to the
Internet, entering a phone number that’s provided
by your ISP. This is the slowest connection method,
but it’s relatively inexpensive. Your dial-up Internet
provider will give you local access numbers, which you
use to go online. Using these local access numbers,
you won't incur long distance charges for your con-
nection. However, with this type of connection, you
can’t use a phone line for phone calls while you're
connected to the Internet, so it's no longer a very
popular way to connect.

w= Digital Subscriber Line: DSL also uses a phone line,
but your phone is available to you to make calls even
when you're connected to the Internet. DSL is a form
of broadband communication, which may use phone
lines and fiber-optic cables for transmission. You have
to subscribe to a broadband service (check with your
phone company) and pay a monthly fee for access.
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Cable: You may also go through your local cable
company to get your Internet service via the cable
that brings your TV programming rather than your
phone line. This is another type of broadband ser-
vice, and it’s also faster than a dial-up connection.
Check with your cable company for monthly fees.

Satellite: Especially in rural areas, satellite Internet
providers may be your only option. This requires
that you install a satellite dish. BlueDish and
Comcast are two providers of satellite connections to
check into.

Wireless hotspots: If you take a wireless-enabled
laptop computer with you on a trip, you can piggy-
back on a connection somebody else has made. You
will find wireless hotspots in many public places,
such as airports, cafes, and hotels. If you're in range
of such a hotspot, your laptop usually finds the con-
nection automatically, making Internet service avail-
able to you for free or for a fee.

Internet connections have different speeds that depend partially on
your laptop’s capabilities and partially on the connection you get from
your provider. Before you choose a provider, it's important to under-
stand how faster connection speeds can benefit you:

[T 2

1=

Faster speeds allow you to send data faster. In addi-
tion, Web pages and images display faster.

Dial-up connection speeds run at the low end, about
56 kilobits per second, or Kbps. Most broadband
connections today are around 500 to 600 Kbps. If
you have a slower connection, a file might take min-
utes to upload (for example, a file you're attaching to
an e-mail). This same operation might take only sec-
onds at a higher speed.
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Depending on your type of connection, you'll need different
hardware:

w= A broadband connection uses an Ethernet cable and
a modem, which your provider should make avail-
able, as well as a connection to your phone or cable
line.

w= Some laptops come with a built-in modem for dial-
up connections (though these are being left out
more and more as people move to wireless connec-
tions) and are enabled for wireless service. If you
choose a broadband connection, your phone or
cable company will provide you with an external
modem and wireless router (usually for a price).
Remember, though, that you can’t use this connec-
tion when you travel with your laptop.

w= f you have a laptop that doesn’t have a built-in wire-
less modem, you can add this hardware by buying a
wireless CardBus adapter PC card at any office sup-
ply or computer store. This card enables a laptop to
pick up wireless signals.

Many providers offer free or low-cost setup when you
open a new account. If you're not technical by
nature, consider taking advantage of this when you
sign up.

@,

If you fly with your laptop, you may not be able to
connect to the Internet during the flight. Also, it’s
important to remember that during takeoff and land-
ing you will be asked to turn off electronics so that
they don't interfere with air traffic communications.
Be alert to the announcement if you intend to use
your laptop on the plane.

@,
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1. The first step is to set up a connection in Windows so
that you can access the Internet. Choose Start=>Control
Panel=>Network and Internet.

2. In the resulting window, click Network and Sharing

Center.

3. In the resulting Network and Sharing Center window

(see Figure 18-2), click the Set Up a New Connection or
Network link.

Click this link

Chapter 18: Understanding Internet Basics

Set Up an Internet Connection

[=I=E]
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.:_:l Troubleshoot problems
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Figure 18-2
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4. In the Choose A Connection Option window, click Next
to accept the default option of creating a new Internet con-
nection. If you are already connected to the Internet, a
window appears; click Set Up A New Connection Anyway.

5. In the resulting dialog box, click your connection. (These
steps follow the selection of Broadband.)

6. In the resulting dialog box, as shown in Figure 18-3,
enter your username, password, and connection name
(if you want to assign one) and then click Connect.
Windows automatically detects the connection, and the
Network and Sharing Center appears with your connec-
tion listed.

=l
{9 ¢ty Connect to the Internet
Type the information from your Internet service provider (ISP)
User name: lulie]
Pa::worcl: .............‘l
Show characters
Remember this password
Connection name: Broadband Connection
Allow other people to use this connection
This option allows anyone with access to this computer to use this connection,
Idon't have an ISP
Connect | Cancel

Figure 18-3

In many cases, if you have a disc from your ISP, you

@ don’t need to follow the preceding steps. Just pop
that DVD into your DVD-ROM drive, and in no time,
a window appears that gives you the steps to follow
to get set up.
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Navigate the Web

1. You need to learn how to get around the Web using a
browser such as the popular Internet Explorer (IE) from
Microsoft. Open IE by clicking the Internet Explorer icon
in the Windows Taskbar.

2. Enter a Web address in the Address bar, as shown in
Figure 18-4 (www.ilookbothways.com is my
company’s Web site), and then press Enter.

Enter a Web address
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Figure 18-4
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3. On the resulting Web site, click a link (short for hyperlink;
a link takes you to another online page or document),
display another page on the site using navigation tools
on the page (such as the Education tab on the page), or
enter another address in the address bar to proceed to
another page.

blue. After you click a link, it usually changes to
another color (such as purple) to show that it's been
followed.

@ A text link is identifiable by colored text, usually

4. Click the Back button to move back to the first page that
you visited. Click the Forward button to go forward to
the second page that you visited.

5. Click the down-pointing arrow at the far right of the
Address bar to display a list of sites that you visited
recently, as shown in Figure 18-5. Click a site in this list
to go there.

Address bar are useful for navigating sites. Clicking
the Refresh button redisplays the current page. This is
especially useful if a page updates information fre-
quently, such as on a stock market site. You can also
use the Refresh button if a page doesn’t load cor-
rectly; it might load correctly when refreshed.
Clicking the Stop button stops a page that’s loading.
So, if you made a mistake entering the address, or if
the page is taking longer than you'd like to load,
click the Stop button to halt the process.

E ; You can use the Pop-Up Blocker to stop annoying

@ The Refresh and Stop buttons on the right end of the

pop-up ads as you browse. Click the Tools button,
choose Pop-up Blocker, and choose Turn On Pop-Up
Blocker to activate this feature. You can also use the
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Pop-up Blocker Settings command on this same
menu to specify sites you want to allow pop-ups to

appear in.
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Figure 18-5

Use Tabs in Browsers

1. Tabs allow you to have several Web pages open at once
and easily switch among them. With Internet Explorer
open, click New Tab (the smallest, blank tab on the far
right side of the tabs).
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2. When the new tab appears, which displays some infor-
mation about tabs (see Figure 18-6), enter a URL in the
Address bar and press Enter. The URL opens in that tab.
You can then click other tabs to switch among sites.

3. Click the Quick Tabs button (it consists of four little
squares on the far-left side of the tabs) to display thumb-
nails (small pictures) of all open tabs (see Figure 18-7),
or click the Tab List button (the arrow to the right of the
Quick Tabs button) to display a text list of tabs. You can
return to a page by clicking that page’s tab, thumbnail, or
name in the drop-down list.

The new tab
& New Tab - Windows Internet Explorer el = ([ (=5
ol ‘Q '|"¢‘A‘|A’-"writingtou\5 p =
File Edit View Favorites Tools Help
. Favorites | 93 @] Suggested Sites v & | Get More Add-ons » & | Getting Started £ | Customize Links
. : = »
58|~ @ Amazon.com:.. | @ Nanotechnolo... ©) Look Both Wa... @ Amazon.com:... (& New Tab X 3.';\ v B v~ & mm v Pagev Safety~ Tools~ (@~
% Fine: | nanotube enioLs |[ 7] Options = |
Browse with InPrivate
Browse the web without storing data about your browsing
session and help prevent websites from collecting information
about the sites you visit.
Dpel n InPrivate win
Learn more abat s i Accele rs, and InPrivate Br g
Done @ Internet | Protected Mode: On #100% -

Figure 18-6
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The Quick Tabs button
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Amazon.com: Online Shopping for Elec... X Nanotechnology Made Clear X Look Both Ways: Clearspace: Look Both..,

Figure 18-7

4. Close an active tab by clicking the Close button on the
right side of the tab.

A tab is a sort of window you can use to view any
number of sites. (But you don’t have to create a new
tab to go to another site. You can navigate to a new
site from a page in a tab that you're done looking
at.) Having the ability to keep a few tabs open at a
time means you can more quickly switch between
two or more sites without navigating back and forth
either with the Previous or Next buttons or by
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entering URLs. You can also create more than one
Home Page tab that can appear every time you open
IE. See the next task “Set Up a Home Page” for more
about this.

You can also press Ctrl+T to open a new tab in
Internet Explorer. Also, if you want to keep one tab
open and close all others, right-click the tab you
want to keep open and choose Close Other Tabs.

Internet Explorer 8 includes a feature that lists several
frequently used sites when you click a new tab.
Clicking one of these may help you jump quickly to
the site you need.

Set Up a Home Page

292

1. Your home page(s) appear automatically every time you
log on to the Internet, so choose one or a few sites that
you go to often for this setting. Open Internet Explorer
and choose Tools=>Internet Options.

2. In the resulting Internet Options dialog box, on the

General tab, enter a Web site address to use as your
home page, as shown in Figure 18-8, and then click OK.
Note that you can enter several home pages that will
appear on different tabs every time you open IE, as
shown in Figure 18-8.

Alternatively, click one of the following preset option
buttons shown in Figure 18-8:

e Use Current: Sets whatever page is currently dis-
played in the browser window as your home page.

e Use Default: This setting sends you to the MSN
Web page.
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e Use Blank: If you're a minimalist, this setting is
for you. No Web page displays; you just see a
blank area.

Internet Options L

General ISecurity i Privacy | Content ! Connections ; Programs ! Advanced|

Home page
/‘ To create home page tabs, type each address on its own line.
P http:/fwww. gmail. com/ - Type the Qddress(es)
http:/fwww.understandingnano.com/ .
hittp:/fwwnw.ilookbathways.com/| _ - for your desn'ed home poge(s)

Use current | | Use default ] | Use blank

Browsing history

T Delete temparary files, history, cockies, saved passwords,
¥ and web form information,

[T Delete browsing history on exit

Delete... | | Settings ]
Search
() Change search defaults. | Settings
&
Tabs
Change how webpages are displayed in | Settings |
tabs. -
Appearance
Colors || Languages H Fonts ]l Accessibility |
| oK ] | Cancel ] Appl

Figure 18-8

3. Click the Home Page icon (see Figure 18-9) on the IE
toolbar (it looks like a little house) to go to your home

page.

can create multiple home page tabs that will display
when you click the Home button. Click the arrow on
the Home button and choose Add or Change Home
Page. In the Add or Change Home Page dialog box
that appears, click the Add This Web Page to Your
Home Page Tabs radio button, and then click Yes.
Display other sites and repeat this procedure for all
the home page tabs you want.

@ If you want to have more than one home page, you
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The Home Page icon
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Figure 18-9

To remove a home page you have set up, click the

arrow on the Home Page button, choose Remove,

and then choose a particular home page or choose
Remove All from the submenu that appears.



Browsing the
Web with
Internet Explorer

browser is a program that you can use to

move from one Web page to another. You
can also use a browser to search for information,
Web sites, videos, and images. Most browsers,
such as Internet Explorer (IE) and Google
Chrome are available for free. Macintosh
computers come with a browser called Safari
installed.

Chapter 18 introduces browser basics, such as
how to go directly to a site when you know the
Web address, how to use the Back and Forward
buttons to move among sites you've visited,
and how to set up the home page that opens
automatically when you launch your browser.

In this chapter, you discover more ways of
using Internet Explorer. By using IE you can

w= Navigate all around the Web. Use the IE
navigation features to go back to places
you've been (via the Favorites and
History features), and use Google to
search for new places to visit.

w= Customize your browser. You can
modify what tools are available to you
on Internet Explorer toolbars to make
your work online easier.

| “*op’rer
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w= Work with RSS feeds. On the Internet, you can use
RSS feeds to get content from sites sent to you to

keep you up to date on news or opinions from various
sources.

w= Print content from Web pages. When you find what
you want online, such as a graphic image or article,
just use Print to generate a hard copy.

w= Play Podcasts. You can listen to podcasts, which are
audio programs you find on many Web sites covering
a variety of topics.

Search the Web

1. You can use words and phrases to search for information
on the Web using a search engine. In this example,
you'll use Google, a popular search engine. Enter www .
google.com in your browser Address bar.

2. Enter a search term in the text box and then click the
Google Search button.

3. In the search results that appear (see Figure 19-1), you
can click a link to go to that Web page. If you don't see
the link that you need, click and drag the scrollbar to
view more results.

perform your searches (it’s in the upper-right corner
of IE, with a little magnifying glass button on the
right edge). Change the search engine by clicking the
arrow to the right of the Search field and choosing
another provider listed there, or click the Find More
Providers link to see a more comprehensive list.

@ You can use the Internet Explorer search feature to

4. 1f you didn’t find what you need in Steps 1-3, click the
Advanced Search link on the Google home page to
change Search parameters and narrow the search.
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Click a link in the results list
Figure 19-1

5. In the resulting Advanced Search page, as shown in
Figure 19-2, modify any of the following parameters as
necessary:

¢ Find Web Pages That Have: These options let you
narrow the way words or phrases are searched; for
example, you can find matches for the exact word-
ing you enter.

e But Don’t Show Pages That Have: Enter words
that you want to exclude from your results. For
example, you could search countertops and specify
you don't want results that involve laminate.

e Need More Tools: Here you can control how
many results are shown on a page, what language
to search for, and specific file types or domains to
search.
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¢ Date, Usage Rights, Numeric Range, and More:
Click here for even more advanced search
parameters.

Type the word(s) you want to find

G OcC nge Advanced Search
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Figure 19-2

Knowing how search engines work can save you
time. For example, if you search by entering golden
retriever, you typically get sites that contain both
words or either word. If you put a plus sign between
these two keywords (golden+retriever), you get only
sites that contain both words.

Many search engines allow you to specify the media
to search for. For example, you can search for maps,
images, videos, or sound files related to your search
term. In Google, for example, these options are listed
across the top-left corner of the search engine screen.
Enter your search term and then click the type of
results you want to find.
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Find Content on a Web Page

1. With Internet Explorer open and the Web page that you
want to search displayed, click the arrow to the right of
the Search box and choose Find on This Page.

2. In the resulting Find toolbar that appears on the active
tab, as shown in Figure 19-3, enter the word that you
want to search for. As you type, all instances of the word
on the page are highlighted. Click the Options button
and use the following options to narrow your results:

e Match Whole Word Only: Select this option if you
want to find only the whole word. (For example,
use this option if you enter elect and want to find
only elect and not electron or electronics.)

e Match Case: Select this option if you want to
match the case. (For example, use this option if
you enter Catholic and want to find only the
always-capitalized religion and not the adjective
catholic.)

Enter the word to find

Eaal

in Medicine - N dicine - Wind Internet Explorer T =

ay

&N
@-v- - |¢3_ http://hinderstandingnano.com/medicine.html -|+,| » | |f" writing tools 2o
File Edit View Favgrites Tools Help

¢ Favorites | 53 @] puggested Sites v & | Get More Add-ons v @& Getting Started & | Customize Links

:éNanotechnu\ogyin edicine - Nanomedicine a?‘ ~ B - = @ ~ Page~ Safety~ Tools~ é' 2

% Find: | nanotube — | Pre le !@ Options v | 1 match
e e anotechnology 1n Medicine

Nanotech

le
Applications: ads by Googl

Applications of nanotechnology in medicine currently being developed involve employing nano-
particles to deliver drugs, heat, light or other substances to specific cells in the human body.
Medicine Engineering particles to be used in this way allows detection and/or treatment of diseases or

injuries within the targeted cells, thereby minimizing the damage to healthy cells in the body.

Vicks® Brand
Vicks® therapy
solutions relieve

Air Quality

Figure 19-3

3. Click the Next button and you move from one highlighted
instance of the word to the next. (See Figure 19-4.) If you
want to move to a previous instance, click the Previous
button.
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These RNA strands are attracted to cancer cells. When the nanoparticle encounters a cancer cell
it adheres to it and releases the drug into the cancer cell. This directed method of drug delivery
has great potential for treating cancer patients while producing less side harmful affects than
those produced by conventional chemotherapy.

Fabrics. The properties of familiar materials are being changed by manufacturers who are
adding nano-sized components to conventional materials to improve performance. For example,
some clothing manufacturers are making water and stain repellent clothing using nano-sized
whiskers in the fabric that cause water to bead up on the surface.

Reactivity of Materials. The properties of many conventional materials change when formed as
nano-sized particles (nanoparticles). This is generally because nanoparticles have a greater
surface area per weight than larger particles; they are therefore more reactive to some other
molecules. For example studies have show that nanoparticles of iron can be effective in the
cleanup of chemicals in groundwater because they react more efficiently to those chemicals
than larger iron particles.

Strength of Materials. Nano-sized particles of carbon, (for example | ﬂs and bucky balls)
are extremely strong. Nanotubes and bucky balls are composed of only cafbon and their strength
comes from special characteristics of the bonds between carbon atoms. pne proposed

application that illustrates the strength of nanosized particles of carbon if the manufacture of t-
shirt weight bullet proof vests made out of carbon nanotubes.

Micro/Nano ElectroMechanical Systems. The ability to !ﬁrgemrors, sensor elements,
as well as electronic circuitry in silicon surfaces allows the manufgcture of miniature sensors
such as those used to activate the airbags in your car. This technique is called MEMS (Micro-
ElectroMechanical Systems). The MEMS technique results in close [integration of the mechanical
mechanism with the necessary electronic circuit on a single silicop chip, similar to the method
used to produce computer chips. Using MEMS to produce a device|reduces both the cost and size
of the product, compared to similar devices made with conventiopal methods. MEMS is a
stepping stone to NEMS or Nano-Electromechanical Systems. NEM$ products are being made by a
few companies, and will take over as the standard once manufactprers make the investment in
i the eaninment neaded tn nrodiuce nann-sized features. o o
Done & & Internet | Protected Mode: On

Hq10% ~

The highlighted instances of the word
Figure 19-4

4. When you're done searching, click the Close button on

the left side of the Find toolbar.

Many Web sites have a Search This Site feature that
allows you to search not only the displayed Web
page but all Web pages on a Web site, or search by
department or category of item in an online store.
Look for a Search text box and make sure that it
searches the site — and not the entire Internet.
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Add a Web Site to Favorites

1. If there’s a site you intend to revisit, you might want to
save it to Internet Explorer’s Favorite folder so you can
easily go there again. Open IE, enter the URL of a Web
site that you want to add to your Favorites list, and then
click Go (the button with two blue arrows on it to the
right of the Address bar).

2. Click the Favorites button on the left side of Internet
Explorer to display the Favorites pane, and then click the
Add to Favorites button.

3. In the resulting Add a Favorite dialog box, as shown in
Figure 19-5, modify the name of the Favorite listing to
something easily recognizable. If you wish, choose
another folder or create a folder to store the Favorite in.

Change the favorite name here

Add a Favorfte

Add thiz webpage as a favonte. To access pour favorites, visit the
Favorites Centgr.

==

Marme: MSM.com —

Create in: 5.7 Favoites v|| Mew Folder |

Add | [ Cancel |

Figure 19-5
4. Click Add to add the site.

5. To use your Favorites list, click the Favorites button and
then click the name of the site from the list that’s dis-
played (see Figure 19-6) to go to that site.
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Click the Favorites button
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Figure 19-6

Regularly cleaning out your Favorites list is a good
idea — after all, do you really need the sites that you
used to plan last year’s vacation? With the Favorites
Center displayed (just click the Favorites button),
right-click any item and then choose Delete or
Rename to modify the favorite listing.

You can keep the Favorites Center as a side pane in
Internet Explorer by displaying it and then clicking
the Pin the Favorites Center button. (It has a left-
facing green arrow on it and is located in the top-
right corner of the pane.)

Because you might travel with your laptop and
encounter all kinds of folks and risk it being stolen,
be careful about setting up your browser to remember
passwords and then saving those sites as favorites.
For example, say you have an account at Amazon.
com, save Amazon as a favorite, and have set up
Internet Explorer to remember your password at
Amazon. Somebody could check your favorites for
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such sites, and then use your laptop to log on and
purchase items using your account. See Chapter 20
for more about staying safe when using your laptop.

Organize Favorites

1. You can organize favorites into folders to make them
easier to find. With Internet Explorer open, click the
Favorites button to open the Favorites pane. Click the
arrow on the right end of the Add to Favorites button
and then choose Organize Favorites.

2. In the resulting Organize Favorites dialog box (see
Figure 19-7), click the New Folder, Move, Rename, or
Delete buttons to organize your favorites.

Select a favorite...

& Organize Favorites - ——

ASUS E-Service

Favorites Bar

Microsoft Websites

M5N Websites

Windows Live
& | Network Solutions Webmail
L | &l About Grafton Village Cheese, Grafton, Vermont. Aged cheddar cheese.
& | Equifax Freeze Confimation

»

m

£ | Windows 7 Beta Support, Deployment, Resources

8 amazon.com Online Shopping for Blectronics, Apparel, Computers, Book... L
Links for United States
Mozilla Firefox

& | About Grafton Village Cheese, Grafton, Vemont. Aged cheddar cheese

ASUS E-Service
Favorites Folder

Modified:
1/23/2009 4:00 PM

|| New Folder | | Move... | | Rename | | Delete... ||

| Close |

Then click an action
Figure 19-7
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3. When you finish organizing your Favorites, click Close.

sites or folders, but you can also organize favorite
sites one by one by using the Favorites pane. (You
display the Favorites pane by clicking the Favorites
button.) Right-click any favorite site listed in the
pane and choose a command: Create New Folder,
Rename, or Delete, for example.

@ These steps provide a handy way to manage several

will have to manually transfer files into those folders.
To do this, just display the Favorites Center and click
and drag files listed there on top of folders.

@ If you create new folders in the above steps, then you

View Your Browsing History

1. If you went to a site recently and want to return there
again but can’t remember the name, you might check
your browsing history to find it. Click the Favorites but-
ton and then click the History tab to display the History
pane. (See Figure 19-8.)

2. Click the down arrow on the History button (see
Figure 19-9) and select a sort method:

e View By Date: Sort favorites by date visited.
e View By Site: Sort alphabetically by site name.

e View By Most Visited: Sort with the sites visited
most on top and those visited least at the bottom
of the list.

e View By Order Visited Today: Sort by the order in
which you visited sites today.

3. In the History pane, you can click a site to go to it. The
History pane closes.

304



The History tab

Chapter 19: Browsing the Web with Internet Explorer

T o[ )

(%1 amazen (www.amazen.com)

£l Computer

) ilookbothways (www.ilookbothways....
) inbox (www.inbox.com)

2l look2ways (look2ways.com)

), microsoft (www.microsoft.com)

) msn (www.msn.com)

) pubstudio (pubstudio.com)

[, search.live (search.live.com)

1) understandingnane {understandingn...
&, understandingnano (www.understan...
£l webhelp.qwest (webhelp.qwest.net)
) wm3llinbox (wmS0.inbox.com)

OO = |m http:{/www.microsoft.com/en/us/default.aspx b | “7| A | |F writing tools 2z
File Edit View Fajorites Tools Help

7.7 Favorites ‘ 75 2| Suggested Sites » 2| Get More Add-ons v & Getting Started 2 | Customize Links

f = . O »

i Add to Favorites... [+ [#] logyM... © Look Bath Ways: Cl... L] Microsoft Corpo... 3 | | 15 = - [ g v Pagev Safetyv Took+ @~

[ Favorites | Feeds | History | Previous Mt | [FF) Optians ~ |

[V:ew By Date v] United States Changs i
i;l Last Week
gTuesday

in Silverfight

pe plug-in

Figure 19-8

Click the

arrow

Get the latest
security downloads

Visit Microsoft Update
-

T )

Favorites | Feeds | History
[View By Order Visited Today B

View By Date
View By Site

Yiew By Most Visited

View By Order Visited Toda
Search History

=] Today

O .\J = |ﬂ hittp://www.microsoft.comfen/us/default.aspx £2 | “7| A | |F writing tools 2 ol
File Edit View Favorites Tools Hell
7.7 Favorites ‘ 95 | Suggested Sites » k| Get More Add-ons v & Getting Started 2 | Customize Links
R ——— _ »
i Add to Favorites... = [ llogyM... © Look Bath Ways: Cl... [ Microsoft Corpo... 3 | | i = - [ dm v Pagev Safety~ Took+ @~

Hext | [F] options |

in Silverlight

Figure 19-9

You can also choose the arrow on the right of the
Address bar to display sites you've visited.

Choose Search History on the History menu to
display a search box you can use to search for sites
you've visited.

305



Part IV: Exploring the Internet

Customize the Internet Explorer Toolbar

1. You can customize the toolbars that offer common com-
mands in Internet Explorer so that the commands you
use most often are included. Open IE.

2. Choose Tools=>Toolbarse>Customize. The Customize
Toolbar dialog box (as shown in Figure 19-10) appears.

¥ Cut
Copy
[] Paste

Customize Toolbar [l
Available toolbar buttons: Curment toolbar buttons:
Close
Separator B Safety 4| ———
A Text Size Tools |F\'§—set|
a~ Encoding [ Add- | t} Help
* Edit — | £% HP Clipbook

#| Full Screen
4 m

Figure 19-10

3. Click a tool on the left and then click the Add button to
add it to the toolbar.

4. Click a tool on the right and then click the Remove
button to remove it from the toolbar.

5. When you're finished, click Close to save your new tool-
bar settings. The new tools appear (see Figure 19-11);
click the double-arrow button on the right of the toolbar
to display any tools that IE can't fit onscreen.

®
®
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You can click to select a tool and then use the Move Up
and Move Down buttons in the Customize Toolbar
dialog box to rearrange the order in which tools appear
on the toolbar. To reset the toolbar to defaults, click the
Reset button in that same dialog box.

If you want to add some space between tools on the
toolbar so that they're easier to see, click the
Separator item in the Available Toolbar Buttons list
and add it before or after a tool button.
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Find new tools here
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Figure 19-11

View RSS Feeds

1. You can view information sent to you via RSS feeds
using IE. Click the Favorites button; then click the Feeds
tab to display a list of recently displayed RSS feeds.

(See Figure 19-12.)

¢ Favorites l 25 = 8 Amazon.com: Onling
< Add to Favorites.., - [

Favorites | Feeds | History
Feeds for United States
Links

& Microsoft at Home
] Microsoft at Work
E MSNBC News

Figure 19-12

2. Click a folder to open it, and then click a feed to display
it. (See Figure 19-13.)

3. You can also click the orange View Feeds on This Page
button on the toolbar to view any active feeds listed on
the currently displayed page.

The View Feeds on This Page button is grayed out
when there are no RSS feeds on the current page, and

it turns red when feeds are present.
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Click a feed to view it
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Figure 19-13

built in, you can explore other feed readers. Just type
RSS feeds into Internet Explorer’s search box to find
more information and listings of readers and RSS
feed sites.

Print a Web Page

1. 1f a Web page includes a link or button to print or
display a print version of a page, click that and follow
the instructions.

@ Though Internet Explorer has an RSS feed reader

2. If the page doesn't include a link for printing, click the
Print button on the Internet Explorer toolbar.

3. In the resulting Print dialog box, decide how much
of the document you want to print and then select one
of the options in the Page Range area, as shown in
Figure 19-14.

Note that choosing Current Page or entering page
numbers in the Pages text box of the Print dialog box

doesn’t mean much when printing a Web page — the
whole document might print because Web pages
aren’t divided into pages as word processing docu-
ments are.
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Choose a page range option

I
B

= Print
| General :Opﬁong!.

Select Printer

i B Add Printer i m Microsoft XPS Docurr
o0 Brother DCR-116C % Snaglt 9

Fax

[#] %) HP Deskjet F4100 series

4 n »

Status: Cffling Print to file | Preferences |
Location:
Comment: | Find Prirter... |
| Page Range |
@ Al Mumber of copies: 1
"1 Pages: 1 Collate
231 2l3
Enter either a single page number or a single 1} 1=

page range. For example, 5-12

Figure 19-14

4. Click the up arrow in the Number of Copies text box
to print multiple copies. If you want multiple copies
collated, select the Collate check box.

5. After you adjust all settings you need, click Print.

Play Podcasts

Many sites offer podcasts, which are audio recordings of interviews,
opinions, or informative oral articles. To check this out, go to The
New York Times site by entering this address in your browser address
bar: www.nytimes.com/ref/multimedia/podcasts.html.

Click the little arrow on the right of any podcast, as shown in Figure
19-15. The podcast begins playing. (In some cases, podcasts open a
new window with an animated display that plays during the podcast,
though that doesn’t happen at The New York Times site.) Use the con-
trols to do any of the following:
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m=  Click the Pause button (it has two little vertical bars
on it) to stop playback.

m= Click and drag the wedge-shaped volume control to
increase or decrease the volume.

w= Click the diamond-shaped object on the bar that
shows the podcast’s progress to move forward or
backward in the program. Note that the time point
where you are in the podcast is displayed to the right
of this bar.

[& Podcasts - New York Times - Mozilla Firefox o | (=
File Edit View History Bookmarks Tools Help
y C 4y & | hitpiwww.nytimes com/ref/multimedia/podcasts. html vy ~ [CGl+|Google P

2| Most Visited ¥ Getting Started Latest Headlines

-

Walcome to-TunasPanpla n TimesPeople Lets You Share and Discaver the Best of NY. TAGAM | ¥ o ks

‘What's this?

HOME PAGE | TODAY'S PAPER | VIDEC | MOST POPULAR TIMES TOPICS | GetHome Delivery Login | Register Now

E’ht Krwum’k @ﬁ;’iml‘g Search All MY Times.com
Tuesday, April 21, 2009 POdcaStS

WORLD U.S. N.Y./REGION| BUSINESS TECHNOLOGY SCIENCE HEALTH SPORTS @ OPINION ARTS STYLE TRAVEL JOBS REALESTATE AUTOS

Go =

WIN A 7~ /(#// VOYAGE

ﬁ % THE YACHTS OF SEABOURN. VENTER TO WIN
= -

NYTimes.com Podcasts

45 AUDIO |:| feed our addiction
PODCAST LATEST EPISODE to Mideast oil
B Backstory NYT: Back Story With f

Jane Bornemeier talks to Times reporters about the Sheryl Gay Stolberg |Z i ht Iobal
STORY top stories of the day. (mp3) g g_
Schedule: Mendsy through Fridsy - 4
= 06 warmlng com
SUBSCRIBE
1] 3 P e
Book Review NYT: Book Review for ROBERTSON ';,!ni e

itor of The New York Times Book 4.‘"1"-"2_009 (mp3)
s this week's issue. Visit an archive of =
eview Podcasts. . 15:00 el

BEVIEW S Tane

Schedule: Friday

SUBSCRIBE

Done

Click the arrow to play the podcast
Figure 19-15
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Staying Safe
While Online

If you're using your laptop to go online,
you're probably enjoying all the Internet has
to offer. But going online also brings with it
some risks. If you understand those risks, you
can learn to avoid most of them and stay
relatively safe online.

In this chapter, you discover some of the risks
and safety nets that you can take advantage of
to avoid risk, including:

w= Understand what risks exist. Some risks
are human, in the form of online preda-
tors wanting to steal your money or
abuse you emotionally; other risks come
from technology, such as computer
viruses. For the former, you can use the
common sense you use when interacting
offline to stay much safer. For the latter,
there are tools and browser settings to
protect you.

w= Be aware of what information you
share. Abuses such as ID theft occur most
often when you or somebody you know
shares information about you that’s
nobody’s business. Find out how to spot
who is exposing information (including
you) and what information to keep
private, and you'll become much safer
online.

”'*’o ter
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w= Avoid scams and undesirable content. You can use
the Content Advisor to limit the online locations
that you can visit so that you don't encounter sites
you consider undesirable. You can also find out how
to spot various e-mail scams and fraud so that you
don’t become a victim.

w= Create safe passwords. Passwords don’t have to be
hard to remember, just hard to guess. I provide some
guidance in this chapter about creating passwords
that are hard to crack.

Understand Technology Risks on the Internet

312

When you buy a car, it has certain safety features built in. After you
drive it off the lot, you might find that the manufacturer slipped up
and either recalls your car or requests that you go to the dealer’s ser-
vice department to have a faulty part replaced. In addition, you need
to drive defensively to keep your car from being damaged in daily use.

Your laptop is similar to your car in terms of the need for safety. It
comes with an operating system (such as Microsoft Windows) built in,
and that operating system has security features. Sometimes that oper-
ating system has flaws or new threats emerge after it’s installed, and
you need to get an update to keep it secure. And as you use your lap-
top, you're exposing it to dangerous conditions and situations that you
have to guard against.

Threats to your laptop security can come from a file you copy from a
disc you insert into your laptop, but most of the time, the danger is
from a program that you download from the Internet. These down-
loads can happen when you click a link, open an attachment in an
e-mail, or download one piece of software without realizing that
malware (malicious software) is attached to it.

You need to be aware of these three main types of dangerous
programs:
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A virus is a little program that some nasty person
thought up to spread around the Internet and infect
computers. A virus can do a variety of things, but
typically, it attacks your data, deleting files, scram-
bling data, or making changes to your system set-
tings that cause your laptop to grind to a halt.

Spyware consists of programs responsible for tracking
what you do with your laptop. Some spyware simply
helps companies you do business with track your
activities so that they can figure out how to sell you
things; other spyware is used for more insidious
purposes, such as stealing your passwords.

Adware is the computer equivalent of telemarketing
phone calls at dinner time. After adware is down-
loaded onto your laptop, you'll get annoying pop-up
windows trying to sell you things all day long.
Beyond the annoyance, adware can quickly clog up
your laptop. Its performance slows down, and it’s
hard to get anything done at all.

To protect your information and your laptop from these various types
of malware, you can do several things:

2

You can buy and install an antivirus, anti-spyware,
or anti-adware program. It’s critical that you install
an antivirus program, such as those from McAfee,
Symantec (see Figure 20-1), or Trend Micro, or the
freely downloadable AVG Free. People are coming
up with new viruses every day, so it's important that
you use software that is up-to-date with the latest
virus definitions and protects your laptop from
them. Many antivirus programs are purchased by
yearly subscription, which gives you access to
updated virus definitions that the company con-
stantly gathers throughout the year. Also, be sure to
run a scan of your laptop on a regular basis. For
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convenience, you can use settings in the software to
set up automatic updates and scans. Consult your
program'’s Help tool for instructions on how to use
these features.

# Norton

Norton Internet Security”
Subscription: 171 days remaining.

| Tasks & Scans r |

Run a Scan

Schedule a scan

Wanage Quarantined ltems
Run Security Inspectar Reay
Log in or out of [dentity Safe
manage Identity Safe Profile

Figure 20-1

=y

nmp

Install a program that combines tools for detecting
adware and spyware. Windows 7 has a built-in pro-
gram, Windows Defender, which includes an anti-
spyware feature. (I cover Windows Defender tools
later in this chapter.) If you don’t have Windows 7,
you can purchase programs such as Spyware Doctor
from PC Tools or download free tools such as
Spybot or Spyware Terminator.

Use Windows tools to keep Windows up-to-date
with security features and fixes to security prob-
lems. You can also turn on a firewall, which is a
feature that stops other people or programs from
accessing your laptop without your permission. I
cover Windows Defender and firewalls in Chapter 23.
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w= Use privacy and security features of your browser,
such as the Suggested Sites and InPrivate Browsing
features new to IE 8.

another type of security concern. Because you carry
your laptop with you, it is exposed to potential theft
or loss. See Chapter 23 for more about protecting
laptops while travelling.

@ Laptop users who travel with their laptops face

Use Suggested Sites

1. To have Internet Explorer suggest sites you might like
that are related to the currently-displayed site, click the
Tools button and choose Suggested Sites if it isn't already
selected. (A check mark appears next to it, as shown in
Figure 20-2.) When a prompt appears asking if you want
to discover Web sites you might like based on sites you
have visited, click Yes.

Bl ~ (=] o= v Pagev Safety~ | Tools~+

15 Reopen Last Browsing Session

1 Pop-up Blocker 4
2] Manage Add-ons

e Work Offline
3 Compatibility View
Compatibility View Settings

| Full Screen F11
Toolbars L
Explorer Bars 4
<l Developer Tools F12

v Suggested Sites

Y. Internet Options

Choose Suggested Sites
Figure 20-2
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2. Click the Suggested Sites button on the Favorites toolbar.
(If the toolbar isn't displayed, right-click the toolbar area
and click Favorites Bar.) A list of suggested sites appears
in a pop-up window. (See Figure 20-3.)

A list of suggested sites

& | Suggested Sitesv]:ti Get More Add-ons ~ & | Gettin

&Y eBay

@ Target
‘) Best Buy

m Barnes & Moble

O overstock.com: Online Shopping -...

Other Suggestions

< +4 | https://ieonline.micr... % Microsoft Corpora...

Figure 20-3

3. Click a site to display its URL.

up with suggestions, so when you first activate it, it
may take a little while before the feature comes up
with useful suggestions.

Download Files Safely

1. Open a Web site that contains downloadable files (such
as www . adobe . com, which offers its Adobe Reader
program for free). Typically, Web sites offer a Download
button or link that initiates a file download.

@ Suggested Sites uses your browsing history to come

2. Click the appropriate link to proceed. Windows might
display a dialog box asking your permission to proceed
with the download; click Yes.
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3. In the resulting File Download dialog box, as shown in
Figure 20-4, choose either option:

e Click Run to download to a temporary folder.
You can run an installation program for software,
for example. However, beware: If you run a
program directly from the Internet, you could be
introducing dangerous viruses to your system. You
might want to set up an antivirus program to scan
files before downloading them.

e Click Save to save the file to your hard drive. In
the Save As dialog box, select the folder on your
laptop or removable storage media (a USB flash
drive, for example) where you want to save the
file. If you're downloading software, you need to
locate the downloaded file and click it to run the
installation.

File Download - Security Warning —— ]
Do you want to run or save this file?

""'| Name: windows-kb&90830-v2.8.exe
|

| Type: Application, 9.77ME

From: download.microsoft.com

L

Run || Save | [ Cancel |

| E~ | While files from the Intemet can be useful, this file type can
) ﬂ potentially ham your computer. i you do ot trust the source, do not
run or save this software. What's the risk ?

Figure 20-4
@ If you're worried that a particular file might be unsafe

to download (for example, if it’s from an unknown
source and, being an executable [ . exe] file type,
could contain a virus), click Cancel in the File
Download dialog box.

317



Part IV: Exploring the Internet

If a particular file will take a long time to download
(some can take 20 minutes or more) you may have
to babysit it. If your laptop goes into standby mode,
it could pause the download. If your laptop automat-
ically downloads Windows updates, it may cause
your laptop to restart automatically as well, cancel-
ling or halting your download. Check in periodically
to keep things moving along.

Turn on InPrivate Browsing and Filtering

318

1. InPrivate Browsing is a new feature that stops Internet

Explorer from saving information about your browsing
session, such as cookies and your browsing history.
InPrivate Filtering allows you to block or allow sites that
are automatically collecting information about your
browsing habits. To turn on InPrivate features, open IE.

2. Click Safety on the toolbar and choose InPrivate

Browsing to turn that feature on. The tab shown in
Figure 20-5 appears.

3. Click Safety and choose InPrivate Filtering Settings; if you

haven’t turned this feature on, a window appears asking
you to turn it on; click the Block for Me link and again
choose In Private Filtering Settings. The dialog box shown
in Figure 20-6 appears. Choose one of the following
settings:

e Automatically Block: Blocks any site that uses
content from other sites you've visited.

¢ Choose Content to Block or Allow: Allows you to
open the InPrivate Filtering Settings dialog box
and use the Allow and Block buttons to select
which sites to allow and which to block.
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The InPrivate tab

‘& InPrivate - Windows Internet Explorer - [InPfivate] —— | [
& A g = B | =T
@IOR it Plfostipia] ~[ 2] x |[ A tive seorch »
File Edit View Favorites Tools Help
< Favorites fé InPrivate 'f-} - E] - [ E1 » Page~v Safety~ Tools~ -.-ﬂ" i

When InPrivate is turned on, you will see this indicator

g L\ it £ | aboutinPrivate

inPrivate Browsing helps prevent Internet Explorer from storing data about your
browsing session. This includes cookies, temporary Internet files, history, and other
data. Toolbars and extensions are disabled by default. See Help for more
information.

inPrivate Blocking helps you control whether third parties can automatically collect
information about your web browsing based on the sites you visit. InPrivate Blocking
does this by identifying third-party content that is used by multiple websites you visit.
Some website content might not be displayed unless you choose to allow these third-
party websites.

To turn off InPrivate, close this browser window.

Learn more about InPrivate | Read the Internet Explorer privacy statement online

“& InPrivate Blocking: Off 9 Internet | Protected Mode: On HI00% -

Figure 20-5

4. Click OK to save your settings. When you browse a bit
and then reopen the InPrivate Filtering Settings dialog
box (Safety=>InPrivate Block) you see blocked and
allowed sites listed.

If you don’t want to use InPrivate Browsing but
would like to periodically clear your browsing history
manually, with IE open you can press
Ctrl+Shift+Delete to do so.
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Choose a setting

InPrivate Filtering settings

InPrivate Filtering

When you wizit multiple websi
map, advertizenent, or web m)
be shared with the content pn
websites you visit might not by

E= that contain content from the zame provider, such az a
Easurement toolz, some information about pour wisitz might
wvider. |f you choose to block content, portions of the

available.

i l

Chooge content ta block
or allow
r
Content provider Statuz Used by Content i !
googlesyndication.com  Blocked 11 sites expanzion_emb| = |
quantserye. com Blocked 14 sites quant.js |
doubleclick.net Blocked 15 sites test_domain.js
doubleclick. et Blocked 15 sites ads
googlx_e_—anal_l,_ltic;s_._cgm Bloc:k_ed 15 sit_es gqis et
14 m } |
More information from this content provider Al Block
10 *| Show content from providers used by this number of websites Refrash
you've visited, [3-30] =
Advanced settings
Learm maore abaut InPrivate Filtering | K. | | B

Figure 20-6

Use SmartScreen Filter
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1. SmartScreen Filter lets you check Web sites that have
been reported to Microsoft as generating phishing scams
or downloading malware to your laptop. To turn
SmartScreen Filter on, click the Safety button on the
Internet Explorer toolbar and then choose SmartScreen
Filter>Turn On SmartScreen Filter. In the confirmation

dialog box that appears, click OK.

2. To use SmartScreen Filter, go to a Web site you want to
check. Click the Safety button and choose SmartScreen

Filter=>Check This Website.

3. The SmartScreen Filter window appears (see Figure 20-7),
indicating whether it found any threats. Click the OK
button to close the message.
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SmartScreen Filter PR — |

| | SmartScreen Filter checked this website and did not report any threats
L'y

= Ewven though this site has not been reported to Microsoft for containing threats, check the
address to make sure itis a site you trust. If you believe this is an unsafe site, dick the
Safety button, dick SmartScreen Filter, and then dick Report Unsafe Website.

.@ How does SmartScreen Filter help protect me?

Figure 20-7

checks Web sites and will generate a message if you
visit one that has reported problems. However, that
information is updated only periodically, so if you
have concerns about a particular site, use the proce-
dure given here to check the latest information about
the Web site.

@ Once turned on, SmartScreen Filter automatically

Change Privacy Settings

1. You can modify how Internet Explorer deals with privacy
settings to keep information about your browsing habits or
identity safer. With IE open, choose Tools=>Internet Options
and click the Privacy tab, as shown in Figure 20-8.

2. Click the slider and drag it up or down to make different
levels of security settings.

3. Read the choices and select a setting that suits you.

4. Click the Sites button to specify sites to always or never
allow the use of cookies. In the resulting Per Site Privacy
Actions dialog box (as shown in Figure 20-9), enter a site
in the Address of Website field and click either Block or
Allow.
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The Privacy tab
|

I 7 |[=
General Securit}_f_f Privacy | Content Connections < Pragrams , Advanced: )
Settings
F_ Select a setting for the Internet zone,
@

Medium

- Blocks third-party cookies that do not have a compact

privacy policy

- Blocks third-party cookies that save information that can
=) be used ko conkact you without yaur explicit consent

- Restricts first-party cookies that save information that

can be used to contact you without your implicit consent

| Sites || Import || Advanced | Default

Pop-up Blocker

| 1| Prevent most pop-up windaws from | Settings
@--‘-' Appearing.

[¥] Turn on Pop-up Blacksr

InPrivate

My | Do not collect data For use by InPrivate Filkering
 Disable toolbars and extensions when InPrivate Browsing

A starts

| OF | | Cancel Apply

Figure 20-8
5. Click OK twice to save your new settings.

The default setting, Medium, is probably a good bet
for most people. To restore the default setting, click
the Default button on the Internet Options dialog
box’s Privacy tab or use the slider to move back to
Medium.

You can also use pop-up blocker settings on the
Privacy tab to specify which pop-up windows to
allow or block. Just click the Settings button, enter a
Web site name, and then click Add to allow pop-ups.
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Enter a Web site here

Per Site Privacy Actions [ —— ]

Manage Sites

] You can specify which websites are always or never allowed to use

@\, cookies, regardless of their privacy policy.

Type the exact address of thg website you want to manage, and then click Allow
or Block.

To remove a site from the list pf managed sites, select the name of the website
and click the Remove button

Address of website:
|

Block |

Allow

Managed webstes:

Domain Setting Bemove
freegamesgalore.com Always Block T
smithsonian.org Always Allow ———

OK

Figure 20-9

Enable the Content Advisor

1. Use Content Advisor to alert you when you visit sites
with certain types of content that you or your family
might find objectionable. With Internet Explorer open,
choose Tools>Internet Options.

2. In the resulting Internet Options dialog box, click the
Content tab to display it.

3. Click the Enable button; if a confirmation dialog box
appears, click Yes to proceed. (Note: If there is no Enable
button but Disable and Settings buttons instead, Content
Advisor is already enabled. Click the Settings button to
see the options and make changes if you wish.)
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4. On the Ratings tab of the Content Advisor dialog box
(see Figure 20-10), click one of the categories (such as
Depiction of Drug Use) and then move the slider to use
one of three site screening settings: None, Limited, or
Unrestricted.

Content Advisor [ ——

Select a category to view the rating levels:
G2k ICRA3

Zk Content that sets a bad example for young children
Z{‘ Depiction of alcohol use

Z{‘ Depiction of drug use

Q Depiction of gambling 21|

Adjust the slider to specify what users are allowed to see:

]

] »

MNone
Description

No content that creates feelings of fear, intimidation, etc. in any
context

To view the Intemet page for this rating service, | More Info
click More Info. —

[ ok [ concel |

Figure 20-10
5. Repeat Step 4 for each of the categories.

6. Click the Approved Sites tab (see Figure 20-11) and enter
the name of a specific site that you want to control access
to. Then click Always or Never.

e Always: Allows users to view the site, even if it's
included in the Content Advisor screening level
you've set.

e Never: Means that nobody can visit the site, even
if it's acceptable to Content Advisor.

7. When you finish making your settings, click OK. If
prompted to create a supervisor password, do so. Click
OK again to save your settings.
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Enter a Web site here

Content Advisdr —

Allow this webgite:

d Sites :E?ﬂq@l 5 Advanc:edi

“ou can create a list of websites that are always viewable or never
viewablg regardless of how they are rated.

List of approved and disapproved websites:

@ alffreeringtons som Remave
& microsoft.com

& onlinegamblingUSA com
& wonderfulgames.com

[ ok [ conesl |[ ooty |

Figure 20-11

®

If you want to view sites that you don’t want others
to see, you can do that, too. On the General tab of
the Content Advisor dialog box, make sure that the
Supervisor Can Type a Password to Allow Viewers to
View Restricted Content check box is selected, and
then click Create Password. In the dialog box that
appears, enter the password, confirm it, and then
enter a hint and click OK. Now if you're logged on as
the system administrator, you can get to any
restricted site by using this password.

To find rating systems that various organizations
have created and apply them to Internet Explorer,
click the Rating Systems button on the General tab.
Here you can choose a system already shown there.
Or click Add; then, in the resulting Open Ratings
System File dialog box, choose another system to

apply.
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Understand Information Exposure

326

Many people think that if they aren’t active online, their information
isnt exposed. But you aren’t the only one sharing your information:

n-p
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-y

nmp

Employers: Many employers share information
about employees. Consider carefully how much
information you're comfortable with sharing
through an employee bio posted on your company
Web site. How much should be visible to other
employees on your intranet? When you attend a con-
ference, is the attendee list shown in online confer-
ence documents? And even if you're retired, there
may still be information about you on your former
employer’s Web site. Review the site to determine if
it reveals more than you'd like it to — and ask your
employer to take down or alter the information if
needed.

Government agencies: Some agencies post personal
information, such as documents concerning your
home purchase and property tax (see Figure 20-12),
on publicly-available Web sites. Government agen-
cies may also post birth, marriage, and death certifi-
cates, and these documents may contain your social
security number, loan number, copies of your signa-
ture, and so on. You should check government
records carefully to see if private information is
posted — and demand that it be removed.

Family members and friends: They may write about
you in their blogs or mention you on special-interest
sites, such as those focused on genealogy.

Clubs and organizations: Organizations with whom
you volunteer, the church you attend, and professional
associations may reveal facts such as your address,
age, income bracket, and how money much you've
donated.
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‘& Treasurer - Excise Tax Affidavit Search - Windows Internet Explorer L=l =S
@\./' - |é hitp:/fwww.co.jefferson.wa.us Areasurer/PropertyTaxSearch.asp v| ] |~y| x | ‘l‘-” Live Search o~
i Favorites | &3 @& Suggested Sites > @] Web Slice Gallery =

- »
| @& Treasurer - Excise Tax Affidavit Search Fi = B v [0 o v Pagev Safetyv Took~ @+

@Jefferson County

©~ Weather Station  ~ _ Database Taols.

=_@; vebcam
Home = County Info - Departments - Search

Maps

Property Tax Search

Search by Parcel Number

If you know your parcel number, enter it below then click search. You will be redirected
to the Tax Information Page for this parcel.

Parcel Number: [ sEaRcH |

Search by House Number and Street Name

i

m

Figure 20-12

w=  Newspapers: If you've been featured in a newspaper
article, you may be surprised to find the story, along
with a picture of you or information about your
work, activities, or family, by doing a simple online
search. If you're interviewed, ask for the chance to
review the information that the newspaper will
include, and be sure that you're comfortable with
exposing that information.

w= Online directories: Services such as www.white
pages . com, shown in Figure 20-13, or www. any
who . com list your phone number and address,

unless you specifically request that these be removed.

You may be charged a small fee associated with
removing your information — a so-called privacy
tax — but you may find the cost worthwhile. Online
directories often include the names of members of
your family, your e-mail address, the value of your
home, your neighbors’ names and the values of their
homes, an online mapping tool to provide a view of
your home, driving directions to your home, and
your age. The record may also include previous
addresses, schools you've attended, and links for
people to run background checks on you.
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£ The Official WhitePages - Find People for Free - Windows Internet Explorer =40 Ex8
@‘\J = [e@ nttp: /o whitepages.com v| =] |v¢| % || 2 tive searen Bz
¢ Favorites | 9= €| Suggested Sites = @ | Web Slice Gallery =

@@ The Official WhitePages - Find Peaple far Free B v~ B ~ [ d= v Pagev Safety~ Toalsv @~
Try the new WhitePages! 3

WhitePages.com” CTEEME® & SAVE 28180 corrmmmmurmnre

search. find. connect UROTRSIA NS RNCATR IR % Up to $15 per monthly refl

)

heta—

LM People Search | Business Search | Rewverse Lookup | Area & ZIP Codes | Add Your Listing SIGH IN
Quick Search | iPhone & Mobile | International Resources | Send Text Messages

People Search |2]|| Business Search 7 ;

: ; WhitePages
Bagic Seatch | Advanced Search *Hame or Category EXTR E E =
Fist Hame Makeover

City or ZIP/Postal State/Prov
*Last Hame

[Tl zave a= default locstion Faster searches
City or ZIP/Postal State/Prov Fresh ’3'0(? £ 'i"Si’]‘W

*reguired Search | More ways to connect
“required Search

Try the New
WhitePages today. ASclvertise with Us
Find old high school friends Eind old high school friends
.
Figure 20-13

Because services get new information from many
sources, you'll need to check back periodically to see
if your information has again been put online — if it

has, contact the company or go through their
removal process again.

Try entering your home phone number in any browser’s
address line; chances are that you'll get an online
directory listing with your address and phone num-
ber (although this doesn’t work for cell phone
numbers).

Keep Your Information Private
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Sharing personal information with friends and family enriches your
relationships and helps you build new ones. The key is to avoid shar-
ing information with the wrong people and shady companies because,
just as in the real world, exposing your personal information online is
one of your biggest risks.
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Criminals come in all flavors, but the more savvy ones collect
information in a very systematic way. Each piece of information is

like another drop of water that, over time, collects to form a very clear
picture of your life. And after criminals collect and organize the
information, they never throw it away because they may be able to use
it many times over.

Fortunately, information exposure is a risk you have a great deal of
control over. Before sharing information such as your date of birth,
make sure that you're comfortable with how the recipient will use it.
Consider the following points regarding the types of information you
might be asked for:

w= Address and phone number: Abuse of this informa-
tion results in you receiving increased telemarketing
calls and junk mail. Although less common, this
information may also increase a scammer’s ability to
steal your identity and make your home a more
interesting target for break-ins.

w= Names of husband/wife, father, and mother
(including mother’s maiden name), siblings,
children, and grandchildren: This information is
very interesting to criminals, who can use it to gain
your confidence and then scam you, or use it to
guess your passwords or secret question answers,
which often include family members’ names. This
information may also expose additional family
members to ID theft, fraud, and personal harm.

w= [nformation about your car: Limit access to license
plate numbers; VINs (vehicle identification numbers);
registration information; make, model, and title num-
ber of car; your insurance carrier's name, coverage lim-
its, loan information, and driver’s license number. The
key criminal abuse of this information includes car
theft (or theft of parts of the car) and insurance fraud.
The type of car you drive may also indicate your finan-
cial status, and that adds one more piece of informa-
tion to the pool of data criminals collect about you.
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Information about work history: In the hands of
criminals, your work history can be very useful for
“authenticating” the fraudster and convincing people
and organizations to provide them with more of
your financial records or identity.

Information about your credit status: This informa-
tion can be abused in so many ways that any time
you're asked to provide this online, your answer
should be no. Don't fall for the temptation to check
your credit scores for free through sites that aren’t
guaranteed reputable. Another frequent abuse of
credit information is found in free mortgage calcula-
tors that ask you to put in all kinds of personal
information in order for them to determine what
credit you qualify for.

Many people leave messages on their e-mail automated
response letting people know when they'll be away
from their offices. This is really helpful for colleagues,
but exercise caution and limit who you provide the
information to. Leaving a message that says, “Gone
11/2-11/12. I'm taking the family to Hawaii for ten
days,” may make you a prime target for burglary. And
you'll probably never make the connection between the
information you exposed and the offline crime.

You may need to show your work history, particu-
larly on resumes you post on Internet job or business
networking sites. Be selective about where you post
this information, create a separate e-mail account to
list on the resume, and tell what kinds of work
you've done rather than give specifics about which
companies and what dates. Interested, legitimate
employers can then contact you privately, and you
won't have given away your life history to the world.
After you've landed the job, take down your resume.
Think of it as risk management — when you need a
job, the risk of information exposure is less than the
need to get the job.
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Spot Phishing Scams and Other E-mail Fraud

As in the offline world, the Internet has a criminal element. These
cybercriminals use Internet tools to commit the same crimes they've
always committed, from robbing you to misusing your good name
and financial information. Know how to spot the types of scams that
occur online and you'll go a long way towards steering clear of
Internet crime.

Before you click a link that comes in a forwarded e-mail message or
forward a message to others, ask yourself:

w= s the information legitimate? Sites such as
www . truthorfiction.com, www.snopes.com
(see Figure 20-14), or http://urbanlegends.
about.com can help you discover if an e-mail is a
scam.

(a5

/2 snopes.com: Urban Legends Reference Pages - Windows Intemet Explorer
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v B v &b v [k Page v () Tools * -
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= College Granp

oot CHARITY
Figure 20-14

w= Does a message ask you to click links in e-mail
(see Figure 20-15) or instant messages? If you're
unsure whether a message is genuinely from a
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company or bank that you use, call them, using the
number from a past statement or the phone book.
Remember: Don’t call a phone number in the e-mail;
it could be fake. To visit a company’s or bank’s Web
site, type the address in yourself if you know it or
use your own bookmark rather than clicking a link.

If the Web site is new to you, search for the company

using your browser and use that link to visit its site.
Don’t click the link in an e-mail, or you may land on
a site that looks right — but is just a good fake.

——
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Calendar

Link within an e-mail

Figure 20-15

w= Does the e-mail have a photo or video to download?
If so, exercise caution. If you know the person who
sent the photo or video, it's probably fine to down-
load, but if the photo or video has been forwarded
several times and you don’t know the person who
sent it originally, be careful. It may deliver a virus or
other type of malware to your laptop.
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In addition to these questions, also remember the following:

w= If you decide to forward (or send) e-mail to a
group, always put their e-mail addresses on the
Bcc: (or Blind Carbon Copy) line. This keeps every-
one’s e-mail safe from fraud and scams.

w= Think before you click. Doing so will save you and
others from scams, fraud, hoaxes, and malware.

Create Strong Passwords

A strong password can be one of your best friends in protecting your
information in online accounts and sites. Never give your password to
others, and change passwords on particularly sensitive accounts, such
as banks and investment accounts, regularly.

Table 20-1 outlines five principles for creating strong passwords.

Table 20-1 Principles for Strong Passwords

Principle How to Do It

Length Use at least 10 characters.

Strength Mix it up with upper- and lowercase letters, characters, and
numbers.

Obscure Use nothing that's associated with you, your family, your
company, and so on.

Protect Don't place paper reminders near your laptop.

Change The more sensitive the information, the more frequently you

should change your password.

Look at Table 20-2 for examples of password patterns that are safe but
also easy to remember.
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Table 20-2

Examples of Strong Passwords

Logic

Password

Use a familiar phrase typed with a
variation of capitalization and num-
bers instead of words (text message

shorthand).

L8r_L8rNot2day = Later, later, not today

2BorNot2B_ThatIsThe? = To be or not
to be, that is the question.

Incorporate shortcut codes or
acronyms.

CSThnknAU2day = Can't Stop Thinking
About You today

2Hot2Hndle = Too hot to handle

Create a password from an easy-to-
remember phrase that describes
what you're doing, with key letters
replaced by numbers or symbols.

1mlooklngatyahoo = I'm looking at
Yahoo (We replaced the Is with 1s.)

MyWork@HomeNeverEnds

Spell a word backwards with at
least one letter representing a char-
acter or number.

$1lidoffaD = Daffodils (The $ replaces the s.)
v1frettuB = Butterfly (The 1 replaces the |.)

QWERTY7654321 = This is the 6 letters from
left to right in the top row of your keyboard,
plus the numbers from right to left across the
top going backwards.

Use patterns from your keyboard.
Make your keyboard a palette and
make any shape you want.

1QAZSDRFBHUS is really just making a W on
your keyboard.
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It's a good idea for laptop owners to password-protect
their laptop so that if it's left running in a public
place, or lost or stolen, nobody else can log on to

access the information on it. See Chapter 23 for
information about setting up a Windows password.



Keeping In
Touch with
E-Mail

7-0 use e-mail, you have to have an Internet
connection through an Internet service pro-
vider, such as your phone or cable company.
Once you are online, you can use an e-mail pro-
gram, which is a tool you that allows you to
send e-mails (text messages that you send to oth-
ers over the Internet). These messages are deliv-
ered to e-mail inboxes, usually within seconds.

You can attach files to e-mail and even put
photos or other images within the message
body. You can get an e-mail account through
your Internet provider or through sites such as
Yahoo! or Microsoft Live. These accounts are
typically free.

When you have an e-mail account, you can
send and receive e-mail through the account
provider’s e-mail program online, or you can
set up a program on your laptop — such as
Microsoft Outlook, which comes with
Microsoft Office, or Windows Live Mail, which
is built into the Internet Explorer browser — to
access that account. These programs typically
offer more robust e-mail and contact manage-
ment features than the programs that providers
such as Yahoo! offer.
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To make your e-mailing life easy, this chapter takes a look at how to

perform these tasks:

nmp

[ 2

=y

I

=y

Choose an e-mail provider. Find out how to locate
e-mail providers and what types of features they offer.

Manage your e-mail account. Make settings so you can
send and receive messages for different e-mail addresses
from one e-mail account. This ability to check all your
messages in one place can be useful if you use both a
work and a home e-mail account, for example.

Receive, send, and forward messages. Deal with the
ins and outs of receiving and sending e-mail. Use the
formatting tools that Windows Live Mail provides to
make your messages more attractive and readable.

Add information into the Address Book. You can
quickly and easily manage your contacts as well as
organize the messages you save in e-mail folders.

Set up the layout of all Windows Live features. Use
the Folder bar and Layout features to create the most
efficient workspace.

Set Up an Internet-Based E-Mail Account

336

Your Internet service provider (ISP), whether that’s your cable or phone
company or a satellite provider, probably offers you a free e-mail account
along with your service. You can also get free accounts from many online

sources, such as Yahoo!, AOL, Gmail, and Windows Live Mail.

Here are some tips for getting your own e-mail account:

n-p

Using e-mail accounts provided by an ISP: Check
with your ISP to see whether an e-mail account
comes with your connection service. If it does, your
ISP should provide instructions on how to choose an
e-mail alias (that is, the name on your account, such
as SusieXYZ@att.com) and password and sign in.
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Searching for an e-mail provider: If your ISP
doesn’t offer e-mail, or you prefer to use another ser-
vice because of features it offers, use your browser’s
search engine (see Chapter 19 for more about how
to search online) to look for what's available. Don’t
use the search term free e-mail because results for any
search with the word free included are much more
likely to return sites that will download bad pro-
grams like viruses to your laptop. Alternatively, you
can go directly to services such as Yahoo!, AOL, or
Gmail by entering their addresses in your browser
address box (for example, www.gmail.com).

Finding out about features: E-mail accounts come
with certain features that you should be aware of.
For example, they each provide a certain amount of
storage for your saved messages. (Look for one that
provides 4 gigabytes or more.) The account should
also include an easy-to-use Address Book feature to
save your e-mail contacts’ information. Some services
provide better formatting tools for text, a calendar,
and a to-do list feature. Whatever service you use,
make sure it has good junk mail features to protect
you from unwanted e-mails. You should be able to
control junk mail filters to place messages from cer-
tain senders or with certain types of content in a junk
mail folder, where you can review or delete them.

Signing up for an e-mail account: When you find
an e-mail account you want to use, sign up (usually
there will be a Sign Up or Get An Account button or
link to click) by providing your name and other con-
tact information and selecting a username and pass-
word. The username is your e-mail address, in the
form of UserName@service.com, where service is,
for example, Yahoo!, Windows Live Mail, or AOL.
Some usernames might be taken, so have a few
options in mind.
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w= Choosing a safe username: Don't use your full
name, your location, age, or other identifiers if possible.
Such personal identifiers might help scam artists or
predators to find out more about you than you want
them to know. A username such as GolfFan@aol.
com tells little about you that someone could use to
find you. On the other hand, Joan75Phoenix@
gmail.com reveals your name, age, and location.

Manage Accounts in Windows Live
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In addition to providing your Windows Live e-mail address so that
others can send you mail directly, you can use settings in various
e-mail programs to forward your mail to your Windows Live address
so that you can receive all your e-mail messages in one place. You can
then make settings in Windows Live to use other e-mail addresses
when responding to messages so that your recipients assume the
messages are coming from the originating account.

In the tasks in this chapter, I use Windows Live as an
example of an e-mail service, but most tasks work similarly
in any e-mail program. The first step is to set up an
e-mail account in Windows Live. Open your browser and
type www.windowslive.com in the address field and
press Enter.

2. Your browser displays the Windows Live Mail Sign-In

page shown in Figure 21-1. If you need to start a new
account at this point, click the Sign Up button and go
through the sign up procedure. If you already have an
account, click the Sign In to Windows Live button, click
the account you want to sign into if you have multiple
accounts, enter your password in the field that appears,
and then click the Sign In button.

3. After signing in, click the Mail link to go to the Mail

portion of Windows Live.
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Figure 21-1

4. Choose Options=»More Options. In the resulting Options
window, as shown in Figure 21-2, click the Send and
Receive Mail from Other E-Mail Accounts link.

5. In the resulting window, click the Add an E-mail Account
link.

6. In the following screen, enter an e-mail address and pass-
word; Windows Live verifies your address and sends a
confirmation e-mail to you. Open your other e-mail
account, and click the confirming link in the e-mail.

7. Back in Windows Live, click Next. In the Add an E-Mail
Account window that appears, choose whether to place
mail from this account into your inbox or into a separate
folder. If you like, you can choose to have messages for
this account to appear in a unique color; click one of the
radio buttons in the How Would You Like Unread
Messages for xxx@xxx.com to Appear section. Click Next.
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Click this link
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Figure 21-2

8. Once you are set up to send out messages with that
account name, messages from that account will be delivered
to the folder you selected in Step 7. When you create a
new e-mail form, simply click the arrow on the right of
the From field and select the account you want the

message to go from.

Get to Know Windows Live Mail

Windows Live (see Figure 21-3) is typical of many e-mail programs in
that it includes both menus and tools to take actions, such as deleting
an e-mail, creating a new e-mail, and so on. There’s also a list of
folders on the left. Some typical folders are your Inbox, where most
incoming mail appears; your Outbox or Draft folder, where saved
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drafts of e-mails are saved ready to be sent; and your Sent folder,
where copies of e-mails you've sent to other people are stored.
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Figure 21-3

Finally, the central area of the screen may display folder contents or, if
you are creating or viewing a message, a preview pane that shows the
contents of the selected message. (In Figure 21-4, the contents of a
message being composed is displayed.)

To organize messages in the inbox, click the Sort By
drop-down list and select an option, such as From (to
sort the messages alphabetically by sender), Received
(to sort by the date they were received), and so on.
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Figure 21-4

When you access Windows Live Mail and many of
the other online e-mail services, you are using a pro-
gram that is hosted online, rather than software on
your laptop. That makes it easy to access your mail
from any computer because your messages and fold-
ers are kept online. If you use an e-mail program
such as Outlook, the software and your messages are
stored on your laptop.

Open and Receive Windows Live Mail

1. Use your browser to go to Windows Live at www.mail.
live.com.

2. Your browser and displays the Windows Live Sign-In
page shown in Figure 21-5.
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Messages in the Inbox
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Figure 21-5

3. Click the Sign In to Windows Live button and enter your
password in the field that appears, and then click the
Sign In button to sign in. Windows Live automatically
sends and receives all messages.

4. Click the Mail link at the top of the page if necessary to
view your inbox. (You can see what my inbox looks like in
Figure 21-6.) New messages are displayed in your inbox;
unread messages sport a small closed-envelope icon; those
with attachments have a paper clip icon as well.

If your mail doesn’t come through, it’s probably
because your e-mail provider’s servers are experiencing
technical problems. Just wait a little while. If you still
can’t get mail, make sure your connection to the
Internet is active. Your browser may show you your
inbox, but if you've lost your connection, new
messages can’t be received.
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A new, blank e-mail
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Figure 21-6

Note that if an e-mail has a little exclamation point
next to it in your Inbox, somebody has flagged it as
urgent. It's usually best to check out those e-mails
first!

Create and Send E-Mail

1. Creating e-mail is as simple as filling out a few fields in a
form. Open Windows Live Mail in your browser by going
towww.mail.live.com.

2. Sign in, and then click the Mail button on the Windows
Live Mail screen if needed to go to your inbox.

3. Click the New button to create a new blank e-mail form.
(See Figure 21-7.)
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Enter your message here
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Figure 21-7

4. Type the e-mail address of the recipient(s) in the To field
text box. If you want to send a copy of the message, click
the Show Cc & Bcc link and enter an address(es) in the
Cc: or Bec: field text boxes.

5. Click the Subject text box and type a concise yet
descriptive subject.

6. Click the message window and type your message.
(See Figure 21-8.)

Don't press Enter at the end of a line when typing a
message. Windows Live has an automatic text wrap
feature that does this for you. Do be concise. If you
have lots to say, consider sending a letter by snail-
mail or overnight delivery. Most people tire of read-
ing text onscreen after a short while.
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Keep e-mail etiquette in mind as you type. For exam-
ple, don't type in ALL CAPITAL LETTERS. This is
called shouting, which is considered rude. Do be
polite even if you're really, really angry. Your message
could be forwarded to just about anybody, just about
anywhere, and you don’t want to get a reputation as
a hothead.

7. When you finish typing your message, you should check
your spelling (unless you're the regional state spelling
champ). Click the Spell Check button, and Windows Live
automatically checks spelling and places a red, wavy line
under questionable words. (See Figure 21-9.) Correct any
errors. If you add more text to your message and want to
check the new text for spelling, click the Spell Check
button again.

8. Click the Send button. A message appears, like the one in
Figure 21-10, telling you the e-mail is on its way!
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Confirmation of a sent message
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Figure 21-10
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®

®

If the message is really urgent, you might also click
the High Importance button (it looks like a red
exclamation point) to add a bright-red exclamation
mark to the message header to alert the recipient.
Click the Low Importance button (it looks like a
blue, downward-pointing arrow) to return the priority
to Low.

Remember that when creating an e-mail, you can
address it to a stored address by using the Address
Book feature. Click the To button, and your Address
Book appears. (Check out the “Add People to the
Contact List” section later in the chapter to find out
how to populate your e-mail Address Book.) You can
then select a contact(s) from there. Windows Live
Mail also allows you to just begin to type a stored
contact in an address field (To Bcc: or Cc:), and it
provides a list of likely options while you type. Just
click the correct name when it appears in the list, and
Windows Live enters it.

Send an Attachment

1. It's very convenient to be able to attach a document or
image file to an e-mail that the recipient can open and
view on his end. To do this, log on to your Windows Live
e-mail account and click New to create a new e-mail
message.
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2. Address it, enter a subject, and type a message.

3. Click the Attach button.

4. The Choose File to Upload dialog box appears. (See
Figure 21-11.) Locate the file that you want and then
click Open.
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An attached file
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Figure 21-11

5. The name of the attached file appears in the Attach field
(see Figure 21-12), indicating that it's uploading. When
the first attachment finishes uploading, you can click the
Attach button again and repeat Step 4 as many times as
you like to add additional attachments.

6. Click the Send button to send the message and
attachment.

You can attach as many files as you like to a single
e-mail by repeating the steps in this task. Your only
limitation is size. Various e-mail programs have
different limits on the size of attachments, and some
prevent you from attaching certain types of files for
security reasons. If you attach several documents and
your e-mail fails to go through, it might be too large;
just send a few e-mails and spread the attachments
out among them.
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Figure 21-12

Read a Message

1. When you receive an e-mail, your next step is to read it.
Click an e-mail message in your Inbox or double-click it to
open it in a larger window. Unread messages sport an icon
of an unopened envelope to the left of the message subject.

2. Use the scrollbars in the message window to scroll down
through the message and read it. (See Figure 21-13.)

3. If the message has an attachment, it shows a paper clip
symbol when the message is closed in your inbox;
attachments are listed in the open message. To open
an attachment, click it.

4. In the File Download dialog box (see Figure 21-14),
click the Open button to open the file with the suggested
program. The attachment opens in whatever program is
associated with it (such as the Windows Fax and Picture
Viewer for a graphics file) or the program it was created

350 in (such as Microsoft Word).




If you'd rather save an attachment to a storage disk
or your hard drive, click the Save button in Step 4,
choose the location to save the file to, and then click
Save.

MName: FY 2010 Request -- Murray[l].doc
Type: Microsoft Office Word 97 - 2003 Document, 94.0..,
From: 65.55.40.119

[ oen |[ Swe ][ Cancd ]

harm your computer. F fou do not trust the source, do not open or

@ ‘While files from the Intgmet can be useful, some files can potentially
save this file. What's tHe rsk?

Click Open

Figure 21-13

Select a reply option
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Reply to a Message

1. If you receive an e-mail and want to send a message
back, use the Reply feature. Open the message you want
to reply to, and then select one of the following reply
options, as shown in Figure 21-15:

e Reply: Send the reply to only the author.

¢ Reply All: Send a reply to the author as well as
everyone who received the original message.

Enter recipients here
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Figure 21-15

2. In the resulting e-mail form (see Figure 21-16), enter any
additional recipient(s) in the To: and/or Cc: or Bec: text
boxes and type your message in the message window area.

3. Click the Send button to send the reply.
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Forward E-Mail

1. To share an e-mail you receive with others, use the
Forward feature. Open the e-mail message that you want
to forward.

2. Click the Forward button on the toolbar.

3. In the message that appears with FW: added to the
beginning of the subject line, enter a new recipient(s) in
the To: and/or Cc: and Bcc: fields, and then enter any
message that you want to include in the message window
area, as shown in the example in Figure 21-17.

4. Click Se

nd to forward the message.
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Figure 21-17

Create and Add a Signature

1. A signature is a quick way to add some closing informa-
tion, such as your name and organization, to the end of
every message. Choose OptionswMore Options to open
the Options page. Click the Personal E-mail Signature
link (under Customize Your Mail). (See Figure 21-18.)

2. In the Personal E-Mail Signature form that opens (see
Figure 21-19), type your signature. If you'd like, you can
use the formatting tools on the toolbar to change the
look of the text, including the font, font size, or effects
such as bold or italic.
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Enter your signature here
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Figure 21-18
3. Click Save to save the signature.

If you have a Web site and want to include a link to it
in your signature, click the Insert Hyperlink button on
the toolbar shown in Figure 21-19. Enter the address
in the text box that appears and then click OK.

Remember that if you attach your signature to every
outgoing e-mail, including e-mail replies, whoever
you communicate with will get the information pro-
vided there. Consider issues of identity theft before
you provide your address, phone number, and other
personal information to all and sundry.
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Format E-Mail Messages
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1. Windows Live provides tools to format the text in your
message to change fonts, add color, and more, just as you
would in a word processed document. Create a new
e-mail message or open a message and click Reply or
Forward.

2. Enter text, and then select the text that you want to for-
mat. (See Figure 21-20.)

3. Use any of the following options to make changes to the
font. (See the toolbar containing these tools in Figure 21-21.)

¢ Font Name drop-down list: Choose an option
from the drop-down list to apply it to the text.

¢ Font Size drop-down list: Change the font size here.
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Unindent and Indent options
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Figure 21-20

Bold, Italic, and Underline buttons: Apply styles
to selected text.

Justify Left, Justify Center, and Justify Right but-
tons: Adjust the alignment.

Insert Ordered List and Insert Unordered List
buttons: Apply numbering order to lists or precede
each item with a round bullet.

Unindent and Indent button: Indent that para-
graph to the right or move it (decrease the indent)
to the left.

Insert Hyperlink button: Use this to insert a
hyperlink to a Web site or online document.

Insert Horizontal Rule button: Inserts a line
dividing the signature from the message body.

Foreground Color button: Display a color palette
and click a color to apply it to selected text.

Background Color button: Add color to the
background of the message.

Insert Emoticon button: Click this to view a
selection of graphical smiles and other images to
include in your signature for a bit of fun.
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Figure 21-21

Apply a Theme and Add a Picture

1. You can modify the appearance of Windows Live Mail by
applying a theme, which contains preset designs and col-
ors, to the window. Choose Optionss>More Themes.

2. In the Themes page that appears (see Figure 21-22), click
a theme from the list.

3. Click Save to apply the theme to Windows Live Mail, and
click the Mail link to return to your inbox sporting the
new look. (See Figure 21-23.)
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Figure 21-22

If you are the visual type, you should know that you
can also insert a picture in an e-mail message. With
the e-mail form open, click the Images item in the
Quick Add pane to the right. Enter a search term in
the Search field text box to find an image online, and
then click on any image result to insert it in your
e-mail. You can also use Quick Add to add a map,
movie time, video, business listing, or restaurant
information.
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Figure 21-23

Add People to the Contact List
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1. To make addressing e-mails faster, you can save people’s
e-mail addresses and more in the Contact List. In the
Windows Live Mail main window, click the Contact List
link in the left pane to open the People page, as shown
in Figure 21-24.

2. To create a new contact, click the New button.

3. In the resulting Contact dialog box, as shown in
Figure 21-25, enter the contact information that you
want to save in your Address Book.

e Name and E-Mail: Enter the person’s first and last
name. (This is the only information you must
enter to create a contact.)
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e Personal Information: Enter the person’s e-mail
address, home and mobile phone numbers, and
home addresses.

e Business Information: Enter information about
the company that the person works for as well as
his work e-mail, phone, fax, and address.

e Other Information: Enter any other e-mail,
phone, Web site, or birthday information for the
person.

4. Click Save to save your new contact information, and
then click Mail to return to your inbox.
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Figure 21-24
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£ Windows Live Hotmail - Windows Internet Explorer —— e =]
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Figure 21-25

You can search contacts by clicking People in any
Windows Live window and entering search text in
the Search Your Contact List field. You can also
click the letters listed across the top of the Contacts
window to look for people whose last names begin
with that letter.

Customize the Reading Pane Layout

1. You can modify the layout of elements in the Windows
Live main page to suit you. In the Mail portion of
Windows Live, choose Options>More Options to open
the Options window. Click the Mail link in the left pane.

2. Click Reading Pane Settings (under Customize Your
Mail). Select various options in the Reading Pane
Settings, as shown in Figure 21-26, to modify where the
reading pane appears and when to show messages in
the reading pane.
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Figure 21-26

3. Click Save to save your reading pane settings.

Create Message Folders

1. Message folders are a way to organize your incoming
messages so that you can find them easily. You can
create folders with a few simple steps. Choose the
Manage Folders link near the bottom of the list of folders
in the left pane to open the Manage Folders window
shown in Figure 21-27.

2. Click New.
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3. On the New Folder page (see Figure 21-28) enter a folder

name and click Save.

Enter a name for the new folder
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The message being moved
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4. Click Mail to return to your inbox.
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If you want to remove or rename a folder, you can
use the Rename and Delete buttons in the Manage
Folders window shown in Figure 21-27 to do so.

Organize Messages in Folders

1. To move a message from your inbox into a folder, select
the check box to the left of the message and click Move

Tor>folder name, as shown in Figure 21-29.

The message being moved
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Figure 21-29

2. To move a message between folders, with a folder (such
as the inbox) displayed, click a message and then drag it
into another folder in the Folders list.
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3. To delete a message in a folder, click the folder name to
open it, and click the check box in front of the message.
Click Delete.

If you want to mark a message as junk mail so that
Windows Live Mail puts any message from that
sender in the Junk folder going forward, click the
check box in front of the message and then click
Junk.
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Connecting with
People Online

The Internet is a great place to find people

with similar interests and share information.

You'll find discussion boards and chat features
on a wide variety of sites, with people sharing
information from news to recipes. There are
also sites focused around issues such as grief
and healthcare, and sites that host political- or
consumer-oriented discussions.

There are some great senior chat rooms for
making friends, and many sites allow you to
create new chat rooms on topics that interest
you at any time.

Instant messaging (IM), on the other hand,
isn't a Web site but a service. Using software
such as Windows Live Messenger, IM allows
you to chat in real time with your contacts.
You can access instant messaging programs
via your computer or your cell phone.

With any site where users share information,
you can stay safer if you know how to sidestep
some abuses, including data mining (gathering
your personal information for commercial

or criminal intent), social engineering ploys
that try to gain your trust and access to your
money, ID theft scams, and so forth.

| “*opter
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Throughout this chapter, I provide safety tips, but remember that if
you're careful to protect your privacy, you can enjoy socializing online
with little worry.

In this chapter, I look at some ways you can share information with
others online, and I tell you how to do so safely.

Use Discussion Boards

368

A discussion board is a place where you can post written messages,
pictures, and videos on a topic. Others can reply to you, and you can
reply to their postings.

Discussion boards are asynchronous, which means that you post a
message (just as you might on a bulletin board at the grocery store)
and wait for a response. Somebody might read it that hour — or ten
days or several weeks after you make the posting. In other words, the
response isn’t instantaneous, and the message isn't usually directed to
a specific individual.

You can find a discussion board about darn-near every topic under the
sun, and the information on them can be tremendously helpful when
you're looking for answers. They're also a great way to share your
expertise — whether you chime in on how to remove an ink stain,
provide history trivia about button styles on military uniforms, or
announce the latest breakthroughs in your given field. Postings are
likely to stay on the site for years for people to reference, so be aware
that what you read there may be up-to-date or not that current.

To try out a discussion board, enter this URL in

your browser address field: www.microsoft.com/
communities/newsgroups/en-us/default.
aspx. (Note that some discussion boards require that
you become a member with a username and that you
sign in before you can post comments, though this par-
ticular site doesn't.)
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2. On the left side of the screen, click English (or another
language of your choice) and then click a topic area, such
as Home and Entertainment.

3. In the topic list that appears, click another topic, such as
Games, to see more options. Continue to click until you
get to a specific discussion board, such as the one shown
in Figure 22-1.
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File Edit View Bookmarks Widgets Tools Help
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@ Age of Empires 1 post 11/28/2008
@ General Gamin AOE Mythology )
Discussion 1 post : 11/28/2008
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# Windows XP Gamin Installer reports OMB RAM a9
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e — SD KE!ty 11f22,4'200gﬁ
pos
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H Xbox 1 post 11/21/2008
Lohen graavauksesta
.
Figure 22-1

4. When you click a posting that has replies, you'll see that
they are organized in the middle of the page in easy-to-
follow threads, which arrange postings and replies in an
outline-like structure. You can review the various partici-
pants’ comments as they add their ideas to the entire
conversation.

5. To reply to a posting yourself, first click the posting, and
then click the Reply button. Fill in your comments (see
Figure 22-2) and click Post.
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Enter your comments here
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Figure 22-2

Participate in Chat
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A chat room is an online space where groups of people can talk back
and forth via text, audio, Web camera, or a combination of media.
(See Figure 22-3, which shows a Web site that links to hundreds of
chat rooms.) In chat, you're having a conversation with one or more
people in real time (without delay, as with a discussion board), and

your entire conversation appears in the chat window. Here are some
characteristics of chat you should know:
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w= When the chat is over, unless you save a copy, the
conversation is typically gone.

m= Several people can interact at once, although this can
take getting used to as you try to follow what others
are saying and jump in with your own messages.

w= When you find a chat you want to participate in,
sign up to get a screen name, and then you simply
enter the chat room, enter your message, and submit
it. It shows up in the stream of comments, and others
may — or may not — reply to it.
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Figure 22-3
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When you're talking to someone in a chat room with
multiple people, you can, if you'd like, invite him to
enter a private chat room, which keeps the rest of the
folks who wandered into the chat room out of your
conversation. Also, others can invite you into private
chat rooms. Be careful who you interact with in this
way, and be sure you understand the motivations for
making your conversation private. This may be
entirely reasonable, or it may be that you're dealing
with someone with suspect motivations.

Warning: Before you get started, check out the Web
@ site’s Terms of Use, privacy, and monitoring and
abuse reporting procedures to understand the safety
protections in place before joining a conversation.
Some sites are well monitored for signs of abusive
content or interactions; others have no monitoring at
all. If you don't like the terms, find a different site.

Send and Receive Instant Messages (IMs)

Instant messaging (often called just IM) used to be referred to as
real-time e-mail. It used to be synchronous, meaning that two (or more)
parties could communicate in real time, without any delay. It’s still
synchronous, but now you can also leave a message that the recipient
can pick up later.

Instant messaging is a great way to stay in touch with the younger
generations, who rarely use e-mail. IM is ideal for quick little messages
where you just want an answer without writing a formal e-mail, as
well as for touching base and saying hi. Texting on cellphones,

which you see kids doing on every street corner, is largely the same
phenomenon: This isn’t a tool you'd typically use for a long,
meaningful conversation, but it’s great for quick exchanges.

Depending on the IM service you use, you can do the following:
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w= Write notes to friends, grandchildren, or whomever,
as long as they've installed the same IM service that
you're using.

w= Talk as if you were on the phone.
w= Send photos, videos, and other files.

w= [se little graphical images, called emoticons (such as
smilies or winks) and avatars, to add fun to your IM
messages.

w= See participants via Web cameras.
w= Get and send e-mail.

w= Search the Web, find others using Global Positioning
System (GPS) technology, listen to music, watch
videos, play games, bid on auctions, find dates, and
more.

w= Track the history of conversations and even save
transcripts of them to review later.

Instant messaging programs vary somewhat, and you have several to
choose from, including Windows Live Messenger (available at
http://download.live.com/?sku=messenger), Yahoo!
Messenger (available at http: //messenger.yahoo.com), and AOL
Instant Messenger, also know as AIM, (available at www.aim. com).
Google mail (www.gmail.com) has a built-in IM feature.

To get started with a new messaging program, you need to follow the
general steps in the upcoming list. But as with any software, if you
aren’t sure how to use its features, consult its Help documentation for
specific instructions.

1. Download and install the messaging program according
to the instructions on the provider's Web site.
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2. Set up an account and sign in; this may simply involve
entering your e-mail address and a password.

®

Warning: You can send IMs from a computer to a
mobile phone (and vice versa) and from one mobile
phone to another. If you include your mobile phone
number as part of your IM profile, anyone who can
see your profile can view it. This is useful informa-
tion for friends and criminals, so it's important to
consider whether you want your number exposed —
especially if you have many people on your contact
list who you don't personally know.

3. Double-click a contact to initiate chat. (You can import
contacts from your e-mail contacts when you sign up, or
you can add them yourself.)

4. Click the phone button or other call icon to initiate a
phone call.

®

IM programs let your contacts see when you're
online, unless you change your settings to hide this
information — something that’s good to know when
you're busy and don’t have time to chat. You can
choose availability settings such as Online, Busy, Be
Right Back, Out to Lunch, or even display your status
as Offline, even when you aren’t. In the Windows
Live Messenger IM program shown in Figure 22-4,
you click the arrow next to your name to access such
a list.

IM is one place where people use shortcut text. Some
of this will be familiar to you, such as FYI (for your
information) and ASAP (as soon as possible). Other
short text may be less familiar, such as LOL (laughing
out loud). Visit www . swalk.com for a table of com-
mon shortcut text terms. Knowing these will make
communicating with younger folks more fun.
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Figure 22-4

IM and how you'd feel if the information was made
public. IM allows you to store your conversation his-
tory, which is super useful if you need to go back and
check something that was said. But it has its down-
side. Anything you include in IM can be forwarded to
others. If you're at work, keep in mind that many
employers monitor IM (and e-mail) conversations.

@ Warning: Consider what you're saying and sharing in

child pornography — downloading or continuing to
view this for any reason is illegal. Report the incident
to law enforcement immediately.

@ Warning: If you run across illegal content — such as
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Use Webcams
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Webcams are small video cameras you can use to transmit your picture
to somebody in an online conversation or meeting. They are relatively
inexpensive, and many laptops now come with Webcams embedded
in their lids. (See Figure 22-5.) Each computer manufacturer includes
a software program to use with your built-in Webcam, and some soft-
ware even allows you to record, edit, and post video to YouTube, such
as Hewlett Packard’s CyberLink YouCam.

When you use instant messaging software or join an online meeting,
your Webcam is likely to begin displaying video automatically. Use
the tools in that program to control your Webcam.

A Webcam can be a great way to communicate with friends and fam-
ily, but it can quickly become risky when you use it for conversations
with strangers.

w= Giving your image away, especially one that may
show your emotional reactions to a stranger’s state-
ments in real time, simply reveals too much infor-
mation that can put you at risk.

w= [f you use a Webcam to meet with someone you
don’t know online, they may expose you to behavior
you'd rather not see.

w= Note that Webcams can also be high-jacked and
turned on remotely. This allows predators to view
and listen to individuals without their knowledge.
When you aren’t using them, consider turning your
Webcam off — or disconnecting it, if it isn’t a built-
in model.
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"&" http:/fwww.gateway.com/programs/pseries/design.php ~| 42| x [ nstional Fraud Informstion center 2 ~

File Edit View Favorites Tools Help
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Done & Intemnet | Protected Mode: On #100% -

Figure 22-5

Warning: Teens in particular struggle to use good
judgment when using Webcams. If you have grand-
children or other children in your care, realize that
normal inhibitions seem to fall away when they
aren’t physically present with the person they're
speaking to — and many expose themselves, figura-
tively and literally. In addition to having a conversa-
tion about appropriate Webcam use with children
and teens, it may be wise to limit access to Webcams.
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Overview of Collaborative and Social Networking Sites

Although you may think kids are the most active group using social
networking, you can see from the table in Figure 22-6 that it isn’t the
case. In fact, people 35-54 years old make up the largest segment of
social networkers.

US Internet Users Who Visit Social Networks, by
Gender and Age, Q2 2008 & Q2 2009 (% of respondents
lin each group)

Q2 2008 Q2 2009

Gender

Male 21.3% 37.6%
Femala 31.1% 43.0%
lage

<35 52.4% 71.5%
[5-54 21.3% 43.1%
55+ 6.4% 18.9%

Bource: TNS and The Conferance Board, "Consumer Irternet Barameter;
Becand Quarter 2009, " June 14, 2009

(105201 i eMarketer com

Figure 22-6

There are several types of sites where people collaborate or communi-
cate socially. The following definitions may be useful:

w=  Wiki: A Web site that allows anyone visiting to con-
tribute (add, edit, or remove) content. Wikipedia, for
example, is a virtual encyclopedia built by users pro-
viding information in their areas of expertise.
Because of the ease of collaboration, wikis are often
used when developing group projects or sharing
information collaboratively.

w= Blog: An online journal (blog is short for web log)
that may be entirely private, open to select friends or
family, or available to the general public. You can
usually adjust your blog settings to restrict visitors
from commenting on your blog entries, if you'd like.
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w= Social networking site: This type of Web site (see
Figure 22-7) allows people to build and maintain an
online Web page and create networks of people that
they're somehow connected to — their friends, work
associates, and/or other members with similar inter-
ests. Most social networking sites also host blogs and
have social networking functions that allow people
to view information about others, in the form of
member profiles, and contact each other.

w= Social journaling sites: Sites such as Twitter allow
people to go online with short notes which are typi-
cally about what they're doing or thinking at the
moment. Many companies and celebrities are now
tweeting, as posting comments on Twitter is referred
to. You can follow individuals on Twitter so that
you're always informed if somebody you are a fan of
makes a post.

-
REWARDS
BWMj.com Today's Date: October27-2008 Sign Up | Login | Local Business Search CENTER @

home browse search Bs.?g'g politics travel finance health movies lifestyle video blogs groups

Weewme |/ the #1 Destination for Baby Boomers & Generation Jones Member Iogin

Username / email

* Connect with friends, family and colleagues * Meet new people with similar interests

. " P d
* Get expert advice and voice your opinions # Upload and share photos and videos il
* Shop name brand products at great prices * Members earn valuable reward points

L] REmemberMeﬁ

Forgotyour password?
gotyourp y

| community - shopping | » { Tatle _ 4

ADVERTISEMENT

Connect with friends, family and experts:

Enter aname oremail address

Featured Members LOABING

yeeni:

|

Figure 22-7
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Sign Up for a Social Networking Setvice

380

Many social networking sites are general in nature and attract a wide
variety of users, such as Facebook or MySpace. Facebook, which was
begun by some students at Harvard as a college student-only site, has
become today’s most popular general site, and many seniors use its
features to blog, exchange virtual “gifts” and post photos. Other social
networking sites revolve around particular interests or age groups.

When signing up for a service, understand what is required informa-
tion and what is optional. You should clearly understand why a Web
service needs any of your personally identifiable information and how
they may use that information — before providing it. Consider care-
fully the questions that sites ask users to complete in creating a profile.

Warning: Accepting a social networking service’s default
settings may expose more information than you intend.

Walk through the signup process for Eons, a senior social networking
site, to see the kinds of information they ask for. Follow these instruc-
tions to do so:

1. Type this URL into your browser address line:

WWww.eons.com.

2. Click the Sign Up link near the top of the page.

3. In the signup form that appears (see Figure 22-8), enter

your name, e-mail address, a password, your birthdate,
gender, and zip code.

Note that the site requires your birthdate to verify that
you are a senior, but you can choose to hide this infor-
mation from others later if you don’t want it displayed.

4. Click Sign Up. On the screen that appears (see

Figure 22-9), you can enter a screen name.

Consider nicknames and the messages they send. Names
like lookin'forlove or lonelyinHouston may send
a message that you're lonely and emotionally vulnerable.
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Logina up Help

Already signed up as an Eons member? Log in

Sign up for Eons. It's free and easy to join.

Al flelds on this page are required. Eons is the online

community for
Full name  |Jane Alexandersan First and last name BOOMers and beyond.
Email address  IllAmom5E7@juno. com| On Eons, you can
= Stay in touch with friends and family online
Create 3 password At least 5 characters = Share photos and videos

= Discuss your passions and interests
Binthday  Qctober ~ 27 = 1850 : @ Why does Eons nead this? * Control your privacy
= Find friends you havent seen in eons

Gender o Eitisle = Challenge yourself and others to brain games
= And, most of all, hawve fun!
2 Male
LS. ZP code | live outside the U5, Get ready to BOOM Your Life!

By clicking "Sign up" you are indicating that you have read
and agree to the 1 Terms of Use and '] Privacy Palicy

Figure 22-8

Change your screen name

See if your new screen name is available

‘four screen name is how Eu.ns Eons is the online
members know you. Keep this

or create a new one community for
BOOMers and beyond.

Screen name JaneAlexanderson

On Eans, you can

Werification (type what

oo | gspammy

= Stay in touch with friends and family online

Share photos and videos
= Discuss your passions and interests

| Typethe two words: = Control your privacy

= Find friends you havent seen in eons

® Challenge yourself and others to brain games
= And, most of all, have fun!

Get ready to BOOM Your Life!

@ 2006-2008 Eons, Inc. All rights reserved.  Home  AboutUs  Careers  Privacy Policy  TermsofUse  Advertise  Help  ContactHelp Team

Figure 22-9
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Click Check Availability to see if the alias you entered is
not already in use as a screen name. If the screen name
you request is already taken, choose another screen name
and try again.

Type the word or phrase shown in the Verification field
and click Sign Up.

At this point, you're instructed to check your e-mail
account for a message. When you receive the message,
click the link in it to confirm your e-mail address.

Note that after you confirm your e-mail address, a confir-
mation appears, offering a link to enhance your profile.
Click that link.

Scroll to the bottom of the page. In the last paragraph on
the page, click the Privacy Settings link.

On the Privacy Settings page (see Figure 22-10), note
which settings default to Everyone, allowing anyone on
the site to view your information, see your recent activity,
comment on your blog, contact you, and so on.

Change any privacy settings you wish and click Save.

Click the Profiles tab to return there and post a blog
entry, add photos, or make changes to your profile by
clicking links in the About section.

@ It's often very difficult to remove information from
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sites if you later regret the amount of information
you've shared. It’s best to be conservative in the
information you share during the signup process;
you can always add more later.
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# Home Hella, Logout (@1 Account Settings Invite Help

—_— - - Search Eons
an eons ¥ }__proﬂle- vuﬂplore v | groups ¥ | people ¥ ||_g_gmes v| A Peaple

Who can view my full profile? Everyone -
Wyho can view my real name? Ma one -
i .
Who can view my email? Mo one -
YWho can contact me by private messaging me? Everyone -

YWho can see when | am online? Evaryona =

Who can imvite me as a friend?  Everyone -
Whao can see my LifePath? Everyone -
Wha can comment on my blog? Everyone -
Who can comment on my profile? Everyone -
Comments posted to my profile will be posted Automatically -
Who can see my recent activity?  Everyone -

Who can be notified when it's my birthday? My friends and groups | belong to

Figure 22-10

How Online Dating Works

Many seniors are making connections with others via online dating
services. In fact, finding a possible partner online can be a good way to
gradually get to know somebody (and make sure he or she is right for
you) before you meet in person. If you've been wondering if this route
could be for you, here’s how you can jump into the world of online
dating:

w= Choose a reputable dating site. (See the section,
“Select a Dating Service,” later in this chapter.)

w= Sign up and provide information about your likes,
dislikes, preferences, and so on. This often takes the
form of a self-guided interview process.
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Create and modify your profile to both avoid expos-
ing too much personal information and ensure that
you're sending the right message about yourself to
prospective dates.

Use search features on the site (see Figure 22-11) to
find people who interest you and send them mes-
sages or invitations to view your profile.

You'll get messages from other members of the site,
to which you can respond (or not). Use the site’s
chat and e-mail features to interact with potential
dates. You may also be able to read comments about
the person from others who've dated him or her, if
the site has that feature.

When you're comfortable with the person and feel
there might be a spark, decide if you want to meet
the person offline.

Formal dating sites aren’t the only places that people
meet online, but they typically have the best safe-
guards in place. If you want to interact with people
you meet on other sites, you should provide your
own safeguards. Create a separate e-mail account (so
you can remain anonymous and abandon the e-mail
address if needed). Many dating sites screen partici-
pants and provide strong reporting measures that are
missing on other types of sites, so be particularly
careful. Take your time getting to know someone first
before connecting.
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- e o 5 VIEW MORE | LOCAL SINGLES

5.
l‘{

[trznslate]

o Senior Passions

Ads by Google Senior Activities Senior Chat Room Senior Year Senior Men Senior Citizens

Search My Account | EVERYTHING IS 100% FREE

line opular Search = Y ) y State Search by Keyword

General Dating Search

lama: |Male seeking a Female E
Age range: mﬁln 55 E

Country: ‘USA E

Location: \Entlre Country B

Identify the type of people you'd like to meet
Figure 22-11

Select a Dating Service
Select your online dating service carefully.

w= ook for an established, popular site with plenty of
members and a philosophy that matches your own.

w= Review the site’s policy regarding your privacy and
its procedures for screening members. Make sure
you're comfortable with them.

m= [Ise a service that provides an e-mail system that you
use for contacting other members only (sometimes
called private messaging). By using the site’s e-mail
rather than your own e-mail address, you can main-
tain your privacy.
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w=  Some sites, such as http://saferdates.com,
shown in Figure 22-12, offer stronger levels of
authenticating members. Safer Dates, for example,
uses fingerprint identification and screening to make
you more confident that you know who you're inter-
acting with.

_H
love 3, O r— |
P Q - seeking & |Woman E
'S"’Léf)l’ D“’é&é‘“: 7::‘: > who is from 1EBtD EUE

wha has a photo [

Search

The Newest and Safer Way of Dating Online

Login | Register Now
=
REGISTERINOW,

Member Login | Username: | Password: ‘

A Safer Way to Date Online

—a— THERE’S A BETTER, SAFER

=5 ¥ WAY OF DATING!

IT'S OKAY TO SNEEK PEEK

GET STARTED NOW YO‘JR SAFER DATE

LRV A
Featured Profiles

Investidate

LEVEL 1 VERIFIED

Age: 22 " N\
Investi 5
Looking for: Man

Figure 22-12

we» Visit a site such as www . consumerrankings.com/
Dating.com for comparisons of sites. Whether you
choose a senior-specific dating site such as Dating
ForSeniors.com or a general population site such as
PerfectMatch.com, reading reviews about them ahead
of time will help you make the best choice.

ing, but if you try a site and experience an unpleasant
incident involving another member, report it and
make sure the service follows through to enforce its
policies. If it doesn’t, find another service.

@ Most people have good experiences with online dat-
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Your Laptop
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“ A centralized security management system
sounds £ine, but then what would we do
with all the dogs?”







Laptop Security
and Safety

our laptop contains software and files that

can be damaged in several different ways.
One major source of damage is from malicious
attacks that are delivered via the Internet. Some
people create damaging programs called viruses
specifically designed to get into your laptop
hard drive and destroy or scramble data.
Companies might download adware to your
laptop, which causes pop-up ads to appear,
slowing down your laptop’s performance.
Spyware is another form of malicious software
that you might download by clicking a link or
opening a file attachment; spyware sits on your
laptop and tracks your activities, whether for
use by a legitimate company in selling you
products or by a criminal element to steal your
identity.

Microsoft provides security features within
Windows 7 that help to keep your laptop and
information safe, whether you're at home or
travelling.

In this chapter, I introduce you to the

major concepts of laptop security and cover
Windows 7 security features that allow you to
do the following:

w= [Understand laptop security and why you
need it.

| “*opter

Getready to. ..
w= Understand Laptop

Security ..oooveeiiieeiieee,

w=» Understand Windows

Update Options...............
w= Run Windows Update .....

w= Set Up Trusted and

Restricted Web Sites .......

w= Enable the Windows

Firewall....oooeeeeeeeeeeee,

= Set Up a Password for

Your Laptop ......ccceeeene.

w= Check Your Laptop’s

Security Status ................

w= Use a Lock to Deter

Thieves .....ovvvvveeeeannn,

w= Utilize a Fingerprint

Reader.....ooooveeeeeeeeeeeenn,

w= Protect Your Laptop from
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w= Run periodic updates to Windows, which install
security solutions and patches (essentially, patches
fix problems) to the software.

w= Enable a firewall, which is a security feature that
keeps your laptop safe from outsiders and helps you
avoid several kinds of attacks on your data.

w= Set up a password to protect your laptop from
others.

w= Protect yourself against spyware.

w= [Ise devices such as a laptop lock or fingerprint
reader to keep bad guys away from your laptop.

w= Protect your laptop from physical damage.

Understand Laptop Security

390

When you buy a car, it has certain safety features built in. After you
drive it off the lot, you might find that the manufacturer slipped up
and either recalls your car or requests that you go to the dealer’s ser-
vice department to get a faulty part replaced. In addition, you need to
drive defensively to keep your car from being damaged in daily use.

Your laptop is similar to your car in terms of the need for safety. It
comes with an operating system (such as Microsoft Windows) built in,
and that operating system has security features. Sometimes that oper-
ating system has flaws, and you need to get updates to it to keep it
secure. (I tell you more about that in the next two sections.) And as
you use your laptop, you're exposing it to dangerous conditions and
situations that you have to guard against.

Threats to your laptop security can come from a file you copy from a
disc you insert into your laptop, but most of the time, the danger is
from a program that you downloaded from the Internet — knowingly
or unknowingly. These downloads can happen when you click a link,
open an attachment in an e-mail, or download a legitimate piece of
software without realizing that the malware is attached to it.
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There are three main types of dangerous programs (called malware)
you should be aware of:

2

In=p

A virus is a little program that some nasty person
thought up to spread around the Internet and infect
laptops. A virus can do a variety of things, but typi-
cally it attacks your data, deleting files, scrambling
data, or making changes to your system settings that
cause your laptop to grind to a halt.

Spyware consists of programs whose main purpose in
life is to track what you do with your laptop. Some
spyware simply helps companies you do business
with to track your activities so they can figure out how
to sell you things; other spyware is used for more
insidious purposes, such as stealing your passwords.

w=  Adware is the computer equivalent of telemarketing

phone calls at dinner time. Once adware is down-
loaded onto your laptop, you'll get annoying pop-up
windows trying to sell you things all day long.
Beyond the annoyance, adware can quickly clog your
laptop. Its performance slows down, and it’s hard to
get anything done at all.

To protect your information and your laptop from these various types
of malware, you can do several things:

[ 2

You can buy and install an antivirus, antispyware,
or anti-adware program. Programs such as McAfee
Antivirus, Norton Antivirus from Symantec (see
Figure 23-1), or the freely downloadable AVG Free
from Grisoft can help stop the downloading of mali-
cious files. These types of programs can also detect
files that have somehow gotten through and delete
them for you. Remember that after you install such a
program, you have to download regular updates to it
to handle new threats, and you need to run scans on
your system to catch items that might have snuck
through. Many antivirus programs are purchased by
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yearly subscription, which gives you access to
updated virus definitions that the company con-
stantly gathers throughout the year.

w= Some other programs, such as Spyware Doctor from
PC Tools, combine tools for detecting adware and
spyware. Windows 7 has a built-in program, Windows

Defender, that includes an antispyware feature.

w= You can use Windows tools to keep Windows up

to date with security features and fixes to security
problems. You can also turn on a firewall, which is a
feature that stops other people or programs from
accessing your laptop without your permission.
These two features are covered in this chapter.

£ Antivirus Software - Spyware Remover | Norton AntiVirus - Windows Internet Explorer

[ D nttp/w

symantec.com norton antivirus

N rton United States = Shopping & Search

MNorton

Welcome Products & Services Viruses & Risks Downloads

Support

Community Store

Norton™ AntiVirus 2009 Upgrade

Norton Winning protection against viruses, spyware, and malicious software
AntiVirus 2009

ek Antispyware

© Download antivirus software
co
2-vear Download

$39.%0

Norton will donate
10% OF YOUR
SECURITY PRODUCT
PURCHASE PRICE

to keep kids safe online

More Infor
For Windows KPAista® | View Product Tour £1¢ | “iew Product Tutoriaks 51

How It Works System Requirements Compare Related Products Product Support

From now until Thursday May 14, 2009, Norton will donate 10% of your 1-Year

Award-Winning Protection
product purchase to keep our kids safe online.

100

Key Benefits
« Stops viruses, worms, spyware, bots, and more—Keeps your system

protected against all types of malicious threats VIRUS
« Norton™ Insight—Delivers innovative intelligence-driven technology for faster,

fewer, shorter scans

« NEW Rapid pulse updates every 5 to 15 minutes—provides up-to-the-minute
protection

- Prevents virus-infected emails and instant messaces from snreading—

& Internet | Protected Mode: On

HAPPY MOTHER'S DAY!

£ A0D

Renew Subscription +

4~ HRioox o~

Figure 23-1
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Understand Windows Update Options

When a new operating system like Windows 7 is released, it has been
thoroughly tested; however, when the product is in general use, the
manufacturer begins to find a few problems or security gaps that it
couldn’t anticipate. For that reason, companies such as Microsoft
release updates to their software, both to fix those problems and deal
with new threats to laptops that appeared after the software release.

Windows Update is a tool you can use to make sure your laptop has
the most up-to-date security measures in place. You can set Windows
Update to work in a few different ways by choosing Start=>All
Programs>Windows Update and clicking the Change Settings link on
the left side of the Windows Update window that appears. In the
resulting dialog box (see Figure 23-2), click the Important Updates
drop-down list and you find these settings:

w= nstall Updates Automatically: With this setting,
Windows Update starts at a time of day you specify, but
your laptop must be on for it to work. If you've turned
off your laptop, the automatic update will start when
you next turn on your laptop, and it might shut down
your laptop in the middle of your work to reboot (turn
off and then on) and complete the installation.

w= Download Updates But Let Me Choose Whether to
Install Them: You can set up Windows Update to
download updates and have Windows notify you
(through a little pop-up message on your taskbar)
when they're available. You get to decide when the
updates are installed and when your laptop reboots
to complete the installation. This is my preferred set-
ting because I have control and won’t be caught
unawares by a laptop reboot.

w= Check for Updates But Let Me Choose Whether to
Download and Install Them: With this setting, you
neither download nor install updates until you say
so, but Windows notifies you that new updates are
available.
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w= Never Check for Updates: You can stop Windows
from checking for updates and check for them your-
self, manually. (See the following task for instruc-
tions.) This puts your laptop at a bit more risk
because you may neglect to download important
updates, but it’s useful for you to know how to per-
form a manual update if you discover a new update
is available that you need.

Click this arrow for drop-down list

F=H|EDH
@Uv\ 7 « Systemand Security » Windows Update » Change settings ~ [ 4 ||| searcn Jrontrot pane o]

Choose how Windows can install updates

When your computer is onling, Windows can autematically check for impertant updates anfl install them
using these settings. When new updates are available, you can also install them before shuting down the
computer.

How does automatic updating help me?

Important updates

Check for updates but let me choose whether to download and install them

Every day at |3:00 AM
Recommended updates

[¥] Give me recommended updates the same way [ receive important updates
Who can install updates

[Z] Allow all users to install updates on this computer

Note: Windows Update might update itself automatically first when checking for other updates. Read our
privacy statement online.

[ ®ok || cancel

Figure 23-2

Run Windows Update
1. Choose Start=>All Programs=>Windows Update.

2. In the Windows Update window, click Check for
Updates. Windows thinks about this for a while, so feel
free to page through a magazine for a minute or two.
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3. In the resulting window, as shown in Figure 23-3, click
the Updates Are Available link to see all optional or
important updates.

4. In the following window, which shows the available
updates (see Figure 23-4), click to select available critical
or optional updates that you want to install. Then click
the OK button.

5. In the Windows Update window that appears, click the
Install Updates button. A window appears, showing the
progress of your installation. When the installation is
complete, you might get a message telling you that it's a
good idea to restart your laptop to complete the installa-
tion. Click Restart Now.

Click this link

Chapter 23: Laptop Security and Safety

— ]
O_u - |f.7i » Control Panel » System and Security » Windows Update iz ‘ ‘9‘ | Search Control Panel il

File Edit View Tools Help

@
& Control Panel Home <
I oniinl 2anel Home Windows Update

+3 Check for updates

Change settings - ) )
r No important updates avpilable
View update history |
re hidden updates 6 optional updates are available 4 Mo updates are currently selected.

(7) Updates: frequently asked
questions

Mast recent check for updates:  Yesterday at 7:27 PM
Updates were installed: Yesterday at 7:28 PM. View update history
You receive updates: For Windows and other praducts from Microsoft Update

See also
Installed Updates

Figure 23-3
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Select update to install

— )= ]
@ :/-w‘ £l <« System and Security » Windows Update » Select updates to install - |¢f| ‘ Search Control Panel £ |
File | Edit View Tools Help
Sglect the updates you want to install
P y
= =
"] Mame Size Microsoft Silverlight (KB960353)
Opti Silverlight (1) . * | Microsoft Silverlight is a lightweight

browser plug-in for Internet Explorer

o - and Firefox that blends animation,
Windows 7 Client (4) ~

audio/video, and interactivity to deliver
"1 Realtek - Network - Realtek RTLB168C(P)/8111C(P) Family PCI-E Gigabit Ether... 119 KB richer Web site experiences.
[C] Ricoh Company - Bus Controllers and Ports, Storage - Ricoh Memory Stick H... 81 KB Published: 2/25/2009

-:; Ricoh Company - Bus Controllers and Ports, Storage - Ricoh SD/MMC Host C... 55 KB Z  ypdateis ready for
| Ricoh Company - Bus Controllers and Ports, Storage - Ricoh xD-Picture Card ... 117 KB "_ﬁ% downloading

Windows Live (1) ~ | More information

“1 Windows Live Essentials 11 MB Support information

Mo updates are selected. OK | | Cancel

Figure 23-4

You can set up Windows Update to run at the same

time every day. Click the Change Settings link in the
Windows Update window and choose the frequency
(such as every day) and time of day to check for and
install updates.

Running Windows Update either automatically or
manually on a regular basis ensures that you get the
latest security updates to the operating system. It's a
good idea to stay current with those updates.

Set Up Trusted and Restricted Web Sites
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1. You can set up Internet Explorer to recognize Web sites

you trust, and those you don’t want Internet Explorer to
take you or anybody else who uses your laptop to. Click
the Internet Explorer icon in the Windows taskbar to start
your browser.
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2. Choose Tools=>Internet Options.

3. In the Internet Options dialog box (see Figure 23-5),
click the Security tab.

Security tab
|

Internet Optipns St 7 (=5

| General | Security | Privacy l Content l Connections | Programs ! Advanced |

Select a zone to view or change security settings.

@ & v 0O

Local intranet  Trusted sites  Restricted sites

Internet

0 This zone is for Internet websites, SES
except those listed in trusted and
restricted zones.

Security level for this zone

Custom
Custom settings.
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level,

|| Enable Protected Mode (reguires restarting Internet Explorer)

| Custom level... || Default level |

I Reset all zones to default level |

[ oK ] | Cancel

Figure 23-5

4. Click the Trusted Sites icon and then click the Sites
button.

5. In the resulting Trusted Sites dialog box, enter a URL
(Web site address) in the Add This Web Site to the Zone
text box for a Web site you want to allow your laptop to
access.

If you wish any locations for a particular company, such
as Microsoft, to be allowed, you can use a wildcard in the
form of an asterisk, as shown in the Websites field in
Figure 23-6.
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An asterisk serves as a wildcard

Trusted s{tes — e (3]

pu can add and remove websites from this zone. All websites in

’
7 Y
" this zone will use the zone's security settings.

&

Add this website to the zone:
https :/fvww.ilookbothways.com

Websites:
https: /= microsoft.com Remove

[¥] Require server verification (https:) for all sites in this zone

Close

Figure 23-6

6. Click Add to add the site to the list of Web sites, as
shown in Figure 23-6.

7. Repeat Steps 3-6 to add more sites.

8. When you're done, click Close and then click OK to close
the dialog boxes.

9. To designate sites that you don’t want your laptop to
access, repeat Steps 1-8, clicking the Restricted Sites icon
rather than Trusted Sites in Step 4 to designate sites that
you don’t want your laptop to access.

Verification (https:) for All Sites In This Zone check
box is selected, any trusted site you add must use the
https prefix, which indicates that the site has a secure
connection.

@ In the Trusted Sites dialog box, if the Require Server
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You can establish a Privacy setting on the Privacy tab
of the Internet Options dialog box to control which
sites are allowed to download cookies to your laptop.
Cookies are tiny files that a site uses to track your
online activity and recognize you when you return to
the source site. Some sites need to use cookies to
allow you to use your account and that’s fine, but
other sites may use cookies to track and even sell
information about your online activities that could
put you at risk. Trusted sites are ones that you allow
to download cookies to your laptop even though the
privacy setting you have made might not allow many
other sites to do so. Restricted sites can never down-
load cookies to your laptop, no matter what your
privacy setting is.

Enable the Windows Firewall

1. A firewall keeps outsiders from accessing your laptop via
the Internet. Choose Starte>Control Panel=>System and
Security>Windows Firewall.

2. In the Windows Firewall window that appears (see
Figure 23-7), check that the Windows Firewall is marked
as On. If it isn’t, click the Turn Windows Firewall On or
Off link in the left pane of the window.

3. In the resulting Customize Settings window (see
Figure 23-8), select the Turn on Windows Firewall radio
button for Home or Work (private) Network Location
Settings and/or Public Network Location Settings and
then click OK. It's always a good idea to have the firewall
turned on when you go online using a public location
such as an Internet café. If you have a home network,
you may already have a firewall active in the router (one
piece of equipment used to set up the network) so the
home setting could be optional.

Chapter 23: Laptop Security and Safety
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Verify the firewall is on

E Control Panel Home r . .
I ~oniroiane Home Help protect your computer with Windows Firewall

llow a program or feature
through W

@ Chang

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.

How does a firewall help protect my computer?

What are network locations?
l l@ Home or work (private) networks Connected (&)

Metworks at home or work where you know and trust the people and devices on the network

Troubleshoot my network

'— Windows Firewall state: On
Incoming connections: Block all connections to programs that are not on the
list of allowed programs
Active home or work (private) networks: ff‘.‘? 2WIRE148
Motification state: Motify me when Windows Firewall blocks a new
program
. @ Public networks Not Connected (¥

See also

Figure 23-7

4. Click the Close button to close Windows Security Center
and the Control Panel.

A firewall is a program that protects your laptop from
the outside world. This is generally a good thing. If
you have set up a Virtual Private Network (VPN) that
you connect your laptop to when at home, be aware
that using a firewall with a VPN results in you being
unable to share files and use some other VPN features.

Antivirus and security software programs may offer
their own firewall protection and may display a
message asking if you want to switch. Check their

= = 22
@Qv‘o » Control Panel » pystem and Security » Windows Firewsll - |¢,| | Search Control Panel Pl
File Edit View Tools Help




features against Windows and then decide, but
usually most firewall features are comparable. The
important thing is to have one activated.

Select this option

——— ] )

File Edit View Tools

Custo

a.

\?'

@\;jvlﬁ <« System and Security » Windows Firewall » Customize Settings - ‘ hy‘ | Search Control Panet P |

You can thodify the firewall settings for each type of network location that you use,
What are petwork locations?

Home erfwork (private) network location settings

Public ngtwork location settings

| LS Turn on Windows Firewall

elp

njize settings for each type of network

@ Turn on Windows Firewall
["] Block all incoming connections, including those in the list of allowed programs

[7] Notify me when Windows Firewall blocks a new program

Turn off Windows Firewall (not recommended)

| Block all incoming connections, including those in the list of allowed programs

[] Notify me when Windows Firewall blocks a new program

Turn off Windows Firewzll (not recommended)

ok || Ccancel

Figure 23-8

Set Up a Password for Vour Laptop

1. To set up

a password on your user account so others can’t

get at your laptop and files without entering that pass-
word, choose Start=>Control Panel, and then click User

Accounts

and Family Safety.

2. In the resulting window shown in Figure 23-9, click the
Change Your Windows Password link. Then, if you have
more than one user account, click an account to add the

password

to. Click the Create a Password for Your

Account link.

Chapter 23: Laptop Security and Safety

401



Part V: Taking Care of Your Laptop

Click this link

h v‘% v Control Panel » User Accounts and Family Safety » - | 5 | | Search Control Pane! P

% User Accounts

em and Security Change your account picture 'ﬁ' Add or remove user accounts | Change your Windows password
k and Internet
Parental Controls

Hardware and Sound ; l&‘ Set up parental controls for any user

Programs

User Accounts and Family |EM Windows CardSpace
Safety ' Manage Information Cards that are used to log on to enline services

Appearance and :
Personalization é'j Credential Manager
Clack, Language, and Region Manage Windows credentials

i @ Mail (32-bit)
All Control Panel tems

Figure 23-9

3. In the Create a Password for Your Account screen, shown
in Figure 23-10, enter a password, confirm it, and add a
password hint.

4. Click the Create Password button.

5. You return to the Make Changes to Your User Account
window. If you wish to remove your password at some
point, you can click the Remove Your Password link here.
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Enter and confirm the new password

| (5]
@v-e“.e{ + Control Panel »| User Accounts and Family Safety » User Accounts » Create Your Password - |+y| [ Search Control Pane! Pl

File Edit View Tools Help

Create a password for your account

|
5 Owner
Administrator

[receeeed]

Confirm new password

T your password contains capital letters, they must be typed the same way every time you log on.
How to create a strong password

Type a password hint
The password hint will be visible to everyone who uses this computer,
What is a password hint?

| Create password || Cancel

Figure 23-10

6. Click the Close button to close the User Accounts
window.

If you forget your password, Windows shows the hint
you entered to help you remember it, but remember
that anybody who uses your laptop can see the hint
when it's displayed. So, if lots of people know that
you drive a Ford and your hint is “My car model,”
your password protection is about as effective as a
thin raincoat in a hurricane. Consider using a less
known but easy to remember password. If you love
Shakespeare, for example, use ROmeO&Jullet where
the o's are replaced by zeros and the I's by ones. Easy
to remember, but hard to guess!

After you create a password, you can go to the User
Accounts window and change it at any time by click-
ing Change Your Password. You can also change the
name on your user account by typing Change Your
Account Name.
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Check Vour Laptop’s Security Status
1. Choose Start=>Control Panel=>System and Security.

2. In the resulting System and Security window, (see Figure
23-11) click the Review Your Computer’s Status and
Resolve Issues link.

Click this link
|

@uw“*@ » Control Panel » System and Security » v|-,|| Search Control Pane

Control Panel Home

w Action Center

Review your computer's status and resolve issues

System and Security
MNetwork and Internet

"“_'1‘ Change User Account Control settings | Troubleshoot commeon computer problems
Restore your computer to an earlier time

Hardware and Sound & ‘ .
£¥ \Windows Firewall

Programs Check firewall status | Allow a program through Windows Firewall

User Accounts and Family

Safety g System

o == View smount of RAM and processorspeed | Check the Windows Experience Index
ppearance and =

Personalization

Clock, Language, and Region = Windows Update

Ease of Access Turn automatic updating on or off | Check for updates | View installed updates

H Allow remote access | See the name of this computer | Bl Device Manager

‘-i Power Options
= Change battery settings | Require a password when the computer wakes
Change what the power buttons do | Change when the computer sleeps

A Backup and Restore

g" Back up your computer | Restore files from backup

’_i BitLocker Drive Encryption

W\ Protect your computer by encrypting data on your disk | Manage BitLocker
s, Administrative Tools

{#=| Free up disk space | Defragment your hard drive
) Create and format hard disk partitions | ¥ View event logs | Y Schedule tasks

NVIDIA Control Panel
=B

=D

Figure 23-11

3. In the Action Center window that appears (see Figure
23-12), check to see if the Security item states whether
Windows found any antivirus software on your laptop.

4. 1f Windows did not find such software, click the Find A
Program Online button and review the recommended
security software partners that Microsoft recommends. If
you want to purchase one of these solutions, click the logo
of the company you want to buy from, and you are taken to
their site, where you can buy and download the software
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Find out if you have antivirus software
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E= [[CO8 [Ex3)
@\/ﬂ?lf’ » Control Panel » Pystem and Security » Action Center - ‘ h’»‘ | Search Control Panei gl |
& -
Control Panel Home . )
Review recent messages and resolve problems

Change Action Center settings Action Center has detected one or more issues for you to review.
®J Change User Account Control

Gt ings Security X

View archived messages

View perfformance information Virus protection (Important) —————————

Find a program online

Windows did not find antivirus software on this computer,

Turn off messages about virus protection

Windows Defender needs to scan your computer

Scanning on a regular basis helps improve the security of your Scan now
computer.

Windows Update

Windows Update is set to check with you before downloading Change settings...
and installing updates,

Turn off messages about Windows Update

]

See also Maintenance X

Backup and Restore

Windows Update I you don't see your problem listed, try one of these:

Windows Program .

Compatibility Troubleshooter r_l—| Troubleshoating i L Recovery A
S Find and fiv nrohleme | Rectare unur comnuter fn

Figure 23-12

It’s very important that you do have antivirus and

antispyware software installed on your laptop, and
that you run updates to them on a regular basis.
These types of programs help you avoid download-
ing malware to your laptop that could cause advertis-
ing pop-ups, slow your laptop’s performance,
damage computer files, or even track your keystrokes
as you type to steal your identity and more. If you
don’t want to pay for such a program, consider a free
solution such as Spyware Terminator (www. spyware
terminator.com).

Use a Lock to Deter Thieves

When you travel with your laptop, you may have to leave it alone for
a few moments now and then — perhaps in a cubicle in a branch
office or a table at an Internet café while you step away to grab your
latte. When that happens, a lock that you clip to your laptop (usually
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on the back or side, identified by a lock icon) and wrap around a
table or desk leg might make you feel more secure. These are similar to
the lock you use to keep your bicycle safe as you wander into a store
or gym.

Don’t count on a laptop lock for a lengthy absence. They are relatively
easy to circumvent. But for a short period of time in a non-high-risk
area, they can have their uses.

Locks are relatively cheap, from about $5 to $30 or so. They're also
usually pretty easy to tuck into a laptop case without adding much
bulk.

Utilize a Fingerprint Reader

406

Fingerprint readers use biometric technology that identifies you by a
unique physical characteristic. Here’s what you should know about
laptop fingerprint readers:

w= Many laptops include a built-in fingerprint reader for
security. This is useful to keep anybody but you from
accessing data on your laptop because your finger-
print is unique. See your manual for instructions on
using it.

w= If your laptop doesn’t have a built-in fingerprint
reader, you can buy an external model such as the
Microsoft Fingerprint Reader. These have a wide
price range (from about $40 to $200), but they are
relatively portable. Figure 23-13 shows one such
device from Eikon.

w= Some fingerprint readers allow you to log in to your
laptop by simply swiping your finger over the reader,
and some can also store passwords for your online
accounts.



Figure 23-13

Protect Vour Laptop from Damage

Here are a few tips for protecting your laptop from physical damage,

or recouping some losses if damage does occur:

[T 2

Iy

[T 2

A well-made laptop case is really a must when mov-
ing about with your laptop. It helps to protect the
laptop in the case of a fall and from things falling on
it. Look for one with both good padding and slots
for USB sticks and cords and DVDs, a power cord,
and possibly a fingerprint reader or lock.

Your laptop screen is one of its biggest vulnerabilities.
If it gets scratched or damaged in some way, short of
attaching an external monitor (which doesn’t do you
much good if you're on a plane), your laptop is pretty
much a goner. You can buy a fairly lowcost screen
protector, a thin sheet of plastic that you place across
your monitor that can help prevent scratches and, as a
bonus, keep your screen clean, as well.

Because you can't prevent each and every possible
disaster, always back up your data so you don’t lose
it, and consider getting insurance for your laptop. If
your homeowner’s policy doesn’t already cover it,
companies such as Safeware offer special laptop
insurance against damage and theft. If your laptop is
essential to your work or hobby, or if you travel with
it a great deal, you might want to get an insurance
quote and see if it fits your budget.

Chapter 23: Laptop Security and Safety
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Maintaining
Windows

A 11 the wonderful hardware that you've
spent your hard-earned money on doesn’t
mean a thing if the software driving it encoun-
ters problems. If any programs cause your sys-
tem to crash (meaning it freezes up), you can
try a variety of measures to fix it. You can also
keep your system in good shape to help you
avoid those crashes. In this chapter, you find
out how to take good care of your programs
and operating system in these ways:

w= When a program crashes, you can simply
shut that program down by using the
Windows Task Manager. This utility
keeps track of all the programs and pro-
cesses that are running on your laptop.

w= [f you've got problems and Windows
isn't responding, sometimes it helps to
restart in Safe mode, which requires your
system to run only basic files and drivers.
Restarting in Safe mode often allows you
to troubleshoot what's going on, and you
can restart Windows in its regular mode
after you solve the problem.

w= [Ise the System Restore feature to first create
a system restore point (a point in time when
your settings and programs all seem to be
humming along just fine) and then restore
Windows to that point when trouble hits.

”'*’o ter

Get ready to...
w= Shut Down a Nonresponsive
Application ..........ccc..... 410
w= Start Windows in Safe
Mode ......coooviiiiiin, 411
> Create a System Restore
Point.....cooviieiiiiiiiei, 413
w= Restore the Windows
SyStem ..covvveiiiiiiie 415
w= Defragment a Hard Drive... 417
w= Free Disk Space................ 419

w= Delete Temporary Internet
Files by Using Internet

Explorer.......ccocevicninnnn. 420
w= Schedule Maintenance

TASKS v, 422
w= Troubleshoot Software

Problems.....ccoooe 424
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w= You can clean up your system to delete unused files,
free up disk space, and schedule maintenance tasks.

w= [f you need a little help, you might run a trouble-
shooting program to help you figure out a problem
you're experiencing with a program.

Shut Down a Nonresponsive Application

1. If your laptop freezes and won't let you proceed with
what you were doing, press Ctrl+Alt+Del.

2. In the Windows screen that appears, click Start Task
Manager.

3. In the resulting Windows Task Manager dialog box (see
Figure 24-1), click the Applications tab and select the
application that you were in when your system stopped
responding.

The Applications tab

= Windows Task Manager [=l[E ==
File Qptions View Windows Help
| Applications | processes | services | Perfarmance | Netwarking [ Lsers |
=
Task Status
Ill&1534830 Chz2 [Compatibility Mode] - Microsoft W...  Running
| Snagit Running
Submitted Chapters Senior 2nd edition Running
End Task ] l Switch To ] I Mew Task...
Processes: 44 CPU Usage: 0% Physical Memory: 27%

Figure 24-1
410



Chapter 24: Maintaining Windows

4. Click the End Task button.

5. In the resulting dialog box, the Windows Task Manager
tells you that the application isn’t responding and asks
whether you want to shut it down now. Click Yes.

If pressing Ctrl+Alt+Del doesn’t bring up the Task
@ Manager, you're in bigger trouble than you thought.
You might need to press and hold your laptop power
button to shut down. Note that some applications
use an AutoSave feature that keeps an interim version
of the document that you were working in — you
might be able to save some of your work by opening
that last-saved version. Other programs don’t have
such a safety net, and you simply lose whatever
changes you made to your document since the last
time you saved it. The moral? Save, and save often.

You may see a dialog box appear when an applica-
tion shuts down that asks if you want to report the

problem to Microsoft. If you say yes, information is
sent to Microsoft to help them provide advice or fix
the problem down the road.

Start Windows in Safe Mode

1. To start Windows in a mode that loads only the most
vital files, allowing you to get started and fix problems
(for example, by performing a system restore to a time
before the problems) remove any CDs or DVDs from
your laptop.

2. Choose Start, click the arrow on the right of the Shut
Down button, and then choose Restart to reboot your
system. (See Figure 24-2.)

3. When the laptop starts to reboot (the screen goes black),
begin pressing F8.
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E‘:% Snagit9 ‘ iéh .

6 Windows Media Center

412

=

=N

\% Snipping Toal
Games

B renote Desktop Connection
(0

i“h‘ Maagnifier
2 Devices and Prin Switch user

Microsoft Office Application
Recovery Default Program: Lock

»  AnPrograms Help and Suppol

Nancy

‘ Getting Started >

T Documents

Calculator

Pictures

Sticky Notes
Music

_p
/f Faint
- Computer

Control Panel

Log off

Restart

Closes all open programs, shuts down Windows, and
then starts Windows again.

Sleep
Hibernate

| Search programs and files jel |

Figure 24-2

4. 1f you have more than one operating system, you might

see the Windows Boot Manager menu. Use the up- and
down-arrow keys to select the Windows 7 operating sys-
tem. Or type the number of that choice, press Enter, and
then continue to press F8.

5. In the resulting Advanced Boot Options (a plain-vanilla

text-based screen), press the up- or down-arrow key to select
the Safe Mode option from the list and then press Enter.

6. Log in to your laptop with administrator privileges; a

Safe Mode screen appears. (See Figure 24-3.) Use the
tools in the Control Panel and the Help and Support sys-
tem to figure out your problem, make changes, and then
restart. When you restart again (repeat Step 2), let your
laptop start in the standard Windows 7 mode.

in the old text-based world that users of the DOS oper-

@ When you reboot and press F8 in Steps 3 and 4, you're

ating system will remember. It's scary out there! Your
mouse doesn’t work a lick, and no fun sounds or cool
graphics exist to soothe you. In fact, DOS is the reason
the whole For Dummies series started because everybody
felt like a dummy using it, me included. Just use your
arrow keys to get around and press Enter to make
selections. You're back in Windows-land soon . . .



Figure 24-3

@ windows Help and Support N =]

& &) ’f‘ - I‘; 48, sk Options ¥

|Sear:n Help Fel

Whatis safe mode?

[This content is preliminary and subject to change.]

Safe made is 3 troubleshooting option for Windows that starts your computer in a
lirnited state, Only the basic files and drivers necessany to run Windows are started,
The wards Sate Mode appear in the carmers of your manitorta identify which
Windows mode you're using,

If an existing problerm doesn't reappearwhen you start in safe mode, you can
elirninate the default settings and basic dewice drivers as possible causes, Fyou don't
know the cause of the problem, you can use the process of elimination to help you
find the problem, Try starting all of the programs you commanly use, including the
programs inyour Startup folder, one by one to see if a program might be the cause
aof the problemm,

If your computer automatically starts in safe mode without prompting, 3 problem
writh your computer might be preventing Windows from starting normally, If you
think the cause of the probler might be a recently installed program or device, try
using Recavery in Cantral Panel. For more information, see ithat is Recovery?

For more information about warking in safe mode, see the following Help topics:

o Advanced startup options (including safe mode)
» Startyour computerin safe mode

o Diagnostic tools to use in safe mode

H3, More support options

When you're troubleshooting and trying things like
starting in Safe mode, it’s a good idea to plug your

laptop in, if possible. Some of these procedures can

take some time, and you don't want to run out of

battery power while running an important diagnostic

and add to your woes!

Create a System Restore Point

1. You can back up your system files, which creates a restore
point you can later use to return your laptop to earlier set-
tings if you begin to experience problems. Choose Starte>

Control Panel=>System and Security, and in the resulting
System and Security dialog box, click the System link.

2. In the System dialog box, click the System Protection link
in the left panel. In the System Properties dialog box that

appears (see Figure 24-4), click the Create button.

3. In the Create A Restore Point dialog box that appears,
enter a name to identify the restore point, such as the
current date or the name of a program you are about to
install, and click Create.

Chapter 24: Maintaining Windows
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System Properties

System Restore

You can undo system changes by reverting l
your computer to a previous restore paint.

System Restore...

Protection Settings

Available Drives
& VistaB4 (C) (System) On
= DATA (D) Off

Protection

Configure restore settings, manage disk space,
and delete restore points.

Create a restore point right now for the drives that |
have system protection tumed on.

| Configure...

Create... |

Cancel ]

Figure 24-4

Click this button

4. Windows displays a progress window. When the restore
point is created, the message shown in Figure 24-5
appears. Click Close to close the message box, and then
click Close to close the System Protection dialog box, and
Close again to close the Control Panel.

[0‘. The restore point was created successfully.

System Protection -

Close |

Figure 24-5

Every once in a while, when you install some soft-
ware or make some new settings in Windows and
things seem to be running just fine, create a system
restore point. It's good laptop practice, just like back-
ing up your files, only you're backing up your set-
tings. Once a month or once every couple months
works for most people, but if you frequently make
changes, create a system restore point more often.
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@ A more drastic option to System Restore is to run the

system recovery disc that probably came with your
laptop or that you created using discs you provided.
However, system recovery essentially puts your lap-
top right back to the configuration it had when it was
carried out of the factory. That means you lose any
software you've installed and documents you've cre-
ated since you began to use it. A good argument for
creating system restore points on a regular basis,
don't you think?

Restore the Windows System

1.

2.

3.

7.

Choose Starte>Control Panel=>Back up Your Computer
(under System and Security).

In the Back Up and Restore window, click the Recover
System Settings on Your Computer link. In the Recovery
window shown in Figure 24-6, click the Open System
Restore button.

The System Restore feature shows a progress dialog box
as it starts. In the resulting System Restore window, click
Next.

. In the System Restore dialog box that appears, click the

system restore point to which you want to restore the
laptop and click the Next button.

A dialog box confirms that you want to run System
Restore and informs you that your laptop will need to
restart to complete the process. Close any open files or
programs, and then click Finish to proceed.

. The system goes through a shutdown and restart

sequence, and then displays a dialog box that informs
you that the System Restore has occurred.

Click OK to close it.

415



Part V: Taking Care of Your Laptop

416

——— )]
CJU [ » Control Panel » All Control Panelltems » Recovery = [ 42 | [ Search Contrel Panei o

File Edit View Tools Help

@
Bl Control Panel Home . . s N
B Restore this computer to an earlier point in time

Troubleshoot 2 problem For most system problems, try System Restore first, For serious problems, use the advanced recovery methods
Uninstall a program to re-image your computer or reinstall Windows.

Restare user files
System Restore

Unde changes to system files and programs, but leave user files such as 7] Open System Restore

documents, pictures, and music unchanged. This might remove
recently-installed programs and drivers.

Advanced recovery methods

Click this button
Figure 24-6

System Restore doesn’t get rid of files that you've
saved, so you don't lose your family genealogy

files. System Restore simply reverts to Windows set-
tings as of the restore point. This can help if you or
some piece of installed software made a setting that
is causing some conflict in your system that makes
your laptop sluggish or prone to crashes. If you're
concerned about what changes will happen, click
the Scan for Affected Programs button shown in the
window displayed in Figure 24-7.

System Restore doesn’t always solve the problem. Your
very best bet is to be sure you create a set of backup
discs for your laptop when you buy it. If you didn't do
that, and you can’t get things running right again, con-
tact your laptop manufacturer. They may be able to
send you a set of recovery discs, though they may
charge a small fee. These discs restore your laptop to
its state when it left the factory, and in this case you
lose applications you installed and documents you
created — but you get your laptop running again.
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i System Restore — —— (]
Restore your computer to the state it was in before the selected event n".— |
f
e
How do I choose a restore point?
Current time zone: Pacific Daylight Time
Date and Time Description Type
15/2009 7:27:23 AM,
3/15/2009 £:53:56 AM March 15 Manual
3/15/2003 6:52:44 AM Windows Backup System
3/15/2009 £:43:47 AM Windows Backup System
[] Show more restore paints l Scan for affected programs -|—
< Back |[ MNext = ] | Cancel |

Click this button
Figure 24-7

Defragment a Hard Drive

1. To clean up files on your hard drive, choose Start=>
Control Panel=>System and Security and then click
Defragment Your Hard Drive in the Administrative Tools.

2. In the resulting Disk Defragmenter window (see
Figure 24-8), to the left of the Defragment Now button
is the Analyze Disk button. Use this to check whether
your disk requires defragmenting. When the analysis is
complete, click the Defragment Disk button. A notation
appears (see Figure 24-9) showing the progress of
defragmenting your drive.

3. When the defragmenting process is complete, the Disk
Defragmenter window shows that your drive no longer
requires defragmenting. Click Close to close the window
and then close the Control Panel.
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4, Disk Defragmenter

performance. How does Disk Defragmenter help?

Schedule:

Scheduled defragmentation is turned on
Run at 1:00 AM every Wednesday

Mext scheduled run: 3/11/2009 1:00 AM

Current status:

»  Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system

——— )

| '@'Configuregchedule...

Disk Last Run
c—-"u’istaﬁél (C) MNewer run
o DATA (D) Mewer run

Progress

To best determine if your disks need defragmenting right now, you need to first analyze your disks.

| '-'_‘fgf'ﬂnalyze disk | E

¥ Defragment disk ]

Close

Figure 24-8

4; Disk Defragmenter

performance. How does Disk Defragmenter help?

Schedule:

Scheduled defrac tation is turned on

Run at 1:00 AM every Wednesday
Mext scheduled run: 3/11/2009 1:00 AM

Current status:

+  Disk Defragmenter consolidates fragmented files on your computer's hard disk to improve system

—— -] ) )]

| "E' Configure schedule...

Disk Last Run
&L Vistabid (C:) Running...
cuDATA (D:) Mewver run
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Warning: Disk defragmenting could take a while. If
you have energy-saving features active (such as a
screen saver), they could cause the defragmenter to
stop and start all over again. Try running your defrag
overnight while you're happily dreaming of much
more interesting things (with your laptop plugged in
so that you don’t run out of battery power!). You can
also set up the procedure to run automatically at a
preset period of time, such as once every two weeks,
by using the Run Automatically setting in the Disk
Defragmenter window.

Free Disk Space

1. To run a process that cleans unused files and fragments
of data off of your hard drive to free up space, choose
Start=>Control Panel=>System and Security and then click
Free Up Disk Space in the Administrative Tools.

2. In the Disk Cleanup dialog box that appears, choose the
drive you want to clean up from the drop-down list and
click OK. Disk Cleanup calculates how much space you
will be able to free up. (See Figure 24-10.)

Disk Cleanup P

o Diisk. Cleanup iz calculating how much space vou will be
51" able to free on [C:). Thiz may take a few minutes to
complete.

Calculating...
Cancel

Scanning: System eror memorny dump files

Figure 24-10

3. The resulting dialog box shown in Figure 24-11 tells you
that Disk Cleanup calculated how much space can be
cleared on your hard drive and displays the suggested
files to delete in a list. (Those to be deleted have a check
mark.) If you want to select additional files in the list to
delete, click to place a check mark next to them.

419



Part V: Taking Care of Your Laptop

=, Disk Cleanup for (C) @

[ Digk Cleanup |

23 You can uze Disk Cleanup to free up to 339 MB of disk,
S zpace on [C:].

Filez to delete:

V] =) Temporary Internet Files 461 KB

m | »

] (53 Offine 'webpages 90.3KE

[]'% Recycle Bin 216KB

U] | Setup Log Files 404 KB
Total amount of disk gpace you gain; 24 4 MB

Drescription

Downloaded Program Files are dctivel controls and Java applets
downloaded automatically from the Intermet when you view certain
pages. They are temporarily stored in the Downloaded Program
Files folder on your hard disk.

! Clean up spstem files Wiew Files

How does Disk Cleanup work?

| QK || Cancel |

Figure 24-11

4. After you select all the files to delete, click OK. The
selected files are deleted. Click the Close button to close
the Control Panel.

log box to see more details about the files that
Windows proposes to delete, including the sizes of
the files and when they were created or last accessed.

@ Click the View Files button in the Disk Cleanup dia-

you might try using a flash drive (they are available
in sizes up to 32 GB) to store some of your files.
These little storage devices plug into a USB port on
your laptop, are wonderfully portable, and are also
great for backing up files.

@ If you can’t free up enough disk space for your needs,

Delete Temporary Internet Files
by Using Internet Explorer

1. When you roam the Internet, various files may be down-
loaded to your laptop to temporarily allow you to access
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sites or services. To clear these away, first open Internet
Explorer.

2. Choose Tools=>Internet Options.

3. On the General tab of the resulting Internet Options dia-
log box (see Figure 24-12), click the Delete button in the
Browsing History section.

Click this button

Internet Options T 2]

General iSecurity I Privacy | Content ! Connections ! Programs ! Advanced|

Home page

/‘ To create home page tabs, type each address on its own line.

Use current | | Use default ] | Use blank

Browsing history

) Delete temporary files, histqry, cookies, saved passwords,
¥ and web form information,

[T Delete browsing history n exit

Delete... | | Settings ]
Search
() Change search defaults. | Settings
&
Tabs
Change how webpages are displayed in | Settings |
tabs. -
Appearance
Colors |l Languages H Fonts Jl Accessibility ]
[ oK ] | Cancel ] Appl
Figure 24-12

4. In the resulting Deleting Browsing History dialog box, as
shown in Figure 24-13, click the Temporary Internet Files
check box to select it, if it's not already selected, and click
Delete.

5. A confirmation message asks whether you want to delete
the files. Click Yes. Click Close and then click OK to close
the open dialog boxes.
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Verify this option is selected

Delete Browsing History [l

Keep cookies and temporary Internet Files that enable your favaorite
websites ta retain preferences and display Faster,

—F7| Temporary Internet files

Copies of webpages, images, and media that are saved for Faster
wiewing,

I«

| Cookies
Files stored on your computer by websites to save preferences
such as login information.

=

|History
List of websites you have visited,

" | Form data
Saved information that yvou have byped into forms,

" | Passwords
Saved passwords that are automatically filled in when vou sign in
to a website you've previously visited,
InPrivate Filtering data

Saved data used by InPrivate Filkering to detect where websites may
be automatically sharing details about your visit,

About deleting browsing histary Delete | | Cancel

Figure 24-13

Temporary Internet files can be deleted when you
run Disk Cleanup (see the preceding task in this
chapter), but the process that I describe here allows
you to delete them without having to make choices
about deleting other files on your system.

Windows 7 offers a feature for rating and improving
your laptop’s performance. From the Control Panel,
click System and Security, and then click the Check
the Windows Experience Index Base Score link. In the
resulting dialog box, click the Rate This Computer
button to get a rating of your processor speed, mem-
ory operations, and more.

Schedule Maintenance Tasks

1. Choose Start=>Control Panel=>System and Security and
then click Schedule Tasks in the Administrative Tools.
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2. In the resulting Task Scheduler dialog box, as shown in
Figure 24-14, choose Action=>Create Task.

(1) Task Scheduler —— ]S
File Action View Help
&= EH
(£) Task Scheduler (Local) Actions
@ Task Scheduler Library . | Task Scheduler (Local) =
| Overview of Task Scheduler - Connselte Ansiherc
f J:_ i You can use Task Scheduler to create and manage 2 ] Create Basic Task..,

common tasks that your computer will carry out
automatically t the times you specify. To begin,
click a command in the Action menu. Import Task...

= t  Create Task...

Display All Running Ta...

Tasks are stored in folders in the Task Scheduler
lihrary Ta view ar nerfarm an aneratinn nn an

AT Service Account Co...

Task Status -

View 4

Status of tasks that have started in .. | Last 24 hours |G Refresh

E Help

Reading data, please wait...

Reading data ... Cancel Refresh

Figure 24-14

3. In the resulting Create Task dialog box (see Figure 24-15),
enter a task name and description. Choose when to run
the task (only when you are logged on, or whether you're
logged in or not).

4. Click the Triggers tab and then click New. In the New
Trigger dialog box, choose a criteria in the Begin the Task
drop-down list and use the settings to specify how often
to perform the task, as well as when and at what time of
day to begin. Click OK.

5. Click the Actions tab and then click New. In the New
Action dialog box, choose the action that will occur from
the Action drop-down list. These include starting a pro-
gram, sending an e-mail, or displaying a message.
Depending on what you choose here, different action
dialog boxes appear. For example, if you want to send an
e-mail, you get an e-mail form to fill in. Click OK.
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(%) Create Task

MName: |

Location: !
Author: Owner-PC\Owner

Description:

Security options
When running the task, use the following user account:

Owner-PC\Owner Change User or Group...

@ Run only when user is logged on
Run whether user is logged on or not
Do not store password, The task will only have access to local computer resources.

[T] Run with highest privileges

[ Hidden Configure for: | Windows Vista™, Windows Server™ 2008 v|

0K | | Cancel I

Choose when to run the task
Figure 24-15

6. 1f you want to set conditions in addition to those that
trigger the action that control whether it should occur,
click the Conditions tab and enter them.

7. Click the Settings tab and make settings that control how
the task runs.

8. After you complete all settings, click OK to save the task.

new task, you can choose the Create Basic Task item
from the Action menu. This walks you through the
most basic and minimal settings you can make to
create a new task.

@ If you like a more wizard-like interface for building a

Troubleshoot Software Problems

1. If you can't figure out why you're having problems with a
piece of software, choose Startz>Control Panel=>Find and

424 Fix Problems (under System and Security).
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2. In the resulting Troubleshooting window (see
Figure 24-16), click Programs.

3. In the resulting Troubleshooting Problems—Programs
window, choose what you want to troubleshoot:

2

1=

[T 2

[T 2

2

Network: Allows you to troubleshoot a connection
to the Internet.

Web Browser: Helps you figure out problems you
may be having with the Internet Explorer browser.

Program Compatibility: (Under Programs) This is a
good choice if you have an older program that
doesn’t seem to be functioning well with this version
of Windows. Program compatibility is a common
cause of problems running software.

Printing: Allows you to find out why you're having
difficulty with your printer, including checking for
the correct printer-driver software.

Media Player Troubleshooting: Can be used to pin-
point problems with general settings, media files, or
playing DVDs.

4. Follow the sequence of instructions for the item you
selected to let Windows help you resolve your problem.
(See Figure 24-17.)

®

In some cases, you'll be asked for administrator per-
mission for the troubleshooter to perform an action,
so it's a good idea to run the troubleshooting wizard
through an administrator-level account. See Chapters 3
and 23 for more about user accounts and
administrators.
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Click this link

- ——
@C-\E » Control Panel » All Control Pane|ltems » Troubleshooting =] s | [ Search Controt Panel

File Edit View Tools Help

Troubleshpot computer problems

Click on a tasf to automatically troubleshaot and fix comman computer problems. To view more
troubleshootgrs, click on a category or use the Search box.

ew history
Change settings ProdiFTiE
oo 5] oY e
Get help from someone Run programs made for previous versions of Windows

trust Help improve Internet Explorer performance

Hardware and Sound
‘S‘ Configure a device | Usea printer '@' Troubleshoot audio recording
B Troubleshoot audio playback

Network and Internet
Connectto thelnternet | Access shared files and folders on other computers

LY

Appearance and Personalization
‘.@' Display Aerc desktop effects

&

System and Security
Fix problems with Windows Update | Run maintenance tasks '@' Improve power usage
Check for performance issues

&

Action

Help and Support

Recovery Get the most up-to-date troubleshooters from the Windows Online Troubleshooting service

Figure 24-16

=

(;.-) | Hardware and Devices

Troubleshooting has successfully completed
Is the problem fixed? Try attempting the task you were trying to do before.

< Close the troubleshooter

* Explore additional options

Problems found
Hardware changes might not have been detected Detected A

View detailed information

Figure 24-17
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accessibility
cursor, customizing, 108-110
keyboard repeat rates, setting up,
105-106
keyboard settings for, 101-103
onscreen keyboard feature, 103-105
overview, 91-92
read aloud, text and descriptions, 92
sounds replaced with visual
cues, 95-96
speech recognition, setting up, 98-101
text, sizing, 96-97
touchpad, customizing, 106-108
visually challenged, tools for, 92-94
volume, increasing, 95
accessories, 29-30
address and phone number, sharing, 329
Address Book feature (Windows Live
Mail), 348
administrator account, 41
adware, 313, 389, 391
Aero Theme, 89-90
antiadware programs, 313-314, 391
antispyware programs, 313-314, 391, 405
antivirus programs, 313-314,
391-392, 405
appearance of laptop, 8
applications. See software
arranging items on desktop, 66-67

audio. See also volume
burning music to CD/DVD, 252-254
as factor in selecting a type of
laptop, 19-20
master system volume, adjusting,
249-250
playing music, 255-257
playlist, creating a, 251-252
replaced with visual cues, 95-96
ripping music, settings for, 257-259
speakers, setting up, 248-249
syncing with music device, 254-255
system sounds, 250
visual alternatives to, 95-96
auto-arranging items on desktop, 67
automatic installation of updates, 393
automatic startup of software programs,
151-152
AutoSum button (Works
Spreadsheet), 219
availability settings for instant
messages (IMs), 374

ol e

background, changing, 82-84
backing up

data, 407

files, 175-176
banking online, 225-227
battery, 12, 32-33, 47
Battery Meter icon, 33
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blogs, 378
broadband Internet connection, 27
browser. See also Internet Explorer
entering Web address in, 287
history, viewing your, 304-305
home page, setting up a, 292-294
overview, 280, 295
privacy and security features of, 315
tabs in, 289-292
burning music to CD/DVD, 252-254
buying a laptop
accessories, 29-30
customized laptops, 28-29
Internet connection as factor in, 26-27
monitor, selecting a, 23-24
optical drive, choosing an, 24-25
price range, determining a, 21-23
processor speed and memory as factor
in, 25-26
type of laptop, selecting a, 18-20
Windows, selecting a version of, 20-21

oo

cable Internet connections, 27, 283
Calendar gadget, 183-184
case, laptop, 29
CD
backing up files to, 175-176
burning photos to, 241-243
ripping music from, 257-259
CD drives, DVD drives compared, 24
central processing unit (CPU), 16, 188
chat rooms, 370-372
chats, 280
Chess Titans, 273-274
clicking and dragging with touchpad, 37
clicking with touchpad, 36-37
clip art, 203
Clipboard, cut or copied text placed on,
196-197
Clock gadget, 180-181

closing
gadgets, 179
items in Frequently Used Programs
area, 66
programs, 77-78
Remote Assistance, 138
Windows Media Player, 234
collating documents, 208
color
for e-mail, 357
for printing, 117
for text, 198
of windows, changing, 87-89
communities, posting a question in
Windows, 132-135
compressing files and folders, 172-173
Contact List, 360-362
Content Advisor, 323-325
cookies, 399
copy-and-paste operation, 149
copying
files, 167
folders, 167
text, 196
CPU (central processing unit), 16, 188
CPU Meter gadget, 188-189
crash (system), 409
Ctrl+Alt+Delete, 45, 410-411
Currency Conversion gadget, 185-186
cursor, 108-110
customized laptops, buying, 28-29
customizing
desktop, 80-90
Recycle Bin, 68
scanners, 124-126
themes, 85
windows, 87-89
Windows Help and Support, 139-140
cut or copied text placed on Clipboard,
196-197
cut-and-paste operation, 149
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damage, protecting your laptop from
physical, 407
data mining, 367
data storage, hard drive capacity for, 26
date, setting, 38-40
DatingForSeniors, 386
DDR2, 26
default printer, setting a, 115-117
default programs, setting, 153-154
deleting
files, 170-171
folders, 170-171
shortcuts, 72
text, 193
design of laptop, 19
desktop computer
appearance of, 8
laptop compared, 7-9
portability, lack of, 8
power source, 8
desktop replacements, 13
desktop (Windows)
arranging items on, 66-67
auto-arranging items on, 67
background, changing, 82-84
customizing, 80-90
Frequently Used Programs area,
60, 65-66
gadgets, 62, 178-180
Notifications area, 60
overview, 59-62
Recycle Bin, 60, 67-68
screen savers, setting up, 86-87
shortcuts, 61, 70-72
sizing icons on, 67
Start menu, 62-64
taskbar, 60
theme, choosing, 84-85
viewing, 62

windows, changing color and
appearance of, 87-89
windows, modifying transparency
of, 89-90
dial-up Internet connections, 27, 282, 283
dictionary, adding words to, 206
digital camera, 235
Digital Subscriber Line (DSL), 27, 282
discussion boards
finding, 368-369
overview, 280, 368
replying to posts in, 369
threads in, 369
Disk Cleanup, 419-420
Disk Defragmenter, 417-419
disk space, freeing, 419-420
display settings, adjusting, 51-52
document review, 98
documents
naming, 194
opening, 195
printing, 208-209
saving, 194
Documents folder, 158
downloading files, 316-318
DRAM, 26
DSL (digital subscriber line), 27, 282
DVD
backing up files to, 175-176
burning photos to, 241-243
ripping music from, 257-259
standards, 25
DVD drives, 24-25
DVD/CD combo drive, 24

oF o

easier to see, making items on screen, 93
e-commerce, 280

editing text, 192-193

effects for text, 198

Index 4 29
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e-mail. See also Windows Live Mail
account, 336-338
alias, 336
alignment, 357
attachments, 241, 348-350
color, 357
emoticons, 357
etiquette for, 346
fonts, 356
hyperlinks, adding, 357
indenting, 357
junk mail, 366
overview, 335
private messaging, 385
scams, spotting, 331-333
shouting in, 346
styles, 357
emoticons, 357
emptying Recycle Bin, 67-68
Eons, 380-383
etiquette for e-mail, 346
external CD drive, 29
external DVD drive, 29

ofF e

Facebook, 380

favorites
adding a Web site to, 301-303
adding files to, 173-175
adding folders to, 173-175
organizing, 303-304

Feed Headlines gadget, 187-188

files
backing up, 175-176
CD, backing up files to, 175-176
compressing, 172-173
copying, 167

deleting, 170-171
downloading, 316-318
DVD, backing up files to, 175-176
Favorites list, adding files to, 173-175
locating, 162-163
moving, 160, 165-167
organizing, 158-160
overview, 157, 158
recently used files, accessing, 160-162
renaming, 167-168
restoring, 170
searching, 163-165
shortcut to, creating a, 169-170
Filter Keys, 102
financial information online, 224-225
fingerprint reader, 29, 406
firewalls, 314, 399-401
flash drive, 30, 158
flat panels, 23
flights, Internet connections during, 284
folders. See also specific folders
compressing, 172-173
copying, 167
creating, 159
deleting, 170-171
Favorites list, adding folders to,
173-175
locating, 162-163
moving, 160, 165-167
organizing, 158-160
predefined, 158
renaming, 167-168
restoring, 170
searching, 164
shortcut to, creating a, 169-170
subfolders, 159-160
in Windows Live Mail, 363-365
fonts, 197, 356



Index 43 ’

footer, inserting, 208
formatting
e-mail, 356-358
numbers, 215-217
text, 197-199
forwarding e-mail, 353-354
FreeCell, 265-267
Frequently Used Programs area
closing items in, 66
overview, 60
using, 65-66
frozen laptop, troubleshooting, 45,
410411
function keys, 37-38

o(Goe

gadgets
Calendar gadget, 183-184
Clock gadget, 180-181
closing, 179
CPU Meter gadget, 188-189
Currency Conversion gadget, 185-186
desktop, adding gadgets to, 62, 178-180
Feed Headlines gadget, 187-188
overview, 177-178
Picture Puzzle gadget, 184-185
Slide Show gadget, 181-183
Stocks gadget, 225
games
Chess Titans, 273-274
FreeCell, 265-267
Hearts, 271-273
Minesweeper, 269-271
online games, 274-276
overview, 261-262
Solitaire, 262-265
Spider Solitaire, 267-269
gaming/multimedia model, 19-20

Get More Gadgets Online link, 179
gigahertz (GHz), 25
Google, 296-298
Google Docs, 191
grammar checking, 206
graphics. See also photos
documents, adding graphics to,
202-203
handles for sizing, 203-204
as hyperlinks, 281
resizing, 203-204
Windows Live Mail, adding to, 359
grayscale setting for printers, 117

o o

handles for sizing graphics, 203-204
hard copies, 111
hard drive
defragmenting, 417-419
saving downloaded files to, 317
hardware, 16-17, 284
header, inserting, 208
Hearts, 271-273
help and support. See Windows Help and
Support
Hibernate mode, 45, 63
high contrast, turning on, 92
higher screen resolution, 81
hint for passwords, 403
home page, 292-294
Home Premium version of Windows 7, 20
hyperlinks
adding to e-mail, 357
clicking on, 288
graphical, 281
overview, 280-281
text, 281, 288
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image quality of monitors, 23
information exposure
by clubs and organizations, 326
by employers, 326
by family members and friends, 326
by government agencies, 326
by newspapers, 327
by online directories, 327
overview, 326-328
InPrivate Browsing, 318-320
insertion point, 36
installation
of printer, 112-115
of scanner, 122-124
instant messages (IMs)
availability settings for, 374
choosing program, 373
overview, 372-373
setting up program, 373-374
shortcut text used in, 374
steps for using, 373-375
Internet
defined, 280
overview, 279-281
understanding technology risks on,
312-315
Internet connections
broadband, 27
cable, 283
dial-up, 27, 282, 283
Digital Subscriber Line (DSL), 282
during flights, 284
hardware for, 284
local access numbers for, 282
overview, 26, 281-282
password for, 286

satellite, 283
setting up, 285-286
speed of, 283
types of, 282-283
wireless, 27, 283
Internet Explorer (IE)
browsing history, viewing your,
304-305
Content Advisor, 323-325
favorites, adding a Web site to, 301-303
favorites, organizing, 303-304
home page, setting up a, 292-294
InPrivate Browsing, 318-320
navigating Web with, 287-289
opening, 287
podcasts, playing, 309-310
pop-up blocker settings, 322
privacy settings, changing, 321-323
RSS feeds, viewing, 307-308
searching with, 296-298
SmartScreen Filter, 320-321
Suggested Sites, 315-316
tabs in, 289-292
temporary Internet files, deleting,
420-422
toolbar, customizing, 306-307
troubleshooting, 425
Web page, finding content on a,
299-300
Web pages, printing, 308-309
Internet Service Provider (ISP), 281, 336
investing online, 227-228
iPod, syncing with, 254-255

o]o

junk mail, 366
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keyboard
accessibility settings, 101-103
choosing, 103
Filter Keys, 102
Mouse Keys, 101
onscreen keyboard feature, 103-105
overview, 16
repeat rates, setting up, 105-106
Sticky Keys, 101
Toggle Keys, 101

o/ o

laptop
appearance of, 8
design of, 19
portability, 8
power source, 8
types of, 13-14
uses for, 9-12
laptop case, 29
laptop locks, 29, 405-406
larger, making items on screen, 93
launching software programs, 146-148
LCD (liquid crystal display), 23
links. See hyperlinks
local access numbers for Internet
connections, 282
logging on, 34-35
lower screen resolution, 81

ol o

maintenance
disk space, freeing, 419-420
hard drive, defragmenting, 417-419
overview, 409-410

scheduling tasks for, 422-424
system recovery disc, running, 415, 416
System Restore, restoring Windows
system with, 413-415
system restore point, creating a,
413-415
temporary Internet files, deleting,
420-422
Windows system, restoring, 415-417
malware, 312-315, 391-392
master system volume, adjusting,
249-250
maximizing
programs, 62
windows, 75
memory
CPU Meter gadget used to monitor,
188-189
data storage, hard drive capacity
for, 26
overview, 25
RAM, 26
microphone, 17
Microsoft Customer Support, 140-142
Microsoft Fingerprint Reader, 406
Microsoft Works 9, 191. See also Word
Processor; Works Spreadsheet
Minesweeper, 269-271
minimizing
programs, 62
windows, 75-76
Mobile Internet Devices (MIDs), 13-14
monitors, 16, 23-24
Mouse Keys, 101
movies, 232-235
MP3 player, syncing with, 254-255
multiple clocks, displaying, 181
Music folder, 158

Index 433
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naming documents, 194
navigation of World Wide Web, 287-289
netbooks, 13, 19
network connections,
troubleshooting, 425
new user account, creating, 40-41
nonresponsive applications, shutting
down, 410-411
notebook computer, 13
Notifications area of desktop, 60

o() o

online auctions as factor in price range
for laptop, 22-23
online banking, 225-227
online dating services
DatingForSeniors, 386
overview, 383-385
PerfectMatch, 386
private messaging, 385
Safer Dates, 386
selecting, 385-386
online directories, information exposure
by, 327
online games, 274-276
online help, accessing, 135-136
online shopping, 11-12
onscreen keyboard feature, 103-105
opening
existing documents, 195
Internet Explorer (IE), 287
Windows Explorer, 69
Windows Live Mail, 342
Windows Media Player, 232
Word Processor (Microsoft), 192
Works Spreadsheet (Microsoft), 214

OpenOffice, 191

operating system. See also Windows 7
described, 2
RAM for running, 26
utilities in, 18

optical drive, 24-25, 254

option buttons, 36

o e

page setup for document, changing,
206-208
paper size setting for printers, 118
paper source setting for printers, 118
password
for banking online, 227
changing, 403
creating strong, 333-334
examples of, 334
hint for, 403
for Internet connections, 286
for new accounts, 41
restricted content, password for
viewing, 325
setting up your laptop, 34-35, 401-403
for switching user accounts, 42
pasting text, 196-197
PerfectMatch, 386
peripherals, 17
personal information, sharing, 328-330
phone number, sharing, 329
photos
CD, burning photos to, 241-243
described, 11
digital camera, uploading photos
from, 235
DVD, burning photos to, 241-243
emailing photos from Pictures library,
239-241
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printing without uploading, 235
tagging photos in Windows Photo
Viewer, 237-239
viewing photos in Windows Photo
Viewer, 236-237
physical damage, protecting your laptop
from, 407
picture, changing your account, 43-44
Picture Puzzle gadget, 184-185
Pictures folder
documents, adding pictures to, 202
overview, 158
slide show, displaying a continuous,
181-183
Pictures library
burning photos to CD/DVD, 241-243
emailing photos from, 239-241
overview, 230
slide shows, creating and playing,
243-245
playlist, 230, 251-252
podcasts
overview, 296, 309
playing, 309-310
volume for, 310
pointing stick, 35
pop-up ads, blocking, 288-289, 322
portability, 8, 12
ports, 17
posting a question in Windows
communities, 132-135
Power button functions, defining, 54-56
power management
Adjust Plan Brightness option, 52
battery life, 47
Dim the Display option, 51
display settings, adjusting, 51-52
overview, 47-48
Put the Computer to Sleep option, 52

sleep, changing setting for, 53-54
Turn Off the Display option, 51
power plan, 48-51
power source, 8
predefined folders, 158
preferences, setting printer, 115, 117-119
Premier Third Tier Support, 141-142
price range for laptop, 21-23
printer driver, 111
printers
color setting, 117
default printer, setting a, 115-117
grayscale setting, 117
installation of, 112-115
overview, 111
paper size setting, 118
paper source setting, 118
preferences, setting, 115, 117-119
quality setting, 117
removing, 121-122
viewing currently installed, 120-121
printing
from digital camera, 235
documents, 208-209
help topics, 129
photos without uploading, 235
troubleshooting, 425
priority of e-mail, 348
privacy settings, changing, 321-323
private chat rooms, 372
private messaging, 385
processor speed, 25
Professional version of Windows 7, 20
programs. See software
protection from malware, 313-315
provider. See Internet service provider
public hotspots, 12
Put the Computer to Sleep option for
power management, 52
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quality setting for printer, 117

o R o

RAM (Random Access Memory), 25-26
read aloud, text and descriptions, 92
readable DVD drives, 24
readable-writable DVD drives, 25
reading e-mail in Windows Live Mail,
350-351
Reading Pane (Windows Live Mail),
362-363
reboot, 45
recently used files, accessing, 160-162
recently used programs list used to
launch software programs, 146
recovery discs, 25
Recycle Bin
customizing, 68
emptying, 67-68
overview, 60
retrieving items from, 68
Remote Assistance, 137-139
removing
applications from Startup folder, 152
home page, 294
printers, 121-122
software programs, 154-156
renaming files and folders, 167-168
replying to e-mail, 352-353
replying to posts in discussion
boards, 369
research, 10
resolution of monitors, 23
Restart option for shutting down your
laptop, 45
restoring files and folders, 170

restricted content, password for
viewing, 325

restricted Web sites, 398, 399

resumes, posting, 330

retrieving items from Recycle Bin, 68

rewinding with Windows Media
Player, 234

right-clicking with touchpad, 36-37

ripping music, 257-259

RSS feeds, viewing, 307-308

oS e

Safe Mode, starting Windows in, 411-413
Safer Dates, 386
satellite Internet connections, 283
saving

changes in programs, 77

documents, 194

downloaded files to hard drive, 317
scams, spotting, 331-333
scanners

installing, 122-124

overview, 111

settings for, modifying, 124-126

using, 125
scheduling tasks for maintenance,

422-424

screen, protecting your, 407
screen resolution

described, 79

higher, 81

lower, 81

setting, 81-82
screen savers

overview, 81

setting up, 86-87
scrolling with touchpad, 37
SDRAM, 26
Search This Site feature, 300
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searching

files, 163-165

folders, 164

with Internet Explorer (IE), 296-298

Windows Help and Support, 130-132

World Wide Web, 296-298

security. See also password

address and phone number,
sharing, 329

antiadware programs, 391

antispyware programs, 391, 405

antivirus programs, 391-392, 405

automobile information, sharing, 329

backing up data, 407

for banking online, 226-227

browsers, using privacy and security
features of, 315

chat rooms, 372

Content Advisor, 323-325

cookies, 399

credit status, sharing, 330

detecting adware and spyware,
installing a program that combines
tools for, 314

for downloading files, 316-318

e-mail account username, choosing, 338

fingerprint readers, 406

firewalls, 399-401

information exposure, 326-328

InPrivate Browsing, 318-320

Internet, understanding technology
risks on, 312-315

laptop locks, 405-406

malware, protection against, 391-392

for music sharing, 254

names of relatives, sharing, 329

for online games, 275

overview, 311-312, 390-392

personal information, sharing, 328-330
pop-up blocker settings, 322
recovery discs, 25
for Remote Assistance, 138-139
restricted content, password for
viewing, 325
restricted Web sites, setting up, 398
resumes, posting, 330
scams, spotting, 331-333
SmartScreen Filter, 320-321
status of, checking, 404-405
trusted Web sites, setting up, 396-398
Windows Firewall, enabling, 399-401
Windows tools for, using, 314
Windows Update, options for, 393-394
Windows Update, running, 394-396
work history, sharing, 330
selecting a type of laptop, 18-20
semiconductor chip, 16
servers, 281
setting up
instant messages (IMs), 373-374
Internet connections, 285-286
setting up your laptop
battery, installing and charging, 32-33
date, setting, 38-40
function keys, using, 37-38
logging on, 34-35
new user account, creating, 40-41
password, entering your, 34-35,
401-403
picture, changing your account, 43-44
switching user accounts, 42-43
time, setting, 38-40
touchpad, using your, 35-37
turning on your laptop, 33
shortcut icon used to launch software
programs, 146
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shortcut text used in instant messages
(IMs), 374
shortcuts
creating, 70-72
deleting, 72
to files, 169-170
to folders, 169-170
overview, 61
shouting in e-mail, 346
shuffle option for playing music, 257
shutting down your laptop
Hibernate option, 45
overview, 44
Restart option, 45
Sleep option, 45
signature, 354-356
signing in Windows Live Mail, 338, 343
signing up
for e-mail account, 337
for social networking sites, 380-383
size of monitors, 23
size of text, choosing, 197
sizing
icons on desktop, 67
windows, 74-76
Skype, 17
sleep, changing setting for, 53-54
Sleep mode, 45, 63
slide show
creating and playing, 243-245
displaying a continuous, 181-183
Slide Show gadget, 181-183
SmartScreen Filter, 320-321
social journaling sites, 379
social networking sites
Eons, 380-383
Facebook, 380
overview, 379
signing up for, 380-383

socializing online

on blogs, 378

chat rooms, 370-372

discussion boards, 368-370
instant messages (IMs), 372-375
online dating services, 383-386
overview, 367

on social journaling sites, 379
on social networking sites, 379, 380-383
Twitter, 379

types of sites for, 378-379

with Webcams, 376-377

on wikis, 378

software programs

automatic startup of, 151-152

closing, 77-78

compatibility, 425

default programs, setting, 153-154

launching, 146-148

maximizing, 62

minimizing, 62

moving information between, 148-150

overview, 15, 17-18

recently used programs list used to
launch, 146

removing, 154-156

saving changes in, 77

shortcut icon used to launch, 146

Start button used to launch, 146

starting, 72-74

switching between, 76-77, 78

taskbar used to launch, 146

troubleshooting, 424-426

uninstalling, 17, 154-156

uses for, 17

utilities, 18

Solitaire, 262-265
sound. See audio



speakers
overview, 17
setting up, 248-249
speech recognition, 98-101
speed of Internet connections, 283
spellcheck, 204-206, 346
Spider Solitaire, 267-269
spinner arrows, 206
spreadsheet programs, 211-213. See also
Works Spreadsheet
spyware, 18, 313, 389, 391
Spyware Doctor, 392
Spyware Terminator, 405
stand-alone monitor, connecting your
laptop to a, 94
standard user account, 41
Start button used to launch software
programs, 146
Start menu
displaying, 62
overview, 62-64
starting programs, 72-74
Startup folder
automatic startup of software
programs, setting up, 151-152
removing applications from, 152
status of security, checking, 404-405
Sticky Keys, 101
Stocks gadget, 225
strong passwords, creating, 333-334
styles for e-mail, 357
subfolders, 159-160
Suggested Sites (Internet Explorer),
315-316
suite, 191
switching between programs, 76-77, 78
switching user accounts, 42-43

syncing laptop with music device,
254-255

system recovery disc, running, 415, 416

System Restore, restoring Windows
system with, 413-415

system restore point, 409, 413-415

system sounds, 250

oJ e

table, inserting into document, 200-202
Table of Contents for Windows Help and
Support, 128-129
tablet PC, 13, 19
tabs
described, 291-292
using, 289-292
tagging photos in Windows Photo
Viewer, 237-239
Task Scheduler, 423-424
taskbar
overview, 60
used to launch software programs, 146
temporary Internet files, deleting,
420-422
text
accessibility, sizing for, 96-97
color, selecting, 198
copying, 196
cutting, 196
deleting, 193
editing, 192-193
effects, adding, 198
entering, 192
font style, choosing, 197
fonts, choosing, 197
formatting, 197-199

Index 439
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text (continued)
pasting, 196-197
selecting, 37, 195
size, choosing, 197
underlining, 198
in Windows Help and Support,
sizing, 140
wrapping, 192
text hyperlinks, 281, 288
themes
Aero Theme, 89-90
choosing, 84-85
customizing, 85
overview, 80
in Windows Live Mail, 358-359
threads, 133, 369
time
Clock gadget, 180-181
multiple clocks, displaying, 181
setting, 38-40
time using computer as factor in price
range for laptop, 21
Toggle Keys, 101
toolbar, customizing Internet Explorer
(IE), 306-307
touchpad
accessibility, customizing for, 106-108
clicking and dragging with, 37
clicking with, 36-37
overview, 16, 35-36
right-clicking with, 36-37
scrolling with, 37
using, 35-37
transparency of windows, modifying,
89-90
troubleshooting
frozen laptop, 45, 410-411
Internet Explorer (IE), 425
media player, 425
network connections, 425

nonresponsive applications, shutting
down, 410411
printing, 425
program compatibility, 425
Safe Mode, starting Windows in,
411-413
software problems, 424-426
System Restore, restoring Windows
system with, 413-415
trusted Web sites, 396-398, 399
Turn Off the Display option for power
management, 51
turning on your laptop, 33
Twitter, 379

olf o

Ultimate version of Windows 7, 20
underlining text, 198
uninstalling software, 17, 154-156
uploading photos from digital
camera, 235
used or refurbished option as factor in
price range for laptop, 22
username for email account,
choosing, 338
utilities, 18

oo

versions of Windows 7, 20
video files as e-mail attachments, 241
Videos folder, 158
Virtual Private Network (VPN), 400
virus, 313, 389, 391
visibility

easier to see, making items on

screen, 93
high contrast, turning on, 92
larger, making items on screen, 93
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read aloud, text and descriptions, 92

tools for visually challenged, 92-94
visual alternatives to sound, 95-96
visual elements, 19
visually challenged, tools for, 92-94
VoIP (Voice over Internet Protocol), 10
volume

accessibility, increasing for, 95

increasing, 95

master system volume, adjusting,

249-250

for podcasts, 310

in Windows Media Player, 233
volume controls, 250

o/ o

Web. See World Wide Web
Web pages
finding content on, 299-300
multiple Web pages, opening and
switching between, 289-292
overview, 280
printing, 308-309
Web sites
Content Advisor used for notification of
objectionable, 323-325
home page, setting up a, 292-294
overview, 280
Search This Site feature, 300
SmartScreen Filter used to check,
320-321
Webcams, 17, 376-377
windows
color and appearance, changing, 87-89
customizing, 87-89
maximizing, 75
minimizing, 75-76

sizing, 74-76
transparency, modifying, 89-90
Windows 7
Home Premium version of, 20
overview, 20
Professional version of, 20
software programs, running and
managing, 146-156
Ultimate version of, 20
versions of, 20
Windows Aero Glass, 80, 89-90
Windows Defender, 18, 392
Windows Explorer, 69-70
Windows Firewall, enabling, 399-401
Windows Help and Support
browsing, 131
customizing, 139-140
display options, changing, 139-140
Microsoft Customer Support,
contacting, 140-142
online help, accessing, 135-136
overview, 127-128
posting a question in Windows
communities, 132-135
Premier Third Tier Support, 141-142
printing help topics, 129
Remote Assistance, 137-139
searching, 130-132
Table of Contents for, 128-129
text in, sizing, 140
using, 128-129
Windows Live Mail
Address Book feature, 348
attachments, sending, 348-350
Contact List, adding people to, 360-362
Contact List, searching, 362
creating e-mail, 344-348
folders, creating message, 363-365
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Windows Live Mail (continued)
folders, deleting messages in, 366
folders, organizing messages in,

365-366
folders, removing message, 365
folders, renaming message, 365
formatting e-mail, 356-358
forwarding e-mail, 353-354
graphics, adding, 359
inbox, viewing, 343
managing accounts in, 338-340
opening, 342
overview, 338, 340-342
priority of e-mail, 348
reading e-mail, 350-351
Reading Pane, customizing, 362-363
replying to e-mail, 352-353
signatures, adding, 354-356
signing in, 338, 343
spellchecking e-mail, 346
themes, applying, 358-359

Windows Media Center, 244

Windows Media Player
burning music to CD/DVD, 253-254
closing, 234
fast forwarding with, 234
opening, 232
overview, 230
pausing movies with, 233
playing movies with, 232-235
playing music, 255-257
playlist, creating a, 251-252
rewinding with, 234
ripping music, settings for, 257-259
shuffle option for playing music, 257
syncing laptop with music device,

254-255
troubleshooting, 425
volume, adjusting, 233

Windows Photo Viewer
overview, 230
tagging photos in, 237-239
viewing photos in, 236-237
Windows system, restoring, 415-417
Windows tools for security, using, 314
Windows Update
options for, 393-394
running, 394-396
Windows Vista, 21
Windows XP, 21
wireless hotspot, 27
wireless Internet connection, 27, 283
wireless mouse for games, 276
Wireless Wide Area Network
(WWAN), 27
Word Processor (Microsoft)
clip art, adding, 203
dictionary, adding words to, 206
document, printing, 208-209
documents, naming, 194
documents, opening existing, 195
documents, saving, 194
footer, inserting, 208
grammar, checking, 206
graphics, adding, 202-203
graphics, resizing, 203-204
header, inserting, 208
opening, 192
page setup, changing, 206-208
spelling, checking, 204-206
table, inserting, 200-202
text, copying, 196
text, cutting, 196
text, deleting, 193
text, editing, 192-193
text, entering, 192
text, formatting, 197-199
text, pasting, 196-197



text, selecting, 195
text, wrapping, 192
word processors, 192. See also Word
Processor
work history, sharing, 330
Works Spreadsheet (Microsoft)
autoformatting cells, 217-218
AutoSum button, 219
calculations, performing simple,
218-220
charts, inserting, 222-223
data, entering, 214-215
data, saving, 215
fill, completing a series with, 220-222
formatting numbers, 215-217
opening, 214
World Wide Web
browser, entering Web address in, 287
hyperlinks, clicking on, 288
navigation of, 287-289
overview, 280
pop-up ads, blocking, 288-289
searching, 296-298
wrapping text, 192
writable DVD drives, 24
WWAN (Wireless Wide Area
Network), 27
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